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Chapter 1 Overview (Updated 6/30/2010) 

1.1 Introduction to Site 

The Environmental Screening Tool (EST) supports agency participation and community involvement throughout 
Florida's Efficient Transportation Decision Making (ETDM) Process. This application provides tools to input and 
update information about transportation projects, perform standardized analyses, gather and report comments 
about potential project effects, and provide information to the public. It brings together information about a 
project and provides analytical and visualization tools that help synthesize and communicate that information. It 
is used throughout the ETDM Process to:  

• Integrate data from multiple sources into an easy to use, standard format  

• Analyze the effects of proposed projects on the human and natural environment  

• Communicate information effectively among Environmental Technical Advisory Team (ETAT) 
representatives and make information available to the public  

• Store and report results of the ETAT review effectively and efficiently  

• Maintain project records, including commitments and responses, throughout the project life cycle  

The EST is continually updated to provide additional information and tools in support of the ETDM Process. A 
list of EST functions is provided in Chapter 2.4 of the EST Handbook, and is also available in the application 
under EST Site Map.  

The EST integrates Internet mapping technology, relational database management systems and geographic 
information systems (GIS). This integration was implemented using industry-standard platform-independent 
development tools such as Hyper Text Markup Language (HTML), Hibernate, Velocity, Java Script, and 
Extensible Markup Language (XML). The EST is deployed as a Web-based application in order to minimize 
system requirements on the users' desktop computers. The application is deployed at the University of Florida 
in conjunction with the Florida Geographic Data Library (FGDL). FGDL is a repository of GIS data gathered from 
federal, state, and local governments. 

1.2 System Requirements 

Hardware 
Following are the minimum requirements for the end user’s desktop computer: 

• 700 MHz, Intel Pentium III or equivalent AMD processor 

• 3 gigabyte free disk space 

• 1024 x 768 video card resolution 

• 17-inch color monitor (19-inch monitor recommended) 

• Access to the Internet (128 Kb connection or better) 

• Access to color printer recommended, but not required 

• 256 MB RAM 
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Software 
The following software packages are required on the end user’s desktop computer: 

• Microsoft Windows 7, Vista, XP Professional or Home, Windows 2000, NT, 95, and 98  

• Microsoft Internet Explorer (IE) 7 or higher (must run in compatibility mode if running IE 8 or 9), available for 
free download at: 

http://www.microsoft.com/windows/ie/default.asp 

• Adobe Acrobat Reader, current version available for free download at: 

http://www.adobe.com/support/downloads/main.html 

• Adobe SVG Viewer, version 3 or higher, available for free download at: 

http://www.adobe.com/support/downloads/main.html 

1.3 Website Access 

ETDM Coordinators and authorized MPO and FDOT District staff have read/write access to the Environmental 
Screening Tool so that they can update project information and respond to ETAT review comments. ETAT 
representatives have read/write access to provide comments about potential effects to environmental 
resources. Community Liaison Coordinators (CLCs) create community inventories and review projects for 
potential sociocultural effects using the Environmental Screening Tool. These users are authorized by FDOT’s 
ETDM Coordinators and granted access by EST administration staff. Each user is given a unique username 
and password that grants permission to the servers and to the database. Each user is assigned a specific role 
according to their job duties which grants them write authority to specific portions of the database. These 
authorized users access the Environmental Screening Tool through a common Internet website at: 

http://www.fla-etat.org 

To enter the site, use Microsoft Internet Explorer version 7.0 or higher. The application may not function properly 
with other Internet browser software. Type the website address (above) in the address box at the top of the 
screen.  

Security Certificate 
When the site is first accessed, a security 
alert may appear about the site security 
certificate. This warning is issued if the 
user profile does not recognize www-fla-
etat.org site as a trusted site. The 
warning will appear each time you log on 
until you accept and install the certificate.  

1. To install the certificate, first click on 
the button "View Certificate." 

1 
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2. In the next window, click "Install Certificate."  

 

 

 

 

 

 

 

 

 

 

3. Click "Next" in the Certificate Import Wizard window.  

 

 

 

 

 

 

 

 

 

 

 

4. The next window specifies where the 
certificates are kept. Use the default value 
to allow Windows to automatically select a 
certificate store. Click "Next" to continue. 

 

 

 

 

 

 

 

 

2

3

4
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5. In the next window, click "Finish" to complete the certificate import process. 

 

6. In the next security-warning window, click on "Yes" to confirm the validity of the site and install the 
certificate. 

 

 

7. A message window will appear to confirm that the import was 
successful. Click "OK" to close the window. 

 

 

 

 

 

 

 

5

6

7
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8. After importing the certificate, click "OK" on the 
Certificate Information window. The window will 
close. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Click "Yes" to proceed from the initial security 
warning message. The window will close. 

 

 

 

 

 

 

 

 

 

The certificate installation process only needs to be done one time. The next time you go to the EST website, 
the warning message will not appear. 

For a description of the logon splash page, please proceed to Chapter 2 of the EST Handbook. 

 

8 

9
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1.4 Background 

The Environmental Screening Tool (EST) is a fundamental component of the ETDM Process. As such, its 
development occurred while the new business process was being defined. This produced a very flexible 
environment in which the process could be refined to take advantage of technology, and the technology could 
be easily adjusted as process details were defined. It also presented the application development team with the 
challenge of developing a complex application while the work process requirements were still evolving. The 
team addressed this challenge by designing for change and developing the application incrementally in a series 
of modules using an evolving prototype model for the development methodology. This is a life-cycle model in 
which the system is developed in increments so that it can be modified in response to customer feedback. 
Unlike other types of prototyping, the prototype code is not discarded; instead, it evolves into the code that is 
ultimately delivered. In the EST, the database design emphasizes flexibility so that the application can be easily 
adapted as the process is adjusted. Each of the initial modules was developed by starting with the basic 
requirements and adding complexity as the process was refined. This allowed frequent opportunities for the 
Steering Committee and potential users to review and respond to the application as it was being developed. 
The end result is a toolbox of customized applications that support the ETDM Process. Although the initial 
release of the EST was well received, it was anticipated that modification would be needed to reflect further 
refinement of the new business process after it had been used during the first year. Based on feedback from 
users during the first year of implementation, a new integrated design of the EST was developed to improve the 
graphical user interface, code maintainability, and user work flow. The new design also took advantage of 
technology advancements and upgrades made available since the conception of the project. 

One primary objective of the new site organization was the integration of functionality. The original site 
organized functions by module. Each module supported specific process tasks such as project data input, ETAT 
review, or Sociocultural Effects evaluation. By developing the original application in modules, the development 
team was able to respond quickly to changes in part of the ETDM Process without affecting code developed to 
support other parts of the Process. However, as the Process evolved and people began using the application, 
the use of modules became somewhat problematic. Some functions were duplicated or slightly modified among 
modules. Users who had access to more than one module had trouble finding functionality among the various 
modules. The new site solved these problems by making all of the functions available in one integrated 
navigation system. The integrated navigation system is described in Chapter 2 of the EST Handbook.  

1.5 Roles and Privileges (Updated 11/30/2011) 

Only the functions needed by a user to perform ETDM task assignments appear in the EST main menu. This is 
determined by the roles and privileges assigned to the user when they are given access to the site. Users’ roles 
are based on the tasks that they will perform. Privileges establish whether or not a user may add or modify 
records to specific parts of the database. The following matrix (Table 1-1) shows the functions available for each 
user role.  

Note: The “Xs” in a row for an individual function indicate the user roles that have access to that function. 
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Table 1-1 EST Roles and Privileges Matrix 
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Menu Sub-category Name Privileges 

Tools Project Diary > Create New 
Project X 

   
X X 

       
X X 

  
X X 

 
X 

             
X X 

      
X 

  
Tools Project Diary > Project Description X 

   
X X 

       
X X 

  
X X 

 
X 

             
X X 

      
X 

  
Tools Project Diary > Alternative 

Description X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Tools Project Diary > Draw Project on 
Map X 

   
X X 

       
X X 

  
X X 

 
X 

             
X X 

      
X 

  

Tools Project Diary > 
Extract Project 
from State 
Highway System 

X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Tools Project Diary > Segment 
Description X 

   
X X 

       
X X 

  
X X 

 
X 

             
X X 

      
X 

  

Tools Project Diary > Project Phase 
(Planning, etc.) X 

   
X X 

       
X 

   
X X 

               
X X 

      
X 

  

Tools Project Diary > Project Status 
(Editing, etc.) X 

   
X X 

       
X 

   
X X 

 
X 

             
X X 

      
X 

  
Tools Project Diary > Attach Documents X 

   
X X 

       
X X 

  
X X 

 
X 

             
X X 

      
X 

  
Tools Project Diary > Transportation 

Plan Summary X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Tools Project Diary > Project Manager 
Information X 

   
X X 

       
X 

   
X X 

 
X 

             
X X 

      
X 

  
Tools Project Diary > Lead Agency X 

   
X X 

       
X X 

  
X X 

 
X 

             
X X 

      
X 

  
Tools Project Diary > Commitments and 

Responses X 
   

X X 
       

X 
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X 
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X 
  

Tools Project Diary > Permits X 
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X 
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X 
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X 
  

Tools Project Diary > Technical Studies X 
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X 
   

X X 
 

X 
             

X X 
      

X 
  

Tools Project Diary > Class of Action X 
   

X X 
       

X 
   

X X 
 

X 
             

X X 
      

X 
  

Tools Project Diary > Project Schedule X 
    

X 
       

X 
   

X X 
                       

X 
  

Tools Advance Notification 
Package > Edit AN Package X 

            
X 

   
X X 

                       
X 

  

Tools Advance Notification 
Package > Transmittal List X 

            
X 

   
X X 

                       
X 
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Menu Sub-category Name Privileges 

Tools 
Advance Notification 
Package > 

Upload Transmittal 
List 

X 
            

X 
   

X X 
                       

X 
  

Tools 
Mailing Labels > AN 
Package > 

Avery 5160 - 2.625 
" x 1" - 30/sheet 
(PDF) 

X 
            

X 
   

X X 
                       

X 
  

Tools 
Mailing Labels > AN 
Package > 

Avery 5161 - 4" x 
1" - 20/sheet 
(PDF) 

X 
            

X 
   

X X 
                       

X 
  

Tools 
Mailing Labels > AN 
Package > 

Avery 5167 - 1.75" 
x 0.5" - 80/sheet 
(PDF) 

X 
            

X 
   

X X 
                       

X 
  

Tools 
Mailing Labels > AN 
Package > 

Excel File X 
            

X 
   

X X 
                       

X 
  

Tools Review Project > 
Advance 
Notification 
Package  

X X 
          

X 
        

X 
           

X X X 
         

Tools Review Project > 
Purpose & Need 
Statement 

X 
   

X X 
     

X X X 
 

X X X X X 
            

X X X X 
      

X 
 

X 

Tools Review Project > Direct Effects X 
   

X X 
     

X X X 
 

X X X X X 
            

X X X X 
      

X 
 

X 

Tools Review Project > 
Secondary & 
Cumulative Effects 

X 
   

X X 
     

X X X 
 

X X X X X 
            

X X X X 
      

X 
 

X 

Tools Review Project > 
Federal 
Consistency 
Finding 

X 
                      

X 
                     

Tools Review Project > 
Class of Action 
Determination 

X 
   

X X 
  

X 
  

X X X 
 

X X X X X 
                      

X 
  

Tools Review Project > 
Eliminated 
Alternatives 

X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Tools Review Project > Summary Reports X 
   

X X 
       

X 
   

X X 
               

X X 
      

X 
  

Tools Review Project > 
Track State 
Clearinghouse 
Projects 

X 
                                           

X 

Tools 
Community 
Coordination > 

Community 
Characteristics 

X 
            

X 
 

X X X X 
             

X X X X 
      

X 
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Menu Sub-category Name Privileges 

Tools 
Community 
Coordination > 

Community-
Desired Features 

X 
   

X X 
       

X 
 

X X X X 
             

X X X X 
      

X 
  

Tools 
Community 
Coordination > 

Public Comments X 
   

X X 
       

X 
 

X X X X 
             

X X X X 
      

X 
  

Tools Coordinate ETAT > Email User Groups X 
   

X X 
     

X X X X X X X X X X 
           

X X 
 

X 
      

X 
 

X 

Tools Coordinate ETAT > 
Review ETAT 
Notifications 

X 
                

X X 
                         

X 

Tools Coordinate ETAT > 
Extend ETAT 
Review Period 

X 
   

X X 
       

X 
   

X X 
               

X X 
         

Tools Coordinate ETAT > 
Allow Comments 
After Review 
Period 

X 
   

X X 
       

X 
   

X X 
               

X X 
         

Tools Coordinate ETAT > Dispute Resolution X 
   

X X 
       

X 
   

X X 
               

X X 
         

Tools 
Performance 
Management > 

District 
Coordinator 
Survey 

X 
                

X X 
                          

Tools 
Performance 
Management > 

ETAT Survey X 
           

X 
                                

Tools 
Performance 
Management > 

Issue/Action 
Tracking 

X 
    

X 
                                       

Tools Agency Invoices > 
Reviewer 
Preference 

X 
                

X X 
                          

Tools Agency Invoices > Edit Expenses X 
                            

X 
           

X 
   

Tools Agency Invoices > 
Log Agency 
Activity 

X 
          

X X 
                

X 
           

X 
   

Tools Agency Invoices > 
Upload Agency 
Activity 
Spreadsheet 

X 
          

X X 
                

X 
           

X 
   

Tools Agency Invoices > 
Manage Master 
Agreement/ 
Contract 

X 
                            

X 
               

Tools Agency Invoices > 
Advance Pay 
Request 

X 
                            

X 
           

X 
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Menu Sub-category Name Privileges 

Tools Agency Invoices > 
Summarize 
Agency Activities 

X 
                            

X 
           

X 
   

Tools Agency Invoices > 
Update Invoice 
Status 

X 
                            

X 
               

Tools Agency Invoices > Upload Receipts X 
                            

X 
           

X 
   

Tools Agency Invoices > Upload Signatures X 
                            

X 
           

X 
   

Tools Agency Invoices > 
Record Invoice 
Comments 

X 
        

X 
                   

X 
 

X 
             

Tools Agency Invoices > Assign Hours X 
                                        

X 
   

Tools Agency Invoices > 
Override Invoice 
Payments 

X 
                            

X 
               

Tools Project Tracker > Project Tasks X X X X X X 
 

X X X 
 

X X X X X X X X X X X X X X 
    

X X X X X X X 
    

X X X X X 

Tools Project Tracker > Task Groups X 
    

X 
           

X X 
                          

Tools Project Tracker > 
Average District 
Project Costs and 
Times 

X 
    

X 
           

X X 
                          

Tools Project Tracker > Track Projects X 
    

X 
       

X 
   

X X 
               

X X 
      

X 
  

Tools Document Review > 
Set Up Document 
Review 

X 
                        

X 
          

X 
        

Tools Document Review > Review Document X 
                        

X X X X 
       

X X X X 
     

Tools Document Review > 
Respond to 
Document 
Reviews 

X 
                          

X 
          

X 
      

Tools Cumulative Effects > Create PARA X 
                                            

Tools Cumulative Effects > Select PARA X 
                                            

Tools Cumulative Effects > 
Add / Modify 
PARA Description 

X 
                                            

Tools Cumulative Effects > 
Record Cumulative 
Effects Evaluation 
Results 

X 
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Menu Sub-category Name Privileges 

Tools Cumulative Effects > 
Summarize 
Cumulative Effects 
Evaluations 

X 
                                            

Reports Project Diary > 
Project Milestone 
Report 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > Project Description X X 
  

X X 
  

X 
  

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > 
Status of GIS 
Analysis 

X 
   

X X 
  

X 
    

X X X X X X X X 
           

X X X X 
      

X 
  

Reports Project Diary > 
Transportation 
Plan Summary 
Report 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > 
Supplemental 
Project Documents 

X 
   

X X 
     

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > Project Managers X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > Project Schedule X 
    

X 
       

X 
   

X X 
                       

X 
  

Reports Project Diary > 
Dispute Resolution 
Activity Log 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > Permits X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > Technical Studies X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Diary > 
Community-
Desired Features 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
           

X X X X 
      

X 
 

X 

Reports Project Diary > 
Project 
Commitments / 
Responses 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports 
Advance Notification 
Package > 

Advance 
Notification 
Package 

X X 
  

X X 
  

X 
  

X X X X X X X X 
 

X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports 
Advance Notification 
Package > 

Comments on 
Advance 
Notification 
Package 

X X 
  

X X 
  

X 
  

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports 
Advance Notification 
Package > 

Transmittal List X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 
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Menu Sub-category Name Privileges 

Reports Project Effects > 
Countywide GIS 
Summary 

X 
                                            

Reports Project Effects > 
GIS Analysis 
Results 

X 
   

X X 
     

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports Project Effects > 
GIS Analysis 
Summary 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Effects > 
Agency Comments 
- Project Effects 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Effects > 
Agency Comments 
- Purpose & Need 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Effects > 
Screening 
Summary Chart 

X X 
  

X X 
  

X 
  

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports Project Effects > Summary Report X X 
  

X X 
  

X 
  

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Reports Project Effects > 
Sociocultural 
Effects Evaluation 
Summary Report 

X 
    

X 
                                       

Reports Project Effects > 
Federal 
Consistency 
Findings 

X 
          

X X 
        

X X X 
                    

X 

Reports Project Effects > 
Track State 
Clearinghouse 
Projects Report 

X 
   

X X 
     

X X X 
   

X X 
    

X 
          

X X 
        

X 

Reports Project Effects > 
Class of Action 
Determination 

X 
   

X X 
     

X X X 
 

X X X X X X 
  

X 
        

X X X X 
      

X X X 

Reports Project Effects > 
Comments on 
Environmental 
Documents 

X 
                                            

Reports Project Effects > 
Agency Comments 
- Ad Hoc Query 

X 
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Menu Sub-category Name Privileges 

Reports Project Effects > 
GIS Analysis 
Results (All) 

X 
                                            

Reports Reminders > 
Projects Flagged 
for Dispute 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Reminders > 
Projects in Dispute 
Resolution 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Reminders > 
Projects Awaiting 
ETDM QA/QC 

X 
   

X X 
       

X 
   

X X 
               

X X 
         

Reports Reminders > 
Un-published 
Summary Reports 

X 
   

X X 
       

X 
   

X X 
    

X 
          

X X 
         

Reports Reminders > 
Projects Needing 
Republication 

X 
   

X X 
       

X 
   

X X 
    

X 
          

X X 
         

Reports Reminders > 
Project Milestone 
Needs 

X 
   

X X 
       

X 
   

X X 
    

X 
          

X X 
         

Reports 
Agency Participation 
> 

Agencies and 
Associated 
Resource Issues 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports 
Agency Participation 
> 

Agency Review 
Overview 

X X X 
 

X X 
  

X 
  

X X X X X X X X X X X 
 

X X 
    

X X X X X X X 
    

X X X 
 

X 

Reports 
Agency Participation 
> 

Agency Websites X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports 
Agency Participation 
> 

ETAT Contact List X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X X X 

Reports 
Agency Participation 
> 

Projects Needing 
Class of Action 
Review 

X 
   

X X 
  

X 
  

X X X 
   

X X X X 
             

X X 
      

X 
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Menu Sub-category Name Privileges 

Reports 
Agency Participation 
> 

Projects Needing 
Federal 
Consistency 
Review 

X                     X  X                      

Reports 
Agency Participation 
> 

Projects Needing 
Advance 
Notification Review 

X X 
                                           

Reports 
Agency Participation 
> 

Projects Needing 
Review 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports 
Agency Participation 
> 

Track ETAT 
Notifications      

X 
           

X X 
                       

X 
 

X 

Reports 
Community 
Coordination > 

Community 
Characteristics 
Inventory     

X X 
     

X X X X X X X X X X 
           

X X X X 
      

X 
 

X 

Reports 
Community 
Coordination > 

Mailing Labels 
    

X X 
  

X 
  

X X X X X X X X X X 
           

X X X X 
      

X 
 

X 

Reports 
Community 
Coordination > 

Public Comments 
Summary 

X 
   

X X 
  

X 
    

X 
 

X X X X 
             

X X X X 
      

X 
  

Reports 
Performance 
Management > 
Surveys> 

View Blank Survey X 
    

X 
                                       

Reports 
Performance 
Management > 
Surveys > 

ETAT Survey X 
    

X 
      

X 
                                

Reports 
Performance 
Management > 
Surveys > 

ETAT Survey 
Results 

X 
    

X 
                                       

Reports 
Performance 
Management > 
Surveys > 

District ETDM 
Coordinator 
Survey 

X 
    

X 
           

X X 
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Menu Sub-category Name Privileges 

Reports 
Performance 
Management > 
Surveys > 

District ETDM 
Coordinator 
Survey Results 

X 
    

X 
                                       

Reports 
Performance 
Management > 
Surveys 

Ad Hoc Survey 
Report 1 

X 
                                            

Reports 
Performance 
Management 
>Surveys 

Ad Hoc Survey 
Report 2 

X 
                                            

Reports 
> Performance 
Management >Issue 
Tracking >  

Details Report X 
    

X 
                                       

Reports 
Performance 
Management >Issue 
Tracking >  

Inbox X 
    

X 
                                       

Reports 
Performance 
Management > 
Issue Tracking >  

Summary Report X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring >  

Agency Annual 
Reports 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports 

Performance 
Management 
Performance> 
Monitoring >  

Agency Feedback 
Report 

X 
    

X 
                                       

Reports 

Performance 
Management> 
Performance 
Monitoring >  

Agency Review 
Matrix 

X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring >  

Agency Review 
Report 

X 
    

X 
  

X 
  

X X X X X X X X X X 
           

X X X X 
      

X 
  



 

 
Environmental Screening Tool Handbook 1-16 

Functions 

Roles 

Ad
m

in
 

Ad
va

nc
e N

ot
ifi

ca
tio

n 
- C

om
m

en
tin

g 
In

te
re

st
ed

 P
ar

ty
 

Ad
va

nc
e N

ot
ifi

ca
tio

n 
- O

th
er

 In
te

re
st

ed
 P

ar
ty

 

CE
MO

 C
om

m
un

ity
 R

es
ou

rc
es

 S
ec

tio
n 

Me
m

be
r 

CE
MO

 L
iai

so
n 

CE
MO

 M
an

ag
er

 

Ce
nt

ra
l L

AP
 A

dm
in

ist
ra

to
r 

Co
m

m
un

ity
 D

at
a E

nt
ry

 

Di
st

ric
t E

nv
iro

nm
en

ta
l A

dm
in

ist
ra

to
r 

Di
st

ric
t I

nv
oi

ce
 R

ev
iew

er
 

Di
st

ric
t L

AP
 A

dm
in

ist
ra

to
r 

ET
AT

 M
em

be
r 

ET
AT

 M
em

be
r P

rim
ar

y 

ET
DM

 C
oo

rd
in

at
or

 M
an

ag
em

en
t T

ea
m

 

ET
DM

 D
at

a E
nt

ry
 

FD
OT

 C
om

m
un

ity
 L

iai
so

n 
Co

or
di

na
to

r 

FD
OT

 C
om

m
un

ity
 L

iai
so

n 
Co

or
di

na
to

r P
rim

ar
y 

FD
OT

 E
TD

M 
Co

or
di

na
to

r 

FD
OT

 E
TD

M 
Co

or
di

na
to

r P
rim

ar
y 

FH
W

A 
Cl

as
s o

f A
ct

io
n 

Au
th

or
ity

 

FI
HS

 C
en

tra
l O

ffi
ce

 

Fe
de

ra
l C

on
sis

te
nc

y -
 C

om
m

en
tin

g 
In

te
re

st
ed

 P
ar

ty
 

Fe
de

ra
l C

on
sis

te
nc

y -
 O

th
er

 In
te

re
st

ed
 P

ar
ty

 

Fe
de

ra
l C

on
sis

te
nc

y R
ev

iew
er

 

Gu
es

t 

In
te

rn
al 

Do
cu

m
en

t R
ev

iew
 - 

Ad
m

in
ist

ra
to

r 

In
te

rn
al 

Do
cu

m
en

t R
ev

iew
 - 

Co
m

m
en

te
r 

In
te

rn
al 

Do
cu

m
en

t R
ev

iew
 - 

Re
sp

on
de

r 

In
te

rn
al 

Do
cu

m
en

t R
ev

iew
 - 

St
af

f 

In
vo

ice
 A

dm
in

ist
ra

to
r 

In
vo

ice
 C

on
ta

ct
 

In
vo

ice
 R

ev
iew

er
 

MP
O 

Co
m

m
un

ity
 L

iai
so

n 
Co

or
di

na
to

r 

MP
O 

Co
m

m
un

ity
 L

iai
so

n 
Co

or
di

na
to

r P
rim

ar
y 

MP
O 

ET
DM

 C
oo

rd
in

at
or

 

MP
O 

ET
DM

 C
oo

rd
in

at
or

 P
rim

ar
y 

Pa
rtn

er
 D

oc
um

en
t R

ev
iew

 - 
Ad

m
in

ist
ra

to
r 

Pa
rtn

er
 D

oc
um

en
t R

ev
iew

 - 
Co

m
m

en
te

r 

Pa
rtn

er
 D

oc
um

en
t R

ev
iew

 - 
Re

sp
on

de
r 

Pa
rtn

er
 D

oc
um

en
t R

ev
iew

 - 
St

af
f 

Pr
e-

sc
re

en
 D

at
a E

nt
ry

 

Pr
im

ar
y A

ge
nc

y I
nv

oi
ce

 S
ub

m
itt

er
 

Pr
oj

ec
t M

an
ag

er
 

Pu
bl

ic 

St
at

e C
lea

rin
gh

ou
se

 C
oo

rd
in

at
or

 

Menu Sub-category Name Privileges 

Reports 

Performance 
Management 
>Performance 
Monitoring >  

Data Quality 
Assessment 

X 
                                            

Reports 

Performance 
Management 
>Performance 
Monitoring >  

Environmental 
Documents Report 

X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring > 

ETAT Participation 
Report 

X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring >  

ETAT Review 
Status Report 

X 
                                            

Reports 

Performance 
Management 
>Performance 
Monitoring >  

ETDM Scorecard X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring > 

Performance 
Measure Results 

X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring > 

SCE Evaluation 
Participation 
Report 

X 
    

X 
                                       

Reports 

Performance 
Management 
>Performance 
Monitoring >  

Summary Report 
Status Report 

X 
                                            

Reports 

Performance 
Management 
>Quality Assurance 
Review >  

Class of Action 
Quality Assurance 
Report 

X 
    

X 
       

X 
 

X X X X 
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Menu Sub-category Name Privileges 

Reports 

Performance 
Management 
>Quality Assurance 
Review >  

Integrated 
Performance 
Management QA 
Report 

X 
    

X 
         

X X X X 
                          

Reports 

Performance 
Management 
>Quality Assurance 
Review >  

Summary of Public 
Comments Status 
Report 

X 
    

X 
       

X 
 

X X X X 
                          

Reports 

Performance 
Management 
>Quality Assurance 
Review >  

Summary Report 
Status by Planning 
Org Report 

X 
    

X 
       

X 
 

X X X X 
                          

Reports 

Performance 
Management 
>Quality Assurance 
Review >  

State Clearing-
house Federal 
Audit Report 

X 
    

X 
                                      

X 

Reports Invoicing Reports > 
Advance Pay 
Request Log 

X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > 
Advance Pay 
Request Report 

X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > 
Agency Activity 
Report 

X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > 
District Invoice 
Reviewer Report 

X 
                            

X 
               

Reports Invoicing Reports > 
Invoice Comment 
Log 

X 
                            

X 
 

X 
             

Reports Invoicing Reports > 
Invoice Tracking 
Report 

X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > 
MA/Contract 
History Reports 

X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > 
MA/Contract 
Summary Report 

X 
                            

X 
 

X 
         

X 
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Menu Sub-category Name Privileges 

Reports Invoicing Reports > 
Payment Tracking/ 
Invoice Report 

X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > Invoice X 
                            

X 
 

X 
         

X 
   

Reports Invoicing Reports > 
Agency Activity 
Log Report 

X 
          

X X 
                

X 
 

X 
         

X 
   

Reports Invoicing Reports > Schedule A-2 X 
                            

X 
           

X 
   

Reports Invoicing Reports > 
Invoice Payment 
Overrides 

X 
                            

X 
               

Reports Project Tracker > 
Average District 
Project Costs and 
Times 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Tracker > 
Project Tasks 
Status 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Project Tracker > Task Groups X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Reports Document Review > 
Document 
Reviews and 
Responses 

X 
                        

X X X X 
       

X X X X 
     

Reports Cumulative Effects > 
PARA Description 
Report 

X 
                                            

Reports Cumulative Effects > 
Cumulative Effects 
Evaluation Report 

X 
                                            

Reports Cumulative Effects > 
PARA Analysis 
Results 

X 
                                            

Reports Cumulative Effects > 
ETAT Comments 
By PARA 

X 
                                            

Reports Cumulative Effects > 
PARAs within 
Project Vicinity 

X 
                                            

Reports Cumulative Effects > 
PARAs within 
County 

X 
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Menu Sub-category Name Privileges 

Wizards 
 

Perform ETAT 
Review 

X 
   

X X 
     

X X X 
 

X X X X X 
            

X X X X 
        

X 

Wizards 
 

Create ETDM 
Project 

X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Wizards 
 

Generate 
Summary Report 

X 
   

X X 
       

X 
   

X X 
               

X X 
      

X 
  

Wizards 
 

Update ETDM 
Project 

X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Wizards 
 

Set Up User 
Preferences 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
 

X X X X 
   

X X X X 
      

X 
 

X 

Wizards 
 

Draft ETAT 
Notification 

X 
   

X X 
       

X 
   

X X 
               

X X 
         

Wizards 
 

Prepare Invoice X 
                            

X 
           

X 
   

Maps 
 

View Interactive 
Maps 

X X 
  

X X 
  

X 
  

X X X X X X X X X X X 
 

X 
        

X X X X 
      

X 
 

X 

Maps Edit Map Features > Project Input X 
   

X X 
       

X X 
  

X X 
 

X 
             

X X 
      

X 
  

Maps Edit Map Features > Community Input X 
   

X X 
       

X 
 

X X X X 
             

X X X X 
         

Maps 
 

Print Hard Copy 
Maps 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Maps 
 

Print Potential 
Impact 
Assessment Maps 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Maps 
 

Hard Copy Map 
Queue 

X 
                                            

Maps 
 

Potential Impact 
Assessment Map 
Queue 

X 
                                            

Account 
Settings  

Change Password X X 
  

X X 
  

X 
  

X X X X X X X X X X X 
 

X 
 

X X X X X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

Update Contact 
Information 

X X 
  

X X 
 

X X X 
 

X X X X X X X X X X X 
 

X 
 

X X X X X X X X X X X 
    

X X X 
 

X 
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Menu Sub-category Name Privileges 

Account 
Settings  

Customize My 
ETDM 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
     

X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

My GIS Analysis 
Reports 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
        

X X X X 
      

X 
 

X 

Account 
Settings  

Manage Saved 
Searches List 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
     

X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

Manage Contact 
Lists     

X X 
     

X X X X X X X X X X 
  

X 
 

X X X X X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

Manage 
Bookmarks 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
 

X X X X X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

Manage My ETDM 
Dashboard 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
 

X X X X X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

Customize Map 
Viewer 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
     

X 
 

X X X X X 
     

X X 
 

X 

Account 
Settings  

Change 
Notification 
Settings 

X 
   

X X 
     

X X X X X X X X X X 
  

X 
     

X 
 

X X X X X 
     

X X 
 

X 

Administration 
 

Manage Users X 
                                            

Administration 
EDMS Tools / 
Reports > 

View EDMS 
Queue 

X 
                                            

Administration 
EDMS Tools / 
Reports > 

Generate 
Alternative 
Elimination 
Reports From 
Queue 

X 
                                            

Administration Developer Tools > Bugzilla X 
                                            

Administration Developer Tools > JavaDoc X 
                                            

Administration Developer Tools > Subversion Web X 
                                            

Administration Developer Tools > Color Palette X 
                                            

Administration 
ISDM Tools > 
Developer Tools > 

Export Site Map 
Privileges Matrix to 
Excel 

X 
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Menu Sub-category Name Privileges 

Administration 
ISDM Tools > 
Developer Tools > 

Generate Data 
Dictionary 

X 
                                            

Administration 
ISDM Tools > 
Developer Tools > 

Get Data elements 
in the assembly 
and their structure 

X 
                                            

Administration 
ISDM Tools > 
Developer Tools > 

Get Relationships 
among assemblies 

X 
                                            

Administration 
ISDM Tools > 
Developer Tools > 

Populate All Data 
Elements and their 
Structure 

X 
                                            

Administration 
ISDM Tools > 
Developer Tools > 

Populate All 
Relationships 
among assemblies 

X 
                                            

Administration E-mail tools > Email Search X 
                                            

Administration E-mail tools > Mass Emailer X 
                                            

Administration Test JSPs > 

Performance 
Measures - 
Stakeholder 
Notification QA QC 

X 
                                            

Administration Test JSPs > 
Document Include 
Tester 

X 
                                            

Administration Test JSPs > ADA Guidelines X 
                                            

Administration Test JSPs > Test Project Filter X 
                                            

Administration Test JSPs > Test Jurisdictions X 
                                            

Administration Test JSPs > 
Test Special 
Characters 

X 
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Menu Sub-category Name Privileges 

Administration Test JSPs > 
Test Group 
Folders 

X 
                                            

Administration 
 

Under 
Construction 

X 
                                            

Administration 
 

Update What's 
New 

X 
                                            

Administration 
 

View Page 
Permissions 

X 
                                            

Administration 
 

View Active 
Sessions 

X 
                                            

Administration 
 

View User Prefs X 
                                            

Administration 
 

ETAT Reviews 
and Summaries 

X 
                                            

Administration 
 

View Comments X 
                                            

Administration 
 

ETDM 
Performance 
Measures 

X 
                                            

Administration 
 

ETDM Coordinator 
and CLC 
Feedback 

X 
                                            

Administration 
 

Agency Feedback 
Notifications 

X 
                                            

Administration 
Issue Tracking and 
Survey Tools > 

Issue Tracking 
Admin Tool 

X 
                                            

Administration  
Issue Tracking and 
Survey Tools > 

Create/Edit Survey X 
                                            

Administration 
Issue Tracking and 
Survey Tools > 

Answer Survey X 
                                            

Administration 
Issue Tracking and 
Survey Tools > 

View Survey X 
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Administration 
Interactive Map 
Viewer > 

Output Interactive 
Map Viewer TOC 
to Excel or 
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X 
                                            

Administration 
Interactive Map 
Viewer > 

Export User Map 
Preferences Matrix 
to Excel 

X 
                                            

  
Quick Bookmark 
page 

X 
   

X X 
  

X 
  

X X X X X X X X X X 
  

X 
 

X X X X 
   

X X X X 
      

X 
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Welcome Page for 
My ETDM 

X 
   

X X 
  

X 
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X 
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X 
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My ETDM 
Dashboard 

X 
   

X X 
  

X 
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X X X X 
   

X X X X 
      

X 
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save minireport 
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Blue box –links 
 

FAQs X X 
  

X X 
 

X X X 
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X 
 

X X X X X 
 

X X X X X X X X X 
 

X X 
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Blue box links 
 

Tip Sheets X X 
  

X X 
 

X X X 
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X 
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X X X X X X X X X 
 

X X 
 

X 

Blue box links 
 

User Handbook X X 
  

X X 
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X 
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X X 
 

X 

Blue box links 
 

ETDM Glossary X X 
  

X X 
 

X X X 
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X X 
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ETDM Acronyms X X 
  

X X 
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X X X X X X X X X 
 

X X 
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ETDM Library X X 
  

X X 
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X X 
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Blue box links 
 

ETDM Calendar X X 
  

X X 
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X X 
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ETDM Training X X 
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X X X X X 
 

X X X X X X X X X 
 

X X 
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Blue box links 
 

Training Videos X X 
  

X X 
 

X X X 
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X 
 

X X X X X 
 

X X X X X X X X X 
 

X X 
 

X 

Blue box links 
 

What's New X X 
  

X X 
 

X X X 
 

X X X X X X X X X X X 
 

X 
 

X X X X X 
 

X X X X X X X X X 
 

X X 
 

X 

Blue box links 
 

Site Map X X 
  

X X 
 

X X X 
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X 
 

X X X X X 
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X X 
 

X 

Blue box links 
 

About EST X X 
  

X X 
 

X X X 
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X 
 

X X X X X 
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X X 
 

X 
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X 
 

X X X X X 
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X 
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Chapter 2 Navigation (Updated 11/30/2011) 

The first window that appears on the Environmental Screening Tool (EST) website is a log-on splash page, 
which displays fields for logging on to the EST and links to other Web sources for additional information.  After 
logging on to the site, the core navigation elements on the EST website include a top toolbar, Project Navigation 
bar, collapsible main menu, and accessible help and resource links.  Navigation among multiple open pages is 
accomplished through the use of tabs and slide-out maps.  Detailed descriptions of each of the navigation 
elements are provided in the following sections of this chapter: 

• Section 2.1 – Log-on Splash Page 

• Section 2.2 – Home Page 

• Section 2.3 – Top Toolbar 

ο 2.3.1 Top Toolbar Links 

ο 2.3.2 Quick Search 

• Section 2.4 – Project Navigation Bar 

• Section 2.5 – Main Menu 

• Section 2.6 – Links to Help and other resources 

• Section 2.7 – Tabs 

• Section 2.8 – Map Slide-out Bar 

• Section 2.9 – Page Toolbar 

2.1 Log-on Splash Page 

The Environmental Screening Tool (EST) is a secure application.  The log-on window contains fields to log on to 
the EST, as well as several options to obtain more information: 

• Summary – Displays a general overview of the Environmental Screening Tool 

• Public Site – Opens a new browser window containing the Public Access site home page 

• Contacts – Lists names, phone numbers, and email addresses of people to contact for more information 

• Florida Geographic Data Library – Opens a new window containing the Florida Geographic Data Library 
(FGDL) home page 

• State of Florida Department of Transportation (FDOT) – Click on the logo to open the FDOT home page 

• MyFlorida.com – Click on the logo to open a new window containing the MyFlorida.com home page. 
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To log on to the EST, complete the three steps listed in below in the following sequence: 

• In the Username field, type your assigned user name. 

• In the Password field, type your EST password. 

• Click Sign In.  

Note:  For security purposes, user accounts are locked after three consecutive login failures 
within a 15-minute time frame.  If this occurs, contact the Help Desk.  
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The EST opens and displays the Home page along with the following core navigation elements of the EST 
website: 

• Top toolbar  

• Project Navigation bar 

• Main menu  

• Links to Help and other resources 

• Map slide-out bar 

• Contact ETDM Help Desk 

 

2.2 Home Page (New 8/30/2010) 

The Home page provides links and information that will help you navigate the EST website.  The EST Home 
page displays the following sections: 

• what's new – Provides the latest information about enhancements made to the EST. Click the more… 
button to view the full list of EST enhancements. 

• quick links – Displays links to Help and frequently viewed pages  
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Tip!   To open the Home page and keep the Home tab visible while you work in the EST, click 

the etdm or est links, , located at the top of 
the EST window.   

 

2.3 Top Toolbar (New 8/30/2010) 

The top toolbar of the EST helps you to quickly access EST pages and functions. You can use the top toolbar 
to: 

• Set your page preferences using the My ETDM wizard. 

• Add and select frequently visited pages using the Bookmarks list.  

• Log out of the EST. 

• Find specific information, forms, reports, or EST functions using the Quick Search feature.   

 

2.3.1 Top Toolbar Links 
The links shown in the top toolbar of the EST are described below. 

• My ETDM – The My ETDM link opens a wizard for selecting EST pages to become part of your 
preferences when accessing the EST.  These pages are referred to as mini-reports. Once the initial 
preferences have been set up, clicking My ETDM returns you to the EST Home page, where the page or 
group of pages you selected will be displayed.   
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Note:  See the Set Up User Preferences section of the Wizards chapter in the EST Handbook 
for details on setting page preferences, and see the Customize My ETDM section of the EST 
User Handbook for information on making changes to your My ETDM preferences.  

• Bookmarks –Click Bookmarks to expand the menu.  

 
This pull-down menu enables you to configure your bookmarks or add the current page to the 
Bookmarks list.  

To open a page already included in your Bookmarks list, click the page link.  

 

Tip!  Alternatively, you can manage your bookmarks by clicking the Manage Bookmarks option 
in the Account Settings menu, which allows you to select or deselect one or more pages from a 
checklist of available pages.  There is no limit to the number of pages you can bookmark. 

• Logout – Click Logout to close the EST session.   

Note:  If the EST site is not used for more than 15 minutes (i.e., you have not clicked any of the functions or 
moved your mouse over an area of the EST window), it will automatically log you out. 

2.3.2 Quick Search (New 6/30/2010) 
The EST Quick Search function lets you search the EST website for specific information without having to 
navigate through the main menu. You can perform a search of the EST website using keywords, project 
numbers, project name (full or partial), EST function, or a name from the ETDM Contact List. 

Using the Quick Search Function: 

1. In the Search Site for field, type your search query. For the next illustration, the search target is for the 
EST function Attach Document. 

 

2. Click Search or press the Enter key.   
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The Search Results window opens, displaying the links related to your search query, along with 
a description of each link.  Links are divided into the following categories.  

• Library Documents – All documentation (e.g., tip sheets, ISDM, technical documentation) related 
to the search query is shown. Click the link to open the selected document. 

• Tools and Reports – Displays the menu locations for the tools and reports related to your search 
query. Click the navigation link to go directly to the selected function. 

• Projects – Lists all projects related to your search query (for the Attach Documents example, all 
projects that have documents attached to the project record would be listed). Click the ETDM 
number link to open the Project Description window for the selected project. 

• Contacts – Shows the list of names from the ETDM Contact List matching the query. Click the 
individual's name to open the Contact Details page, which shows the contact's email address and 
EST role.    

Note: Depending on your search query, the Search Results window will arrange the categories 
accordingly, with the listing most closely related to the query appearing first (e.g., if you search for 
an individual, the Contacts category would appear at or near the top of the list of categories). 

 

3. Do one of the following: 

• Click the link in the numbered list to open the document or access the page for the selected 
function. 

• If your selection does not appear on the first Search Results page, do one of the following: 

ο Go to the next page by clicking the page number link beside Go to page. 

ο Click the Browse all link at the bottom of the category section. 

 

Tip!  You can check the number of results returned for your selected query at the top right of 
each category section.   
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2.4 Project Navigation Bar (Updated 11/30/2011) 

Immediately below the top toolbar, a series of tools are available for navigation. This navigation bar serves as 
the primary method for selecting Projects.  The Active project field shows the project that is in active view with 
a list box containing a group of projects available for active display.  The EST displays pages for information 
related to a selected Project when you select project-specific menu options.  This provides the ability to move 
from section to section without having to repeatedly search for a Project. 

 

Project Navigation Bar Components 

• Active project – Displays the current project in active view.  Click the Active project arrow to view the list 
of currently selected Projects. Click a Project name to select it as the active project.  

Note:  The Project number and name must appear in the Active project field when working with 
tools and reports related to a project. 

• Map It – Shows the project location in the Map Viewer 

 

• Advanced Project Search – Opens a Project selection tool (referred to as the Project Selection Wizard) 
that enables you to search for and select individual or multiple Projects. This selection will be used to 
determine the starting point whenever you subsequently activate functions from the main menu. You may 
also choose to add the selection to the Saved Searches list.   

• Saved Searches – Displays a list of Projects you frequently use.  You can add Projects to this list via the 
Advanced Project Search tool or Project History list. 

• Project History – Displays the Projects most recently viewed, enabling you to quickly switch between 
current and recent Project selections. 
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Using the Advanced Project Search Component: 

1. To search for and select individual or multiple Projects using the Project Selection Wizard, click the 
Advanced Project Search button. 

 
 

2. The Project Selection Wizard opens.  Do one of the following: 

• To select specific Project(s) based on project numbers(s) or project names(s), click the option 
button beside Manual Selection (See Step 3). 

 

• To select a group of Projects based on a region and other criteria, click the option button beside 
Power Search (See Step 4).   

 
 

3. For Manual Selection, do the following: 

• To search for a specific Project, click the option button beside one of the following: 

ο Project Number. The Enter a Project Number field appears. 

ο Project Name. The Enter a Project Name field appears. 

• Type the Project Name or the Project Number. 



 

 
Environmental Screening Tool Handbook  2-9 

• Click Add to Selection. The Project is now added to your selection. 

Tip! Click remove to remove a Project from the selection list. 

 

• Click Next.  

• Under Do you want to save this selection for future use?, click the option button beside the 
appropriate selection – Yes or No.  

 
 
4. For Power Search, do the following: 

• Click the option button beside Power Search, and then click Next. 
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The Project Selection Wizard displays the next step, enabling you to narrow your search 
criteria.   

 

 
• Do one of the following: 

ο Click one of the links listed under Available Categories, and then continue making your 
selections. 

ο Click Next to bypass the category search filter and go to the next step (shown in the next 
illustration). 

 

• To further narrow your search criteria, you can search by: 

ο Project Name 

ο Planning Organization 

ο ETDM Status 

ο ETDM Phase 

ο ETDM Filter 

• After you have entered your selection(s), click Next. The Project Selection Wizard displays your 
search results. 

Tip!  To change your selections, click the Change link beside the selection. The Project 
Selection Wizard returns you to the search filter, where you can change your search criteria. 



 

 
Environmental Screening Tool Handbook  2-11 

 

• Click a checked box beside the Project name(s) you do not want to include in your selection. 

 

Tip!   If your search results in a long list of Projects, and you are interested in limiting your 
selection to only one or a few Projects, click the Select/Unselect All check box to uncheck 
all the Project names, and then click the check box beside the Projects you want to include in 
your selection list.   

• Click Next. The Project Selection Wizard displays options for saving your selection. 

 

• Under Do you want to save this selection for future use?, click the option button beside the 
appropriate response – one of the Yes options (to save your search results for future use) or No (to 
use the search results only during the current session).  

• If you select No, the Project Selection Wizard automatically takes you to the Project Selection 
Complete step, which displays a confirmation stating your selection will only be available for the 
immediate session and in your Project History list. 
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• If you select one of the Yes options, the Project Selection Wizard displays a text box showing the 
name of the dynamic query or selected group. The default name reflects the selected search 
criteria.  

  

• Do one of the following: 

ο To change the name of the dynamic query/selected group, type the new name in the Please 
name your dynamic query text box, and then click Finish.  

ο To accept the default name, click Finish. 

The Project Selection Wizard displays Project Selection Complete, showing a 
confirmation that your selection has been added to your saved searches. For this illustration, 
the name for this query is Florida, FDOT District 3. 
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2.5 Main Menu (Updated 11/30/2011) 

The EST main menu serves as the main access point to the functions 
that make up the EST website. The main menu is grouped into 
categories based on function type, with each category displaying a list 
of functions when expanded.  The main menu categories are as 
follows: 

• Tools – forms for entering data  

• Reports – includes standard reports and queries grouped in 
categories such as Project Diary and Project Effects 

• Wizards – guides you through various complex functions, reports, 
and tasks  

• Maps – the Interactive Map enables you to display information 
over a geographic location through a custom map and to 
dynamically interact with the online mapping application 

• Account Settings – enables you to set user preferences, change 
your password, and other user-specific option management 

Note:  Not all menu functions appear to all users. Depending on your 
assigned role, you will only be able to view the menu functions 
accessible to the role.    

1. To view all the functions listed under a category, click the arrow 
beside the category name. For this illustration, Reports is 
shown. 

 
The category expands, displaying the list of functions.  
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Tip!  Click the up-arrow  to collapse the category. 

2. To view the submenu options related to a selected function, point to the function name.  

Tip!  Left-click on a function to pin the expanded submenu open.  To collapse the submenu 
again, you can either click on one of the submenu options or left-click the pushpin. 

 
 

3. Click the submenu option to open the page displaying the input form, report, maps, or user-specific 
action. 

  
 

4. Click hide menu to collapse the main 
menu, giving you more screen space 
to work on a task. Click the Click to 
open menu bar to display the menu. 

Tip!   To further expand your 
screen work space, click the F11 
key. This expands the EST window 
by hiding the Windows toolbar.  
Click the F11 key again to display 
the Windows toolbar. 
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Tools 
The functions listed in the Tools menu are used primarily for data entry, which includes all input provided 
throughout the life cycle of a project.  Table 2-1 lists the options available in the Tools menu. 

Table 2-1 EST Tool Options 

Sub-category Tool Name 
Project Diary 
  Create New Project 
  Project Description 
  Alternative Description 
  Draw Project on Map 
  Extract Project from State Highway System 
  Segment Description 
  Project Phase (Planning, etc.) 
  Project Status (Editing, etc.) 
  Attach Documents 
  Transportation Plan Summary 
  Project Manager Information 
  Lead Agency 
  Commitments and Responses 
  Permits 
  Technical Studies 
  Class of Action 
  Project Schedule 
Advance Notification Package 
  Edit AN Package 
  Transmittal List 
  Upload Transmittal List 
  Mailing Labels 
Review Project 
  Advance Notification Package 
  Purpose & Need Statement 
  Direct Effects 
  Secondary & Cumulative Effects 
  Federal Consistency Finding 
  Class of Action Determination 
  Eliminated Alternatives 
  Summary Reports 
  Track State Clearinghouse Projects 
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Sub-category Tool Name 
Community Coordination 
  Community Characteristics 
  Community-Desired Features 
  Public Comments 
Coordinate ETAT 
  Email User Groups 
  Review ETAT Notifications 
  Extend ETAT Review Period 
  Allow Comments After Review Period 
  Dispute Resolution 
Performance Management 
  District Coordinator Survey 
  ETAT Survey 
  Issue/Action Tracking 
 Agency Invoices 
  Reviewer Preference 
  Edit Expenses 
  Log Agency Activity 
  Upload Agency Activity Spreadsheet 
  Manage Master Agreement/Contract 
  Advance Pay Request 
  Summarize Agency Activities 
  Update Invoice Status 
  Upload Receipts 
  Upload Signatures 
  Record Invoice Comment 
  Assign Hours  
  Override Invoice Payments 
Project Tracker 
  Project Tasks 
  Task Groups 
  Average District Project Costs and Times 
  Track Projects 
Document Review 
  Set Up Document Review  
  Review Document 
  Respond to Document Reviews 
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Reports 

The Reports menu includes standard reports and queries, as listed in Table 2-2. 

Table 2-2 EST Reports 

Subcategory Report Name 
Project Diary 
  Project Milestone Report 
  Project Description 
  Status of GIS Analysis 
  Transportation Plan Summary Report 
  Supplemental Project Documents 
  Project Managers 
  Project Schedule 
  Dispute Resolution Activity Log 
  Permits 
  Technical Studies 
  Community-Desired Features 
  Project Commitments/Responses 
Advance Notification Package 
  Advance Notification Package 
  Comments on Advance Notification Package 
  Transmittal List 
Project Effects 
  Countywide GIS Summary 
  GIS Analysis Results 
  GIS Analysis Summary 
  Agency Comments – Project Effects 
  Agency Comments – Purpose & Need 
  Screening Summary Chart 
  Summary Report 
  Sociocultural Effects Evaluation Summary Report 
  Federal Consistency Findings 
  Track State Clearinghouse Projects Report 
  Class of Action Determination 
  Comments on Environmental Documents 
  Agency Comments – Ad Hoc Query 
  GIS Analysis Results (All) 
Reminders 
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Subcategory Report Name 
  Projects Flagged for Dispute 
  Projects in Dispute Resolution 
  Projects Awaiting ETDM QA/QC 
  Un-published Summary Reports 
  Projects Needing Republication 
  Project Milestone Needs 
Agency Participation 
  Agencies and Associated Resource Issues 
  Agency Review Overview 
  Agency Websites 
  ETAT Contact List 
  Projects Needing Class of Action Review 
  Projects Needing Federal Consistency Review 
  Projects Needing Advance Notification Review 
  Projects Needing Review 
  Track ETAT Notifications 
Community Coordination 
  Community Characteristics Inventory Report 
  Mailing Labels 
  Public Comments Summary 
Performance Management 
 Surveys View Blank Survey 
  ETAT Survey 
  ETAT Survey Results 
  District ETDM Coordinator Survey 
  District ETDM Coordinator Survey Results 
  Ad Hoc Survey Report 1 
  Ad Hoc Survey Report 2 
 Issue Tracking Details Report 
  Inbox 
  Summary Report 
 Performance Monitoring Agency Annual Reports 
  Agency Feedback Report 
  Agency Review Matrix 
  Agency Review Report 
  Data Quality Assessment 
  Environmental Documents Report 
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Subcategory Report Name 
  ETAT Participation Report 
  ETAT Review Status Report 
  ETDM Scorecard 
  Performance Measure Summary Report 
  SCE Evaluation Participation Report 
  Summary Report Status Report 
 Quality Assurance Review Class of Action Quality Assurance Report 
  Integrated Performance Management QA Report 
  Summary of Public Comments Status Report 
  Summary Report Status by Planning Org Report 
  State Clearinghouse Federal Audit Report 
Invoicing Reports 
  Advance Pay Request Log 
  Advance Pay Request Report 
  Agency Activity Report 
  District Invoice Reviewer Report 
  Invoice Comment Log 
  Invoice Tracking Report 
  MA/Contract History Reports 
  MA/Contract Summary Report 
  Payment Tracking/Invoice Report 
  Invoice 
  Agency Activity Log Report 
  Schedule A-2 
  Invoice Payment Overrides 
Project Tracker 
  Average District Project Costs and Times  
  Project Tasks Status  
  Task Groups  
Document Review 
  Document Reviews and Responses 
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Wizards 
Used for more complex input and query functionality, the Wizard functions combine tools and reports to step a 
user through a sequential process.  To open a Wizard, select one of the following options in the Wizards menu: 

• Perform ETAT Review  

• Create ETDM Project 

• Generate Summary Report 

• Update ETDM Project 

• Set Up User Preferences 

• Draft ETAT Notification 

• Prepare Invoice 

Maps 
The Maps menu is used to access various types of maps, both interactive and hard copy.  Selection of these 
options opens a search page where you can specify/update the criteria to be applied to the map. 

• View Interactive Maps 

• Edit Map Features 

ο Project Input 

ο Community Input 

• Print Hard Copy Maps 

• Print Potential Impact Assessment Maps 

• Hard Copy Map Queue 

• Potential Impact Assessment Map Queue 

Account Settings 
The Account Settings menu includes the following functions to set and manage user preferences: 

• Change Password 

• Update Contact Information 

• Customize My ETDM  

• My GIS Analysis Reports 

• Manage Saved Searches List 

• Manage Contact Lists 
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• Manage Bookmarks 

• Manage My ETDM Dashboard 

• Customize Map Viewer 

• Change Notification Settings 

2.6 Links to Help and Other Resources (New 8/30/2010) 

The options listed below the main menu provide links to Help and additional resources. Click a link for 
quick access to the following resources: 
• FAQ – lists answers to common questions about the ETDM Process and the EST 

• Tip Sheets – links to ETDM Library listing of EST tip sheets 

• User Handbook – displays the online version of the EST User Handbook 

• ETDM Glossary – opens the ETDM Glossary page 

• ETDM Acronyms – opens the ETDM Acronyms page 

• ETDM Library – opens the ETDM Library page 

• ETDM Calendar – displays an interactive calendar that shows upcoming training sessions and events 

• ETDM Training – links to training resources  

• Training Videos – links to EST training videos  

• What’s New – displays the list of EST enhancements 

• Site Map – displays an outline  of the EST website with active links to each function 

• About EST – describes the origin and purpose of the EST  

• Contacts – lists Help Desk and agency contacts 

• Public Site – enables read-only access to the ETDM database, serving as a source of information for the 
public concerning projects 

• Get Adobe Acrobat Reader – opens Adobe website 

2.7 Tabs (Updated 8/30/2010) 

The EST opens each selected function or task as a tabbed page.  By default, when you open a page for 
another task, the page automatically replaces the page that immediately preceded it.  However, you can open 
multiple pages at the same time by right-clicking menu options. For example, as shown in the next illustration, 
right-clicking the Track Projects option will open the Track Projects page beside the current Manage Project 
Tasks screen. 
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The page that was previously in the current screen remains active and available.  

 
EST tabs work like folders in a filing cabinet, allowing you to switch between tasks by clicking the page tabs.  To 
display a page, click the dark tab.  

 
The EST displays the selected page in current view with a white tab.  Dark tabs indicate pages that are active 
and available. 
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To close a page, click the  button.   

 

Note:  Opening multiple EST pages can result in a confusing number of forms and delay page display time. To 
avoid encountering these types of problems, it is recommended you close pages that you are not working in.  

2.8 Map Slide-out Bar  

Maps are opened and moved out of the way by the use of a slide-out window.  Click the Click to Open Map 
bar to open the window.   

Tip!  Click the Click to Close Map bar to close the map window. 

 
 

Maps retain the most recently used data selections and map extent unless you click the button to 
refresh the map using new project selections. 
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2.9 Page Toolbar (Updated 6/30/2010) 

The page toolbar found at the top of the EST pages provides links to the following functions: 

 

The Print tool allows you to print the current page. Clicking this icon opens a printer 
dialogue box to your default printer. 

 
The Tip tool provides a quick navigation reference for the current page. 

 

The Spreadsheet tool allows you to print data (e.g., contact lists) as an Excel 
spreadsheet. 

 
The Video tool opens a separate window, displaying links to training videos associated 
with the selected function. Click a video title to start the video.   

 
The PDF tool is used to export the current page to a PDF viewer, enabling you to save or 
print the PDF.  Click the Close PDF button to close the viewer and return to the current 
page. 

 
The Feedback tool enables you to open a comment form for sending feedback about 
the current page. 

 
The Help tool opens the online version of the EST Handbook, providing a more 
detailed reference for navigating the current page. 

 

The Bookmark tool enables you to add the current page to your bookmarks. Clicking 
the icon opens a dialogue bar, showing the Bookmark Name.  By default, the name 
is the same as the current page.  You can rename the bookmark by clicking the text 
box, and then typing the new bookmark name.   

Click add to make the bookmark part of your user preferences, or click cancel to 
return to the current page. 

 

The My ETDM tool is used to add the current page to your My ETDM preferences. 
The dialogue bar that opens includes a text box that can be used to rename the My 
ETDM page.  (The default name is the same as the current page.)   

Click add to make the page part of your My ETDM preferences, or click cancel to 
return to the current page 
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Chapter 3 Functions 

This chapter describes all of the functions available on the Environmental Screening Tool. Not all of the 
functions are available to all of the users. The actual functions which appear will depend on the user’s access 
role defined when the user account is established.  (See Table 1-1 in the Overview chapter for the complete list 
of roles and privileges.) 

Function descriptions are organized in subsequent sections according to major functional categories as they 
appear in the EST main menu: 

• Tools – Used primarily for data entry related functions 

• Reports –  Standard reports and queries which retrieve data from the database 

• Wizards – Composed of tools and reports to step a user through a sequential process 

• Maps – Opens the interactive maps for viewing or editing, and provides access to standard hard copy 
maps 

• Account Settings – Contains options for setting user-specific preferences 

• Help – Includes system help and other help-related information pages, such as Frequently Asked 
Questions 

3.1 Tools (Updated 11/30/2011) 

The main menu tools are used primarily for data entry related functions, which include all input provided 
throughout the life cycle of a project. See Table 2-2 in Chapter 2 of this Handbook for a list of the options 
available in the Tools category.  To open the Tools menu, click on the up arrow. To close the menu, click the 
down arrow. The functions within categories appear to the right when the cursor hovers over the name. 
Features that are not available to users because of their assigned role do not appear on the menu.  

3.1.1 Project Diary (Updated 11/30/2011) 
The Project Diary category listed in the Tools 
menu allows users to create or update the 
project record and ancillary data.  To view the list 
of available functions, point to Project Diary, 
and then click on a function title to open the 
form. 
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3.1.1.1 Create New Project Record (Updated 04/30/2012) 

The Create New Project Record function in the Environmental Screening Tool (EST) Tools menu 
enables authorized users to do the following: 

• Add a project to the EST database, including Project Description Summary, Purpose and Need 
Statement, Federal Consistency, and other related project information.  

• Designate a project as a Local Agency Program (LAP) project; assign a new or existing LAP agency, 
and enter the assigned LAP agency's PD&E LAP certification status. 

• Designate agencies that will be exempted from participating in the project’s Environmental Technical 
Advisory Team (ETAT) review.   

Users with the following EST roles may access the Create New Project Record tool: Environmental 
Management Office liaisons and managers, FDOT ETDM Management Team, FDOT ETDM Data Entry, 
District ETDM Coordinators Primary, District ETDM Coordinators, Metropolitan Planning Organization (MPO) 
Coordinators Primary, MPO Coordinators, and Project Managers. 

Creating a New Project Record: 

1. On the Tools menu, point to Project Diary, and then click Create New Project. 

 
The Create New Project Record page opens, displaying a page toolbar and a Project 
Description form.   

 

Tip!   Click on the toolbar icons to: 

  View tip sheets for the current page. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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2. For the Project Name** and Planning ID fields enter the name of the project and the Planning ID 
number.   

Note: Double asterisks (**) indicate a required field.  If the field is blank, the information must be 
added before the form can be processed. 

 

3. For the Local Agency Program (LAP)** field,  do one of the following: 

• Leave Unknown as the default selection if the project's LAP status has not yet been determined. 
Go to Step 5. 

• Click the drop-down arrow, , and then do one of the following: 

ο Click Yes if the project is being contracted out by the FDOT to a local agency. Go to the 
next step. 

ο Click No if the project is not being contracted out to a local agency. Go to Step 5. 

ο Click Anticipated (Planning Phase only) if the project is in the process of being 
contracted out to a local agency. Go to the next step. 

 

 
 

4. If you selected Yes or Anticipated (Planning Phase only) for the Local Agency Program (LAP) 
option, the Update Project Description form displays fields for adding LAP information.  Do the 
following: 

• For LAP Agency**, select the LAP agency responsible for the project by doing one of the 
following: 

ο Click the LAP Agency arrow, , to expand the list, and then select an agency by clicking 
on the agency name. 

ο If the LAP Agency is not listed, click the Add another agency to this list link, and then 
type the name of the agency in the text box.  

 

Tip!   If the agency is already in the EST database, you need to type only the first three 
letters of the name. The EST automatically displays a list of names that match your text. 
Click the appropriate selection from the list. 

If the agency is being added to the EST database, type the agency's entire name. The 
agency will be added to the database. 
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• In the Agency Completing NEPA Document** field, do one of the following: 

ο Click the FDOT option button if FDOT will be completing the National Environmental Policy 
Act (NEPA) document, and then go to Step 6 of these instructions. 

ο Click the Local Agency (with FDOT oversight) option button if the local agency will be 
completing the NEPA document.  

Note:  Local agencies must be PD&E LAP Certified if completing the NEPA document 
with FDOT oversight. 

 
 

The LAP Agency Certification** field appears, displaying options for the agency’s 
PD&E LAP Certification status.  

Note:   The agency must be certified by the District LAP Administrator for the type of 
work it will be performing. After the project information has been submitted, the District 
LAP Administrator will receive an email notification about the project’s LAP designation 
and whether the need for agency certification has been indicated. 

• In the LAP Agency Certification** field, click the appropriate option button beside one of the 
following LAP Certification statements: 

ο is already PD&E LAP Certified (The agency selected in the LAP Agency field has 
completed the Local Agency Certification Qualification Agreement and has been approved 
by the District LAP Coordinator.) 

ο will need to be PD&E LAP Certified via LAP Coordinator (The agency selected in the 
LAP Agency field is pending approval by the District LAP Coordinator.) 

5. Add information for the remaining fields: 

• Financial Management No. – Enter the Financial Management Number, if available. 

• Counties** – Use the Counties scroll bar to move down the list. Select one or multiple options 
by clicking the county name(s). 

Tip!  Use SHIFT+click to select adjacent options. Use CTRL+click to select non-adjacent 
options. 

• Beginning Location – Type the project’s beginning location. 

• Ending Location – Type the project’s ending location. 
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• Alternative Corridor Evaluation (ACE) – Indicate whether or not this project is participating in 
the ACE process by either accepting the default No or by clicking the drop-down arrow, , and 
then selecting Yes. 

• ETDM Phase – Click the Project Phase link to open the Update Project Phase page, enabling 
you to change the project phase.  

Note: When a screening cycle is completed (i.e., when the phase is changed, or when 
project Alternatives are moved from non-draft to draft status), previously entered 
consistency information will automatically be removed. 

• Project Web Site – Type the URL to the project's website, if available. More than one URL can 
be entered, if needed. 

• Federal Involvement** – Click the appropriate check box(es) to indicate the level of Federal 
Involvement (or No Federal Involvement) for the project. Descriptions for the various levels are 
provided beside each option listed on the screen. 

Note:  Because PD&E LAP Certified agencies are reimbursed by FDOT with federal 
funds, you must select a level of Federal Involvement for LAP projects.  

 

• Purpose and Need – Make edits, if any, to the project’s Purpose and Need Statement by typing 
or copying and pasting your changes in the text box. 

• Project Description Summary – Make edits, if any, to the Project Description Summary by 
typing or copying and pasting your changes in the text box. 

Tip!  To copy and paste text from another document, highlight the selected text and then 
click Ctrl + C on your keyboard to copy the information. Click Ctrl + V keys to paste the 
information in the text box. 

• Click the Summarize/Modify Public Comments link to open the Summarize/Modify Public 
Comments page, enabling you to add or modify public comments regarding the project.  
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• Planning Consistency Status – This section provides an efficient means to enter and track 
planning consistency information that is required for NEPA approval. 

Note:  Planning consistency information is mandatory for NEPA approval. However, providing 
the information via the EST is optional.  

 

ο Click the Expand this section link to display the form. 

ο Enter the information in the fields and select the appropriate values from the options that 
are presented.  Only fields that have been completed and fields where either a Yes or No 
option has been selected will appear in the report.  

 

Tip!  Click the URL link http://www.dot.state.fl.us/planning/policy/metrosupport shown 
on the screen to get the latest Planning Consistency guidance or download the spreadsheet 
from FDOT’s Metropolitan and Regional Support website. 

  

Note: Selecting No requires a written explanation. Type or copy and paste the explanation into 
the appropriate Comments text box. Instructions for what needs to be included in your 
explanation are displayed in light font within the Comments text boxes.  

  

Tip! After clicking the Submit button, the Upload Attachments section will display 
document links to pages that have been attached for the associated transportation plan. 
Click the Pages link to open the document PDF, or click the delete link to remove the 
attachment. Click the replace link to make edits to or replace the existing document links. 
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6. In the Designate Exempted Agencies field, indicate agencies that are excluded from reviewing the 
project. 

Note: The Federal Transit Administration (FTA) is exempted by default on all Planning Phase 
projects that do not contain a transit mode. However, if the project will contain a transit mode or if 
there is a reason the FTA needs to review the project, you can remove the FTA exemption by 
clicking the remove link.  

 

• Click the Designate Exempted Agencies arrow, , to expand the list of agencies that qualify 
for the exemption.   

• Select the appropriate agency by clicking the agency name.  Agencies that are qualified for 
exemption are noted as follows: 

ο Federal Highway Administration – The project will be a SEIR (State Environmental 
Impact Report) and there is no intent to federalize the project with the FHWA as the lead – 
mostly for projects involving Florida's Turnpike Enterprise. 

ο Federal Rail Administration – The project does not involve a rail component. 

ο Federal Transit Administration – The project does not involve a transit component. 

ο National Park Service – The project is not near any national park assets. 

ο U.S. Coast Guard – The project is not near a navigable waterway. 

ο U.S. Forest Service – The project is not near any U.S. Forest Service assets. 

• Click Add Exemption. The Designate Exempted Agencies area expands and displays the 
Provide Justification For Exemption section. 

 

• Under Provide Justification For Exemption, type the reason for the agency exemption in the 
Justification text box. 

Note: The Justification** text box is a required field.  

• Repeat the process for additional agencies. 

Tip!  Click the remove link to cancel the operation and remove the selected agency from 
the exemption list. 
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7. Click Submit. 

 
The Create New Project Record page refreshes and displays the project information.   

Tip!  Use the Update Project Description function in the Tools menu or Update ETDM Project 
in the Wizards menu to update the project as it moves through the ETDM Process. 

 

3.1.1.2 Update Project Description (Updated 04/16/2012) 

The Update Project Description function in the Environmental Screening Tool (EST) Tools menu 
enables users to do the following: 

• Update the Project Description in the EST database, including Project Description Summary, Purpose 
and Need Statement, Federal Consistency, and other related project information.  

• Designate a project as a Local Agency Program (LAP) project, assign a new or existing LAP agency 
and enter or update the assigned LAP agency’s PD&E LAP certification status.  

• Designate agencies that will be exempted from participating in the project’s Environmental Technical 
Advisory Team (ETAT) review. 

 
After the Project Description has been updated and submitted, the updated project information becomes part 
of the project reports.   

Updating the Project Description: 

1. To update a project description, the project name should appear in the Active project field in the Project 
Navigation Bar. 

 

Note:  See the Navigation chapter of the EST user handbook for instructions on using the 
Project Navigation Bar. 

2. On the Tools menu, point to Project Diary, and then click Project Description. 
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The Update Project Description page opens, displaying a page toolbar and a Project 
Description form.   

 

Tip!   Click on the toolbar icons to: 

  View tip sheets for the current page. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to the Navigation 
chapter of the EST Handbook. 

3. For Project Name** and Planning ID fields, make edits or add information, if needed.   
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Note: Double asterisks (**) indicate a required field.  If the field is blank, the information must be 
added before the form can be processed. 

 

4. For the Local Agency Program (LAP)** field,  do one of the following: 

• Leave Unknown as the default selection if the project's LAP status has not yet been determined. 
Go to Step 6. 

• Click the drop-down arrow, , and then do one of the following: 

ο Click Yes if the project is being contracted out by the FDOT to a local agency. Go to the 
next step. 

ο Click No if the project is not being contracted out to a local agency. Go to Step 6. 

ο Click Anticipated (Planning Phase only) if the project is in the process of being 
contracted out to a local agency. Go to the next step. 

 

 
 

5. If you selected Yes or Anticipated (Planning Phase only) for the Local Agency Program (LAP) 
options, the Update Project Description form displays fields for adding LAP information.  Do the 
following: 

• For LAP Agency**, select the LAP agency responsible for the project by doing one of the 
following: 

ο Click the LAP Agency arrow, , to expand the list, and then select an agency by clicking 
on the agency name. 

ο If the LAP Agency is not listed, click the Add another agency to this list link, and then 
type the name of the agency in the text box.  

 

Tip!   If the agency is already in the EST database, you need to type only the first three 
letters of the name. The EST automatically displays a list of names that match your text. 
Click the appropriate selection from the list. 

If the agency is being added for the first time, type the agency's entire name. The agency 
will be added to the database. 
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• In the Agency Completing NEPA Document field, do one of the following: 

ο Click the FDOT option button if FDOT will be completing the NEPA document, and then go 
to Step 6 of these instructions. 

ο Click the Local Agency (with FDOT oversight) option button if the local agency will be 
completing the NEPA document.  

Note:  Local agencies must be PD&E LAP Certified if completing the NEPA document 
with FDOT oversight. 

 
 

The LAP Agency Certification field appears, displaying options for the agency’s PD&E 
LAP Certification status.  

Note:   The agency must be certified by the District LAP Administrator for the type of 
work it will be performing. After the project information has been submitted, the District 
LAP Administrator will receive an email notification about the project’s LAP designation 
and whether the need for agency certification has been indicated. 

• In the LAP Agency Certification field, click the appropriate option button beside one of the 
following LAP Certification statements: 

ο is already PD&E LAP Certified (The agency selected in the LAP Agency field has 
completed the Local Agency Certification Qualification Agreement and has been approved 
by the District LAP Coordinator.) 

ο will need to be PD&E LAP Certified via LAP Coordinator (The agency selected in the 
LAP Agency field is pending approval by the District LAP Coordinator.) 

6. Add or edit information for the remaining fields: 

• Financial Management No. – Enter the Financial Management Number, if available. 

• Planning Organization – Select the Planning Organization that is sponsoring the project. 
(This applies to users authorized to update projects for more than one planning 
organization.) 

• Counties** – Use the Counties scroll bar to move down the list. Select one or multiple options 
by clicking the county name(s). 

Tip!  Use SHIFT+click to select adjacent options. Use CTRL+click to select non-adjacent 
options. 
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• Beginning Location – Make edits, if any, to the project’s beginning location by typing your 
changes in the text box. 

• Ending Location – Make edits, if any, to the project’s ending location by typing your changes in 
the text box. 

• Alternative Corridor Evaluation (ACE) – Indicate whether or not this project is participating in 
the ACE process by either accepting the default No or by clicking the drop-down arrow, , and 
then selecting Yes. 

• ETDM Phase – Click the Project Phase link to open the Update Project Phase page, enabling 
you to change the project phase.  

Note: When a screening cycle is completed (i.e., when the phase is changed or when 
project Alternatives are moved from non-draft to draft status), previously entered 
consistency information (including Air Quality Conformity, MPO Goals and Objectives, Local 
Government Comprehensive Plan, and Coastal Zone Management Program) will 
automatically be removed from the current project data, in preparation for a new screening 
event. The previously entered information remains available in the summary report and 
milestone snapshot reports of the previous screening event. 

• Project Web Site – Type the URL to the project's website, if available. More than one URL can 
be entered, if needed. 

• Federal Involvement** – Click the appropriate check box(es) to indicate the level of Federal 
Involvement (or No Federal Involvement) for the project. Descriptions for the various levels are 
provided beside each option listed on the screen. 

Note:  Because PD&E LAP Certified agencies are reimbursed by FDOT with federal 
funds, you must select a level of Federal Involvement for LAP projects.  

 

• Purpose and Need – Make edits, if any, to the project’s Purpose and Need Statement by typing 
or copying and pasting your changes in the text box. 

• Project Description – Make edits, if any, to the Project Description Summary by typing or 
copying and pasting your changes in the text box. 

Tip!  To copy and paste text from another document, highlight the selected text and then 
click Ctrl + C on your keyboard to copy the information. Click Ctrl + V keys to paste the 
information in the text box. 

• Click the Summarize/Modify Public Comments link to open the Summarize/Modify Public 
Comments page, enabling you to add or modify public comments regarding the project.  
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• Planning Consistency Status – This section provides an efficient means to enter, edit, and 
track project consistency information that is required for NEPA approval.  

Note:  Project consistency information is mandatory for NEPA approval. However, providing the 
information via the EST is optional.  

ο Do any of the following: 

 Select the appropriate response by clicking an option button (Yes, No, Unknown), or 
by entering or editing a field value.  

 Enter or edit justification text if the response is No. 

 Click a Pages link to view the attached documents.  

 Click the delete link to remove the attachment. 

 Click the replace link to replace the existing document(s). 

 Enter or make the appropriate changes to the Comments text boxes. 

 

Note: Selecting No requires a written explanation. Type or copy and paste the explanation into 
the appropriate Comments text box. Instructions for what needs to be included in your 
explanation are displayed in light font within the Comments text boxes.  

Tip!  Click the URL link http://www.dot.state.fl.us/planning/policy/metrosupport shown 
on the screen to get the latest Planning Consistency guidance or download the spreadsheet 
from FDOT’s Metropolitan and Regional Support website. 

7. In the Designate Exempted Agencies field, indicate agencies that are excluded from reviewing the 
project. 
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Note: The Federal Transit Administration (FTA) is exempted by default on all Planning Phase 
projects that do not contain a transit mode. However, if the project will contain a transit mode or if 
there is a reason the FTA needs to review the project, you can remove the FTA exemption by 
clicking the remove link.  

 

• Click the Designate Exempted Agencies arrow, , to expand the list of agencies that qualify 
for the exemption.   

• Select the appropriate agency by clicking the agency name.  Agencies that are qualified for 
exemption are noted as follows: 

ο Federal Highway Administration – The project will be a SEIR (State Environmental 
Impact Report) and there is no intent to federalize the project with the FHWA as the lead – 
mostly for projects involving Florida's Turnpike Enterprise. 

ο Federal Rail Administration – The project does not involve a rail component. 

ο Federal Transit Administration – The project does not involve a transit component. 

ο National Park Service – The project is not near any national park assets. 

ο U.S. Coast Guard – The project is not near a navigable waterway. 

ο U.S. Forest Service – The project is not near any U.S. Forest Service assets. 

• Click Add Exemption. The Designate Exempted Agencies area expands and displays the 
Provide Justification For Exemption section. 

 

• Under Provide Justification For Exemption, type the reason for the agency exemption in the 
Justification text box. 

Note: The Justification** text box is a required field.  

• Repeat the process for additional agencies. 

Tip!  Click the remove link to cancel the operation and remove the selected agency from 
the exemption list. 

8. Click Submit. 

The Update Project Description page refreshes and displays the updated project information.   
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3.1.1.3 Add/Update Alternative Description (New 06/30/2010) 

Projects may have one or more Alternative corridors. By default, one Alternative is added to the project when 
the project is created.  This form allows users to add more Alternative corridors to an existing project.  

The Add/Update Alternative Description function in the Environmental Screening Tool (EST) Tools menu 
enables the ETDM Coordinator to modify project Alternative description information. 

Updating Project Alternative Description Information: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Tools menu, point to Project Diary, and then click Alternative Description. 

 
The Add/Update Alternative Description window opens as a tabbed page, displaying a page 
toolbar, project header, and an Add/Update Alternative form. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

Note: If fields and buttons in Add/Update Alternative section are grayed out, it means the form 
is inactive. To view the reason for an inactive Add/Update Alternative form, check the 
Permissions Message section located at the bottom of the Add/Update Description window 
(as demonstrated in the next illustration). 
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The Add/Update Alternative section displays a form composed of the following fields: 

• Alternative Number – displays available Alternatives from an option list 

• Alternative Type – displays a pre-populated list of Alternative types 

• SIS – enables you to indicate if the Alternative is associated with a Strategic Intermodal System 
(SIS) Designation Change Request by selecting Yes (Y), No (N), or Yes and No(Y/N) 

• Total Length – enables you to type the Total Length of the Alternative 

• Total Cost – enables you to type the Total Cost of the Alternative 

• Alternative Name – an optional field that enables you to type the Alternative's Name 

• Beginning Location – contains the beginning location of the Alternative 

• Ending Location – contains the ending location of the Alternative 

• Mode(s) – a series of check boxes showing the available transportation modes included in the 
Alternative 

 

3. In the Alternative Number field, click the drop-down arrow .  
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The field expands, displaying a list of existing Alternative numbers along with an Alternative 
Number (New).   

• Do one of the following: 

ο If you are updating an existing Alternative, click Alternative Number. 

 

ο If you are adding a new Alternative to the list, click Alternative Number (New). 

 
4. Click go. 

 

5. In the Alternative Type field, click the drop-down arrow  and select the appropriate option. 



 

 
Environmental Screening Tool Handbook  3-20 

 
 

6. In the SIS field, indicate if the Alternative is part of a Strategic Intermodal System (SIS) project by 

clicking the drop-down arrow  and selecting the appropriate response. 

• Y/N (Yes/No) 

• Y (Yes) 

• N (No) 
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7. In the Total Length field, type the total length of the Alternative in miles. 

 
 

8. In the Total Cost field, type the Total Cost of the Alternative. 
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9. In the Alternative Name field, type the Alternative's Name. 

 
 

10. In the Beginning Location field, type the Location identifier (e.g., Industrial Park) or street name where 
the Alternative begins. 
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11. In the Ending Location field, type the Location identifier (e.g., Industrial Park) or street name where 
the Alternative ends. 

 

12. In the Mode(s) field, click the check box(es) beside the applicable option(s). 

• Roadway 

• Pedestrian 

• Bikeway 

• Transit 

• Rail Facility  

• To be determined 

 
Tip!  Click the checked box(es) to deselect a Mode option(s). 
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13. Click Submit Form. 

 
 

A message appears stating the Alternative has been successfully updated. 
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3.1.1.4 Draw Project on Map (In Development) 

3.1.1.5 Extract Project from State Highway System 

After adding a new project record to the database, the next step is creating the lines that will represent 
Alternative corridor(s) on the map. This tool enables users to copy roadway lines from the State Highway 
System base map into the EST database. Information describing the segments is automatically loaded from the 
base map database.  To add a segment to the project from the base map, the following is needed: 

• Roadway Identifier (Roadway ID) 

• Beginning Milepost (BMP) 

• Ending Milepost (EMP) 

On this form, type the information in the fields. 
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3.1.1.6 Update Segment Description 

After project features have been added to a project Alternative, the segment description can be modified by the 
ETDM Coordinator or ETDM Data Entry user using this form. 

To access the Update Segment Description form, go to the Tools menu, point to Project Diary, and then 
click Segment Description.  The Update Segment Description page opens. 

 
Some of the fields will be pre-filled if roadway segments were extracted from the State Highway System (SHS) 
base map.  Enter the information into the form.  Click Add More Sources if space for more funding sources is 
needed.  Table 3-1 describes the information needed for each of the data fields on the form.  When finished, 
click Submit Form. 
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Table 3-1 Project Segment Description 

Field Name Description Valid Values 

Segment Record Identifier automatically assigned to the segment by the computer 
and displayed on the map  

Segment ID Identifier assigned to the project segment by the planning 
organization  

Facility Name Name of project segment location (for example, street name)  
Beginning Location Boundary location marking the beginning of the project segment  
Ending Location Boundary location marking the end of the project segment  

Jurisdiction Entity with maintenance responsibility 
FDOT 
County 
City 

Length Length of planned project segment, in miles  

Functional Class Functional class of roadway.  Not applicable to projects where 
mode is not roadway. 

RURAL: Principal Arterial – 
Interstate 
RURAL: Principal Arterial - Other 
RURAL: Minor Arterial 
RURAL: Major Collector 
RURAL: Minor Collector 
RURAL: Local 
URBAN: Principal Arterial - 
Interstate 
URBAN: Principal Arterial - Other 
Freeways and   Expressways 
URBAN: Principal Arterial - Other 
URBAN: Minor Arterial 
URBAN: Collector 
URBAN: Local 
N/A 

Transportation 
Concurrency Exception 
Area 

Indicates whether or not the project segment is in a Transportation 
Concurrency Exception Area, if one exists within the county 

In 
Out 

BASE CONDITION 
Year 4-digit year of the existing roadway conditions   
AADT Existing traffic volume  
No. Lanes Total number of existing lanes on road  

Configuration Existing lane configuration 

Lanes Freeway 
Lanes Divided 
Lanes Undivided 
Lanes One-way 

NEEDS ASSESSMENT 
Needs AADT Traffic volume in Needs Assessment  
Needs No. Lanes Number of lanes in Needs Assessment  
Needs Configuration Lane configuration in Needs Assessment Lanes Freeway 
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Field Name Description Valid Values 
Lanes Divided 
Lanes Undivided 
Lanes One-way 

COST-FEASIBLE 

Plan Year 
4-digit year of Cost Feasible horizon year. (For example, if the 
project is proposed for the 2025 LRTP, then the plan year would 
be 2025.) 

 

Plan AADT Traffic volume for Cost Feasible horizon year  
Plan No. Lanes Number of lanes for Cost Feasible horizon year  

Plan Configuration Lane configuration for Cost Feasible horizon year 

Freeway 
Divided 
Undivided 
One-way 
Transit 

INTERIM PLAN 
Interim Year 4-digit year for Interim Plan  
Interim AADT Planned traffic volume for Interim Plan  
Interim No. Lanes Planned number of lanes for Interim Plan  

Interim Configuration Planned lane configuration for Interim Plan 

Lanes Freeway 
Lanes Divided 
Lanes Undivided 
Lanes One-way 

FUNDING 
Source Source of funding Funding Source 

Amount 
Estimated segment cost in US dollars (Includes Project 
Development, Design, Right-of-Way Acquisition, Construction, and 
CEI.) 

Funding Amount 

 

3.1.1.7 Update Project Phase (New 06/30/2010) 

The Update Project Phase function in the Environmental Screening Tool (EST) Tools menu enables the 
ETDM Coordinator to move a project and Alternative corridors through the phases of the ETDM Process.  

Updating a Project's Phase: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can choose another project using 
Advanced Project Search. See the Navigation chapter of the EST Handbook for information on 
using the Project Navigation Bar. 
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2. On the Tools menu, point to Project Diary, and then click Project Phase (Planning, etc.). 

 
 

The Update Project Phase window opens as a tabbed page, displaying a page toolbar, project 
header, an Update Project Phase section, and a Form Permissions section. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to the Navigation 
chapter of the EST Handbook. 

The Form Permissions section lists whether or not the permission requirements or required 
tasks have been met.  Any condition or reason listed next to an  indicates a condition must be 
met before the project phase can be updated. 

 
 

Tip!  If the Update Project Phase form is grayed out (i.e., inactive) when you open the Update 
Project Phase window, check the Form Permissions section for the condition(s) or reason(s).  
Click the More Info link for additional details. 
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3. To update a project Phase, do the following: 

• Click the option button, , beside the selected Phase. 

Note:  Double red asterisks (**) indicate the project's current phase. 

 

Tip!  When you click a Phase option button, the EST displays a brief description of how your 
selection affects the project and its Alternative corridors.  

 

 

• Click Update Phase. 

 
 

The EST displays a message asking you to confirm the phase change. 

Note:  Clicking OK will submit the form, which means that the project’s phase will be changed in 
the database and the Summary Report for the most recent screening event cannot be edited after 
the project phase is changed.  If there is an unpublished Eliminated Alternatives Report, it will be 
automatically published, and edited Summary Reports will also be re-published. 

• Click OK. 

Tip!  Click Cancel to cancel the operation. 
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The Update Project Phase window refreshes and displays a Form Confirmation section, 
showing the project was successfully updated.   

4. When updating a project from Programming Phase to Project Development Phase (PD&E) you 
must select Alternatives that will not be moving to Work Program status along with a justification for the 
eliminated Alternatives. Do the following:  

• Click the option button, , beside Project Development Phase (PD&E). 

 
The Update Project Phase section expands, displaying a form for identifying eliminated 
project Alternatives. 

 
 

Note: If there is an un-published Eliminated Alternatives report, it will be published when 
the phase is changed. 

• Under Select any additional alternatives that you would like eliminated, click the check 
box(es) beside the Alternative(s).  
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• Under Justification for setting the status to "Eliminated" for the selected alternative(s), type 
or copy and paste your justification in the comments text box. 

Note: You must provide sufficient information justifying the elimination of the 
Alternative(s). Include determining factors and details describing how you arrived at your 
conclusion. If you are not eliminating Alternatives from the list, leave the comments text 
box blank. 

 

• Click Update Phase. 

 
 

The EST displays a confirmation message. 
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3.1.1.8 Update Project Status (Updated 04/16/2008) 

This tool allows the ETDM Coordinator, Project Manager, or a member of the Coordinator Management Team 
to move a project and its Alternative corridors through the ETDM Process. Changes in the ETDM phase affect 
the entire project, and are changed using the Update Project Phase option.  Within a phase, you may change 
the status of all, some, or just one of the Alternative corridors in a project. For example, if a determination is 
made that a project Alternative is "non-viable” or should be eliminated from further consideration, the ETDM 
Coordinator Primary can change the status of that project Alternative to "Eliminated."  The ETDM Coordinator 
Primary can also use the Update Project Status tool to reactivate an eliminated Alternative. 

The following status settings are available: 

• Editing: Allows the database record to be edited. This is the default setting when a project is first created. 

• Ready for GIS Analysis: Adds the Alternative to the queue for the GIS analysis program to run. Used after 
the segments have been added or modified. (See Section 3.4) 

• GIS Analysis Complete: Set by the application after the GIS analysis program is complete. 

• FIHS Consistency Review: Used by District staff to inform the FIHS Central Office that a FIHS project is 
ready for a consistency review. 

• ETDM QA/QC: Used by data entry staff to inform the ETDM Coordinator that a project is ready for final 
review prior to releasing to the ETAT for review.  

Note: A clear representation of a project’s extent and location is essential for an accurate ETAT 
review and commentary. Refer to the GIS Quality Review Checklist (Section 3.1.1.8.1) to verify 
the accuracy of the features that have been uploaded to the GIS Analysis database and the EST.   

• ETAT Review: Used by the ETDM Coordinator to initiate a review of the project by the ETAT. Locks the 
record for editing until the review cycle is complete. When a project is in "ETAT Review," its status and 
phase cannot be changed until the 45-day review period is over. Once the 45-day review period has ended, 
the status will automatically be changed to "ETAT Review Complete." This will unlock the project and allow 
the ETDM Coordinator to once again set the status and phase. If any project has been assigned a status of 
"ETAT Review," a follow-up form will allow the ETDM Coordinator to email the concerned parties. The email 
addresses and list of updated projects are automatically filled in when the form loads. Only those ETAT 
members responsible for reviewing projects in the ETDM Coordinator’s district are listed. All of the fields are 
editable, allowing the user to add email addresses and change the email text, subject, and from address. 

• ETAT Review Complete: Automatically set by the application at the end of the review period. 

• Dispute Resolution in Progress: Set by the ETDM Coordinator to flag projects that are in dispute resolution 
negotiations. 

• Work Program: Set by the ETDM Coordinator at the end of the Programming Screen if the project is 
included in the Work Program. 

• Eliminated: Set by the ETDM Coordinator at any time in the process if an Alternative is determined to be 
non-viable or should be eliminated from further consideration.  Justification is required for changing the 
status of an Alternative to “Eliminated.” 
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In the Tools menu, point to Project Diary, and then click Project Status (Editing, etc.).  The Update Project 
Status page opens. 

 
 

Select the status by clicking the option button under the status name.  To change the status for a project 
Alternative, use the option buttons in the row corresponding to the Alternative.  To change the status of the 
entire project, use the option buttons in the row titled All Alternatives.  To submit the status changes, click 
Update Status(es).  To reset the form to the previous status(es) without saving the changes, click Reset Form. 
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Explanations concerning the symbols used in the Update Project Status form are provided at the bottom of the 
form, as shown in the next illustration.  This section of the form includes a More Info link, which can be used to 
access the Project Milestone Needs report for the selected project. 

Note:  The hard copy maps pertaining to a project Alternative are automatically generated when the 
Alternative’s status is set to GIS Analysis Complete, ETDM QA/QC, or ETAT Review.  The hard copy maps 
can then be accessed by selecting the project, then selecting Print Hard Copy Maps under the Maps heading. 

 

Tip!  Click the toolbar icon in the Update Project Status window to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3.1.1.8.1 GIS Data Quality Review Checklist   

A clear representation of a project’s extent and location is essential for accurate reviews and commentary by the 
Environmental Technical Advisory Team (ETAT) and the public. After digitizing features in the Environmental 
Screening Tool (EST), or submitting them to be loaded into the geographic information system (GIS) database, 
use the following list to help identify and correct errors: 

• Verify that the number of mapped Alternatives is equal to the number of Alternatives described in the 
Project Description Report.  

• If the GIS features were loaded into the EST from another source, compare the version in the EST with the 
source to verify that all features loaded correctly. 

• Confirm that mapped Alternative endpoints are consistent with the From and To locations described in the 
Project Description Report. 

• Check the relationships among the map features representing your project (also known as “topology”): 

o Lines – Alternative segments are adjoined at their respective endpoints unless otherwise intended, and 
there are no duplicate lines representing the same feature 
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o Polygons – coincident borders of areas should not overlap, nor should there be gaps between the 
areas unless otherwise intended 

o Points – only one point represents the feature unless otherwise intended 

• Compare the location of project features to other features represented on the map:  

o Zoom to a scale of 1:5000 or less at the endpoint of an Alternative. This scale allows you to use the 
most detailed aerials available in the EST – 1-foot Resolution Digital Orthophoto Imagery (DOI). 

o Turn on map layers  that will help confirm locational accuracy, such as the following: 

 DOI Aerials  

 Navteq Roads, railroads or other layers containing useful information for confirming feature 
locations 

 Layers showing resources you plan to avoid (schools, hospitals, parks, etc.) 

o Using the Pan tool, move along each project feature, looking to see if it is in the right place relative to 
other features on the map and consistent with the project description you provided. If the project is 
intended to avoid a sensitive resource in the area, confirm that the project does not intersect the 
resource. For example: 

 If an Alternative is intended to be within an existing road right-of-way, confirm that it is in fact within 
a few feet of a road. 

 If an Alternative is intended to avoid a particular park, turn on a layer like Florida Natural Areas 
Inventory’s (FNAI’s) Florida Managed Areas to confirm that the Alternative does not intersect the 
park boundary. 

• Compare the value of the length field for a project Alternative against the total length value entered in the 
Add/Update Alternative Description form. 

3.1.1.9 Attach Documents (Updated 06/30/2010) 

The Attach Documents function in the Environmental Screening Tool (EST) Tools menu displays a form that 
enables you to attach documents to one or multiple projects.   

You can attach documents to the current project or any of the projects within your jurisdiction. Attach a 
document by uploading it from your computer or by searching for documents in the EST. 

Attaching Documents: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 
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2. On the Tools menu, point to Maintain Project Diary, and then click Attach Documents. 

 
The Attach Documents window opens as a tabbed page, displaying a page toolbar, a list of 
documents for the selected project, and sections showing the steps needed to attach documents 
to one or multiple projects.  

 

Tip!   Click on the toolbar icons to: 

 Open the Tip Sheet of the current page. 

   Send feedback about the current page. 

   Access online Help for the current page. 

    Bookmark the page. 

   Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 
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3. Under Step 1: Select Project(s), do one of the following:  

• To select only the default project (the same project that is shown in the Default Project from 
Selection field located in the Project Navigation bar), leave the option button as selected.  The 
EST automatically defaults to this option.  Go to Step 2. Selecting Document(s) on the form (See 
Step 5 of these instructions). 

 

• To attach a document to multiple projects from your Current Selection, click the option button 
beside Multiple projects. Go to the next step of these instructions for navigation details on 
selecting multiple projects. 

 

Tip!  Click the change this link (for the single project option) or change this list link (for 
multiple projects) to select another project from your Current Selection list or choose 
another project with the Project Selection Wizard.  

 
 

4. After clicking the Multiple projects option, the Select Projects section expands and displays a 
Projects table showing the projects listed in the Current Selection. 

• Select projects by doing one of the following: 

ο Click the check box on the project row for each project you want to attach a document(s) to. 

ο Click the check box beside All to select all the projects in the list. 

Tip!  Click the ETDM number link in the ETDM# column to open the project description. 
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5. Under Step 2. Select Document(s), do one of the following: 

• To upload and attach a document, click the option button beside Upload a document. Go to Step 
6 of these instructions for information on uploading and attaching documents. 

 
 

• To search for and attach a document(s) in the EST database, click the Search for a document 
option button. Go to Step 7 of these instructions for information on searching for and attaching 
documents. 

 
 

6. After clicking Upload a document, the section expands and displays a form for describing the 
document.  Under Describe new document,  enter the information into the following fields: 

Note: Required fields are indicated by double asterisks (**) and are highlighted in yellow on the 
form. 

• Name – Type the name of the document (up to 240 alphanumeric characters). 

• Description – Type a brief description of the document (up to 254 alphanumeric characters). 

• Commitment – Indicate whether the document is related to a project commitment (Yes or No). 

• State Highway System – Indicate if the document is for a project on the State Highway System 
(Yes, No, N/A-Not Applicable). 

• Public Access – Click the check box beside Exempt from Public Record requests if the 
document is not subject to public disclosure and, therefore, is not to be included in the Public 
Access Site.  

• Document Category – Click the drop-down arrow, , to expand the field, and then make the 
appropriate selection by clicking on it. 

• Publication Date – Type the date the document was published. Use the date format mm/dd/yyyy. 

• City – Click the drop-down arrow, , to expand the field, and then make the appropriate 
selection by clicking on it. 

• Primary Consultant or Contractor – Do one of the following: 

ο Click the drop-down arrow, , to select a primary consultant or contractor from the list. 
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ο Click the Add button to add a name to the list. The field expands, enabling you to type the 
name. 

• Sub-consultant or sub-contractor  – Do one of the following: 

ο Click the drop-down arrow, , to select a sub-consultant or sub-contractor from the list. 

ο Click the Add button to add a name to the list. The field expands, enabling you to type the 
name. 

Tip!  Click the Add a company to the list link to add a company to the Primary 
Consultant or Contractor or Sub-Consultant or Sub-Contractor list. 

 
 

• Permit Agency – Click the drop-down arrow, , to expand the field, and then select the permit 
agency associated with the document. 

• Contract Number – Type the contract number (up to 5 alphanumeric characters). 

• Invoice Number – Type the invoice number (up to 8 alphanumeric characters). 

• Road Id/Section – Type the Roadway Characteristics Inventory (RCI) Identification or sub-section 
number (8-digit number). 

• Local Name – Type the locally assigned name of the road (up to 36 alphanumeric characters). 

• Structure/Bridge Number – Type the structure or bridge number (up to 200 alphanumeric 
characters). 

• To upload your document, click the Browse button next to the File field. Then navigate to and click 
the selected document on your computer.  

 
 

The EST displays the document name in the File field. 

• Go to Step 8 of these instructions to complete the process. 
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7. To search for a document in the EST database, click the Search for a document option button. 

 
The section expands, displaying a search filter. 

• Under Search Criteria, complete one or both of the following fields: 

ο Publication Date Range – Type the date range in the From and To fields. Use the 
mm/dd/yyyy format for typing dates. 

Tip!  You can also click the calendar icon, , to select a date. 

ο Keyword(s) – Type all or part of the name of a document or the project number.  You can also 
type a word related to the document or project. 

Note:  The Publication Date Range or Keyword(s) field must be entered to complete 
the search process.   

• Click Search.  

 
The section expands and displays a Search Results table listing the document(s) matching 
your search criteria.  

Note: Search results may include published documents from any region and un-published 
documents from your assigned regions. 

• Under Search Results, select the document(s) by doing one of the following: 

ο Click the check box on the document row for each document you want to attach. 

ο Click the check box beside All to select all the documents in the Search Results list. 
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Tip!  Click the document link in the Document column to open it.  Click the number link 
in the ETDM# column to open the Project Description window. 

8. Click Save. 

 
The Attach Documents window refreshes, displaying a message confirming the selected 
document(s) has been attached.   

• Do one of the following: 

ο To attach additional documents, click the Attach more documents link.  The Attach 
Documents window refreshes  and displays the project and document selection forms.  

ο To close the Attach Documents window altogether, click the Close button.  
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The attached documents will appear under Project Documents in the Attach Documents 
window. 

 

Note: If you mistakenly upload a document, contact the EST Help Desk at help@fla-
etat.org, and request the document be removed from the database. 

3.1.1.10 Add/Modify Plan Summaries 

This tool enables users to enter the system-wide needs summary and the summary of system-wide public 
comments to describe any proposed or adopted transportation plans which include projects in the ETDM 
process.  To add system-wide needs summary and/or summary of system-wide comments, click on the 
Add/Modify Plan Summaries option found under the "Maintain Project Diary" heading in the Tools menu.  Select 
a County and Planning Organization from the pull-down menus, then enter the Plan Year and a Descriptive 
Name.  Use the text boxes to enter the System Needs Summary and/or Summary of System-wide Public 
Comments.  Information can be typed directly in the text boxes, or copied and pasted from an existing 
document.  Click "Submit Form" when finished.   

 
 

3.1.1.11 Assign Project Managers (Updated 11/30/2011) 

The Assign Project Managers function in the Environmental Screening Tool (EST) Tools menu enables 
authorized users to assign one or multiple project managers to a project.   

Users with the following roles are authorized to use the Assign Project Managers function in the EST: District 
ETDM Coordinators, District ETDM Coordinators – Primary, ETDM Coordinators Management Team, 
Environmental Management Office managers and liaisons, Metropolitan Planning Organization (MPO) 
Coordinators, MPO Coordinators – Primary, Federal Intrastate Highway System Central Office, and Project 
Managers. 
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Assigning Project Managers to a Project: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. Go to the Tools menu, point to Project Diary, and then click Project Manager Information. 

 
The Assign Project Managers page opens, displaying a form that enables you to manage the 
assignment of project managers for the selected project.  

Note: If you received a Form Permissions message with an , you will not be able to access 
the Assign Project Managers form for the selected project.  Contact the ETDM Help Desk at 
help@fla-etat.org. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. Under Select A Project Manager, one of the following screens will appear: 

• If there are no eligible project managers for the project, the EST displays a statement in the 
Eligible Project Manager List field:  "There are no eligible Project Managers for this project."  
You will need to contact the ETDM Help Desk if you receive this message. 

 

• If there is a list of eligible project managers but a project manager(s) has not yet been assigned to 
the project, the EST displays a message stating, "No Project Managers are assigned to this 
project."  Go to Step 4 for instructions on assigning eligible project managers to a project. 

 

• If one or multiple project managers have been assigned to the project, the EST displays the names 
in the Current Project Managers section.   

Tip!  To remove a name from the Current Project Managers section, click the X beside 
the name. 

4. Click the Eligible Project Manager List arrow to expand the pre-populated list of project managers 
who have been approved to work on the project, and then select the name by clicking it. 

Note:  The list shows only the names of project managers that have been approved to work on 
the project.  To add a name to the list of project managers who are eligible to work on the project, 
you must contact the ETDM Help Desk at help@fla-etat.org. 
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5. Click Add.  The EST displays the Current Project Managers section along with the selected name 
and contact information. 

 
 

3.1.1.12 Update Potential Lead Agencies (New 06/30/2010) 

The Update Potential Lead Agencies function in the Environmental Screening Tool (EST) Tools menu 
enables the ETDM Coordinator to identify one or more Potential Lead Agencies for a project. 

Updating Potential Lead Agencies: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can choose another project using 
Advanced Project Search. See the Navigation chapter of the EST Handbook for information on 
using the Project Navigation Bar. 

2. On the Tools menu, point to Project Diary, and then click Lead Agency. 
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The Update Potential Lead Agencies window opens as a tabbed page, displaying a page 
toolbar, project header, and an Update Potential Lead Agencies form. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. In the Potential Lead Agencies field, select the appropriate option(s) by doing the following: 

• If the project has no federal involvement, click the check box beside FDOT (Florida Department of 
Transportation). 

 

• If the project affects a federal area of interest (e.g., highways, rail, public transportation, waterways) 
click the check box(es) beside one or more of the following options: 

ο FHWA (Federal Highway Administration) – If the project impacts a federal highway, the FHWA 
could become the lead agency.  

ο FTA (Federal Transit Authority) – If the project significantly impacts an area’s public 
transportation system, the FTA could become the lead agency. 
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ο USCG (U.S. Coast Guard) – If the project significantly impacts an area’s waterways, the 
USCG could become the lead agency. 

ο FRA (Federal Railway Authority) – If the project significantly impacts a railway system, the 
FRA could become the lead agency. 

 
 

Note:  During ETAT Review, all potential lead agencies must approve the Purpose and 
Need Statement for the project. During the Programming Phase, the selected lead agency 
must indicate whether or not it accepts the role of lead agency before the ETDM 
Coordinator can recommend a Class of Action for the project. 

• If the project's federal involvement is not yet established or if the impacts on the transportation 
systems are not known, then click the check box beside Unknown. 

 
 

4. Click Submit Form. 

 
 

The EST displays a message stating the Potential Lead Agencies information has been 
successfully updated. 

 

Tip! Click Make Changes to add an agency to the list of Potential Lead Agencies or to change 
an agency selection. 
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3.1.1.13 Update Project Commitments/Responses 

This tool allows the ETDM Coordinator, Project Manager, ETDM Management Team user, or ETDM Data Entry 
user to add or modify commitments and/or responses made to the ETAT or public regarding the project.  To 
update commitments and/or responses for a project, select a project from the Project Navigation Bar, and 
then go to the Tools menu, point to Project Diary, and click Commitments and Responses.   

 
 

The Update Project Commitments/Responses page opens and displays a General Project Commitments 
section that shows any previously entered commitment descriptions.  Add additional commitments in the Add 
Project Commitment text box. Type or copy and paste text into the box, and then click Add Commitment. 
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3.1.1.14 Identify Required Permits (Updated 11/30/2011) 

The Identify Required Permits function in the Environmental Screening Tool (EST) Tools menu enables 
ETDM District Coordinators and Project Managers to identify permits required for a project and add information 
about specific permit conditions.  

Identifying Required Permits: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can choose another project using 
Advanced Project Search. See the Navigation chapter of the EST Handbook for information on 
using the Project Navigation Bar. 

2. Go to the Tools menu, point to Project Diary, and then click Permits. 

 
The Identify Required Permits page opens, displaying a form that enables you to select permits 
required for a project.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help for the current page. 
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  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. Click the plus sign, , beside Permits to expand the list. 

 

Tip!  Bold categories indicate categories of permits that have been previously identified for the 
project. 

4. Do one of the following: 

• Click the plus sign, , icon to expand an existing permit category.  Go to Step 5. 

 
 

• If a permit category is not listed, scroll to the Add new category field at the bottom of the Identify 
Required Permits page, and then do the following: 

ο Type the category name. 

ο Click add. 

 

ο In the Add new permit to "New" category field, type the name of the permit and click add. 

ο Repeat the above step for each permit associated with the new permit category. 
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5. Select the permit(s) required for the project by clicking the check box beside the permit name. 

 
 

Tip! If a permit is not listed, click the Add new permit check box.   

The EST automatically bolds the permit name and a Conditions text box appears below the 
selected permit, enabling you to add a condition required for the permit. 

 
 

6. To make changes in a Conditions text box, click the Edit link. The text box becomes active, allowing 
you to add text or edit existing text. 

 
 

7. Click Save Required Permits. 
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3.1.1.15 Identify Required Technical Studies 

This tool allows ETDM Coordinators or Project Managers to identify technical studies required for a project.  To 
identify required technical studies for a project, select the project from the list and then click on the “Identify 
Required Technical Studies” option found under the "Maintain Project Diary" subcategory in the Tools menu 
(main menu).  Select the required technical studies from the list by clicking on the name of the technical study.  
A checkmark will appear next to the technical study, and the name will be bolded.  A text box also opens, where 
details about the required technical study can be added.  

 
A technical study not appearing on the list may be added to a category by clicking “Add new technical study to 
category,” entering the name of the technical study and then clicking “add.”   

 
 
 
 

 
A new category may be added by clicking “Add new category,” entering the name of the category and then 
clicking “add.”  Click "Save Required Technical Studies" when finished. 
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3.1.1.16 Project Schedule Tool (New 07/31/2009) 

The Project Schedule Tool function in the Environmental Screening Tool (EST) Tools menu enables ETDM 
Coordinators and Project Managers to update events related to Project Development & Environment (PD&E) 
milestones and view previously recorded events for projects with assigned Class of Actions (COAs). 

Updating a Project Schedule: 

1. To update a project schedule, you must first select a project that has been assigned a COA. You can 
use the default project that appears in the Active project field in the Project Navigation Bar or you 
can click the Advanced Project Search link to select another project. 

Tip!  To search for projects with all or specific COAs, click the Advanced Project Search link in 
the Project Navigation Bar.  In the ETDM Filter field, select Class of Action, and then select a 
variable from the Class of Action Type field.   

 
 

Note:  See the Navigation chapter of the EST Handbook for information on using the Project 
Navigation Bar. 
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2. On the Tools menu, point to Project Diary, and then click Project Schedule. 

 
 

The Project Schedule Tool window opens as a tabbed page and displays a project header, 
page toolbar, and a Class of Action: Type section.   

The project's COA appears in the section header, as shown in the next illustraton. (For this 
illustration, the COA is State Environmental Impact Report.) 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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The Class of Action: Type section is composed of the following columns: 

• Event  

• Actual Date 

• Related Document 

 
The EST displays pre-populated dates in the Actual Date column for the following events listed in 
the Event column: 

• Planning Screen Notification 

• Planning Screen Summary Report Published 

• Advance Notification 

• Programming Screen Summary Report 

• Class of Action Determination 

Note: These dates are automatically recorded when the events occur in the EST and cannot be 
edited in the Class of Action: Type section. 

 

Tip! To view a brief description of an event, place your mouse pointer on an underscored event 
listed in the Event column, as shown in the next illustration. A callout box appears with the event 
description. 
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3. To view the report details of an event, click the corresponding View Live Report button in the Related 

Document column. The document opens as a tabbed page in a read-only format. 

 
 

The remaining events listed in the Event column in the Class of Action: Type section can be 
updated. The events will depend on the Class of Action type for the selected project.  The EST 
displays a different list of PD&E events for each Class of Action type.  

The following PD&E events are commonly listed in the Event column of the Class of Action: 
Type section in the Update Project Schedule window: 

• Date Initiated   

• Estimated Number of Months to Complete PD&E  

• Public Hearing  

• Location Design Concept Acceptance (LDCA)  

• Re-evaluation Complete 

• 100% Permit Issuance 

To demonstrate the process for navigating the Update Project Schedule window, only the PD&E 
events that are commonly listed in the Class of Action: Type section are illustrated below.   

Note:  The update process is the same for the specific events that are only associated with a 
project’s COA type.  

4. For the Date Initiated event, click the drop-down  arrow in the Date Initiated field, and then select 
the action that started the PD&E phase.  To continue the update process, follow Steps 10 through 12. 
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5. For Estimated Number of Months to Complete PD&E, type or edit the number of estimated months 
in the Actual Date column.  To continue the update process, follow Steps 10 through 12. 

Note:  You must enter whole numbers when typing the number of estimated months. 

 
 

For Public Hearing, type or edit the date the required public hearing was held prior to the LDCA 
in the Actual Date column.   

 
 

Tip!  To add another public hearing event, click the Add button located in the Public Hearing 
row. 

 
 

6. For Location Design Concept Acceptance (LDCA), type the date the LDCA was granted by the lead 
agency in the Actual Date column.  To continue the process, follow Steps 10 through 12. 

7. For Re-evaluation Complete, click the drop-down  arrow in the Re-evaluation Complete field and 
then select the type of re-evaluation that was completed.   
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• Do the following: 

ο To indicate if a significant design change is needed, click the Major Design Change checkbox 
located beneath the date field in the Actual Date column. 

 

ο To add another Re-evaluation Complete field, click the Add button located in the Re-
evaluation Complete row. 

 

ο To continue the update process, follow Steps 10 through 12. 

 
8. For 100% Permit Issuance, enter the date the permit was issued in the Actual Date field.  To continue 

the update process, follow Steps 10 through 12. 

9. In the Actual Date column, type the date for the selected Event. 

 
Tip!  When typing dates, use the mm/dd/yyyy format.  You can also click the calendar icon 

 and select the dates. 

Note:  If you add or change data in any of the Actual Date column fields, you must enter a 
reason for your change in the Comments field located at the bottom of the Class of Action: 
Type section. You will not be able to save your information until you type a reason in the 
Comments field. 

10. In the Comments field, enter your reason for adding or changing the data in the Actual Date column. 

11. To save your information, do one of the following: 

• Click the Save button located on the same row as the selected Event. 

 

• Click the Save All button located at the bottom of the Class of Action: Type section beside the 
Comments field. 
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12. To view or add documents associated with an event in the Event column, click the following buttons in 
the Related Documents column: 

Note: You must click Save before you can view or add related documents. 

• To view an attachment, click View Attachment. If there are any attachments, the View 
Attachment window opens as a tabbed page.  If no attachments are available, a message will 
appear stating there are no documents found for the selected event. 

• To add an attachment not currently stored in EST, click Add Attachment. The Attach 
Documents window opens as a tabbed page.  

• To select an attachment already stored in EST, click Select Attachment. The Select Project 
Attachment window opens as a tabbed page. 

The information in the Update Project Schedule window appears in the Project Schedule 
Report function in the EST Reports menu.  

3.1.2 Advance Notification Package (Updated 11/30/2011) 

3.1.2.1 Edit Advance Notification Package (Updated 11/30/2011) 

Preparation of an Advance Notification (AN) Package is required for ETDM projects before an ETDM 
Programming Screen can begin. A link to the AN Package is automatically included as part of the email 
notification sent by the ETDM Coordinator to the ETAT members to begin their Programming Screen review. 
This notification constitutes the Advance Notification and initiates the Federal Consistency Review if the project 
is federally funded or requires a federal permit or federal action.  The AN Package provides a consistent, 
comprehensive project record to agencies and interested parties. It is a means of informing them of FDOT’s 
intent to proceed with a project. 

The AN Package is printable as a draft document for internal review and as a Final Published AN Package 
available to anyone. An abridged version of the AN Package (referred to as AN LIte) is also provided for the 
purpose of mailing hardcopies. 

The Edit Advance Notification Package function in the Environmental Screening Tool (EST) Tools menu 
enables you to do the following: 

• View published AN Packages, if applicable. 

• Have the option to: 

ο Prepare an AN Package that is created in the EST using the draft outline form to produce a system-
generated package. 

ο Supply a PDF of an AN Package that was prepared outside the EST. 

• Preview, save, and print a draft copy of the AN Package for internal distribution and review before 
dissemination. 

• Generate a final AN Package in PDF format. 
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Preparing the AN Package: 

1. To prepare an AN Package using the EST or to upload an AN Package prepared outside the EST, you 
must first select a project from the Project Navigation Bar. You can use the default project that 
appears in the Active project field in the Project Navigation Bar or you can select another project 
from the Saved Searches or Project History fields, or by selecting another project using the 
Advanced Project Search link. 

 
 

Tip!  Use the Search site for… tool to quickly locate information in the EST. 

2. On the Tools menu, point to Advance Notification Package, and then click Edit AN Package. 

 
The Edit Advance Notification Package window opens, displaying a page toolbar and the Draft 
Advance Notification Package options. The EST defaults to the system-generated AN Package 
option. 
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 Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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Published AN Packages 
In the Edit Advance Notification Package window, the EST displays one of the following screens in the 
Published AN Packages section: 

• If this is the first time an AN Package is being created for the selected project, the EST displays the 
statement There are no published AN packages for this project. 

 
 

• If this is not the first time an AN Package has been created for the selected project (i.e., the project is being 
reprocessed through the Programming Screen), the EST displays a link to the PDF of the previously 
published AN Package. 

 

Tip!  Click the PDF icon, , in the Full AN Link column to view the published version of the 

complete AN Package.  Click the PDF icon, , in the Lite AN Link column to view the 
published version of the abridged AN Package that is provided to hard copy recipients. The AN 
Lite is available for system-generated packages only. 

Selecting a Draft AN Package Option 
The Draft Advance Notification page provides you the option of using the Draft AN Package form to produce 
the system-generated AN Package or creating and uploading your own AN Package as a PDF. 

1. Under Draft Advance Notification Package, select how you would like to produce your AN Package 
by clicking one of the following option buttons: 

• Use system-generated AN Package – The EST generates the AN Package from the form you 
complete in the Draft AN Package Table of Contents. Go to Section 3.1.2.1.1 of these 
instructions for details on preparing the AN Package in the EST. 

• Use Your Own AN Package – The AN Package is prepared outside of the EST and is then 
uploaded as a PDF. Go to Section 3.1.2.1.2 of these instructions for details on creating and 
uploading an AN Package. 

Tip!  Point your mouse to the question mark, , for a brief description of the option. 

 

 

 



 

 
Environmental Screening Tool Handbook  3-65 

3.1.2.1.1 Preparing an AN Package in the EST 

The Draft AN Package Table of Contents provides a checklist that helps guide you through the components 
of the AN Package to ensure data are updated and required information is included.  It also indicates the items 
that are included in the AN Lite version of the AN Package.  

1. Clicking the links in the Draft AN Package Table of Contents lets you view and, in some cases, edit 
the components of the AN Package.     

 
The Draft AN Package Table of Contents enables you to: 

• Upload, save, and edit a Cover Letter.  

• Open a PDF of the project's Location Maps.  

• Review and, if applicable, include updated project information and agency comments along with 
information related to Degree of Effect, Class of Action, and Dispute Resolution.   

• Manage the Transmittal List for the AN Package.  

• Upload a Form SF-424: Application for Federal Assistance, if needed.  
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Note:  As you proceed through the Draft AN Package Table of Contents, use the 

checkmark  and  icons as guides.  If the icon, appears in the AN or AN Lite 
columns, the EST will not publish the AN Package until the information has been created. 

Cover Letter 
The AN Package includes a cover letter that is distributed to all recipients of the AN Package.  The cover letter 
should reference the project name, ETDM number, and, if available, the Financial Number.  The letter will 
become part of the permanent project record.   

The Cover Letter component of the Draft AN Package section enables you to: 

• Upload and save a cover letter PDF from a desktop computer to the AN Package. (See Step 2) 

• Review and edit the cover letter. (See Step 3) 

 
1. To upload the cover letter  PDF from a desktop file, do the following: 

• Type the document path or click the Browse button to navigate to and select the cover letter. 

 

Note: The cover letter must be in PDF format for it to be uploaded.  

 

 
 

The document’s name and path appear in the Upload Cover Letter field. 

 

• Click Save to upload and save the cover letter. 

 
 

The Edit Advance Notification Package window refreshes, displaying the Cover Letter 
link.  The EST also shows green check marks in the AN and AN Lite columns, indicating 
the cover letter is now included in the AN Package. 

 

 
 

Tip!  Click   beside the Cover Letter link in the Edit Advance Notification  

Package window to delete the current cover letter. Click  to edit the cover letter. 
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2. To review and edit the cover letter, do the following: 

• Click the Cover Letter link to open the cover letter. A PDF of the letter opens in a separate tabbed 
window. 

• Make your edits to the cover letter document on your desktop, and then save it as a PDF. 

• Click the  link located on the Cover Letter row.  The Cover Letter row expands, 
displaying Browse, Save, and Cancel buttons. 

• In the Cover Letter field, type the document path, or click the Browse button to navigate to and 
select the revised cover letter. 

• Click Save to upload and save the letter. 

Online EST Handbook users: To return to the Draft AN Package Table of Contents links, click here. 

Location Maps 
A series of three project Location Maps are provided in the AN Package: Aerial Map, Base Map, and County 
Location Map.  Additional maps are generated to show details of the proposed Alternatives.  All maps are 
automatically created from information in the EST when the GIS analysis routines are run; however, ETDM 
Coordinators can select the type of maps they want to include in the AN Package. The maps are combined with 
the rest of the information and distributed as a part of the AN Package via electronic or hard copy. 

The Location Maps component enables you to: 

• View available maps associated with the selected project. (Step 4) 

• Include alternative-level maps in the AN Package. (Step 5) 

Note: If the label Not Available appears, check the project status to ensure the project has completed GIS 
Analysis.  To check the project’s status, go to the Tools menu, point to Maintain Project Diary, and then click 
Update Project Status. 

1. Under Location Maps in the Draft AN Package Table of Contents, click a map link to open a PDF of 
the map.  

 

• Click the Aerial Map link to view a PDF of an aerial view of the project location.  The Project 
Aerial Map window opens as a tabbed page, enabling you to view and print a hard copy of the 
map. 

• Click the Base Map link to view an overview of the project area (e.g., major roads, water bodies 
and rivers, county boundaries, and FDOT District boundaries). The Project Base Map window 
opens as a tabbed page, enabling you to view and print a hard copy of the map. 
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• Click the County Location Map link to view the project location and county boundaries along with 
city limit boundaries within the county. The Project County Location Map window opens as a 
tabbed page, enabling you to view and print a hard copy of the map.  

Tip!  A star icon, , appearing in the AN Package and AN Package Lite columns 
indicates the Location Maps are out of date.  Click re-generate hardcopy maps to 
update the project maps, including alternative(s). 

2. To include maps for specific project Alternatives, click the check box(es) beside the Alternative(s).  

 

Project Information and Agency Comments 
The Draft AN Package Table of Contents section displays available project information and agency 
comments (shown as active links) that have been assembled from the ETDM database. The information is 
organized as follows: 

• Information generated from Maintain Project Diary tools:  

ο Project Description – Includes a summary paragraph, including project limits information, 
proposed improvements (e.g., addition of lanes, bridges, ramps), specific data on Alternatives, 
and summary of public comments; and may include references to other associated projects, 
financial project numbers, and a description of previous coordination efforts. 

ο Community-Desired Features – Lists features (e.g., sidewalks, bicycle paths) that are 
desired by potentially affected communities and have been identified through MPO and FDOT 
public involvement activities. 

ο Environmental Information – Shows results of standard data analyses comparing the 
proposed location(s) of the project's Alternative(s) with the locations of various environmental 
resources as recorded in the ETDM GIS Analysis database, with results for various resources 
within 500 feet from the center of the planned corridor (can be re-run, but not edited directly). 

ο Permits Required – Displays a list of permits that may be needed for the project, as shown in 
the List of Permits report. 

ο Technical Studies Required – Displays a list of technical studies that may be needed for the 
project, as shown in the List of Technical Studies report. 

ο Project Commitments – Displays general project commitments from the Project 
Commitments and Responses report. 

ο Resource Maps – Opens the Print Hard Copy Maps window, enabling you to view maps 
related to specific resource issues. 

• Information based on the most recent Screening Summary Report (Planning or Programming): 
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ο Purpose and Need Reviews – Displays the results of ETAT members' reviews and 
comments on the Purpose and Need Statement for the project (cannot be edited). 

ο Summary Degree of Effect – Displays the Screening Summary Chart report, showing an 
overview chart of the summary degree of effect assigned for specific issues for each project 
Alternative, as published in the most recent Screening Summary Report.  

ο Comments on Advance Notification Package – Displays a report of comments on the 
Advance Notification Package from Advance Notification–Commenting Interested Parties (only 
appears as an active link if the AN Package is being reprocessed). 

ο Summary Degree of Effect Comments – Displays an overview of ETAT reviews of project 
effects with links to individual comments, as published in the most recent Screening Summary 
Report. 

ο Class of Action – Displays the Class of Action from the most recent Programming Screen 
Summary Report; the Class of Action component will be available only for an AN Package 
that is being reprocessed. 

ο Dispute Resolution Log – Displays a log of any disputes listed in the most recent Summary 
Report.  

Note:  For information that has not yet been provided, the component is not active (i.e., not underlined), with 
the label Not Available listed beside it.  This is common for components not yet completed because they are 
part of the Programming Screen or are not included.  

Tip!  Click the plus sign icon, , beside Additional Information to view additional text included in the AN 

Lite package. Click the minus sign icon, , to collapse it. 
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Tip!  The Reminder notice displays the list of Potential Lead Agencies for the project. Be sure to check this 
list before sending the Programming Screen notification. Click the click here to update link to open the Update 
Potential Lead Agencies tool, where you can update the list. 

Online EST Handbook users: To return to the Draft AN Package Table of Contents links, click here. 

Transmittal List 
The Transmittal List link in the EST Tools menu enables you to directly open a list of local, regional, state and 
federal agencies receiving the AN Package. This list includes ETAT members; consistency reviewers; and other 
local, state, and federal agencies that need or have requested to be notified.   

Note: The FDOT Environmental Management Office manages the list of mandatory recipients. The 
ETDM Coordinator and Project Managers can edit or remove contact information for their organization's 
list of project-specific recipients. 

1. In the Edit Advance Notification Package window, click the  link in the Transmittal List row 
of the Draft AN Package Table of Contents section. 

 
 

The Advance Notification Package Transmittal List window opens, displaying a toolbar and the AN 
Package Transmittal List.  Follow the navigation instructions in the Transmittal List section of the EST 
User Handbook for navigation instructions on adding, editing, and removing contact information. 

Tip!  For instructions on generating mailing labels and a spreadsheet of hard copy recipients, see the 
Mailing Labels section of the EST User Handbook. 

 

Online EST Handbook users: To return to the Draft AN Package Table of Contents links, click here. 

Form SF-424: Application for Federal Assistance 
If the project requires Federal Consistency Review, you must include a completed federal-aid application form 
(Form SF-424) in the AN Package.   

The Form SF-424: Application for Federal Assistance link in the Draft AN Package Table of Contents 
enables you to do the following: 

• Download or print FDOT's instructions for completing the SF-424 form (Step 7) 

• Download a blank SF-424 form in PDF or Microsoft Word format (Step 8) 

• Upload the completed SF-424 form to the Draft AN Package (Step 10) 

• View  the completed SF-424 form (Step 11) 

• Replace the SF-424 form (Step 12) 

• Change a project's Federal Involvement status (i.e., you can change a project's Federal Involvement status 
from No Federal Involvement to Federal Funding) (Step 13) 
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1. FDOT provides instructions to assist you in completing the SF-424 form.  To open, print, or save the 
instructions for completing the SF-424 form, click one of the format icons beside Instructions: 

 

• For opening the instructions PDF, click the PDF icon, . The FDOT Instructions for 
Application for Federal Assistance document opens as a PDF in a separate window. 

• For opening the instructions as a Microsoft Word document, click the Microsoft Word icon, . A 
File Download dialog box appears, enabling you to Save the SF-424 Form Instructions to your 
desktop.  

2. To open the blank SF-424 form, click one of the format icons beside Blank Form: 

 

• Click the PDF icon, , to open the blank form in PDF format.   

• Click the Microsoft Word icon, , to open the blank SF-424 form as a Microsoft Word 
document. A File Download dialog box appears, enabling you to Save the Blank SF-424 Form to 
your computer. 

3. Complete the SF-424 form following the FDOT Instructions for Application for Federal Assistance 
guidelines above for opening the instructions (Step 7). 

4. After you have completed the SF-424 form,  do the following: 

• If you completed the form as a Microsoft Word document, save it as a PDF. 

Note:  You must convert the SF-424 form to PDF before it can be uploaded and attached 
to the Draft AN Package.  The EST will not attach a document that is saved in a format 
other than PDF. 

• Type the document path or click the Browse button to navigate to the completed Form SF-424 on 
your desktop. 

 
The document’s name and path appears in the Form SF-424: Application for Federal 
Assistance field. 

• Click Save to upload and save the Form SF-424.  
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The Edit Advance Notification Package window refreshes, displaying the Form SF-424: 
Application for Federal Assistance link along with links for editing or deleting the form .   

 

Tip!  Click   beside the Form SF-424: Application for Federal Assistance link in the 
Edit Advance Notification Package window to delete the current Form SF-424. 

5. To view the completed Form SF-424, click directly on the Form SF-424 Application for Federal 
Assistance link. 

 
The Form SF-424 Application for Federal Assistance PDF opens as a separate window. 

6. To replace a completed Form SF-424, do the following: 

• Make your edits in the version of the SF-424 form that was saved to your desktop file. 

• Save the revised form as a PDF. 

• In the Edit Advance Notification Package/ Draft Table of Contents window, click the 

 link on the Form SF-424: Application for Federal Assistance row.  The row 
expands, displaying a document path field along with Browse and Save buttons. 

• Upload and save the document following the navigation process listed in Step 10. 

7. You can change the project's Federal Involvement status by editing the Project Description.  

Note: To edit the Project Description, use the Update Project Description tool (See the 
Update Project Description section of the EST Handbook for navigation instructions). 

Online EST Handbook users: To return to the Draft AN Package Table of Contents links, click here. 

Save and Publish the AN Package  
Once you have completed reviewing the AN Package and have included the required components, you can 
preview a PDF of the draft AN Package and print it for internal distribution before publishing the final document. 

1. To preview, save, and print a draft of the AN Package, click the appropriate Preview button at the 
bottom of the Edit AN Package window. 

 
The PDF opens as a tabbed page, displaying the draft AN Package (full or Lite version). 
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2. Check each component listed in the Draft AN Package Table of Contents to ensure a   

appears   in the AN and AN Lite columns for each component.  If each component has a , you 
are ready to publish the  final draft of  the AN Package.   

Note:  If an icon appears in the AN or AN Lite columns, you will not be able to publish 
the AN Package until the information has been created. Check the Form Validation box, 
located at the bottom of the Draft Advance Notification Package window for details. 

3. The Save and Publish AN Package section only appears if all components are included in the Draft 
AN Package (i.e., a check mark is shown in the AN and AN Lite columns). To save a final draft of the 
AN Package PDF for publishing, type your EST password in the Enter Password and Save field, and 
then click Save Final Draft.  

 

4. Next to Publish Options, do one of the following: 

• To publish the AN Package and send the Programming Screen notification, click the Update 
Project Status link.  The Update Project Status tool opens, enabling you to change the project 
status to ETAT Review.   

• To publish the AN Package for projects that will not be screened through the EST (e.g., projects 
that are already in the Project Development and Environment [PD&E] Phase), click the Publish 
without Programming Screening link. 

 

Note:  If you change the AN Package option from Use system-generated AN Package to Use 
your own AN Package, the following message will appear: 
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3.1.2.1.2 Preparing an AN Package Outside the EST 

1. Click the Use Your Own AN Package option button. 

 
The Edit Advance Notification Package screen refreshes and displays a form for uploading the 
AN Package PDF. 

Note: Be sure to include the official EST generated transmittal list with the uploaded AN 
Package. The list is available for download in PDF and XLS (Excel) format. 

2. To download the EST generated transmittal list, do one of the following:  

• Click on either the PDF or XLS link in the reminder message on the Edit Advance Notification 
Package page. 

• In the Tools menu, point to Advance Notification Package, and then click Transmittal List.  

•  In the page toolbar, click the PDF icon, , to download a PDF of the list to your desktop or 

click the Excel icon, , to download the list as a spreadsheet.  

• Use Adobe Acrobat to incorporate the list into the AN Package PDF.  

3. Click Browse or type the file path to the AN Package on your desktop. 

 

4. Click Save.  The Edit Advance Notification Package page refreshes and displays a confirmation that 
the upload was successful, along with links to view, delete, or replace the document. 
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Note:  If you change the AN Package option from Use your own AN Package to Use system-
generated AN Package, the following message will appear: 

 
 

3.1.2.2 Advance Notification Package – Transmittal List (New 11/30/2011) 

The Transmittal List link in the Environmental Screening Tool (EST) Tools menu enables you to directly open 
a list of local, regional, state and federal agencies receiving the Advance Notification (AN) Package. This list 
includes Environmental Technical Advisory Team (ETAT) members; consistency reviewers; and other local, 
state, and federal agencies that need or have requested to be notified.   

Note: The FDOT Environmental Management Office (EMO) manages the list of mandatory recipients. ETDM 
Coordinators and Project Managers can add or remove project-specific names, and can edit contact information 
for their organization's list of mandatory and project-specific recipients. 

Using the AN Package Transmittal List Function: 

1. To use the Transmittal List function for AN Package recipients, you must first select a project that is in 
the Programming Phase using the Project Navigation Bar.   

 

Tip!  Use the Search site for… tool to quickly locate information in the EST. 
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2. In the Tools menu, point to Advance Notification Package, and then click Transmittal List. 

 
 

Note: You can also access the Transmittal List in the Edit Advance Notification Package 

window.  Click the  link in the Transmittal List row of the Draft AN Package Table of 
Contents section. 

The Advance Notification Package Transmittal List window opens, displaying a page toolbar, 
search filter, and table containing a list of AN Package recipients. 

 

 Tip!  Click the toolbar icon in the Advance Notification Package Transmittal List window to: 

 Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 
The AN Package Transmittal List enables you to view a list of existing contacts who are 
designated to receive the AN Package. Recipients are listed in a table with information divided 
into the following columns: 

• Organization – Displays the names of the organizations receiving the AN Package 
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• Name – Displays the name and title of the person receiving the AN Package 

Note:  If a position title does not appear with a contact's name, it means the contact's 
position title has not been entered into the database. If the contact is project-specific and 
has been added by your organization, you can add the position title by using the Edit link 
(See Step 6). 

• Recipient Type  

ο Mandatory – Automatically added to all project transmittal lists according to jurisdiction. These 
contacts are maintained by the EMO 

ο Project Specific – Only appears on a transmittal list when added by the ETDM Coordinator or 
Project Manager 

• Notification Type – Displays the method of notification (email or hard copy) 

• Created By – Displays the name of the organization that created the recipient record 

• Last Updated – Displays the date the information for a contact was last updated 

Tip!  Click a column heading to sort the information in ascending or descending order. 

Note:  Recipients listed with Email in the Type column will automatically receive the AN 
Package via email. Recipients listed with Hardcopy in the Notification Type column will need to 
be mailed the AN Lite Package once the project has been submitted for the Programming Screen 
ETAT Review.  

See the following steps for instructions on managing the AN Package Transmittal List: 

• Searching for contacts listed in the EST database and adding them to the list (Step 3) 

• Adding recipients from existing contact lists (Step 4) 

• Creating new contacts (not listed in the EST database or existing contact lists) (Step 5) 

• Editing a recipient’s information (Step 6) 

• Removing a recipient’s name from the list (Step 7) 

3. To add a contact using the search filter, do the following: 

• In the Search for Contact to Add to List field, type at least three letters of the contact's name, 
position title, or organization name. 

 
 

The EST displays a list of contacts matching the name typed into the search filter.    
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• Select the name by clicking it. The EST automatically adds the name to the top of the AN Package 
Transmittal List. 

 

Tip!   If the Search function does not locate a contact's name, you can add the contact to 
the EST database using the Create New Contact wizard (See Step 5 of these instructions). 

 

4. To add a name from a selected contact list, do the following: 

• Click the Add from Contact List button 

 
The EST displays a wizard that guides you through the process for adding a recipient from 
an existing contact list. 

• Select the appropriate list by clicking the link. 

Tip!  To create a Contact List, use the Manage Contact Lists function located in the 
Account Settings menu.  

 
 

Tip! Click Cancel to cancel the operation. 

The EST displays the list of names for the selected contact list. 
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• Click the check box beside the name(s) you want to add to the AN Transmittal List.  

Note:  Recipients already in the list will be displayed as unavailable options. 

• Click Finish. 

The selected name automatically appears at the top of the AN Package Transmittal List. 

5. To create a contact that does not currently exist in the EST database or another contact list, click 
Create New Contact. 

 
The EST displays a wizard that guides you through the process for creating a contact who is not 
listed in the EST database or in an existing contact list.  
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• Do the following: 

ο Under Notification Type, click the option button beside one of the following: 

 Electronic (email) – if the recipient will receive an email notification along with a link to the 
AN Package 

 Hardcopy – if the recipient will receive a hard copy of the AN Package Lite via standard 
mail 

ο Under Allow Comments in the EST, click the option button beside one of the following: 

 Yes (provide access) –  enables you to grant EST access to the recipient, allowing  the 
recipient to provide comments via the EST 

 No (does NOT require access) – if the recipient will only receive the AN Package for 
review but will not be commenting on it or if the recipient will be commenting on the AN 
Package via other means (e.g., letters, email, public hearings) 

Note:  Recipients granted access to the EST must receive notification via email. If you 
choose Hardcopy as the Notification Type, the Yes (provide access) option is disabled. 

• Click Next. 

The EST displays a Name & Organization form. 

 

• Under Name & Organization, type the contact’s information in the following fields: 

ο Prefix  

ο First name*  (Required for recipients with EST Access) 

ο Middle name 

ο Last name*  (Required for recipients with EST Access) 

ο Position Title  (Only required if First name and Last name fields are left blank for recipients 
who have not been granted EST access) 
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ο Organization* (Required) 

Note:  For recipients who have not been granted access to the EST, the First name and 
Last name fields or the Position Title field are required (.i.e., Position Title can be blank 
only if the First name and Last name fields are filled in; First name and Last name fields 
can be blank only if the Position Title field is filled in). 

Note:  If the Organization you are searching for does not appear in the Organization list, 
contact the ETDM Help Desk at help@fla-etat.org to add it to the database. 

• Click Next. 

The EST displays a form for the contact’s address. 

• Under Address, complete one or more of the following fields: 

ο Address 

ο City or Town 

ο State 

ο Zip Code 

Note:  Address is required for hard copy recipients, optional for email recipients. 

• Click Next. 
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The EST displays a form for the contact’s Other Contact Information. 

 

• Under Other Contact Information, complete the following fields: 

ο Direct Phone and Extension (Ext) 

ο Office Phone and Ext. 

ο Fax 

ο Mobile 

ο Email (required for email recipients) 

ο Confirm Email (required for email recipients) 

Note: The email address you type into the Confirm Email field must match the email 
address you typed in the Email field. 

• Click Done. 

The EST automatically adds the contact name to the top of the AN Package Transmittal 
List. 

6. To view a recipient's information for accuracy and make updates to the recipient's account, click the 
Edit link in the selected recipient's row. 

 
The Advance Notification Package Transmittal List window refreshes and displays the contact 
information wizard, enabling you to make the appropriate changes to the following fields: 

• Name & Organization 

• Address 
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• Other Contact Information 

7. To remove a recipient from the Transmittal List, click the Remove link in the selected recipient’s row. 

 
The EST automatically removes the recipient’s name from the Transmittal List. 

 

3.1.2.3 Advance Notification Package – Transmittal List Batch Uploader (New 11/30/2011) 

The AN Transmittal List: Batch Uploader function in the Environmental Screening Tool (EST) Tools menu 
enables District ETDM Coordinators to add additional non-mandatory recipients to the Advance Notification 
(AN) Package transmittal list using an Excel spreadsheet provided by the EST. 

Recipients receiving the AN Package must have their contact information listed in the EST database.  When 
you enter a recipient’s contact information in the AN Package transmittal list spreadsheet, it must match the 
information listed in the EST database for it to be validated. Recipients listed in the uploaded spreadsheet who 
do not match records in the EST database are treated as new contacts. 

Note: Changes to a recipient’s contact information cannot be made using the transmittal list spreadsheet. To 
update contact information in the EST, go to Account Settings and then click Update Contact Information, or 
go to help@fla-etat.org for assistance in updating a recipient’s contact information. 

Using the AN Transmittal List Batch Uploader: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Tools menu, point to Advance Notification Package, and then click Upload Transmittal List. 
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The Agency Activities: Batch Uploader window opens as a tabbed page, displaying a page 
toolbar and a form for uploading additions to an Advance Notification Package transmittal list, 
including a link to a spreadsheet form to be used for those additions. 

 
 

Tip!   Click on the toolbar icons to: 

   View the tip sheet for the current page. 

   Send feedback about the current page. 

   Access online Help. 

    Bookmark the page. 

   Add the page to your My ETDM preferences. 

 

3. Do one of the following: 

• If you are starting a new spreadsheet, click the batch upload spreadsheet link to download a 
blank Excel spreadsheet from the EST database.  

• If you have already downloaded an Excel spreadsheet from the EST database and are making 
edits to the transmittal list, go to Step 6 of these instructions. 
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Tip!  Refer to the information shown in the Validation section for guidance on the transmittal list 
spreadsheet requirements. 
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4. A File Download dialog box appears asking you to Open or Save the spreadsheet. Click Save to 
download the spreadsheet to your computer. 

 
5. Navigate to and click the saved file to open it. The spreadsheet opens as a separate Microsoft Excel 

window.  

6. After you have logged the information into the spreadsheet, click the Validate button located on the 
Excel spreadsheet to verify that all fields have been completed and that the information in the 
spreadsheet matches the information in the EST database. Required cells that have been left blank will 
display as shaded. 

 

Note: If the Validate button does not work, it may have been blocked by your system’s security 
program. Check the Excel message bar (located beneath the ribbon) for a Security Warning 
message (see next illustration).  

 

Note: If you have received a security warning, you can enable the validation macro by doing the 
following: 

• Click Options. A security alert message will appear. 

• In the Security Alert – Macros dialog box, click the Enable this content option button. 
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• Click OK. 

• In the Excel spreadsheet, click the Validate button again. 

7.  After you have completed the additions to the transmittal list in the Excel spreadsheet and saved it to 
your desktop, return to the AN Transmittal List: Batch Uploader screen in the EST. 

8. In the Upload File field, upload the transmittal list by typing or copying and pasting the document path, 
or you can click the Browse button to navigate to the document’s location on your desktop. 

9. Click Upload Spreadsheet. 

 
The AN Transmittal List: Batch Uploader screen refreshes and displays the list.  

 
 

Tip!  The Status column of the spreadsheet indicates whether a contact was validated (shown 

with a check mark ) or not (shown with an ).  A star icon, , indicates the contact was 
added to the transmittal list but could not be updated in the database. Click the Show detailed 
error messages link to view the error messages.  

10. Click the Upload another spreadsheet link to replace a transmittal list or to upload another list. 

11. After the transmittal list has been validated and uploaded, the contacts that were added will appear in 
the official AN Package transmittal list that is generated by the EST database. Go to the Tools menu, 
point to Advance Notification Package, and then click Transmittal List to view the list containing the 
recently added contacts. 

Note: If you have questions regarding contact permissions, contact the ETDM Help Desk at 
help@fla-etat.org. 
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3.1.2.4 Advance Notification Package – Mailing Labels (New 11/30/2011) 

The Mailing Labels link in the Environmental Screening Tool (EST) Tools menu enables you to directly 
generate mailing labels or an Excel spreadsheet of hard copy recipients from the AN Transmittal List.   

Using the Mailing Labels Function: 

1. To use the Mailing Labels function for hard copy AN Package recipients, you must first select a project 
that is in the Programming Phase from the Project Navigation Bar.  

 
 

2. In the Tools menu, point to Advance Notification Package, select Mailing Labels, and then do one 
of the following: 

• Select one of the available Avery label format PDFs.  

• Click Excel File if you want to generate a spreadsheet of hard copy recipients to use in a label 
format not listed in the Mailing Labels submenu. 

 
 

Do one of the following: 

• If you selected one of the mailing label options, a PDF of the hard copy recipient list opens in a 
separate window, displaying the selected label formatting (Avery 30/sheet, 20/sheet, or 

80/sheet).  Click the print icon , on the PDF window to print the labels. 
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• If you selected Excel, a File Download box appears asking if you want to Open or Save this file. 
Select the appropriate option. 

  
 

The list of hard copy recipients is generated as an Excel spreadsheet. 
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3.1.3 Review Project (Updated 11/30/2011) 

3.1.3.1 Comment on Advance Notification Package (Updated 11/30/2011) 

The Comment on Advance Notification Package function in the Environmental Screening Tool (EST) Tools 
menu enables Commenting Interested Parties to review the Advance Notification (AN) Package and record their 
comments.  The AN Package provides a consistent, comprehensive project record to agencies and interested 
parties. It is a means of informing them of FDOT’s intent to proceed with a project. 

Commenting Interested Parties assigned to review the AN Package are usually regional planning council and 
local government personnel who are authorized by a State Clearinghouse Coordinator (Federal Consistency – 
Commenting Interested Parties) or District ETDM Coordinators and Project Managers (Advance Notification –
Commenting Interested Parties) to access the secure EST.  The tasks of Commenting Interested Parties are as 
follows: 

• Federal Consistency – Commenting Interested Parties provide advisory comments, based upon such 
issues as consistency with the strategic regional policy plan or the local government comprehensive plan, or 
conflict with other known area activities. 

• Advance Notification – Commenting Interested Parties review ETAT comments and submit additional 
comments, if warranted, on a project’s effects. 

Individuals assigned to a Commenting Interested Party role receive electronic notification from District ETDM 
Coordinators notifying them that the review process has started.  Commenting Interested Parties have access 
to EST maps and standard reports about the project and resources, including confidential information such as 
locations of archaeological sites.  They will also be able to view draft ETAT commentary and submit comments 
regarding federal consistency or project effects within 45 days of receiving notification. 

Commenting on the AN Package: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Tools menu, point to Review Project, and then click Advance Notification Package. 
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The Comment on Advance Notification Package window opens as a tabbed page, displaying a 
page toolbar, a Reminder section, information about the comment review period and the days 
remaining for the review, a link to the Advanced Notification Package, and a text box for 
comments. 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

 

3. Click the Advance Notification Package link to view the Advance Notification Package PDF. 

 
 

The Advance Notification Package window opens as tabbed page. 

4. After reviewing the AN Package, click the Comment on Advance Notification Package tab to return 
to the form, and then type your comments in the text box. 
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5. Click Add Comment. 

 
 

The Comment on Advanced Notification Package window refreshes, displaying a message 
stating your comments have been added along with an Update Comment button and a Delete 
Comment button. 

6. To update your comments, type your changes in the text box, and then click Update Comment. 

 
 

Tip! Click Delete Comment to clear the comment text box. 
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3.1.3.2 Review Purpose and Need Statement (Updated 06/30/2010) 

The Review Purpose and Need Statement function in the Environmental Screening Tool (EST) Tools menu 
displays a project's Purpose and Need Statement and a form that enables Environmental Technical Advisory 
Team (ETAT) representatives to enter their responses and add comments on behalf of their agencies.  ETAT 
representatives can also use this function to rank the quality of the information provided by the project sponsor. 

The Lead Agency representative for the project records whether the statement is Acceptable or Not Acceptable.  
Other agencies acknowledge that the Purpose and Need Statement is Understood or Not Understood. 

Reviewing and Responding to the Purpose and Need Statement: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Tools menu, point to Review Project, and then click Purpose & Need Statement. 

 
 

  



 

 
Environmental Screening Tool Handbook  3-94 

The Review Purpose and Need Statement window opens as a tabbed page, displaying a page 
toolbar, a Review Permission message, Purpose and Need Statement, and a Review form. 

   
 

Tip!   Click on the toolbar icons to: 

  Open the Tip Sheet for the current page. 

  Open the Training Video for the current page. 

   Send feedback about the current page. 

   Access online Help. 

   Bookmark the page. 

   Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

3. In the Purpose and Need Statement section, use the side scroll bar to move down the section and 
review the project's Purpose and Need Statement.   

 

Tip!  You can expand and collapse a section. Click the plus sign icon, , to expand the 

section. Click the minus sign icon, , to collapse it. 
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4. In the Enter Review Information section, do the following: 

• Under Purpose and Need Review, do one of the following: 

ο If you are representing the Lead Agency, click the option button beside the appropriate 
response: 

 Accepted 

 Not Accepted 

ο If you are representing an agency that is not the lead agency, click the option button beside the 
appropriate response: 

 Understood 

 Not Understood 

 

Note:  If you click the Not Understood or Not Accepted option button, you must enter 
an explanation for your selection in the Comments text box.  Please provide sufficient 
detail about your reason for selecting the Not Understood option.  The more information 
you provide, the more efficiently the project sponsor can address the issue. 

• Under Assess quality of ETDM Project Data for FDOT District, rank the quality of information 
provided by the project sponsor about this project by: 

ο Clicking the option button below the appropriate ranking, as demonstrated in the next 
illustration.   

 
 

Note:  When assessing the data, consider the information provided in the Purpose and 
Need Statement and on the Project Description Report.  Focus on project data only, 
not the resource data in the vicinity of the project.  Resource data is provided by other 
agencies and is not the responsibility of the project sponsor. 
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ο Typing any additional comments in the Rating Comments text box. 

Note:  If you clicked the option buttons beside Fair or Poor, you must provide a reason 
for your rating.   

5. Under Signature, you will need to sign the form whether you selected Understood or Not 
Understood. Do the following: 

• In the Password field, type your EST password.  Typing the Password acts as your signature to 
the Purpose and Need Statement. By signing the form, you are certifying that your comments 
represent the official review from your agency. 

• Click Submit Form. 

The Review Purpose and Need Statement window refreshes, displaying a Confirmation 
message with a green check mark showing your comments have been saved along with your 
Acknowledgement and Comments. 

 
 

Tip!  If you want to make changes to your review comments, click the Edit link. 
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3.1.3.3 Describe Direct Effects (Updated 12/01/2005) 

This tool opens a form for ETAT representatives to enter comments about potential direct effects of the project 
to resources, and assign a degree of effect.  To use this tool, select the project and then click on the Describe 
Direct Effects option found under the Record Results of Project Review heading in the Tools menu.   

In the Tools menu, point to Review Project, and then click Direct Effects.  The Describe Direct Effects page 
opens. 

 

 
 

Select an Alternative, Issue and Degree of Effect from the drop-down menus.  Then enter commentary under 
the Identify resources and level of importance and Comment on effects to resources headings.  Add 
additional comments under the Additional comments (optional) heading, if desired.  To record the information 
on the form as the official review for your agency, enter the agency’s password and click Submit Form. 
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A Short Form option is also available, which limits the resource issues displayed to those associated with the 
user’s organization.  Click the check box next to Use Short Form to access this option.  In the next illustration, 
the user organization is Federal Highway Administration. 
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3.1.3.4 Describe Secondary and Cumulative Effects (Updated 06/30/2010) 

The Describe Secondary & Cumulative Effects function in the Environmental Screening Tool (EST) Tools 
menu enables Environmental Technical Advisory Team (ETAT) members to enter comments about secondary 
(indirect) and cumulative effects a project may have on resources and to designate a degree of effect. 

Using the Describe Secondary & Cumulative Effects Tool: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Tools menu, point to Review Project, and then click Secondary & Cumulative Effects. 

 
 

The Describe Secondary and Cumulative Effects window opens as a tabbed page, displaying 
a page toolbar, project header, and Alternative Details section(s). 
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Tip!  Click the toolbar icon on the Describe Secondary and Cumulative Effects window to: 

 Print a copy of the current page. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

Note:  For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 
of the EST Handbook. 

The Alternative Number Details section displays a table listing the status of the project's 
Alternative(s). 

 
 

Tip!   The EST displays a Reminder stating the reviews entered in the Describe Secondary 
and Cumulative Effects window will be included in your agency's comments on the Advance 
Notification for this project.  

 
 

3. Under Describe Secondary and Cumulative Effects, do the following: 

 

• If there is more than one project Alternative, click the drop-down arrow, , and then select the 
appropriate Alternative from the list by clicking on it. 

Tip!  Alternative 1 is always shown as the default. If there is only one project Alternative, you 
don't need to make any selections. 
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• In the Select a Degree of Effect field, click the drop-down arrow, , and do one of the following: 

 
 

ο Select a Degree of Effect by clicking on one of the following options: 

 N/A/ No Involvement (Not Applicable or No Involvement) 

 None 

 Enhanced 

 Minimal 

 Moderate 

 
 

ο Select Potential Dispute or Dispute Resolution if the Alternative poses a significant impact 
that could lead to a Potential Dispute, or a Dispute Resolution is needed in order for the project 
to move forward. Go to Step 5. 

     

Tip!  The Describe Secondary and Cumulative Effects form is similar to the form for entering 
a project's degree of direct effects.  See Section 3.1.2.2 of the EST Handbook for instructions on 
using the Describe Direct Effects function. 
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4. Under Review At-risk Resources, expand the appropriate Resource area by clicking on the plus sign 

icon, .   For this illustration, Wetlands is shown as the selected Resource. 

Tip!  Click the plus sign icon, , beside expand all to open all the comment and 

recommendation fields.  Click the minus sign icon, , beside collapse all to close all the fields. 

 
 

The section expands, displaying text boxes for adding comments and recommendations.  
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• Type your comments and recommendations into the following text boxes: 

ο Comments on effects  

ο Recommended avoidance, minimization, and mitigation measures  

ο Recommended actions to improve at-risk resources  

Tip!  You can also copy text from another document (CTRL+C) and paste it into the text box 
(CTRL+V). 

• Go to Step 6. 

5. After selecting Potential Dispute or Dispute Resolution in the Select a Degree of Effect list, the 
Describe Secondary and Cumulative Effects window displays sections for adding dispute details. 

 

• Do the following: 

ο Under Dispute Type, click the option button beside the applicable reason for the potential 
dispute. 

 Project appears to be non-permittable 

 Project has significant environmental cost 

 Project is contrary to an agency program, plan or initiative 

ο In the Justification for Dispute text box, type your comments as shown in the next 
illustration. 
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ο In the Citation for Dispute text box, type or copy and paste the documentation reference 
(e.g., statute, citation, rule) that supports the justification for the dispute. 

 

ο In the Recommended Actions for Dispute text box, type your recommendation for resolving 
the dispute.  

 

6. In the Select a Coordination Document field, click the drop-down arrow, . 

 

The field expands, displaying a pre-populated list of documents. 

 

• Select one of the following: 

ο No Selection 

ο No Involvement 

ο PD&E Support Document As Per PD&E Manual 

ο Permit Required 

ο Tech Memo Required 

ο To Be Determined: Further Coordination Required 
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7. After you have selected the Degree of Effect and entered your comments and recommendations, 
complete the process by entering your agency’s EST password into the Password field, and then 
clicking Submit Form. 

 
The Describe Secondary and  Cumulative Effects window refreshes and displays an Input 
received message along with the selected Degree of Effect, required Coordination Document 
(if any), and Dispute Information (if any), followed by comments on effects and 
recommendations for individual at-risk resources. 

Tip!  Click the modify this review link to make any edits to your comments and 
recommendations. 

3.1.3.5 Submit Federal Consistency Finding (Updated 02/23/2009) 

The Submit Federal Consistency Finding tool is used to record and submit agency findings concerning a 
project’s consistency with the Florida Coastal Management Program. The submittal of a Federal Consistency 
finding applies only to projects that are federally funded or require a federal permit or federal action.  

This tool is available to Federal Consistency Reviewers who are not also ETAT members and may also be used 
by Federal Consistency - Commenting Interested Parties for recording and submission of comments.  

Federal Consistency Reviewers who are also ETAT members submit their agency’s federal consistency finding 
using the Purpose & Need Statement tool, located in the Review Project category in the Tools menu.   

To access the Federal Consistency Findings tool, first select the desired project, and then go to the Tools 
menu, point to Review Project, and then click Federal Consistency Finding, as shown in the next illustration.  

 
 

Note:  Federal Consistency Reviewers can also access this tool by clicking the project number in the Projects 
Needing Federal Consistency Review report, which will open a separate tabbed window that contains the 
form; and users with both Federal Consistency Reviewer and ETAT Reviewer roles can access the tool through 
the Purpose & Need Review form on the Projects Needing Review report. 
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The Submit Federal Consistency Finding page opens. At the top of the form is the project header, with 
information that identifies the selected project.  This information includes the ETDM number and project name, 
the FDOT District(s) and county (or counties) where the project is located, the ETDM phase, from and to 
locations, the associated Planning Organization and Plan ID number, the Financial Management number, and 
contact information.  

 
The project header is followed by the form used to record the Federal Consistency Finding.  There are three 
possible findings: 

• Consistent 

• Consistent, With Comments 

• Inconsistent 

The definition for each finding appears next to the option, as shown in the next illustration. 

 
 

Click on the option button next to the applicable finding to select that option.  Note that if “Inconsistent” is 
selected, you must cite (in the Comments textbox) the section of the relevant statute, under your agency's 
authority, with which the project is inconsistent, and you must identify actions that can be taken to resolve the 
conflict.  Prior to issuing a finding of inconsistency, the reviewing agency should immediately notify the State 
Clearinghouse of identified problems. 
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Use the Comments textbox to type in required information and/or additional comments.  Plain text without 
formatting can also be copied and pasted from another document.   

When finished, verify the identity information, enter your password, and then click  . 

Submit Federal Consistency Finding Header Tools 

The toolbar above the project header provides quick access to commonly used functions. Use the  button 

to provide feedback about the page to the ETDM Help desk.  Click  to access the On-line Help 

information for the Submit Federal Consistency Finding page. Use the  button to bookmark the generated 

Submit Federal Consistency Finding page, or click  to add it to your “My ETDM” pages.   

Accessing Tool Through Projects Needing Federal Consistency Review Report 
As noted above, Federal Consistency Reviewers may also access the Federal Consistency Finding tool 
through the Projects Needing Federal Consistency Review report. To access the Projects Needing Federal 
Consistency Review report, go to the Reports menu, point to Agency Participation, and then click Projects 
Needing Federal Consistency Review.  

 

The Projects Needing Federal Consistency Review report contains the list of active projects that are 
currently in a review period that require Federal Consistency Review.  To narrow the search results, select 
County and/or Organization search criteria. 
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Click on the ETDM Number of a project to open, in separate tabbed windows, the Submit Federal Consistency 
Finding tool and the reports to be used in conducting the Federal Consistency Review, as described below.  
Note: all reports are project-specific; by default, the information displayed in each window pertains to the project 
number selected from the Projects Needing Federal Consistency Review report by default. 

• Submit Federal Consistency Finding – used to record and submit comments on federal consistency. 

• Federal Consistency Findings report – displays the findings for a project (searchable by agency, project(s), 
and date range). 

• Project Description - gives a detailed overview of a project, from the summary description and Purpose and 
Need Statement to the segment level details.  

• GIS Analysis Results - displays the most recent results of the GIS Analysis routines for a project. 

• Map Viewer – zooms to the project location and provides access to various resource maps 

There is a Tab title for each tool and report. Click on the Tab title to navigate between the tools and reports.  

 
On the right side of the screen, there is a Show/Hide Map bar.  This bar toggles the display of the Interactive 
Map Viewer.  To view the interactive Map Viewer over the tools and reports, click the Show/Hide Map bar; to 
hide the map and return to the forms and reports view, click the bar again.  (Note that tips for using the 
Interactive Map Viewer are available by clicking “Help” on the upper left side of the map, and a detailed 
description of the Interactive Map Viewer is available in the EST Handbook in the ETDM Library.) 

To close the tools and reports, click on the blue “X”  at the top right-hand side of each page (above the 
Page Tool Bar).  This takes you back to the Projects Needing Federal Consistency Review Report. 
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3.1.3.6 Review Class of Action Determination (New 06/30/2010) 

The Review Class of Action Determination function in the Environmental Screening Tool (EST) Tools menu 
provides a form that enables a Lead Agency Environmental Technical Advisory Team (ETAT) member to 
review and approve (or disapprove) the Class of Action (COA) Determination recommended by the District 
ETDM Coordinator.  

After the COA Determination has been signed by the District and Lead Agency, the COA is published in the 
Summary Report. 

Reviewing the COA Determination: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Tools menu, point to Review Project, and then click Class of Action Determination. 

 
 

The Review Class of Action Determination window opens as a tabbed page, displaying a page 
toolbar, Class of Action Determination section, and a signature form containing a comment text 
box. 



 

 
Environmental Screening Tool Handbook  3-111 

   
 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 



 

 
Environmental Screening Tool Handbook  3-112 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

3. Under Sign the Class of Action Determination, select the option button beside one of the following 
responses: 

• Accepted 

• Not Accepted 

Note:  Selecting Not Accepted requires an explanation. Type your reason for selecting Not 
Accepted in the text box. 

 
 

4. Type your comment(s) in the text box  (this is optional if you clicked the Accepted option button). 

 
 

5. In the Password field, type your EST password.   

Note:  Typing the Password acts as your signature to the Class of Action Determination. 

 
 

6. Click Sign Class of Action. 
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A message appears, displaying a Signature Submission Notice. 

7. Click OK. 

Tip!  If you want to change your response or edit your comments, click Cancel to cancel the 
operation and return to the Review Class of Action Determination window. 

 
 

The Review Class of Action Determination window refreshes, displaying a message that your 
signature has been saved to the database and a Class of Action Signatures section showing 
the: 

•  agency name 

• agency representative's Name 

• Review Status 

• COA Signature Date 

• ETDM Role  

• Comments 
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3.1.3.7 Summarize and Publish Eliminated Alternatives Report (New 04/16/2008) 

The Summarize and Publish Eliminated Alternatives Report tool is used by the FDOT ETDM Coordinator to 
publish an Eliminated Alternatives Report for a project, after changing the status of a project Alternative to 
“Eliminated” using the Update Project Status tool.  Publishing this report documents that the status of an 
Alternative has been changed to “Eliminated” and makes the report available to the public.  Once this report is 
published, the eliminated Alternative is hidden from future milestone reports, as well as draft reports. For 
example, the Project Description Report and the Summary Report will no longer show the full details of an 
eliminated Alternative.  

The Summarize and Publish Eliminated Alternatives Report tool is also used by the FDOT ETDM Coordinator 
to: 

• Preview the "Eliminated Alternatives Report" that will be published 

• Reactivate Alternatives that were previously eliminated 

• Update the justification for an changing an Alternative’s status to “Eliminated” 

The first section of the Summarize and Publish Eliminated Alternatives Report form is a project header with 
information that identifies the selected project.  This information includes the ETDM number and project name, 
the FDOT District(s) and each county where the project is located, the ETDM phase, from and to locations, the 
associated Planning Organization and Plan ID number, the Financial Management number, and contact 
information. 

Below the header information are instructions for using the form, a textbox for entering comments about the 
report that is being published, and a list of project Alternatives with a status of “Eliminated,” which includes 
additional information about each of those Alternatives. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 
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Clicking  will open the PDF Viewer and display the Eliminated Alternatives Report 
that will be published.  You can then use the PDF viewer tools to review, save, or print the Eliminated 

Alternatives Report.  When finished, click  to return to the Summarize and Publish Eliminated 
Alternatives Report form.   

If no changes need to be made concerning the eliminated Alternatives, click . 

Reactivating Alternatives or Updating a Justification 

Clicking the edit tool next to an Alternative  opens a form for reactivating Alternatives 
that were previously eliminated or updating the justification for changing an Alternative’s status to “Eliminated.”  
To reactivate an Alternative, click one of the radio buttons under “Status.”  To update a justification, use the 
textbox under “Justification” to make changes.  Click “Update” to save your changes, or click “Cancel” to cancel 
the changes and return to the Summarize and Publish Eliminated Alternatives Report form. 
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3.1.3.8 Summarize Results of ETAT Review Screen (Updated 03/03/2009) 

ETDM Coordinators use this tool to assign a summary degree of effect for resource issues in collaboration with 
the ETAT reviewers who submitted comments.  

Viewing the Summarize Results of ETAT Review Screen: 

1. In the Tools menu, point to Review Project, and then click Summary Reports. 

 
 

The Summarize Results of ETAT Review Screen opens, displaying the page toolbar, Summary 
Degree of Effects table, and Permission Messages.  
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

Each row of the table represents a project Alternative, and each column on the right-hand side 
represents a Resource Issue organized in Natural, Cultural, and Community categories, as 
illustrated below.  

 
 

The intersection of a project row and issue column is a cell that represents the Summary Degree 
of Effect for a particular project and issue.  For example, under Community, the Resource 
Issue—Aesthetics—has been given a Summary Degree of Effect of Minimal (color-coded green 
and labeled number 2); and the Resource Issue—Economic—has been given a Summary 
Degree of Effect of Moderate (color-coded yellow and labeled number 3).  
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As shown in the legend, a number and color code are used to designate the summary Degree of 
Effect (for example, 1 ).  To aid the ETDM Coordinator with assigning the summary degree of 
effect, certain cells may have been automatically filled in with a tentative summary degree of 
effect.  Specifically, if all ETAT reviewers have assigned the same degree of effect to a project for 
a particular issue, the corresponding number and color will appear in the cell with the number 
appearing in cyan text (for example, 2 ).   

When no reviews have been submitted for an issue, the cell below the issue name is black ( 2  ).  
These issues must be summarized before they can be published.  Under Permission Messages, 
a statement details the Resource Issues that must be assigned a Summary Degree of Effect 
before the project can be published. 
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2. In the Summarize Results of ETAT Review window, click the degree-of-effect cell you want to 

review. For this illustration, a Minimal effect (green) cell ( ) was selected for the Resource Issue—
Contaminated Sites. 

 
 

3. The Summarize Agency Response window opens as a tabbed page, displaying basic project 
information, Alternative #1 Details, and Agency Reviews for the …Issue. 
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Tip! To view the agency review details, click  located next to the Summary Degree-of-Effect 

box .  

 
 

The section expands, displaying agency review details and the Assess quality of ETAT 
Comments for… section. 

 
 

4. Under Assess quality of ETAT Comments for …., complete the rating form following the same steps 
listed on the preceding page. 
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5. After you have assessed the quality of the ETAT comments, you can also provide feedback to the 
reviewing agency. Click add coordinator feedback. 

 
 

The Respond to Agency Reviews window opens as a tabbed page.  Under Respond to 
Agency Review, type your comments in the Enter Agency Response Below text box.  

 
 

 

 



 

 
Environmental Screening Tool Handbook  3-123 

6. After you enter your response, click Add. 

 
The window refreshes and displays your response. Click Edit Response to make changes to 
your response. 

 
Your user identity is automatically included, as illustrated below 

 

Note: If you work for multiple agencies, you must select your agency identification by clicking 

the drop-down arrow , and clicking the appropriate value from the list. 

7. After you have made your edits, click Update.  

 

Tip!  Click Delete to completely erase your comments. 

Your response is automatically saved. 
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8. When you have finished entering your response, return to the Summarize Agency Reviews window 
by doing one of the following: 

• Clicking the  located in the top right corner of the tabbed window. This will close the Respond 
to Agency Review window, making it inactive. 

• Clicking the Summarize Agency Reviews tab, as illustrated below. This will keep the Respond to 
Agency Review window open and active. 

 
The EST displays your comments and the date your feedback was submitted on the Summarize 
Agency Reviews window under Agency Reviews for the…..Issue. 

Note: You will need to refresh your browser to view your comments. 

 
9. To delete or make changes to your comments, click edit coordinator feedback. 
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The EST returns you to the Respond to Agency Review window where you can change your 
response using the previous steps for adding, editing, or deleting comments. 

 
 

Note: For each Alternative, the ETDM Coordinator assigns a summary degree of effect for the 
resource issue in collaboration with the ETAT reviewers who submitted comments.   

10. To assign a Summary Degree of Effect for the selected Resource Issue, click the drop-down arrow  

 in the Summary Effect field. 
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The field expands and displays the Degrees of Effect. 

 
 

Tip!  You can also assign a Degree of Effect to a Resource Issue using the Generate Summary 
Report function in the Wizards menu. See Chapter 3.2.3 of the EST Handbook for further 
information. 

 

11. Select the Degree of Effect. For the next illustration, the selected degree of effect, Minimal (color-
coded green), agrees with the selection made by the reviewing agency, Okaloosa-Walton 
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12. The selected degree of effect—Minimal—appears in the Summary Effect field. 

 
13. In the Comments field, type your comments regarding your selection.   
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14. In the Enter Password field, enter your password, and then click Update Summary. 

 

15. To complete your summary, return to the Summarize Results of ETAT Review Screen by clicking the 
window tab.   

 
The Summarize Results of ETAT Review Screen window opens, displaying the Resource 
Issues and corresponding Summary Degree of Effect. 
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Note:  Before publishing the project, the ETDM Coordinator must ensure all of the Resource 

Issues are assigned a Degree of Effect (i.e., no black-filled cells ). 

16. Click Publish. The report becomes available to ETAT members and the public. 

 
 
 

  



 

 
Environmental Screening Tool Handbook  3-130 

3.1.3.9 Track State Clearinghouse Projects (Updated 07/31/2009) 

The Track State Clearinghouse Projects function in the Environmental Screening Tool (EST) Tools menu 
enables the State Clearinghouse Coordinator to track a project's Federal Consistency Review and to select a 
final Federal Consistency Determination.   

Before selecting a Federal Consistency Determination, the State Clearinghouse Coordinator can view the 
comments and recommendations made by Florida Coastal Management Program (FCMP) member agencies 
regarding a project's consistency with FCMP statute authorities.   

Tracking State Clearinghouse Projects: 

1. To track State Clearinghouse projects, you must first select a project that has a published Advance 
Notification (AN) Package. You can use the default project that appears in the Active project field in 
the Project Navigation Bar or you can select another project using the Project Selection Wizard. 

Tip!  To search for projects with a published Advance Notification Package, click the Advanced 
Project Search link in the Project Navigation Bar.  In the ETDM Filter field, select Published 
Advanced Notification Package Available, and then type the dates in the AN Publication Date 
Range fields. 

 
 

Note:  See Navigation chapter of the EST Handbook for information on using the Project 
Navigation Bar. 
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2. On the Tools menu, point to Review Project, and then click Track State Clearinghouse Projects. 

 
 

The Track Clearinghouse Projects window opens, displaying the form for the selected project 
along with a page toolbar. The next illustration shows the Project Header (for this example, ETDM 
project #2807 is shown) and the top segment of the form. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

3. Click the drop-down arrow  in the Select a Screening Event to Track field to view the screening 
events available for the selected project.  

 
 

Note:  The EST displays the most recent screening event as the default.  If you select another 
screening event from the list, the Track Clearinghouse Projects window will refresh and display 
the form that corresponds with the selected Screening Event. 

The Program Information section consists of a form that displays: 

• Project  information (See Steps 4 through 6 for subsection details) 

• Agency review findings and comments (See Steps 7 and 8 for subsection details) 

• The State Clearinghouse's Federal Consistency Determination (See Step 8 for subsection details) 

• Project Close Information (See Step 9 for subsection details) 

4. For project information related to the screening event selected in the Select a Screening Event to 
Track field, scroll down the Program Information section to view the following subsections: 

• Category  

This subsection displays the proposed Federal action. 

 

• CFDA Number  

This subsection displays the project's Catalog of Federal Domestic Assistance (CFDA) Number 
along with the Department name, Agency name, and program title. (To select or add another 
CFDA Number, see Step 5 of this document.) 

Note:  Because the Track Clearinghouse Projects function is part of the EST, the Department 
will always be the Department of Transportation. 
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• Project Description 

This subsection displays a brief description of the project.  

 

• Review Type 

This subsection displays the type of review the project is undergoing.  

 

• Routing/Consistency 

This subsection displays the routing history of the Federal Consistency Review for the selected 
project.  You can add extension and revision dates along with comments.  (To add extension and 
revision dates and comments, see Step 6 of this document.) 

Note: These fields are only for internal tracking by the State Clearinghouse and are not derived 
from any actual extensions granted to an agency in the ETDM database. 

 

• Applicant Information 

This subsection displays the name of the Planning Organization (Applicant), the Name of the 
Planning Organization's contact person, address, phone number, and contact email. 

 

• Type 

This subsection displays the type of Agency. 
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• Funding 

This subsection displays the funding source and amounts for each segment of the project. 

 
 
5. In the CFDA Number subsection, do one of the following: 

 

• If the CFDA Number is listed, click the drop-down arrow  in the CFDA Number field, and then 
select the appropriate value from the list. 

 

• To add a CFDA Number that is not already listed, click the drop-down arrow  in the CFDA 
Number field, and then select Other. 

.  

The CFDA Number subsection expands, displaying active fields for adding information. 
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ο Do the following: 

 In the Number field, type the CFDA Number. 

 In the Department field, type the name of the Department. 

 In the Agency field, type the name of the Agency. 

 In the Title field, type the name of the program title. 

6. In the Routing/Consistency subsection, enter dates regarding requested Federal Consistency Review 
extensions and revisions along with any additional comments. 

 

• Do the following: 

ο In the Extension Requested date field, type the date of the request for extension. 

ο In the Revision Due 1 date field, type the due date of the first revision. 

ο In the Revision Due 2 date field, type the due date of the second revision. 

Tip!  When typing dates, use the mm/dd/yyyy format. You can also click the calendar icon  
and select the dates. 

ο In the Consistency Notes text box, type any comments regarding a requested extension and 
revisions. 
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7. For information regarding agency Federal consistency findings and AN reviews, scroll down the 
Program Information section to view the following subsections: 

• Federal Consistency Findings 

This subsection displays the review date and findings by FCMP member agencies, regional 
planning councils, and local governments tasked to perform a Federal Consistency Review for 
the selected project.  Agency details, concerns, and recommendations are displayed in the next 
subsection—Advance Notification/Federal Consistency Comments.   

 

• Advance Notification/Federal Consistency Comments 

This subsection displays tables showing comments related to the AN/Federal Consistency 
Reviews conducted by FCMP member agencies, regional planning councils, and local 
governments.  Each agency provides comments on the merits of the proposed project, addresses 
concerns, and makes recommendations. Agencies who have not yet provided their reviews are 
listed in the bottom half of the subsection, as shown in the next illustration. 
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8. After reviewing the agency findings and comments regarding the project's Federal Consistency status, 
go to the Federal Consistency Determination subsection, and then select the Federal Consistency 
Determination that concurs with agency comments and findings.   

• Do the following: 

ο In the Finding column, click the option button next to one of the following:  

 Consistent  

 Consistent With Comments  

 Inconsistent  

ο In the Comments text box, type any comments related to your Finding selection. 

Tip!  To ensure you are selecting the correct option in the Finding column, read the definition 
that applies to each option in the Definition column. 

 
 

 

  



 

 
Environmental Screening Tool Handbook  3-138 

9. In the Project Close Information subsection, select the final consistency status by doing the following: 

 

• Select an option button for Consistency Status to indicate one of the following:  

ο Concur 

ο Object 

• Select an option button for Project Affected? to indicate one of the following: 

ο Comments 

ο No Comments 

 

10. In the Identity subsection, click the drop-down arrow , and then select your name and agency 
email address from the list. 

 
11. Click the Save button at the bottom of the Track Clearinghouse Projects window to save your 

information. 

 
 

The EST displays a message in the top of the Track Clearinghouse Projects window, stating that the 
information has been saved. 

 

  



 

 
Environmental Screening Tool Handbook  3-139 

3.1.4 Community Coordination (Updated 09/04/2008) 

3.1.4.1 Edit Community (Updated 09/04/2008) 

MPOs and Community Liaison Coordinators can add community boundaries and information to describe the 
communities by using the Edit Community tool. In the Tools menu, point to Community Coordination, and 
then click Community Characteristics. 

 
 

The Edit Community page opens, displaying a search filter at the top of the page.  
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If there is a default project selected, the tool will open up with the community information that is closest to the 
project. If there is not a default project selected, the form will be blank. To locate your community, select the 
District and then click on the  button in the district row. This will load all of the counties in the 
selected district. After you have selected the correct county, click on the  button in the county row. 
The ‘Community’ drop down list will is now populated with all communities that are in the district and county you 
selected. Once you have found the correct community, click the  button to populate the form 
with the selected community data. 

 

After you have updated the community, click the  button at the top or bottom of the form to save the 
changes to the database. 

 

Note:  An asterisk (*) next to a form field indicates the data in these fields were provided by a user and have 
not been updated by the automatic data analysis routine. If you believe that the data in brackets is more up to 
date than the user defined data, and would like to replace the current user-defined value with the calculated 
analysis results, check the box next to that field and click the  button. Edit any of the calculated 
results by typing in the appropriate box. Click the  button when you are finished editing the form. 
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3.1.4.2 Record Community-Desired Features (Updated 9/4/2008) 

This tool opens a form that is used by the MPOs and Community Liaison Coordinators to provide information 
about project features that are desired by the affected community.  To use this tool, go to the Tools menu, point 
to Community Coordination, and then click Community-Desired Features.   

 
 

The Record Community-Desired Features page opens. 

 
 

Use the box titled “Enter Desired Project Features” to enter the information.  You can type the text into the box 
or copy and paste text from an existing document.  Select the text to copy and right-click on the selected text. 
Select "Copy" from the pop-up menu.  Place the mouse cursor on the form, in the box where you want to paste 
the text. Right-click in the box. Select "Paste" from the pop-up menu. (You can also use the CRTL+C keys to 
copy and the CTRL+V keys to paste).  When finished, click “Submit Form” to save the information to the 
database. 
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3.1.4.3 Summarize/Modify Public Comments (Updated 09/04/2008) 

This option on the Tools menu opens a form for the Community Liaison Coordinators to summarize the public 
comments received about a project. The information is stored as part of the project record in the database and 
appears on the Project Description Report.  To use this tool, go to the Tools menu, point to Community 
Coordination, and then click Public Comments.   

 
 

The Summarize/Modify Public Comments page opens, displaying a Summary of Public Comment section 
with a text box for typing a summary of public comments.  

 
 

Previously submitted information can be viewed by clicking the View Project Description Report link.  Return 
to the Summarize/Modify Public Comments form to modify or enter new information.  You can type the text into 
the box or copy and paste text from an existing document.  Select the text to copy and right-click on the selected 
text. Select "Copy" from the pop-up menu.  Place the mouse cursor on the form, in the box where you want to 
paste the text. Right-click in the box. Select "Paste" from the pop-up menu. (You can also use the CRTL+C 
keys to copy and the CTRL+V keys to paste).  When finished, click “Submit Form” to save the information to the 
database. 
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3.1.5 Coordinate ETAT (Updated 10/31/2011) 

3.1.5.1 Send Email to User Groups 

Use the Send Email to User Groups tool to correspond with other EST users.  Go to the Tools menu, point to 
Coordinate ETAT, and then click Email User Groups.   

 
 

The tool opens an address book with two columns.  The left-hand column lists the project user roles in each 
FDOT district, displayed in the right-hand column.  To select the email recipient, click the empty checkboxes 
beside the project user role(s) and their district(s).  (Click the checkbox again to unselect).  After selecting email 
recipient(s), click "Select Addresses" to open the Email form (the Email Process Page). 
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On the Email Process Page (example shown below), enter the email subject and comments in the appropriate 
fields.  Manually type in comments or copy and paste from an external document.  To copy from a separate 
document, select the text, right-click on the highlighted text and choose "Copy" from the pop-up menu.  To paste 
the text into the form, right-click in the appropriate summary box on the form and choose "Paste" from the pop-
up menu. (The keyboard shortcuts CTRL-C to copy and CTRL-V to paste also work.  Select source text, CTRL-
C; click target area, CTRL-V.)  To clear subject and comment without closing the email form, click "Clear Form."  
To send the email, click "Send Email."  To change email recipient(s), click "Select New."  The form will close and 
the window will return to the previous address book to allow selection of new recipients.  Note that comments 
entered in the form will be cleared when "Select New" is clicked.    
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3.1.5.2 Track ETAT Notifications (New 11/30/2011) 

The Track ETAT Notifications function in the Environmental Screening Tool (EST) Tools menu enables 
District ETDM Coordinators, Community Liaison Coordinators, and the State Clearinghouse to track 
notifications sent to Environmental Technical Advisory Team (ETAT) members and includes a list of the 
individuals who were sent the notifications.  The Track ETAT Notifications function also enables users to 
forward the notice to additional people on their notification lists.  

Using Track ETAT Notifications: 

1. Select a project from the Project Navigation Bar.  

2. On the Tools menu, point to Coordinate ETAT, and then click Review ETAT Notifications. 

 
 

The Track ETAT Notifications window opens as a tabbed page, displaying the notifications sent to 
ETAT recipients for the selected project. There can be multiple notifications, with each notification 
containing a list of recipients and a Forward button. 

Tip!  Click the minus sign, , to collapse a notification section.  Click the plus sign, , to expand a 
section.  
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Tip!   Click the toolbar icon on the window to: 

 Print a copy of the page. 

  Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

  Add the page to your My ETDM preferences. 

Below each Notice section is a Recipients section, listing the individuals who have received the ETAT 
notification. This section displays the number of recipients who were sent the ETAT review notification for 
the project, along with the recipients' Name, Organization name and E-mail address link. 

 

3. To forward the list of recipients, click the  button located beneath the selected list. 

3.1.5.3 Extend ETAT Review Period (New 11/30/2011) 

The Extend ETAT Review Period function in the Tools menu enables ETDM Coordinators to grant a 15-day 
extension for projects that are currently in ETAT Review.   

Extending an ETAT Review Period: 

1. Select a project from Project Navigation Bar.  

2. Go to the Tools menu, point to Coordinate ETAT, and then click Extend ETAT Review Period. 
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The Extend ETAT Review Period page opens, displaying a section listing the ETAT review 
participants along with a comment text box for listing a justification for the extension.  

 
3. In the Who Requested This Extension field, click the name(s) of the individual(s) requesting an 

extension. 

Tip!  Press Ctrl + click to select multiple non-adjacent names from the list. Click Shift + 
click to select multiple adjacent names from the list. 

 

4. In the Comments Justifying the Extension** text box, you must enter a reason for granting an 
extension for the selected reviewers.  You can type or cut and paste your comment(s) into the text box. 

5. Click Submit Form. 
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The Extend ETAT Review Period page refreshes and displays a confirmation message stating 
the extension has been granted along with the new review end date, and the list of reviewers and 
the justification is also shown. 

 

3.1.5.4 Allow Comments After Review Period (New 11/30/2011) 

The Allow Comments After Review Period function in the EST Tools menu enables ETDM Coordinators to 
allow agencies to submit late reviews after a review period has ended. Comments collected while the user is in 
the overdue role are stored as draft comments until the extension period is over.  

Allowing Comments After Review Period: 

1. Select the project from the Project Navigation Bar. 

2. Go to the Tools menu, point to Coordinate ETAT, and then click Allow Comments After Review 
Period. 
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The Allow Comments After Review Period page opens, displaying a Select Users To 
Comment After Review Period section with a Search for Users filter. The Search for Users 
filter is a drill-down feature that displays options based on previous selections. 

 

3. Under Search for Users, do the following: 

• Click the District arrow, and then click the name of the selected District. 

• Click go.  The Organization field displays. 

 

• Click the Organization arrow, and then select the name of the selected Organization.   

• Click go.  The User field displays, showing the list of names for the selected organization.  
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• Click the name(s) of the individual(s) who are granted an extension. 

Tip!  Click Ctrl + click to select non-adjacent options.  Click Shift + click to select 
adjacent options. 

 

• Click Create Extensions. 

 
The Allow Comments After Review Period page refreshes and displays a Specify End 
Date section, listing the project Alternative(s) and fields for entering the extension begin and 
end dates.  

 

Note:  An extension must be set for each project Alternative and user combination.  

• In the Extension Begin Date field, type the extension begin date or click the calendar icon, 
,and select the date. 

• In the Extension End Date field, type the extension end date or click the calendar icon, , and 
select the date. 

Tip!  Use the MM/DD/YYYY date format. 

• Click Submit Extension Information. 



 

 
Environmental Screening Tool Handbook  3-151 

 
The EST displays a confirmation message stating the extension for the selected 
individual(s) has been granted. 

 

3.1.5.5 Track Dispute Resolution Activities 

When a project is flagged for a dispute during the Programming Screen, it does not move forward until the 
dispute is resolved. The purpose of this tool is to record events and actions associated with resolving the 
dispute.  Such events may be meetings, emails, teleconferences, and other correspondences.  The Track 
Dispute Resolution Activities tool opens a form that will be completed for a specific environmental resource 
issue.  To access the form, select the project from the list and then click on the “Track Dispute Resolution 
Activities” option found under the "Coordinate ETAT Activities" heading in the Tools menu (main menu).  Use 
the "Issue" pull-down menu to select the issue of dispute.  In the "Description of Action" entry, record the event 
and actions associated with resolving the dispute.  Click "Select a Date" and enter the date of the event from a 
pop-up calendar.  If applicable, attach a document to the event. A document may be meeting minutes, sign-in 
sheet, memoranda, and other supporting information. This is optional.  To attach a document, click "Browse" 
and add a document.  When a document is added, the Save As name is defaulted to the document's file name.  
Change the Save As name as necessary.  Use logical and recognizable file names.  For example, “Meeting 
Minutes.pdf” is better than “mm.pdf.”  The ETDM document standard is Adobe Acrobat™ PDF as the document 
format.  The tool can support other file formats, but please consider that users may not have the proper software 
to read the file correctly.  A document that is in Word Perfect™ may not be useful to MS Word™ users.  If it is 
necessary to attach a non-PDF file, state the file format in the File Description so that other users are aware of it. 
In File Description, include the document’s title, author, agency, date, status (preliminary, draft, final, etc.), 
purpose and applicable remarks.  Click "Submit" to commit the entry.  Please note that only one document can 
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be attached at a time. To attach multiple documents, repeat the process. 

3.1.6 Performance Management (Updated 06/30/2010) 
 

3.1.6.1 Answer District ETDM Coordinator Survey (Updated 06/30/2010) 

Biennially, District ETDM Coordinators complete a survey assessing the performance of participating agencies 
and the ETDM Process. ETDM Coordinators Primary provide a qualitative assessment of ETDM benefits; 
customer service; and the quality of information, coordination and communication. 

Completing the District ETDM Coordinator Survey: 

1. On the Tools menu, point to Performance Management, and then click District Coordinator Survey. 

 
The Answer District ETDM Coordinator Survey window opens, displaying the survey and page 
toolbar.  
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

2. To view, print, or copy the blank survey in PDF format, click Show Blank Survey PDF. 
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The PDF of the blank survey opens as a tabbed page. 

 
 

3. Click the navigation icons in the left column of the Blank Survey window to view the contents of the 
District ETDM Coordinator Survey. 

 

Tip!  You can switch between the Blank Survey PDF and the Answer District ETDM 
Coordinator Survey window by clicking the tabs at the top of the page.  Click the dark-colored tab 
to display a window, as demonstrated below. 

 
 

Once the window opens, the tab turns white. 

 
 

The survey comprises 47 questions, with text boxes provided for additional comments.   
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4. In the Answer District ETDM Coordinator Survey window, respond to the survey questions by 

clicking the appropriate check boxes  and option buttons , and by typing your comments in the 
text boxes. 

Note:  You can select multiple responses in the sections that contain check boxes. However, 
you can only select one response in the sections with option buttons. 

5. For questions requesting you to select a ranking, click the option button,  , below the selected 
ranking: 

• Excellent 

• Very Good 

• Good 

• Fair 

• Poor  

• N/A  

 

Note:  If you click the Fair or Poor option button, please type a reason for your selection in the 
Comments text box. 

Type any additional comments in the Comments text box. 

 
6. Once you have completed and reviewed the survey, select one of the following options located at the 

bottom of the Answer District ETDM Coordinator Survey window: 

• Click Save Draft if you plan to make changes to the survey at a later time.  

• Click Finalize if you do not plan to make any changes. 
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Depending on your selection, a message appears stating you have either saved a draft or final 
version of the survey. The illustration below displays the message for a saved draft version. 

 
 

7. Click OK.  

 
 

The View Survey window opens as a tabbed page, displaying the completed survey and a page 
toolbar.  
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Tip!   Click the toolbar icon on the View Survey window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

Note:  For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 
of the EST Handbook. 

3.1.6.2 Answer ETAT Survey (Updated 12/18/2009) 

Biennially, ETAT members complete a survey to provide feedback on how the participating agencies view the 
management and administration of the ETDM Process, the quality of the working relationship between the 
agencies and FDOT, and recommended improvements or changes. 

Completing the ETAT Survey: 

1. On the Tools menu, point to Performance Management, and then click ETAT Survey. 
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The Answer ETAT Survey window opens as a tabbed page, displaying the survey and a page 
toolbar.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. To view, print, or copy the blank survey in PDF format, click Show Blank Survey PDF. 
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The PDF of the blank survey opens as a tabbed page. 

3. Click the navigation icons in the left column of the Blank Survey window to view the contents of the 
Answer ETAT Survey PDF. 

 

Tip!  You can switch between the Blank Survey PDF and the Answer ETAT Survey window by 
clicking the tabs at the top of the page.  Click the dark-colored tab to display a window, as 
demonstrated below. 

 

The survey comprises 43 questions, with text boxes provided for additional comments.   

4. In the Answer ETAT Survey window, respond to the survey questions by clicking the appropriate 

check boxes  and option buttons , and by typing your comments in the text boxes. 

Note:  You can select multiple responses in the sections that contain check boxes. However, you 
can only select one response in the sections with option buttons. 

5. For questions requesting you to select a ranking, click the option button,  , below the ranking: 

• Excellent 

• Very Good 

• Good 

• Fair 

• Poor  

• N/A  
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Note:  If you click the Fair or Poor option button, please type a reason for your selection in the 
Comments text box. 

Type any additional comments in the Comments text box. 

 

6. Once you have completed and reviewed the survey, select one of the following options located at the 
bottom of the Answer ETAT Survey window: 

• Click Save Draft if you plan to make changes to the survey at a later time.  

• Click Finalize if you do not plan to make any changes. 

 
Depending on your selection, a message appears stating you have either saved a draft or final 
version of the survey. The next illustration displays the message for a saved draft version. 

 

7. Click OK.  

The View Survey window opens as a tabbed page, displaying the completed survey and a page 
toolbar.  

Tip!   Click the toolbar icon on the View Survey window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

3.1.6.3 Issues Tracking Tool (New 07/31/2009) 

The Issues Tracking Tool function in the Environmental Screening Tool (EST) Tools menu enables 
Environmental Management Office (EMO) staff to record, assign, and track issues and concerns submitted by 
ETDM participants.  Only ETDM issues related to policy and procedure are addressed. 

After EMO personnel, Invoice Reviewers, or Invoice Administrators become aware of an issue, they forward the 
information to the Performance Management Coordinator.  The Performance Management Coordinator inputs 
the issue into the Issue Tracker and assigns it to a category.  The issue is then assigned to an EMO staff 
member who uses EST to notify the appropriate EMO personnel.  EMO personnel address assigned issues 
according to their program area and ETDM role. 

Issue resolutions are documented in the Issue Tracking Summary Report and the Issue Tracking Details Report 
and are reported in the semi-annual Agency Feedback Report.   

Using the Issue Tracking Tool: 

1. On the Tools menu, point to Performance Management, and then click Issue/Action Tracking. 

 
The Issues Tracking Tool window opens as a tabbed page, displaying search filters and a page 
toolbar.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 
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The Issues Tracking Tool window is divided into two sections—Issues Tracking Query and 
Issues--that enable you to search existing issues or enter a new issue. 

Note:  Before entering a new issue, it is recommended that you first conduct a search using 
the Issue Tracking Query to ensure the issue is not already in the EST.   

2. To search for an issue, complete one or more fields under Issues Tracking Query.  The fields are not 
required fields, so you have the option to enter as much information as you want into the search filter or 
you can leave all the fields blank.  

Note:  Leaving all the fields blank when you submit your query will result in the EST displaying 
all issues listed in the system. 

 
 

3. To narrow your search results, complete one or more of the following fields in the Issues Tracking 
Query search filter:  The EST then displays the issues matching your search criteria. 

• In the Issue ID field, type the identification number assigned to an issue. 

• In the Assignment ID field, type the assignment ID.  

• In the Reporter field, click the drop-down arrow . The field expands, displaying a pre-populated 
list of people who have reported issues. Do one of the following: 

ο Select your name from the list if you want to view or edit issues you have previously reported.  

ο Select another name to view all of the issues reported by the selected person. 

• In the Assignee field, click the drop-down arrow , and then select the person assigned to take 
action on specific issues. 

Tip!  You can also select a name in the Reporter and Assignee fields by typing the first letter of 
the person's first name. Keep pressing the letter until the name you are seeking appears.  
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• In the Category field, click the drop-down arrow , and then select the issue category.  

 

• In the Type field, click the drop-down arrow  and select the issue type. The Type field 
populates with options related to the category you selected in the Category field.  

• In the Status field, click the drop-down arrow , and then select the issue status.  

 

• In the Priority field, click the drop-down arrow , and then select the issue priority. 

 

• In the Resolution field, click the drop-down arrow , and then select the issue's resolution type.  

 

• In the Submission Date Range fields, type the date range when an issue was originally 
submitted.  

• In the Due Date Range fields, type the date range for action item due dates associated with an 
issue. 

Tip!  When typing in dates, use the mm/dd/yyyy format. You can also click the calendar icon 

 and select the dates. 

• In the Keywords field, type any words related to your search query. 
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4. Click Submit Query. 

 
 

5. In the Issues section, the Select an Existing Issue or create a new Issue field populates with the 
results based on your search criteria, as shown in the next illustration. 
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6. To search for an issue, click the drop-down arrow  in the Select an Existing Issue or create a 
new Issue field.  

 
The field expands and displays a list of issues matching the search criteria you entered in the 
Issues Tracking Query section. 

• Do the following: 

ο If the issue you queried appears in the list, EST enables you to view and edit the issue 
information.  Go to Step 7 for directions on selecting, viewing, and editing an issue. 

ο If the issue you queried does not appear in the list of existing issues, do one of the following: 

 Under Issues Tracking Query, click Clear Query, and then enter the information related 
to the new issue (Repeat Steps 2 to 4). 
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ο Create an issue by clicking Create New. Go to Step 11 for directions on creating a new issue. 

 
7. Select an issue you want to view and edit. 

 
8. Click Load and Edit. 

 
 

The Issues section refreshes and expands, displaying the issue's details under the following sections: 

• Issues  

• CC List and Agencies  

• Action Items  
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9. Under Issues, edit the following fields, as needed.  

• Title 

• Category 

• Type 

• Description 

• Priority 

• Resolution 

• Reported by 

• Submission date 

10. To save your changes, click the Save button at the bottom of the screen (Go to Step 12). 

11. After clicking Create New, complete the following fields: 

• Title 

• Category 

• Type 

• Description 

• Priority 

• Resolution 

• Reported by 

• Submission date 

12. Click Save. 
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A message appears stating that the issue has been saved. 

13. Click OK. 

 

14. Under CC List and Agencies, you can add a person to an email notification list pertaining to a 
particular issue and add agencies to a notification list. The agencies that are added to the list will 
receive notifications pertaining to an issue, and the information will be documented in the semi-annual 
Agency Feedback Report.  

• To add a person to the CC List, do the following: 

ο Click the drop-down arrow  in the Add to CC List field. 

 
The field populates with a list of EMO staff members. 

ο Click the name you want to add to the notification list. 

 

ο Click Add to CC List. 

 
 

The selected name appears in the Name column of the CC List. 

 

Tip! To remove a name from the CC List, click  beside the name in the Name column. 
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• To add an agency to the issue notification list, click the drop-down arrow  in the Agencies field, 
and do the following:  

 

ο Click the agency you want to add to the notification list. 

 

ο Click Add Agency. 

 
The selected agency appears in the Name column of the Agencies field. 

 

Tip! To remove a name from the Agencies list, click the  beside the agency name in the  
Name column. 

 
15. Under Action Items, you can view, edit, update, or create issue action items.  
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• Do one of the following: 

ο To view, edit, or update the details of an existing issue action item, click the drop-down arrow 
in the Select an Existing Assignment or create a new one field, and select an assigned 

issue. Go to Step 16 for directions on viewing, editing, or updating the details of an existing 
issue action item. 

 
 

ο To create a new action item, click Create New. Go to Step 19 for directions on creating a new 
action item. 
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16. After you have selected an existing issue from the list, click Load and Edit. 

 
The Action Items section expands and displays the details of an issue assignment and a 
Comments section, allowing you to view, edit, and update the information.  

 

17. Edit and update the following fields, as necessary: 

• Assign To 

• Assignment Summary 

• Action Items 

• Due Date 
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• Select an Existing Status 

18. To save your changes, click the Assign button at the bottom of the screen (see Step 20). 

19. After clicking Create New, complete the following fields: 

• Assign To 

• Assignment Summary 

• Action Items 

• Due Date 

• Select an Existing Status 

20. Click Assign. 

 
 

A message appears, stating that the issue has been saved. 

21. Click OK. 
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22. Under Comments, you can add a comment by typing your comment in the Add New Comment field, 
and then click Add Comment. 

 
 

23. To attach a document, click Attach Document. 

 
 

The Issues Tracking: Attach Document window opens as a tabbed page. 

 
 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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24. In the Upload File field, click the Browse button to navigate to and select files for uploading. 

 
 
In the Description field, type the document description. 

25. In the Comment field, type any comments related to the document. 

26. Click Attach Document.  

 
 

Tip!  Click Back to Issue Tracking Tool to return to the Issue Tracking Tool window. 

 

Note:  Once you have made edits or created a new issue or action item, the changes or new 
issue will appear in the Issue Tracking Details Report, and the action item will appear in the 
assignee's Issue Tracking Inbox. 
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3.1.7 Agency Invoices (Updated 06/30/2010) 
Invoicing tools are available under the Agency Invoices function in the Tools menu.  These tools are used by 
the Invoice Administrator, Invoice Reviewers, Agency Invoice Submitters, and ETDM District Coordinators as 
part of the Agency On-line Invoicing System.  Depending on the user’s role, links to specific tools are provided.  
The menu options shown below are those available to Agency Invoice Submitters. 

 
 

3.1.7.1 District Reviewer Preference (New 05/15/2008) 

The District ETDM Coordinator uses the District 
Reviewer Preference tool to identify agencies for 
which the District wishes to review invoices.  The 
tool presents the District ETDM Coordinator with 
a list of agencies that are members of that 
District’s ETAT, and allows the District ETDM 
Coordinator to select agencies for which the 
District wishes to review invoices.  

In the Tools menu, point to Agency Invoices, 
and then click Reviewer Preference. 
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The form opens and displays  the FDOT District associated with the District ETDM Coordinator (District 3 in the 
example), and displays a list of ETAT agencies associated with the FDOT District (Agencies not Reviewed) 
and a list of previously selected agencies (Agencies to be Reviewed), if any. 

 
 

To add an agency to the District Reviewer Preference list, the District ETDM Coordinator highlights the agency 
name, and then clicks Add. 
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The agency name will be displayed in the Agencies to be reviewed field, as shown in the next illustration. 

 
 

To remove an agency from the Preference List, the District ETDM Coordinator clicks on the name of the agency 
in the Agencies to be Reviewed field, and then clicks Remove. 

3.1.7.2 Edit Expenses (Updated 06/27/2008) 

The Agency Invoice Submitter uses the Edit Expenses tool to provide information needed to complete the 
schedules and summary sheet for an invoice.  In an Advance Pay this would be called current reporting dates 
and in a Reimbursable it is the invoicing period.   

In the Tools menu, point to Agency Invoices, and then click Edit Expenses.   
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The form that opens will be populated with information related to the user name used to log on to the EST.  The 
form accessed using the Edit Expenses tool is the same form provided on the Edit Expenses screen of the 
Prepare Invoice wizard.  In the example shown below, the user name for a Northwest Florida Water 
Management District Agency Invoice Submitter was used.  (The information shown is for example purposes 
only and does not reflect actual Northwest Florida Water Management District agreements or invoices.) 

 

The Agency Invoice Submitter selects an agreement from the Agreement pull-down menu.  If entering 
information about an unsubmitted invoice, the Agency Invoice Submitter selects an invoice from the Invoice 
pull-down menu, and then clicks the Load button.  The form will be populated with information related to the 
selected invoice.   

 
 

If entering information for a new invoice, the Agency Invoice submitter enters the 
Invoicing Period End date by either typing in the date (in mm/dd/yyyy format) or 
selecting the date from a calendar by clicking the  icon.   

The next portion of the Edit Expenses form is used to enter or edit personnel 
costs for the invoicing period.  The Agency Invoice Submitter clicks Add 
Personnel to begin completing or editing this part of the form. 

 
 

 

 

  



 

 
Environmental Screening Tool Handbook  3-180 

If a previously saved draft invoice is being edited, the Agency Invoice Submitter clicks on the field that needs to 
be edited, and enters the new information.  When information is being added for a new invoice, the Agency 
Invoice Submitter clicks Add Personnel, a line is added to the form where the person’s name and job 
classification, number of hours worked during the invoicing period, average hourly rate, an additional overhead 
amount, or the overhead percentage are entered.   

 
 

As the Agency Invoice Submitter types each number, the Cost this Period is automatically calculated.  The 
Invoice Submitter clicks Add Personnel to add additional personnel.  Entries for personnel charges must have 
a unique identifier.   

 
If entering a person and job class more than once, each Name and Job Class entry must include a unique 
identifier (for example AAI for the first entry, AAIb for the second entry, and so forth).  The Agency Invoice 
Submitter should note that all fields must contain data, so if you add a line that is not going to be used, you must 
delete that line before finalizing and submitting the invoice.  To delete a line, the Agency Invoice Submitter clicks 
the Remove button next to the line.  The Agency Invoice Submitter also clicks the Remove button to delete 
personnel charges that were previously entered and are not to be included in the invoice (prior to finalizing and 
submitting the invoice). 

Once the Agency Invoice Submitter completes the Personnel Expense portion of the form, the Agency Invoice 
Submitter moves on to the Travel Expenses portion of the form.  The Travel Expenses portion of the form is 
used to enter or edit travel expenses for the invoicing period.  If editing previously entered Travel Expenses, the 
Agency Invoice Submitter clicks on the field that needs to be edited, and enters the new information.  If entering 
Travel Expenses for a new invoice, the Agency Invoice Submitter clicks the Add Expense button to begin. 
When the Agency Invoice Submitter clicks the Add Expense button, a line will be added to the form, as shown 
below, where a description of the travel expense and the amount are entered.  Note that an image of the receipt 
for each travel expense amount must be uploaded into the database (using the Upload Receipts tool) before 
an invoice can be finalized and submitted. Instructions for uploading a receipt are discussed in Section 3.1.7.9.   
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The Agency Invoice Submitter clicks the Add Expense button again to add additional travel expenses.  Note 
that entries in the travel expense Description field must be unique.  If an employee has more than one travel 
expense for the invoice period, each entry must include a unique identifier (for example, Smith 01-04-06, Smith 
02-01-06, and so forth).  The Agency Invoice Submitter should note that all fields must contain data, so if you 
add a line that is not going to be used, you must delete that line before finalizing and submitting the invoice.  To 
delete a line, the Agency Invoice Submitter clicks the Remove button next to the line.  The Agency Invoice 
Submitter also clicks the Remove button to delete expenses that were previously entered and are not to be 
included in the invoice (prior to finalizing and submitting the invoice). 

After the Agency Invoice Submitter completes the Travel Expense portion of the form, the Agency Invoice 
Submitter moves on to the Training Expenses portion of the form.  The Training Expenses portion of the form 
is used to enter or edit training expenses for the invoicing period.  If editing previously entered Training 
Expenses, the Agency Invoice Submitter clicks on the field that needs to be edited, and enters the new 
information.  If entering Training Expenses for a new invoice, the Agency Invoice Submitter clicks the Add 
Expense button to begin this portion of the form.  

 
 

When the Agency Invoice Submitter clicks the Add Expense button, a line will be added to the form, as shown 
in the next illustration, where a Description of the travel expense and the Amount are entered.   

 
 

Note that entries in the training expense Description field must be unique.  If an employee has more than one 
training expense for the invoice period, each entry must include a unique identifier (for example, Smith 01-04-
06, Smith 02-01-06, and so forth).  The Agency Invoice Submitter should note that all fields must contain data, 
so if you add a line that is not going to be used, you must delete that line before finalizing and submitting the 
invoice.  To delete a line, the Agency Invoice Submitter clicks the Remove button next to the line.  The Agency 
Invoice Submitter also clicks the Remove button to delete expenses that were previously entered and are not to 
be included in the invoice (prior to finalizing and submitting the invoice). 

The next portion of the Edit Expenses form is used to enter or edit other expenses for the invoicing period.  If 
editing previously entered Other Expenses, the Agency Invoice Submitter clicks on the field that needs to be 
edited, and enters the new information.  If entering Other Expenses for a new invoice, the Agency Invoice 
Submitter clicks the Add Expense button to begin this portion of the form.  When the Agency Invoice Submitter 
clicks the Add Expense button, a line will be added to the form, as shown here, where a description of the 
expense and the amount are entered.  The Agency Invoice Submitter should note that an image of the receipt 
for each expense amount must be uploaded into the database (using the Upload Receipts tool) before an 
invoice can be finalized and submitted.  The Agency Invoice Submitter clicks the Add Expense button again to 
add additional expenses.  Note that entries in the other expenses Description field must be unique.  If an 
employee has more than one Other Expense for the invoice period, each entry must include a unique identifier 
(for example, Smith 01-04-06-Supplies, Smith 02-01-06-Supplies, and so forth). 



 

 
Environmental Screening Tool Handbook  3-182 

The Agency Invoice Submitter should note that all fields must contain data, so if you add a line that is not going 
to be used, you must delete that line before finalizing and submitting the invoice.  To delete a line, the Agency 
Invoice Submitter clicks the Remove button next to the line.  The Agency Invoice Submitter also clicks the 
Remove button to delete expenses that were previously entered and are not to be included in the invoice (prior 
to finalizing and submitting the invoice).  In the example shown, a description of the expense and amount would 
need to be entered before saving the draft invoice. 

The final portion of the Edit Expenses form displays the total cost for the invoice being prepared.  This total cost 
is automatically calculated based on the amounts entered for personnel, travel, training, and/or other expenses.  
A text box is also provided for adding additional notes.  The Agency Invoice Submitter clicks Save Draft.  (Note 
that the Agency Invoice Submitter can use the Save Draft button at any time when entering expenses.  This 
allows the Agency Invoice Submitter to return to the invoice at a later time without having to re-enter expense 
information.)  The draft invoice can be added to or changed at any point prior to submittal.  After the Agency 
Invoice Submitter saves the draft invoice, the Agency Invoice Submitter can submit the invoice by clicking 
Submit Draft Invoice for Review. However, it should be noted that the other invoice components (summary of 
agency activities and uploaded receipts) should be entered into the database before submitting the invoice.  
Section 3.1.7.7 describes how to summarize agency activities for the invoicing period. 

 

When the Invoice Submitter clicks the Submit Draft Invoice for Review button, the View/Submit Invoice 
screen opens.  This screen displays the Payment Tracking Report for the invoice.  The Payment Tracking 
Record includes a summary of the agreement information pertaining to the invoice, followed by the completed 
Schedule A-1 (Salary Costs), Schedule A-2 (Hours Assignments), Schedule E-1 (Reimbursable Direct 
Expense – Travel), Schedule E-2 (Reimbursable Direct Expense – Training), and Schedule  E-3 
(Reimbursable Direct Expense – Other) forms, reflecting the information entered using the Edit Expenses tool.  
The screen also includes the Agency Activity Report, which includes information entered using the 
Summarize Agency Activities tool and the Log Agency Activity tool (if applicable).  The Summarize 
Agency Activities tool and the Log Agency Activity tool are discussed in Sections 3.1.7.7 and 3.1.7.3, 
respectively.  The Invoice Submitter should note that the Agency Activity Report must be submitted prior to 
finalizing the draft invoice. 

If the draft invoice is complete, the Agency Invoice Submitter enters the appropriate password, and then clicks 
Submit Invoice. 

  



 

 
Environmental Screening Tool Handbook  3-183 

3.1.7.3 Log Agency Activity (Updated 06/27/2008) 

The Log Agency Activity tool is used to provide 
details about agency activities that are not 
recorded in the EST.  These may include activities 
such as meetings, technical support of non-ETDM 
projects, and permit coordination.  The activities 
may be entered at any time by any of the agency 
ETAT representatives.  Each agency activity is 
logged individually.  The Agency Invoice 
Submitter also uses this tool to edit Activity Logs 
previously submitted via the EST. 

In the Tools menu, point to Agency Invoices, 
and then click Log Agency Activity. 

 

 

 
 
 
 
 
 
The form that opens comprises two sections:  The first section contains pull-down menus for selecting an 
agency and selecting and loading an existing Activity Log.  It also includes a button for clearing the form and 
creating a new Activity Log. 

 
 

The Agency Invoice Submitter selects an agency using the Agency pull-down menu.  The form will be 
populated with a list of Activity Logs using the EST. The Agency Invoice Submitter then selects an existing 
Activity Log to be edited from the pull-down menu, or proceeds to the second portion of the form to add a new 
Activity Log.  
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To edit an existing Agency Activity Log, the Agency Invoice Submitter selects the Activity Log from the pull-
down menu at the top of the form, then clicks the Load button.  The form will be populated with information for 
the selected Activity Log.  The Agency Invoice Submitter makes changes using the pull-down menus and 
textboxes, then clicks Save.  The Agency Invoice Submitter can then use the Clear/Create New button to clear 
the form and select and edit another existing Activity Log or create a new Activity Log. 

The Agency Invoice Submitter first enters the date of the activity by either typing in the date (in mm/dd/yyyy 
format) or selecting the date from a calendar.  To select the date from a calendar, the Agency Invoice Submitter 
clicks the  icon.   

The Agency Invoice Submitter then uses the pull-down menus to select Activity Type, Work Program Phase, 
FDOT Districts, and Counties. 

 
If the activity is related to an ETDM project, the Agency Invoice Submitter types the ETDM project number in the 
Project/ETDM # field.   

 
If the activity is not directly related to an ETDM project, click the ETDM button to toggle to Non ETDM.  

 
The EST displays the Non ETDM button.  Type the project name in the Project/Name field. 

 
In the FDOT FM Number field, type the FDOT Number. 

 

In the ETAT Representative field, click the drop-down arrow  and select the ETAT Representative who 
performed the activity. 
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Note: The list only displays active EST users within the agency. Click Include Disabled Users to include past 
users who are no longer active EST users in the agency. 

 
In the Hours field, enter the number of hours associated with the activity. 

 
Next, the Agency Invoice Submitter uses the Activity Description textbox to type in a brief text description of 
the activity being logged.  The Agency Invoice Submitter uses the Results or Anticipated Actions textbox to 
describe any actions taken by FDOT or the agency as a result of the activity or any actions anticipated. 

The Agency Invoice Submitter clicks the Save button to save the information entered.   

 

 

3.1.7.4 Agency Activities: Batch Uploader (New 06/30/2010) 

The Agency Activities: Batch Uploader function in 
the Environmental Screening Tool (EST) Tools 
menu displays a form that enables you to upload an 
Excel spreadsheet detailing agency activities that 
are not recorded in the EST. These may include 
activities such as meetings, technical support of non-
ETDM projects, and permit coordination. The 
activities may be entered at any time by any of the 
agency Environmental Technical Advisory Team 
(ETAT) representatives.  

You can enter multiple activities at one time, with the 
option to select and upload logged activities by date 
range. 

Using the Agency Activities Batch Uploader: 

1. On the Tools menu, point to Agency 
Invoices, and then click Upload Agency 
Activity Spreadsheet. 
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The Agency Activities: Batch Uploader window opens as a tabbed page, displaying a page toolbar, 
and a form for uploading the Agency Activity spreadsheet. 

   
 

Tip!   Click on the toolbar icons to: 

   Send feedback about the current page. 

   Access online Help. 

    Bookmark the page. 

   Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

2. Click the batch upload spreadsheet link to download a blank Excel spreadsheet from the EST 
database.  

Tip!   You can also download the spreadsheet from the ETDM Library. 
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3. A File Download dialog box appears asking you to Open or Save the spreadsheet. Click Save to 
download the spreadsheet to your computer. 

 
4. Navigate to and click the saved file to open it. The spreadsheet opens as a separate Microsoft Excel 

window.  

5. Check the Validation list on the Agency Activities: Batch Uploader window before logging the 
activities into the spreadsheet.  The data must be correct and follow the format criteria detailed in the 
list. 

 

Note:  The data must be in the first sheet of the Excel file. The first row of the spreadsheet must 
contain the column headings as they appear (see next illustration).  These headings cannot be 
changed or deleted. 

 
6. After you have logged the information into the spreadsheet and saved the file on your computer, click 

the Browse button next to the Upload File field to navigate to and upload the spreadsheet. 
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7. Do the following: 

• In the Agency field, click the drop-down arrow, , and select the agency you are logging the 
activities for. 

• In the Filter Start Date and Filter End Date fields, type the date range to select the activities to be 
uploaded. 

Tip!  Type the date using the mm/dd/yyyy format.  You can also click the calendar icon, , 
and select a date. Only activities that occurred between the filter Start and End dates will be 
imported; you must leave one or both of these fields blank if you would rather import all events 
instead of filtering them.  

8. Click Upload Document for Batch Processing. 

 
 

The Agency Activities: Batch Uploader window refreshes and displays the activities that have 
been imported into the database. 

 



 

 
Environmental Screening Tool Handbook  3-189 

Note:  If there is incorrect data or if data has been logged incorrectly, the EST will display a 
validation error message, along with the errors, and a View Excel button to access a read-only 
view of the entire spreadsheet. The next illustration displays the Agency Activities Batch 
Uploader window with an error message. 
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3.1.7.5 Manage Master Agreement/Contract (Updated 06/27/2008) 

When a new agreement between FDOT and a participating agency is executed, the Invoice Administrator logs 
onto the EST and enters basic setup information into the database to describe the agreement.  This information 
is then used on the forms and reports associated with the invoice package.  In addition, if any changes are 
made to an existing agreement, the Invoice Administrator updates the database prior to the next invoicing cycle. 

In the Tools menu, point to Agency Invoices, and then click Master Agreement/Contract.   
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The form that opens has two main functions: Add/Remove Reviewers and Add/Edit Agreement.   
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The Add/Remove Reviewers function is used to add or remove EST users who are responsible for reviewing 
draft invoices and submitting comments to the Invoice Administrator.   

 
To add a reviewer, type the user’s name (or portion of the name) in the text box under “Find a User to Add.”  
The user’s name and log-in identification will be extracted from the database and displayed, as shown in the 
next illustration.   

Click on the user name/log-in identification, and then click   .  The user will be added to the list of 
“Primary Reviewers.”  Click “Save” to add this change to the database.  To remove a reviewer, click on the 
reviewer’s name under “Primary Reviewers,” then click “Remove Selected.”  When finished, click “Save.” 

To add an agreement or contract to the database, scroll down to the Add/Edit Master Agreement portion of the 
form.  First, type in your agency name (or a portion of the name) in the “Organization” text box under 
“Agreement Loading.”  In the example shown below, “FL Department of State” was typed in.  If there are 
existing agreements for your agency in the database, they will be listed in the “Existing Agreements” pull-down 
menu.  Check this list to confirm that the agreement or contract you want to enter is not already in the database. 
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If the agreement to be entered is not listed, use the “Initial Agreement Creation” portion of the screen to enter 
information about the new agreement.  First, type in the agreement or contract number, then select “agreement 
number” or “contract number” from the pull-down menu.  Then select the Primary Invoice Submitter and 
Remittance Contact person for the agreement/contract from the pull-down menus.  Type in the contract limits for 
salary, training, travel, and other expenses, or  check the  “Only use a Single Limit” check box and enter the 
single limit total..  If advance payments are authorized by the agreement, click the Allow Advance Pay Requests 
check box. 

 

To add the dates for Notice to Proceed, End of Service, Agency Operating 
Agreement Renewal, Funding Agreement Renewal, and Master Agreement 
Renewal, either enter the dates in dd/mm/yyyy format or click on the  icon to 
select the date from a calendar.  When finished, click the “Save” button at the 
bottom of the form.  The information will be added to the database.  Any of the 
information can be revised (prior to clicking “Save”) by typing over the existing 
information or selecting different dates.  Click the “Clear Form” button to remove all 
the information entered. 
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To edit information for an agreement or contract already stored in the database, type in the organization name, 

select the agreement from the “Existing Agreements” pull-down menu, then click the  button.  The 
information pertaining to the selected agreement will appear in the form, as shown below.  Make changes by 
typing in the text boxes, or change the dates by typing in the new dates (in dd/mm/yyyy format) or by clicking on 
the  icon and selecting the new date from a calendar.  Add an explanation of the changes made by typing in 
the “Change notes” text box, or you can copy and paste information for this field from an existing document.   

 

When finished, click the “Save” button at the bottom of the form.  The revised information will be added to the 
database.  The “Clear Form” button can be used to remove all the information at any time prior to clicking 
“Save.”  
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3.1.7.6 Prepare Advance Pay Request (Updated 06/27/2008) 

Agencies that are authorized by their ETDM Agency Funding Agreement to receive advance payments can 
request those payments using the EST. The Agency Invoice Submitters within these agencies submit requests 
via the EST using the Prepare Advance Pay Request tool. 

To use the Prepare Advance Pay Request tool, the Agency Invoice Submitter goes to the Tools menu, points to 
Agency Invoices, and then clicks Advance Pay Request.   

  
The form that opens is divided into four sections: Select an Organization, Master Agreement, and Invoice; 
Prepare Advance Pay Request; Compensation Elements; and Final Notes and Submitting.  The form will 
be populated with information related to the user name used to log on to the EST, and by default will display 
information for the last invoice viewed by that user.  In the example shown below, the user name for a 
Northwest Florida Water Management District Agency Invoice Submitter was used.  (The information shown is 
for example purposes only and does not reflect actual Northwest Florida Water Management District 
agreements or invoices.) 
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The Agency Invoice Submitter begins by either loading the invoice highlighted in the 
Invoices pull-down menu, or selecting another invoice.  To select a different invoice, 
first select an agreement using the Existing Agreements pull-down menu.  If the 
Agency Invoice Submitter is requesting an advance payment for an unsubmitted 
invoice, the Agency Invoice Submitter selects the invoice from the Unsubmitted 
Invoices pull-down menu, then clicks the Load button.  The form will be populated 
with information related to the selected invoice.  If the Advance Pay Request is 
associated with a new invoice, the Agency Invoice Submitter enters the Invoicing 
Period End date by either typing in the date (in mm/dd/yyyy format) or selects the 
date from a calendar by clicking the  icon, then clicks Create New Invoice.   

 

 

The Advance Payment Request form that opens is automatically populated with information about the 
agreement.  The Agency Invoice Submitter reviews the information shown in the Prepare Advance Pay 
Request portion of the form, and then proceeds to enter the compensation elements for the Advance Pay 
Request.  

 

The Agency Invoice Submitter enters the amounts for compensation elements (labor and expenses being 
requested), and other notes, if desired.  The Agency Invoice Submitter presses the tab key after entering the 
labor and expenses amounts, and clicks Save when finished. 
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3.1.7.7 Summarize Agency Activities (Updated 06/27/2008) 

The Summarize Agency Activities tool is used by the Agency Invoice Submitter to enter information about 
agency activities for an invoicing period.  It is also used to edit information previously entered.  In the Tools 
menu, point to Agency Invoices, and then click Summarize Agency Activities.   

 
 

The form that opens will be populated with information related to the user name used to log on to the EST, and 
by default will display information for the last invoice viewed by that user.  In the example shown below, the user 
name for a Northwest Florida Water Management District Agency Invoice Submitter was used.  The information 
that is shown is for example purposes only and does not reflect actual Northwest Florida Water Management 
District agreements or invoices. 

  



 

 
Environmental Screening Tool Handbook  3-198 

Begin by either loading the invoice highlighted in the Invoices pull-down menu, or 
selecting another invoice.  To select a different invoice, first select an agreement 
from the Existing Agreements pull-down menu.  Then select an invoice from the 
“Load an unsubmitted invoice” pull-down menu, and click the Load button.  The 
form will be populated with information related to the selected invoice.  If entering 
information for a new invoice, enter the Invoicing Period End date by either typing in 
the date (in mm/dd/yyyy format) or selecting the date from a calendar by clicking 
the  icon.  The new invoice number and ending date will be added to the 
Invoices pull-down menu.  Select it, and then click the Load button. 

The next portion of the form is used to enter or edit narrative about agency activities 
during the invoicing period, with separate sections for accomplishments made 
during the period, a summary of ETDM screening activities, and anticipated 
accomplishments for the next period, as shown in the example.  Use the textboxes to enter a brief description of 
activities for each category, or edit the descriptions previously entered.  Note that agencies authorized to receive 
Advance Payments can set a Reporting Period end date that is different from the Invoicing Period end date, by 
entering the date or using the calendar feature described above.  The example shown below includes this 
option.   

The first section is used to enter or edit information about accomplishments made during the invoicing (or 
reporting) period. 
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Following are guidelines for the information for each category under Accomplishments Made During Period: 

• Administrative or Supervision Tasks – discuss management and/or supervision tasks performed during the 
period 

• Coordination – discuss non-field interagency and FDOT coordination 

• Performance Measures – discuss how the agency has performed on the Performance Measures outlined in 
the Agreement 

• Problems Encountered/Suggestions for Improvement – provide information on any problems discovered or 
anticipated, and any proposed improvements that would facilitate the streamlining effort of the ETDM 
Process 

Under Summary of ETDM Screening Activities, use the textboxes to describe any problems encountered using 
the EST and to add or edit any other comments. 

 
Under the Anticipated Accomplishments for Next Period, enter a brief description of anticipated activities for the 
next reporting period, and the number of anticipated hours and number of persons performing the anticipated 
activities.  When finished, click the “Save Draft” button on the left side of the screen. 

 
A message will be displayed, confirming that the invoice has been saved. 

After the draft invoice has been saved, it can be submitted for review by 
clicking the Submit Draft Invoice for Review button. 

Clicking the Submit Draft Invoice for Review button opens the View/Submit 
Invoice screen, which will display the Payment Tracking Report for the 
invoice.  The Payment Tracking Record includes a summary of the 
agreement information pertaining to the invoice, followed by the completed 
Schedule A-1 (Salary Costs), Schedule A-2 (Hours Assignment), Schedule E-1 (Reimbursable Direct Expense 
– Travel), Schedule  E-2 (Reimbursable Direct Expense – Training), and Schedule  E-3 (Reimbursable Direct 
Expense – Other) forms.  The Payment Tracking Report also includes the Agency Activity Report, which 
displays the information entered using the Summarize Agency Activities tool and the Log Off-line Activity tool (if 
applicable).  Note that the information for Schedules A-1, E-1, E-2, and E-3 must be entered using the Edit 
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Expenses tool or the Prepare Invoice wizard, and the Schedule A-2 information must be entered using the 
Assign Hours tool, prior to finalizing the invoice. 

If the invoice is for an agency authorized to receive Advance Payments, an Advance Pay Request Report will 
also be displayed (preceding the Payment Tracking Record). 

 
Portions of an example Payment Tracking Report are shown below.  The information can be reviewed.  If any 

changes need to be made, close the View/Submit Invoice window by clicking the  button in the upper right 
corner of the screen.  You can then access the invoice using the Edit Expenses or Assign Hours tools, and 
make changes.  If no changes or additions are needed, proceed with submitting the invoice by entering the 
Agency Invoice Submitter password, and then click the Submit Invoice button.  
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3.1.7.8 Update Invoice Status (Updated 07/08/2008) 

The Update Invoice Status tool is used by the Invoice Administrator to authorize final invoices, and indicate 
when they have been processed.   

1. In the Tools menu, point to Agency Invoices, and then click Update Invoice Status.   

 
 

The Invoice Administrator begins by selecting an agency from the Agency pull-down menu.  The form will 
be repopulated with lists of existing agreements and associated invoices for the selected agency.  The 
Invoice Administrator selects an agreement from the Agreements pull-down menu, then selects the 
invoice from the Invoice pull-down menu.  The current status of the invoice will be displayed in the 
Status field.  The status will be Draft, Final Authorized, Final Submitted or Processed. 



 

 
Environmental Screening Tool Handbook  3-202 

The Invoice Administrator clicks the View Invoice button to view the invoice.  The Payment 
Tracking Record for the invoice will open in a new window.  After reviewing the invoice, the 
Invoice Administrator clicks the Update Invoice Status tab to return to the Update Invoice 
Status window. 

 
 
 
2. In the Update Invoice Status window, click Load.  

 
In the Invoice # section, the Invoice Administrator can update an invoice status and add 
comments. 

 

3. To change the invoice status, do the following: 

• To send requested changes or an approval to the invoice submitter, type your comments in the 
Comments to invoice submitter field.   

Important:  Before entering your comments, you should ensure you are including 
comments from other reviewers. Open the Invoice Comment Log window to view the list of 
reviewers and comments for the selected invoice.  To access the Invoice Comment Log 
window, go to the EST Reports menu, point to Invoicing Reports, and then click Invoice 
Comment Log.   

Once you have accessed the Invoice Comment Log, print out the log to keep a hard copy 
record of the list of comments. This enables you to keep a record of previous reviewer 
comments that may be deleted and replaced by new comments. 

Then return to the Update Invoice Status window, and type your comments in the 
Comments to invoice submitter field. 
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• In the Status field, click the drop-down arrow  and select one of the following: 

ο If changes need to be made to the current draft, click Draft. 

ο If no changes need to be made to the current draft, and you have determined it's ready to be 
processed, click Final Authorized. 

ο If the invoice has been processed, click Processed. 

Note:  You must add comments before selecting a status in the Status field. 

 
 

Note:  The Final Submitted option in the Status field only indicates an agency has submitted a 
final invoice. You cannot make any changes to an invoice status with this selection. 

• Click Update Status. 
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A message appears stating the invoice has been updated and an email notification sent to the 
invoice submitter.  Click OK. 

 
 

Upon submittal of the Final Authorized invoice, the database automatically updates the invoice 
status to Final Submitted.  

 

Note:  If changes need to be made to the draft invoice, the invoice will maintain its unsubmitted 
status. 

 

Tip!  To regenerate a PDF of the invoice, click Regenerate PDF, as illustrated below. 
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3.1.7.9 Upload Receipts (Updated 06/27/2008) 

If a previously saved draft invoice is being edited, the Agency Invoice Submitter clicks the field that needs to be 
edited, and enters the new information.  The Agency Invoice Submitter is required to provide scanned images of 
expense receipts as part of the invoice package.   

In the Tools menu, point to Agency Invoices, and then click Upload Receipts.   

Note: Scanned images of the documentation must be black and white, with a scanning density of 300 dots per 
inch (DPI).   

 
 

The form that opens is divided into three sections.  The Agency Invoice Submitter uses the first section to select 
an Agency, Existing Agreement, and Invoice. This section of the form will be populated with information related 
to the user name used to log on to the EST.  In the example shown below, the user name for a Northwest 
Florida Water Management District Agency Invoice Submitter was used.  (The information shown is for example 
purposes only and does not reflect actual Northwest Florida Water Management District agreements or 
invoices.)  

The Agency Invoice Submitter begins by selecting an agreement using the Existing Agreements pull-down 
menu.  If the Agency Invoice Submitter is uploading a receipt for an unsubmitted invoice saved in the database, 
the Agency Invoice Submitter selects the invoice from the Invoice pull-down menu.  If the receipt is not related 
to an unsubmitted invoice, the Agency Invoice Submitter proceeds to the Upload File portion of the form. 
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The Agency Invoice Submitter uses the second section of the form to view and/or delete receipts that were 
previously uploaded.  The Agency Invoice Submitter selects the receipt from the Pick Receipt pull-down menu.  
The PDF version of the receipt will be displayed in a new window, as shown below.  To keep the receipt as part 
of the invoice package, the Agency Invoice Submitter clicks the Yes – keep receipt button.  To delete the 
receipt, the Agency Invoice Submitter Clicks the No – delete receipt button.  
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The Agency Invoice Submitter uses the third section of the form to upload a receipt, as shown below.  Receipts 
may be in BMP, GIF, JPG, PNG or PDF format, but the images must be black and white, with a scanning 
density of 300 dots per inch (DPI).  If the receipt pages are in a format other than PDF, they must be uploaded 
one 8-1/2 x 11-inch page at a time.  To upload images of receipts, the Agency Invoice Submitter uses the 
Browse button to locate and select the file containing the image that has previously been saved on the 
computer.  The Agency Invoice Submitter adds a brief description of the receipt in the Description textbox, then 
clicks the Upload and View Confirmation Page button.  The PDF version of the receipt will be displayed in a 
new window, as shown above.  To keep the receipt as part of the invoice package, click the Yes – keep receipt 
button.  To delete the receipt, click the No – delete receipt button.  

3.1.7.10 Upload Signatures (New 07/08/2008) 

The Upload Signatures tool is used by the Agency Invoice Submitter to add an electronic signature of an 
agency-designated person approving submittal of a final invoice.   

In the Tools menu, point to Agency Invoices, and then click Upload Signatures.   
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To add an approval signature to a final invoice, the Agency Invoice Submitter first selects their agency and an 
existing agreement from the pull-down menus.  A list of invoices associated with the selected agreement will be 
displayed in the Invoice pull-down menu.  The Agency Invoice Submitter then selects an invoice.   

 

If the invoice approver’s signature has been previously uploaded to the database and associated with the 
selected invoice, the Agency Invoice Submitter can pick the signature from the Pick Signature pull-down menu.   

 
To add an electronic signature to the database, the Agency Invoice Submitter uses the Browse button to locate 
and select the file containing the image of the signature that was previously saved on their computer.  Electronic 
signatures may be in BMP, GIF, JPG, PNG or PDF format, but the images must be black and white, with a 
scanning density of 300 dots per inch (DPI).  If signature pages are in a format other than PDF, they must be 
uploaded one 8-1/2 x 11-inch page at a time.  Tab to the Name textbox and type in the person’s name 
associated with the electronic signature.  Then click the Upload and View Confirmation Page button. 

 

The PDF version of the signature will be displayed in a new window.  To keep the signature as part of the 
invoice package, click the Yes – keep signature button.  To delete the signature, click the No – delete 
signature button.   
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3.1.7.11 Record Invoice Comments (Updated 05/15/2008) 

Once a draft invoice is submitted using the EST, the Invoice Administrator and Invoice Reviewers receive an 
email informing them that the draft invoice is ready for review.  District Invoice Reviewers will receive emails only 
for invoices associated with agencies identified by the District ETDM Coordinator (using the District Review 
Preference tool).  The notification email contains the agency name, agreement number, invoice number, and 
submittal date.  The Invoice Administrator and Invoice Reviewers log on to the EST and review the submitted 
invoice for completeness and correctness using the Record Invoice Comments tool.  The Invoice Administrator 
and Invoice Reviewers use the Record Invoice Comments tool to log comments about the invoice.  The log 
includes the invoice number, name of the person submitting the comment, comment, and date submitted.  
During the commenting period, the Invoice Administrator and Invoice Reviewers may view other reviewers’ 
comments, submit additional comments, and edit their own comments. 

In the Tools menu, point to Agency Invoices, and then click Record Invoice Comments. 
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After the Record Invoice Comments form opens, the Invoice Reviewer selects the invoice from the Invoicing 
Period pull-down menu, then clicks View Invoice.  The Payment Tracking Record for the selected invoice will 
open in a new window.   

 

After reviewing the invoice, the Invoice Reviewer returns to the Record Invoice Comments form by clicking the 
Record Invoice Comments tab at the top of the screen. 

 

The Invoice Reviewer enters comments concerning the invoice in the Comment textbox, then clicks Save when 
finished. 

After clicking Save, a description of the comment will be displayed in the Load/Edit Existing field.   

 

To edit a previously submitted comment, the Invoice Reviewer selects the comment from the Load/Edit 
Existing pull-down menu (note that the comment description will be highlighted in blue), then clicks the Load 
button.   

The comment will be displayed in the Comment textbox, as shown below.  After editing the comment text, the 
Invoice Reviewer clicks Save.  
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If other reviewers have submitted comments concerning the invoice, the comments will be displayed in the 
Comments from other reviewers field.   

 

3.1.7.12 Assign Hours (New 05/15/2008) 

The Assign Hours tool provides a list of the ETDM projects reviewed during an invoicing period and activities 
from the Agency Activity Log for that invoicing period.  The Agency Invoice Submitter uses the Assign Hours 
tool to assign hours for each project or activity, or update hours previously assigned in the Agency Activity Log.  
The total hours assigned will be reflected on Schedule A-2, which is part of the Invoice Package. 

In the Tools menu, point to Agency Invoices, and then click Assign Hours.   

Tip!  The Assign Hours function can also be accessed through the Prepare Invoice Wizard, where it 
appears after the Agency Activity Log step. 
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When the form opens, it will include information for the Agency Invoice Submitter’s agency.  To assign hours to 
the projects and activities listed, the Agency Invoice Submitter first selects an agreement from the Agreement 
pull-down menu.  This is accomplished by clicking on the name of the agreement (which will then be highlighted 
in blue), then pressing the Select button.  The Invoices field will be populated with a list of invoices associated 
with the selected agreement.  Next, the Agency Invoice Submitter selects an invoice from the Invoices pull-
down menu and presses the Load button. 

 
 

The next illustration shows a list of invoices, with Invoice 1 highlighted.   

 
 

After clicking Load the information for the selected agreement and invoice will be displayed. 

 
 

Tip!  Click Clear to return the form to its default display. 
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The next illustration displays the information for a selected agreement (DEP1 87654321098) and invoice 
(Invoice 1, Ending on 03/31/2007).  This information is for demonstration purposes only and does not reflect an 
actual agreement or invoice. 

 
 

To assign hours for a project or activity, the Agency Invoice Submitter enters the number of hours in the Hours 
field to the right of the activity, then clicks Save.  

 
 

  



 

 
Environmental Screening Tool Handbook  3-214 

If assigning hours for more than one activity, the Agency Invoice Submitter enters the number of hours for each 
activity, then clicks the Save All button at the top left side of the table.  

 
Note that as hours for an activity are entered, the Total hours accounted for field at the bottom of the table will 
automatically change to reflect the total number of hours assigned for the listed activities. 

 
The Agency Invoice Submitter uses the Remove button to remove an activity from the table.  
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The activity (and associated hours) will be moved from the Assigning Hours for Invoice Name table to the 
Agency Activity drop-down list above the table.   

 
 

To move an activity from the Agency Activity drop-down list back to the Assigning Hours for Invoice Name 
table, the Agency Invoice Submitter clicks the drop-down arrow in the Agency Activity field, selects the activity 
from the list, and then clicks Add.  

 
 

Tip!  Click Add All to move all invoices from the Agency Activity drop-down list to the Assigning Hours for 
Invoice Name table. 

The activity will be added back into the table, but marked as Unsaved.  The Agency Invoice Submitter must 
reassign hours to the activity and click Save to retain it. 
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To delete an activity from the invoice, the Agency Invoice Submitter clicks Delete.   

 
 

Note: Clicking Delete removes the activity from the database.  If the activity is deleted by mistake, the Agency 
Invoice Submitter will have to re-enter it using the Log Agency Activity tool. 

3.1.7.13 Override Invoice Payments (In Development) 

3.1.8 Project Tracker (New 07/31/2009) 

3.1.8.1 Manage Project Tasks (New 07/31/2009) 

The Manage Project Tasks function in the Environmental Screening Tool (EST) Tools menu enables 
authorized users to manage tasks assigned to a project.  

Users with the following assigned privileges can send the report to EDMS: 

• Environmental Management Office (EMO) Managers 

• Florida Department of Transportation (FDOT) Coordinators Primary 

• FDOT Coordinators  

For a list of roles authorized for using the Manage Project Tasks function, see Table 1-1 in Chapter 1.5 of the 
EST Handbook. 

Using the Manage Project Tasks Tool: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 
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2. On the Tools menu, point to Project Tracker, and then click Project Tasks. 

 
The Manage Project Tasks window opens as a tabbed page, displaying the details for the 
selected project and a page toolbar. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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3. Under Groups and Tasks, click the drop-down  arrow in the Groups field, and then select a group 
from the list. 

 
 

The Groups and Tasks section expands, displaying a table showing a list of tasks associated 
with the selected project. 

 
 

Note:  Tasks that are grayed out are inactive because they have not been assigned to the 
selected project.   

 

  



 

 
Environmental Screening Tool Handbook  3-219 

4. To assign a task, click the check box in the Assigned column. The EST activates the task and displays 
it in bold font. 

 
 

5. To change the task priority, click the arrows in the far right column of the table.  For example, in the next 
illustration, clicking the up arrow for the Develop SCE Evaluation task moves it above the Complete 
ETAT Review Period (List Date) task. 
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The task—Develop SCE Evaluation—is now displayed before Complete ETAT Review Period 
(List Date), as shown in the next illustration.   

 

Tip!  To remove an assigned task from the project, click the checked box in the Assigned 
column beside the Task name.  The task row will become grayed out and all information related 
to the task will be removed. 

6. Click the pencil icon in the table's far-right column to make edits to or add: 

• Comments 

• Target Date (the task start date) 

• Completed Date (the date the task was completed) 

• Assigned To 

 
The task row expands, displaying fields for editing or adding information and designating task 
assignees. 

 



 

 
Environmental Screening Tool Handbook  3-221 

• Do the following: 

ο In the Comments column, type your comments in the text box. 

 
 

Note:  Authorized users can only edit or delete their own comments. Only FDOT Coordinators 
and Project Managers can edit or delete other users' comments. 

 

ο In the Target Date column, type the task start date. 

Tip!  When typing dates, use the mm/dd/yyyy format.  You can also click the calendar icon 

 and select the dates. 

 

Note:  Task assignees will enter the date the task was completed in the Completed Date field.  

ο In the Assigned To column, do the following: 

 Type the first three letters of the person's name in the text box, as shown in the next 
illustration. 

 

The EST automatically populates the field with a list of matching names and agencies. 
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Tip!  Click  to cancel the actions.  All information related to the task will be removed. 

 

 Select the person you want to designate as the task assignee from the prepopulated drop-
down list. 

 Click Assign. The designated task assignee's name now appears in the Assigned To 
column. 

 

 Repeat the process to designate additional task assignees. 

• Click  to save your information. 
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The EST now displays the task and designated assignees. 

 
 

Tip!  To remove a designated task assignee, select the name from the Assigned To column, 
and then click the Remove button. 

 

7. Under Task Notification Email,  do the following: 

• In the From field, click the drop-down arrow  and select the name of the person sending the 
Task Notification. 

• In the Task Notification Email table, select the task assignee(s) you want to include in the task 
notification emails by clicking the check box next to the assignee's name.   

Note: If you want to deselect a name from the list, click the checked box beside the assignee's 
name to remove the checkmark. 
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8. Click Send Email.  The EST will send the task assignees a system email with the task information, 
including the: 

• ETDM Project Number 

• ETDM Project Name 

• Group 

• Task 

• Target Date  

Note:  Task assignees only have write-access privileges for entering the Task Completed Date. 

The information entered in the Manage Project Tasks window will appear in the Project Tasks Status 
Report. 

See the Project Tasks Status Report section of the EST Handbook for instructions on navigating the 
Project Tasks Status Report window. 

3.1.8.2 Manage Task Groups (New 07/31/2009) 

The Manage Task Groups function in the Environmental Screening Tool (EST) Tools menu enables 
Environmental Management Office (EMO) Managers, Florida Department of Transportation (FDOT) ETDM 
Coordinators Primary, and FDOT ETDM Coordinators to manage tasks and groups by: 

• Creating groups and assigning new and existing tasks 

• Assigning or removing tasks from an existing group 

• Removing groups 

• Deleting tasks 

Using the Manage Task Groups Tool: 

1. On the Tools menu, point to Project Tracker, and then click Task Groups. 
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The Manage Task Groups window opens as a tabbed page, displaying a search filter and a 
page toolbar. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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2. To create a group and assign tasks to it, do the following: 

• Under Groups and Tasks, type the name of the new group in the New Group Name field, and 
then click Save.  For the next illustration, the new group name is Bob's Group. 

 
 

The new group name—Bob's Group—now appears in the group list of the Groups field.   

 
 

Once you have created a new group name, you can assign tasks to the group by: 

• Assigning existing tasks (See Step 3 for details) 

• Creating and assigning new tasks (See Step 4 for details) 
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3. To assign tasks that already exist in the database, do the following: 

• Under Existing Tasks, select the task(s) from the list of options. 

Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

 

• Click Assign Task(s). 

 
The selected tasks now appear in the Task for Selected Group field, and the EST displays a 
message that the Task(s) were successfully assigned. 
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4. To create a new task and assign it to a group, do the following: 

• Under Task for selected Group, type the task name in the New Task Name field.  For the next 
illustration, the new task name Develop Documentation was created. 

 
 

• Click Save & Assign. 

 
 

The new task—Develop Documentation—now appears in the Task for selected Group field and 
in the Existing Tasks field, which means it can be assigned to other groups. 
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5. To manage the tasks for an existing group, do the following: 

• Click the drop-down arrow   in the Groups field, and then select a group from the list.  

 
The group name now appears in the Groups field along with the list of tasks assigned to the 
group. 

 

6. To remove tasks from a group or create a new task and assign it to the group, do the following: 

• To remove an assigned task from a group, select the task from the Task for selected Group field, 
and then click Remove. 

 

Note:  A task can only be removed from a group if there are no other projects assigned to that 
task. 

A message appears asking you to confirm the deletion. Click OK. 

 



 

 
Environmental Screening Tool Handbook  3-230 

The task is removed from the list of tasks for the selected group.  

Note: Tasks removed from the list in the Task for a selected group field are not deleted from 
the list of Existing Tasks.  

• To create a new task for an existing group, do the following: 

ο Type the task name in the New Task Name field.   

 
 

ο Click Save & Assign. 

 
 

The new task name appears in the Task for selected Group field. 
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7. To delete a group from the list in the Groups field, do the following: 

• Click the drop-down arrow   in the Groups field, and then select a group from the list.  For the 
next illustration, the group Bob's Group was selected. 

 

Note: A group cannot be deleted if there are other projects that have assigned tasks for that 
group. 

• Click Delete. 

 
A message appears asking you to confirm the deletion. Click OK. 

 
 

The group is removed from the list of in the Groups field.   

 



 

 
Environmental Screening Tool Handbook  3-232 

8. To delete tasks from the Existing Tasks list, do the following: 

• Click the drop-down arrow   in the Existing Tasks field, and then select a task from the list.  
For the next illustration, the task Document Review was selected. 

 

• Click Delete Task. 

 

Note: A task cannot be deleted if it is still assigned to another group or project. 

3.1.8.3 Average District Project Costs and Times (New 07/31/2009) 

The Average District Project Costs and Times function in the Environmental Screening Tool (EST) Tools 
menu enables ETDM Coordinators Primary and ETDM Coordinators to enter Florida Department of 
Transportation (FDOT) Average Project Costs for PD&E Studies for the District(s) to which they are assigned 
(e.g., an ETDM Coordinator for District 3 can only update District 3 information).   

The information can be edited by an FDOT Manager, ETDM Coordinator, and Environmental Management 
Office (EMO) Manager. 

Using the Record Average District Project Costs and Times Tool: 

1. On the Tools menu, point to Project Tracker, and then click Average District Project Costs and 
Times. 
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The Average District Project Costs and Times window opens as a tabbed page, displaying a 
search filter and a page toolbar. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

2. In the Districts field, click the drop-down arrow , and then select a District from the list. 

 

Note: Only the Districts to which you are assigned will appear in the Districts field. 

3. Click Search. 
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The Average District Project Costs and Times window refreshes and expands, displaying the 
FDOT Average Project Costs and Time for PD&E Studies form.   

 
 

4. In the Cost Category column, do one of the following: 

• To select another category, click the drop-down arrow  in one of the fields in the Cost 
Category column, and then select a category from the list. 
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• If a category is not already listed, you can add another category to the prepopulated list of 
categories by typing the name of the category in the Enter New Cost Category field, and then 
clicking Add. 

 
 

The new category now appears in the prepopulated Cost Category list. 

 
 

• To add another row to the Cost Category column, click Add Cost. 
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The EST displays another row of active fields for entering information. 

 
 

Tip!  To remove a row, click the Remove button beside the selected row.  

5. Once you have selected your Cost Categories, do the following: 

• In the Amount CE column, enter the amount for Categorical Exclusion (CE) for each 
corresponding Cost Category. 

• In the Amount EA column, enter the amount for Environmental Assessment (EA) for each 
corresponding Cost Category. 

• In the Amount EIS column, enter the amount for Environmental Impact Statement (EIS) for each 
corresponding Cost Category. 

• In the Amount SEIR column, enter the amount for State Environmental Impact Report (SEIR) for 
each corresponding Cost Category. 

 
 

Note: The EST automatically updates the Total Costs each time an amount changes in the 
Amount columns. 
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6. In the Number of Projects Analyzed fields, enter the number of projects analyzed for: 

• CE 

• EA 

• EIS 

• SEIR 

 

7. In the Average Months to Process Document, enter the number of months to process the document 
for: 

• CE 

• EA 

• EIS 

• SEIR 

 
 

8. Click Submit. 
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3.1.8.4 Track Projects (New 07/31/2009) 

The Track Projects function in the Environmental Screening Tool (EST) Tools menu enables authorized users 
to view the status details of selected projects.   

Florida Department of Transportation (FDOT) ETDM Coordinators, ETDM Coordinators Primary, ETDM 
Management, and Metropolitan Planning Organization (MPO) ETDM Coordinators Management Team have 
write-access privileges to edit or add information to projects within their organization's jurisdiction.  Project 
Managers have write-access privileges only for projects to which they are assigned. 

Environmental Management Office (EMO) Managers have read-only access privileges. 

All authorized users can retrieve the PDF version or spreadsheet file of the Track Projects report.  For a list of 
EST user roles and privileges, refer to Table 1-1 in Chapter 1.5 of the EST Handbook. 

Using the Track Projects Tool: 

1. On the Tools menu, point to Project Tracker, and then click Track Projects. 

 
The Track Projects window opens as a tabbed page, displaying a search filter and a page 
toolbar.  
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The search function in EST enables users to track one or more selected projects from the Project 
Navigation Bar or to search for projects using the search filter in the Track Projects window.  
The differences between the two search functions are as follows: 

• Searching for and selecting projects using the Project Navigation Bar enables users to narrow 
their search criteria (e.g., Class of Action [COA], AN Federal Consistency Reviews). 

• The search filter in the Track Projects window only enables users to perform a broader search 
(e.g., by district and organization).  

Tip! For additional information on using the Project Navigation Bar, see Chapter 2.3 of the EST 
Handbook. 

2. To select one or multiple projects from the Project Navigation Bar, do one of the following: 

• To track one project, click View default project from selection. 
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• To track all selected projects listed in the Project Navigation Bar, click View all projects from 
selection. 

 
 

3. To search for projects using the search filter in the Track Projects window, do the following: 

 

• In the Phase field, do one of the following: 

ο To view projects in all phases, accept the default –All-. 

ο To view projects in a specific phase, click the drop-down arrow , and then select a project 
phase. 

• In the Planning Organization field, click the drop-down arrow , and then select one or multiple 
planning organizations. 

• Click Search.  

Tip!  You can select multiple entries by using SHIFT + click for adjacent entries or CTRL + click 
for non-adjacent entries. 
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4. After entering your search criteria or making your project selection, the Track Projects window refreshes 
and expands, displaying an expanded page toolbar and the following sections: 

• Export to Excel Column Selection 

• ETDM Screened Project Benefits and Issues Worksheet 

• Summary of Project by Phase 

• Summary of Project by District 

• Summary of Project by Planning Organization 

• Summary of Project by Lead Agency 

• Summary of Projects by Class of Action 

• Summary of Projects by Purpose and Need 

• Summary of Projects by Federal Consistency Required 

• Charts 

• FDOT Average Project Costs and Time for PD&E Studies for FDOT Selected District 

• EDMS Integration 
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Tip!  Click the toolbar icon in the Track Projects window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Export the current page to Excel. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

5. Under Export to Excel Columns selection, you have the option to include or exclude data columns 
appearing on the Excel spreadsheet. 

Note: The boxes default to checked. You need to click the box to remove the checkmark. 

 

6. Click the Excel icon, , located on the page toolbar to export the project information to an Excel 
spreadsheet. 
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7. In the ETDM Screened Project Benefits and Issues Worksheet section, you can view project details 

by clicking  beside the project to expand the section.  

 

Tip!  Click  to collapse the section. 

The EST displays the detailed project information, which is divided into the following sections: 

• Project Details 

• Project Coordination 

• Summary Report 

• Previous Project Screening 

• Project Specific Comments or Issues 

• Project Specific Benefits and Cost or Time Saving 

• Project Specific Issues or Additional Costs 

• Project Specific Contracts 

Note: Authorized users with write-access privileges can edit all the sections except Previous 
Project Screening, which is a read-only section. 

8. To update the Project Details section, do the following:  

 
 

• To add, delete, or change project manager information, click the Project Manager(s) link. The 
Assign Project Manager window opens as a tabbed page. 

• To update the project description, click the Update Project Description link. The Update Project 
Description window opens as a tabbed page. 

• To view the project schedule details, click the Project Schedule Tool link. The Project Schedule 
Tool window opens as a tabbed page in a read-only format.  
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9. To update the Project Coordination section, do the following: 

 
 

• To assign a lead agency for the project, click the Lead Agency link. The Class of Action window 
opens as a tabbed page. 

• To assign or change agencies that are Cooperating Agencies for the project, click the 
Cooperating Agencies Assigned link. The Class of Action window opens as a tabbed page. 

• To modify a COA, click the COA Type link. The Add/Modify Class of Action window opens as a 
tabbed page. 

10. To update the Summary Report section, do the following: 

 
 

• To update the project's phase, click the link in the Current Phase field. The Update Project 
Phase window opens as a tabbed page. 

• To update the project's status, click the Current Status link. The Update Project Status window 
opens as a tabbed page. 

• To view the status of the initial summary report, click the Days left to complete Initial Summary 
Report link. The Summarize ETAT Review Screen window opens as a tabbed page. 

• To view the tasks that need to be undertaken in order to complete the summary report, click the 
Tasks to Complete Summary Report link. The Summarize ETAT Review Screen window 
opens as a tabbed page. 

For the Project Specific subsections, users with write-access privileges can add or edit 
information for projects within their jurisdiction.  
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11. Click Edit to add or edit information pertaining to the selected project. 

Note: The Edit button will be inactive if you are viewing projects outside of your jurisdiction or if 
you have read-only privileges. 

 
 

The following sections expand, displaying active fields for adding or editing information: 

• Project Specific Comments or Issues 

• Project Specific Benefits and Cost or Time Saving 

• Project Specific Issues or Additional Costs 

• Project Specific Contracts 

Tip!  You can save your information at any point during the editing process by clicking the Save 
button located at the bottom of the ETDM Screened Project Benefits and Issues Worksheet. 

12. Under Project Specific Comments or Issues, do the following: 

 
 

• In the Special Issues to Track text field, type any special issues that should be tracked for the 
selected project. 

• In the Additional Detail Specific Agencies field, type any additional details.  

• In the Status/Comments field, indicate the status of the issue or comment. 

• To display another field for typing additional comments, click Add.   
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Tip! Click Add each time you want to display a Comment field.  Click Delete to remove a 
Comment field. 

 
 

Note: Only the user who is typing the comments or an FDOT ETDM Coordinator can delete 
Comment fields. 

13. To update the Project Specific Benefits and Cost or Time Saving section, do the following:  

 

• In the Estimated Cost Saving ($) field, type the dollar amount. 

• In the Estimated Time Saving (months) field, type the number of months. 

• In the Specific Example of Benefits field, click the check box beside the applicable statement. 

• In the Enter New Example of Benefit field located at the bottom of the section, add a benefit 
example that is not already listed, and then click Add. The EST adds the benefit example to the 
list. 
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14. To update the Project Specific Issues or Additional Costs section, do the following: 

 

• In the Estimated Cost Increases ($) field, type the amount of the estimated cost increase. 

• In the Estimated Time Increases (months) field, type the number of months. 

• In the Specific Examples of Issues field, click the check box(es) next to the applicable 
statement(s). 

• In the Enter New Example of Issue field located at the bottom of the section, add an issue 
example that is not already listed, and then click Add. The EST adds the issue example to the list. 

 
 

15. To make additions or changes to the Project Specific Contracts section, do the following: 

• To remove a contract number, click a contract number in the Contract Number(s) field, and then 
click Remove. 

 
 

• To add a contract number, type the contract number in the Add field, and then click Add.  

 
 

The added contract number appears in the Contract Number(s) field. 
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16. Click the Save button located at the bottom of the ETDM Screened Project Benefits and Issues 
Worksheet to save your information. 

 
 

17. The following sections are read-only tables showing the total number of projects per category. Scroll 
down the Track Projects window to view the Summary of Projects categories and Charts. 

• The Summary of Project by Phase section displays the total number of projects within the 
planning organization's jurisdiction, and the number of projects in each phase (Planning, 
Programming, and Project Development). 

 

• The Summary of Projects by District section displays the statewide total number of projects and 
total number of projects within each District’s geographic area. 

 

• The Summary of Projects by Planning Organization section displays the planning 
organization's total number of projects. 

 

• The Summary of Project by Lead Agency displays the total number of projects by Lead Agency 
and the number of projects that have not been assigned to a lead agency yet.  
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• The Summary of Projects by Class of Action shows the total number of projects for each COA 
and total number of projects without a determined COA. 

 

• The Summary of Projects by Purpose and Need section displays the total number of projects 
and the number of projects for each Purpose and Need status. 

 
 

• The Summary of Projects by Federal Consistency Required section displays the total number 
of projects and Federal Consistency Required status.  

 

• The Charts section displays graphics representing the data from the Summary of Projects tables. 

 
 

Tip!  You can also view the charts in Excel by clicking the Summaries and Charts tab located 
at the bottom of the Track Projects - Excel window, as shown in the next illustration. 

• The FDOT Average Project Costs and Time for PD&E Studies for FDOT Selected District 
section displays the project costs associated with the applicable type of PD&E Study.   
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Note: This section displays only when one FDOT District has been selected in the search 
criteria.  

 

• The EDMS Integration section lists the Electronic Document Management System (EDMS) 
reports that match the selected criteria. 

Note:  This section only displays for the following authorized user privileges:  EMO Manager, 
FDOT ETDM Coordinator Primary, and FDOT Coordinator.  Users with these roles can send 
reports to EDMS by clicking the Send Report to EDMS button. 

 
 

3.1.9 Document Review (Updated 11/30/2011) 

3.1.9.1 Set Up Document Review (Updated 11/30/2011) 

The Set Up Document Review function in the Environmental Screening Tool (EST) Tools menu enables 
Florida Department of Transportation (FDOT) administrators to set up and manage FDOT document reviews.  

Administrators use the Set Up Document Review form to upload or select documents, add or modify 
document attributes, and manage document reviews. The Administrator also uses this form to: 

• Set up a review period.  

• Identify Commenters, Staff, and Responders for each document.  

• Send email notifications to document review participants, notifying them that a review has started. 

• Modify existing document review events. 

Note:  The document file and its attributes may be changed before the review begins. However, after the 
review begins, only information pertaining to the review duration, the email notification form, and the lists of 
Recipients and Responders can be changed.  
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Setting Up a Document Review: 

1. On the Tools menu, point to Document Review, and then click Set Up Document Review. 

 
 

The Set Up Document Review Event window opens as a tabbed page, displaying a search 
filter, and a page toolbar.   

 
2. Do one of the following: 

• Set up a new document review event. (See Section 3.1.9.1.1 for navigation details.) 

• Modify an existing document review event. (See Section 3.1.9.1.2 for navigation details.) 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to the Navigation 
chapter of the EST Handbook. 
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3.1.9.1.1 Creating a New Document Review Event   

1. Click Create New Event. 

 
The Set Up Document Review Event window refreshes and displays the Event Details form. A 
review event may contain one or multiple documents. This form enables you to give the complete 
review event a name and description along with establishing the review type (Internal or Partner) 
and review duration. 

 
 

2. Under Event Details, complete the following fields: 

Note: Fields containing a double asterisk (**) indicate it is a required field.  The EST will not 
process the form if these fields are left blank. 

• Event Name – Type the name of the review event (e.g., Review of Draft Environmental Impact 
Statement for Project #0123456). 

• Event Description – Describe what the review is about (you can type up to 4000 characters). 

• Event Type – Click one of the following options: 

ο Internal – if the document is being reviewed only by FDOT members  

ο Partner – if the document is being reviewed by partner agencies 

• Review Duration – Type the number of days Official Commenters and Staff have to complete the 
review. 
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• Event Category – Click the Select an Event Category arrow, and then click the appropriate 
selection: 

3. Click Next. 

 
A message appears stating the Event has been saved. 

 

4. Click OK. 

The Describe Document Review Event form displays the Document Details section. This 
section enables you to attach one or more documents associated with the review. 

 
 

5. Under Document Details, complete the following fields: 

• Document File – Type the document path, or click the Browse button to navigate to the 
document's location. 

Note:  Documents must be converted to PDF before being uploaded. The EST will not 
save a document that is not in PDF format. 

• Document Name – Type the name of the document. 
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• Document Description – Type a description of the document (you can type up to 4000 
characters). 

• Document Category – Click the Select a Document Category arrow, and then click the 
appropriate option. 

• Line Numbers Available – Click one of the following option buttons: 

ο Yes – to indicate the document contains line numbering 

ο No – to indicate the document does not contain line numbering 

6. Click Save. 

Tip!  Click Clear Form to reset the form. 

7. A message appears stating the Event Document has been saved. Click OK. 

 
The Set Up Document Review Event window expands, displaying a table listing the: 

• Document (PDF) – document name 

• Size – document size in megabytes (MB) 

• Description – document description 
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Tip!  Click the pencil icon, , to make changes to the Document Description or to replace the 
current document with a revised version. Click the delete icon, , to remove the document 
and document description from the document review event. 

8. Do one of the following: 

• Repeat Steps 7 through 9 to add another document to the document review event. 

• Click Next if no additional documents will be added. 

 
After clicking the Next button, the Set Up Document Review Event window displays the 
Approval section, where you indicate whether the document requires a signature of approval.  

9. In the Needs Approval field, do one of the following: 

• Click the Yes option button if the document requires a signature of approval. Go to the next step. 

• Click the No option button if the document does not need approval. Go to Step 16. 

Note:  Double asterisks (**) indicate an action is required. You must select an option. 

 
10. If you clicked the Yes option button, the Set Up Document Review Event window displays the 

Approval section. 

 

11. Click the plus sign icon, , beside a subsection to expand it. For this illustration, the Document 
Review: Internal Commenters subsection is shown.  
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12. In the Potential list, click the name(s) of the person(s) authorized to approve the document. 

Tip!  You can select multiple entries by using the SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries.  

 

13. Click the right-arrow button, , or double-click the name to move the selected name(s) to the 
Selected box.  

 

 

Tip!  To move all the names from the Potential box to the Selected box, click .  To remove 
one  

or multiple names from the Selected list, click .  To remove all the names from the Selected 

box, click .   You can also double-click a name(s) to move it between boxes. 

 
14. Click Next. 
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15. A message appears stating that the Event has been saved. Click OK. 

 
The Set Up Document Review Event window displays a sequence of Document Review 
screens that enable you to assign: 

• Commenters (Internal and Partner)  

• Staff 

• Responders 

 
Note:  Double asterisks (**) indicate an action is required. You must select Commenters for the 
document review event. 

16. Assign Commenters, Staff, and Responders by following the selection sequence demonstrated in 
Steps 13 through 17 . 

After you have assigned Commenters, Staff, and Responders to the document review event, the 
Set Up Document Review Event window displays the Prepare Notification screen. This screen 
lets you select a template with text tailored to address the required action from the recipients (i.e., 
approval, comment, respond). 
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17. In the Prepare Notification screen, do the following: 

• In the Notification E-mail Templates field, click the drop-down arrow, , and then select the 
appropriate email template. For the following examples, the email template for Approval is shown. 

• Click Load. 

 
The EST displays the text for the selected template in the E-mail Notification Subject and 
E-mail Notification Body (Top and Bottom) boxes.  

• Type any information related to the referenced document in the brackets displayed in the following 
E-mail Notification boxes (see next illustration for example): 

ο Subject  

ο Body (Top) 

ο Body (Bottom) 

 

Note:  E-mail Notification boxes marked with an, , are required fields.  You must enter 
information related to the referenced document in any areas with brackets (e.g., [CHAPTER 
NAME]). The EST will not process the email notification if document-specific information is 
missing. 

• In the E-mail Notification CC field, select any individuals you want to copy (CC) for this document 
review event. (Follow the selection sequence demonstrated in Steps 13 through 17 of this 
document.) 
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18. After you have completed the Prepare Notification fields, click Next. 

 
19. A message appears stating that the Event has been saved. Click OK. 

 

20. Click Send Notification. 

 
21. A confirmation message appears asking Are you sure you want to send the notification? Click OK 

to send the document review notification, or click Cancel to cancel the operation. 

 
22. A second confirmation message appears stating that the Notification has been sent. Click OK. 
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3.1.9.1.2 Modifying a Document Review Event 

1. To search for an existing event, complete any of the following fields in the Search for a Document 
Review Event section: 

Note: The Search for a Document Review Event fields are not required fields, so you have the 
option to enter as much information as you want into the search filter or you can leave all of the 
fields blank.  However, leaving all of the fields blank when you submit your query will result in the 
EST displaying all documents listed in the database. 

• Event Start Date Range - Type the date range or use the calendar icon, ,to select the date 
range of the review event. 

• Organization – Click the Select Managing Organization arrow, and then select the organization. 

• Keyword(s) – Type words associated with the document. 

2. Click Search. 

 
The Search for a Document Review Event window displays a Search Results section 
that lists the document review events matching your search criteria. 

 
3. Click the document review event link to open it.  
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The EST displays the Event Details section. After a document review event has started, only the 
following fields can be modified:  

• Review Duration 

• E-mail notification form 

• Lists of Recipients and Responders 

Note: Follow the selection sequence detailed in Steps 19 through 21 for setting up notifications. 

4. Click Forward Notification. 

 
 

3.1.9.2 Review Document (Updated 11/30/2011) 

The Review Document function in the Environmental Screening Tool (EST) Tools menu enables Florida 
Department of Transportation (FDOT) officials, staff, and partners to review documents and add comments. 

Comments are entered by Commenters and Staff during the review period. Commenters enter the official 
comments from an FDOT office. Staff comments are used only for reference or as a basis for comments by 
Commenters within the same office.  

Note: Comments are not accepted before or after the review period.  

Reviewing and Commenting on Documents: 

1. On the Tools menu, point to Document Review, and then click Review Document. 

 
 

The Review Document window opens as a tabbed page, displaying a page toolbar and a 
search filter.   
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. To search for a document review event, complete any of the following fields in the Search for a 
Document Review Event section: 

Note: The Search for a Document Review Event fields are not required fields, so you have the 
option to enter as much information as you want into the search filter or you can leave all of the 
fields blank.  However, leaving all of the fields blank when you submit your query will result in the 
EST displaying all documents listed in the database. 

• Event Start Date Range – Type the date range or use the calendar icon, , to select the date 
range of the review event. 

• Organization – Click the Select Managing Organization arrow, and then select the organization. 

• Keyword(s) – Type words associated with the document. 

3. Click Search. 
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The Review Document window displays a Search Results section that lists the document 
review events matching your search criteria. 

 
 

4. Click the document review event link to open it.  

 
The Review Document window refreshes, displaying the details for the selected Document 
Review Event in the following sections: 

• Event – displays the name and event description along with the event’s Start Date and End Date 

• Document (PDF) – shows the list of documents to be reviewed for the selected event along with 
the size of each document (in megabytes [MB]) and a description of the document 
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The remainder of the Review Document screen displays an Enter Document Review section, 
consisting of a form for entering comments. 

 
  

5. In the Document (PDF) column, click the document link to open it. 

 
The document PDF opens as a separate window, enabling you to review its contents. 

 
6. After you have finished reviewing the document, scroll to the Enter Document Review section and do 

the following: 

• In the Document field, click the Choose a document to review arrow, and then select the 
document you have just reviewed. 

 
 

• In the Location fields, identify the areas of the document you are commenting on by typing the 
following locations: 

ο Section(s) 

ο Page(s) 

ο Paragraph(s) 

Tip!  Click the Global check box if the comment or edit applies to the entire document. 

• In the Location Comments text box, type your comments or edits. 
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• Click Save. 

 

• A message appears stating that the review has been saved. Click OK. 

 
 

The Review Document window refreshes, displaying your comment(s) for the document in the 
Reviews for Name of Document section. The next illustration shows comments entered by an 
Official Reviewer. 

Note: All reviews from Commenters on the selected document are shown on the page for 
reference. During the review period, a user's own comments can be selected for editing or 
deletion. Staff comments can be copied in to a new official comment by Commenters from the 
same office. 

 
 

Tip!  Click the pencil icon, , to edit your comments. Click the delete icon, , to delete your 
comments. 

• Repeat the process for each comment pertaining to the selected document.  
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7. If there are multiple documents associated with a document review event, repeat Steps 5 and 6 of 
these instructions.  

At the end of the document review event, each document associated with the event will have 
comments from the following reviewers: 

• Official (required) 

• Staff (if applicable) 

The next illustration shows an example of a document review event containing multiple 
documents that have been reviewed by agency Officials and Staff. 

 
 

3.1.9.3 Respond to Document Reviews (Updated 11/30/2011) 

The Respond to Document Reviews function in the Environmental Screening Tool (EST) Tools menu 
enables authorized individuals (Responders) to respond to comments made by agency officials (Commenters) 
during a document review event. 

After the document review period ends, the FDOT document administrator sends an email notification to the 
assigned Responders alerting them that the response to document comments period has begun. Responders 
can then access the Respond to Document Reviews tool to complete this task. 

Responding to Document Reviews: 

1. On the Tools menu, point to Document Review, and then click Respond to Document Reviews. 
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The Respond to Document Reviews window opens as a tabbed page, displaying a page 
toolbar, search filter, and a Document Review Event response form.   

 
 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to the Navigation 
chapter of the EST Handbook. 

2. To search for a document review event, complete any of the following fields in the Search for a 
Document Review Event section: 

Note: The Search for a Document Review Event fields are not required fields, so you have the 
option to enter as much information as you want into the search filter or you can leave all of the 
fields blank.  However, leaving all of the fields blank when you submit your query will result in the 
EST displaying all documents listed in the database. 

• Event Start Date Range – Type the date range or use the calendar icon, , to select the date 
range of the review event. 
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• Organization – Click the Select Managing Organization arrow, and then select the organization. 

• Keyword(s) – Type words associated with the document. 

3. Click Search. 

 
 

The Respond to Document Reviews window displays a Search Results section that lists 
the document review events matching your search criteria. 

 
 

4. Click the document review event link to open it.  

 
 

The Respond to Document Events window refreshes, displaying the details for the 
selected Document Review Event in the following sections: 
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• Event – displays the name and description of the selected event along with the event’s Start Date 
and End Date 

• Document (PDF) – shows the list of documents to be reviewed for the selected event along with 
the size of each document (in megabytes [MB]) and a description of the document 

• Official Reviews – displays the review comments for each document associated with the 
document review event 

 
The remainder of the Respond to Document Reviews screen displays an Enter 
Response to Document Review section, consisting of a text box for entering your 
response. 

 
  

5. In the Document (PDF) column, click a document link to open it. 

 
The document PDF opens as a separate window. 



 

 
Environmental Screening Tool Handbook  3-270 

 

6. Scroll to the Official Reviews for Name of Document section and do the following: 

• In the Select column, click the check box(es) for the reviews you are responding to. For example, if 
you are entering the same response for multiple comments, click the check boxes for the 
comments you are responding to. 

 
 

Tip!  Click the column heading to sort the list in ascending or descending order. 

• In the Response text box, type your responses to the comments selected in the Official Reviews 
for Name of Document list.  

Note: The Response text box is a required field. The EST will not process your responses 
if the Response text box is left blank. 

 
 

• Click Save. 

A message appears stating that Your responses were successfully saved. Click OK. 

 
 

• Click Clear Form to clear the form for the next response entry. 

• Repeat the response process listed in this step for comments listed in the Official Reviews for 
Name of Document section(s), as needed. 
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7. After you have entered and saved your responses, refresh the Respond to Document Reviews page. 

Tip!  You can refresh a webpage by clicking CTRL+R.  Alternately, you can click the right 
mouse button on the webpage, and then click Refresh. 

The Respond to Document Reviews page displays your responses beside the corresponding 
comments.   

 
 

Tip!  Click the pencil icon, , to edit your comments. Click the delete icon, , to delete 
your comments. 
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Chapter 3 Functions 

3.2 Reports (Updated 11/30/2011) 

The Reports menu is located in the Environmental Screening Tool (EST) main menu and includes standard 
reports and queries grouped in categories, such as Project Diary and Project Effects.     

 

3.2.1  Project Diary (Updated 11/30/2011) 
Reports listed under Project Diary enable users to view project records and ancillary data that were entered 
into forms listed under the Update Project Diary section of the Tools menu. To access these reports, point to 
the Project Diary heading in the Reports menu, and then click the name of the report. 
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3.2.1.1  Project Milestone Report (New 03/21/2008) 
The Project Milestone Report provides a timeline of significant milestone events for a project. To access the 
Project Milestone Report, select a project using the Project Navigation Bar, then go to Reports, point to 
Project Diary, and then click Project Milestone Report. 

 
 

The Project ETDM Number Snapshot Timeline section of the Project Milestone Report page displays the 
snapshot timeline for the selected project.  For the example project shown, there are five milestones indicated 
on the timeline, indicated by numbers 1 through 9.  The Snapshot Timeline section is followed by Snapshot 
Details for each milestone event.  Click on one of the numbers on the timeline to jump to the Snapshot Details 
for that milestone event. 
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The Snapshot Details section includes information about the milestone event, including the description (for 
example, “Programming Screen ETAT Review Started”), date, the name of the person who generated the 
milestone event, comments, alternatives included, and a list of reports associated with the event.   

   

To view a report, click the report link.  To return to the Snapshot Timeline section, click the link.   

For the example shown below, the “Project Description Report” link was clicked. 
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3.2.1.2  Project Description (Updated 04/16/2008) 
The Project Description report gives a detailed overview of a project, from the summary description and 
Purpose and Need Statement to the segment level details.  If the Federal Consistency Determination has been 
provided by the State Clearinghouse, it is included in this report. 

To access the Project Description report, select a project using the Project Navigation Bar, expand the 
Reports menu, point to Project Diary, and then click Project Description. 

 
 

The Project Description page opens 
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The Project Details section comprises the Purpose and Need statement, public comments, information about 
the Federal Consistency findings, the name of the lead agency, and other related documents. In the following 
illustration, these sections are collapsed; to see the details for any section, click the plus sign, , beside the 
section heading.   

 
The Project Documents section provides the date, type, file size, name, and a description for each document.  
The list also includes a link to each document.  To view a document, click the link in the Document column.  
The document will load in a separate tabbed window. 
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The Alternative Number section(s) displays a description and details for each segment.  

 
 

Tip!  You can view the alternative on a map by clicking the View Alternative on Map link located on the 
Alternative Number header. The EST opens the Map Viewer and displays the image.  To return to the Project 
Description screen, click the Click to Close Map bar. 

 

  



 

 Environmental Screening Tool Handbook  3-278 

The last section of the Project Description page displays an Eliminated Alternatives section, which provides 
information about project Alternatives that have been considered but subsequently eliminated from further 
consideration.  If an alternative has been eliminated from the project, a detailed description of the alternative is 
no longer available; however, if you click the  link located on the Eliminated Alternatives section 
header, it will open a PDF of an Eliminated Alternatives Report that describes each alternative in detail. 

 

3.2.1.3  Status of GIS Analysis 
This report lists all projects waiting for analysis and indicates if the analysis will run "real-time" (during the day) or 
"batch" (at night). After the program is finished, the project is removed from the list. 

To access the Status of GIS Analysis report for a project,  select a project using the Project Navigation Bar, 
and then in the Reports menu, point to Project Diary, and then click Status of GIS Analysis. 
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The Status of GIS Analysis window opens as a tabbed page. 

 

3.2.1.4  Transportation Plan Summary Report 
The Transportation Plan Summary Report displays the system plan summary information recorded for the 
selected county, plan year and planning organization.  To view the Transportation Plan Summary Report for the 
county where a project is located, first select a project using the Project Navigation Bar.  Then click on the 
Reports button on the main menu.  Select “Transportation Plan Summary Report” under the Project Diary pull-
down menu.  The report will display information for the county where the project is located.  To view 
Transportation Plan Summary information for other counties, plan years or planning organizations, make 
selections from the pull-down menus. 
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3.2.1.5  View Additional Project Documents (New 11/30/2011) 
The View Additional Project Documents function in the Environmental Screening Tool (EST) Reports menu 
enables authorized users to view documents associated with a project. 

Viewing Additional Project Documents: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Reports menu, point to Project Diary, and then click Supplemental Project Documents. 

 
 

The View Additional Project Documents window opens as a tabbed page, displaying a page 
toolbar and a list of documents associated with the selected project.  The Project Documents 
table shows document information under the following column headings: 

• Date – The date the document was submitted to the EST database 

• Type – Displays the document category 

• Size –  Amount of memory the document uses 

• Document – The document's title, which is displayed as an active link 

• Description – Brief description of the document  
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Tip!   Click the toolbar icon on the window to: 

 Print a copy of the report. 

  Export the report to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. To view a document, click the document title link in the Document column.  

 
 

The document PDF opens as a separate tabbed window, enabling you to view, print, or save the 
document. 

3.2.1.6  Project Managers (New 11/30/2011) 
The Project Managers function in the Environmental Screening Tool (EST) Reports menu enables you to view 
the assigned project manager(s) for a project.    

Project manager names are entered into the database through the EST Assign Project Managers function in 
the EST Tools menu by the following EST users: District ETDM Coordinators, District ETDM Coordinators – 
Primary, ETDM Coordinators Management Team, Environmental Management Office managers and liaisons, 
Metropolitan Planning Organization (MPO) Coordinators, MPO Coordinators – Primary, Florida Intrastate 
Highway System Central Office, and Project Managers. 

Viewing the Project Managers Report: 
1. Select a project from the Project Navigation Bar. 
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Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. Go to the Reports menu, point to Project Diary, and then click Project Managers. 

 
The Project Managers page opens, displaying the project manager name(s) and contact 
information.  

 

Tip!   Click the toolbar icon on the window to: 

 Print a copy of the page. 

  Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to the Navigation 
chapter of the EST Handbook. 
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3.2.1.7  Project Schedule Report (New 7/31/2009) 
The Project Schedule Report function in the Environmental Screening Tool (EST) Reports menu enables 
Central Environmental Management Office managers and staff to view Project Development & Environment 
(PD&E) milestones. 

Viewing a Project Schedule Report: 
1. To view a project schedule, you must first select a project that has been assigned a COA. You can use 

the default project that appears in the Active project field in the Project Navigation Bar or you can 
select another project using the Project Selection Wizard. 

Tip! To view projects with all or specific COAs, click the Advanced Project Search link in the 
Project Navigation Bar.  In the ETDM Filter field, select Class of Action, and then select a 
variable from the Class of Action Type field.   

 

Note:  See the Navigation Chapter of the EST Handbook for information on using the Project 
Navigation Bar. 

2. On the Reports menu, point to Project Diary, and then click Project Schedule. 
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The Project Schedule Report window opens as a tabbed page and displays a project header, 
page toolbar, and project schedule information.   

The project's COA appears in the section header, as shown in the next illustraton. (For this 
illustration, the COA is Environmental Assessment.) 

 
 

Tip!  Click the toolbar icon in the Project Schedule Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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The Class of Action: Type section displays the following project schedule information:  

• Project Schedule Milestones  

• Actual Date 

• Change History 

• Related Document 

Note:  EST displays project information based on the Class of Action for the selected project.  
Therefore, the project events listed in the Project Schedule Milestones column of the Project 
Schedule Report window vary. 

 
 

3. To view documents for a project event listed in the Project Schedule Milestones column, click the 
corresponding View Related Document button in the Related Document column. 

 
 

The window for the selected project document opens as a tabbed page. 
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4. To view schedule information for all projects from a search selection, click Show the project schedule 
for all projects in the Current Selection. 

 
The Project Schedule Report window refreshes, displaying all the projects within the search 
selection (in this case, projects identified based on Class of Action category). 

 
 

Tip!  You can switch between the current window and immediately preceding window by 
pressing  the ALT + LEFT ARROW or ALT+ RIGHT ARROW keys. 

EST displays each project's header and Class of Action: Type section, which contains the 
Project Milestones, Actual Date, Change History, and Related Documents columns. 
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5. To return to the project originally displayed, click the Show only the default project schedule button 
located at the bottom of the Project Schedule Report window. 

 
 

The Project Schedule Report window refreshes, displaying the selected project. 

3.2.1.8  Dispute Resolution Activity Log (New 7/31/2009) 
The Dispute Resolution Activity Log function in the Environmental Screening Tool (EST) Reports menu 
enables Central Environmental Management Office (CEMO) managers and users with EST administrative 
privileges to view the list of resolved disputes for designated projects.  

Viewing the Dispute Resolution Activity Log: 
1. On the Reports menu, point to Project Diary, and then click Dispute Resolution Activity Log. 

 
The Dispute Resolution Activity Log window opens, displaying the project header, including 
the Phase, Project Milestone Dates, and a Dispute Resolution Activity Log that displays the 
Dispute Resolution: 

• Action Date 

• Issue 

• Attachment(s) 

• Action 
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Tip!  Click the toolbar icon on the Dispute Resolution Log window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. To view the attachment(s), click the link(s) in the Attachment column. The Dispute Attachment 
window opens as a tabbed page, displaying a PDF of the selected attached document. 

3. To view the Dispute Resolution Activity Log by milestone date, click the date links in the Project 
Milestone Dates row.  

 
The Dispute Resolution Activity Log window refreshes and displays the current project's 
Dispute Resolution Activity for the selected Project Milestone Date. 

3.2.1.9  Permits (New 11/30/2011) 
The Permits function in the EST Reports menu enables authorized users to review a list of permits identified 
for a project.   

Viewing the Permits Report: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
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Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Reports menu, point to Project Diary, and then click Permits. 

 
 

The Permits window opens, displaying a list of permits identified for the selected project. 

 

Tip!   Click the toolbar icon on the window to: 

 Print a copy of the page. 

  Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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The Required Permits section of the report includes a description of the permits that have been 
identified for the project, the permit type, and any specific permit conditions that may apply.   

 

3.2.1.10  Technical Studies 
This report lists the technical studies assigned to a project after the Programming Screen.  To access the 
Technical Studies report for a project, select a project using the Project Navigation Bar, then go to the 
Reports menu, point to Project Diary, and then click Technical Studies.   

 
 

The Technical Studies page opens and displays the list of technical studies assigned to the selected 
project. 
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3.2.1.11  Community-Desired Features 
The Community-Desired Features report lists features (such as sidewalks or bicycle facilities) that are desired 
by the affected community and have been identified through Metropolitan Planning Organization and FDOT 
public involvement activities.  To access the Community-Desired Features report for a project, select a project 
using the Project Navigation Bar, then go to Reports, point to Project Diary, and then click Community-
Desired Features.  

 
 

The Community-Desired Features report page opens, displaying a Desired Project Features section that 
shows any features desired by the featured community. 

3.2.1.12  Project Commitments/Responses 
The Project Commitments/Responses report provides an overview of ETAT review comments by project, 
with a link to the comments provided by the ETDM Coordinator in response to the ETAT review.  To access the 
Project Commitments/Responses report for a project, select a project using the Project Navigation Bar, 
then go to the Reports menu, point to Project Diary, and then click Project Commitments/Responses.   
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The Project Commitments/Responses page opens, displaying a General Project Commitments and 
Responses to Specific ETAT Review Comments sections. 

 

3.2.2  Advance Notification Package (New 11/30/2011) 

3.2.2.1  Advance Notification Package (New 11/30/2011) 
The Advance Notification Package function in the Environmental Screening Tool (EST) Reports menu 
enables authorized users to view, save, and print published Advance Notification (AN) Packages. 

Opening an AN Package:  
1. To use the AN Package function, you must first select a project from the Project Navigation Bar.   

 

Tip!  Use the Search site for… tool to quickly locate information in the EST. 

2. In the Reports menu, point to Advance Notification Package, and then click Advance Notification 
Package. 
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The Advance Notification Package window opens, displaying a page toolbar and a Published 
AN Packages section showing PDF links to the AN Package (Full and Lite) for the selected 
project. 

 

Tip!  Click the toolbar icon in the window to: 

 Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The Published AN Packages section displays a table divided into the following columns: 

• Published On – Displays the date the AN Package was published 

• Full AN Link – Displays a link to the complete AN Package that was sent electronically to 
recipients who are listed in the transmittal list as Notification Type: Electronic  

• Lite AN Link – Displays a link to the abridged version of the AN Package that was mailed to 
recipients who are listed in the transmittal list as Notification Type: Hardcopy 

3. Click the PDF icon, , in the Full AN Link column to view the complete AN Package or click the PDF 

icon, , in the Lite AN Link column to view the abridged version of the AN Package. 
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The PDF of the selected AN Package (Full or Lite) opens in a separate window, enabling you to 
view, save, or print a copy. 

 

3.2.2.2  Comments on Advance Notification Package (New 11/30/2011) 
The Comments on Advance Notification Package function in the Environmental Screening Tool (EST) 
Reports menu enables authorized users to view comments from ETAT reviewers and Commenting Interested 
Parties regarding a project’s AN Package, along with a general overview of agency comments pertaining to the 
project’s effects on area resources.  

Commenting Interested Parties assigned to review the AN Package are usually regional planning council and 
local government personnel who are authorized by a State Clearinghouse Coordinator (Federal Consistency – 
Commenting Interested Parties) or District ETDM Coordinators and Project Managers (Advance Notification –
Commenting Interested Parties) to access the secure EST.  The tasks of Commenting Interested Parties are as 
follows: 

• Federal Consistency – Commenting Interested Parties provide advisory comments, based upon such 
issues as consistency with the strategic regional policy plan or the local government comprehensive plan, or 
conflict with other known area activities. 

• Advance Notification – Commenting Interested Parties review ETAT comments and submit additional 
comments, if warranted, on a project’s effects. 

Viewing the Comments on AN Package Report: 
1. Select a project from the Project Navigation Bar. 

 
 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 
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2. On the Reports menu, point to Advance Notification, and then click Comments on Advance 
Notification Package. 

 
 

The Comments on Advance Notification Package page opens, displaying sections containing 
a link to the Published Advance Notification Package, the project's purpose and need information, 
District ETDM Coordinators and ETAT review information, and comments on the AN Package.  

 

Tip!   Click the toolbar icon on the window to: 

 Print a copy of page. 

  Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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Note:  For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 
of the EST Handbook. 

3. Under Published Advance Notification Package, click the PDF icon to open the AN Package. 

 
The Advance Notification Package window opens as a tabbed page. 

4. Under Table of Contents, click any of the following links: 

 

• Click the Comments on Advance Notification Package and Federal Consistency link to view 
comments from Commenting Interested Parties regarding the AN Package and ETAT reviews. 
The EST automatically scrolls to this section of the page. 

• Click the Purpose & Need link to view comments regarding the project’s Purpose and Need 
Statement.  

• Click the ETAT Review Overview to view ETAT comments concerning any effects the project 
may have on area resources.  

5. Under Purpose & Need, do the following: 

• Click the Project Description – Purpose and Need Statement link to open the Project 
Description page where you can view the Purpose and Need Statement. 

• The Purpose & Need Comments section displays the agency name, whether the agency has 
acknowledged the information presented in the Purpose and Need Statement is accurate and clear 
(i.e., Acknowledgement Understood if the agency found the information in the Purpose and 
Need Statement accurate and clearly defined, or Acknowledgement Not Understood if the 
agency found the Purpose and Need Statement is incomplete or if the information is not clear), the 
date the agency reviewed the Purpose and Need Statement, and the agency’s comments, if any. 
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6. The ETAT Review Overview section is divided by project alternative, showing general ETAT overview 
and comments related to each resource issue for each alternative. 

Tip!  Click the plus sign, , to expand the section. Click the minus sign,  , to collapse the 
section. 

 
 

Note: The EST displays a statement if assigned organizations did not review a specific issue. 

 
 

3.2.2.3  Transmittal List (In Development) 

3.2.3  Project Effects (Updated 
11/30/2011) 

Reports under Project Effects enable users to 
view read-only screens that display project data 
and agency reviews regarding the effects a project 
or a project alternative will have on surrounding 
resources.  
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3.2.3.1  Countywide GIS Summary Report 
The Countywide GIS Summary Report summarizes the results of the GIS analyses for the projects within the 
selected county. This report is useful for assessing cumulative effects.  To view the Countywide GIS Summary 
Report, go to the Reports menu, point to Project Effects, and then click Countywide GIS Summary.   

 
 

When the report opens, select a county from the County list.  Use the scroll bars to view the GIS analyses 
results for specific projects.   
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3.2.3.2  GIS Analysis Report (Updated 03/12/2012) 
The GIS Analysis Report function enables you to view analysis results for Alternatives, study areas within an 
Alternative, and individual features (the components of an Alternative such as bus stops, rail stations, road 
segments, or other physical structures and land areas associated with an Alternative).   

Users can select issues, analysis types, and buffer distances and apply them to an active project. Users have 
the option to select analysis results for an entire Alternative—or for a study area within an Alternative—and for 
individual features of an Alternative.  

Using the GIS Analysis Report Function: 
1. Select a project from the Project Navigation Bar.  

2. Go to the Reports menu, point to Project Effects, and then click GIS Analysis Results. 

 
The GIS Analysis Report page opens, displaying a form that enables you to create a new report 
or use an existing GIS analysis report. The form also allows you to make the following selections 
to include in the report: 

•  Analysis results for entire Alternatives 

•  Analysis results for Alternative Corridor Evaluation (ACE) study areas, if applicable 

•  Analysis results for individual Features  

•  Analysis types for resource issues 
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Tip!   Click on the toolbar icons to: 

  Open the tip sheet for a quick guide on navigating the current page. 

 Open the training video for instructions on using the current page. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

Note: If the project is in the Programming Screen and has one or more milestone dates, you can 
select a Project Milestone Date by clicking the date link under the project header to view an 
analysis snapshot for the date or you can accept the default Current Project.   
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3. The GIS Analysis Report function in the EST enables you to: 

• Create a new GIS report. 

• Use a previously saved report from your My GIS Reports list. (See Step 4 for additional 
information on using previously saved GIS reports). 

Note: The Use one of My GIS Reports field will not appear on your screen if you have not 
previously saved GIS reports. (See Step10 of these instructions for information on saving a GIS 
report). 

4. If you have previously saved GIS reports, the Use one of My GIS Reports field will appear on your GIS 
Analysis Report screen, which enables you to use or modify a previously saved report’s analysis 
selections.  You can then run the report to view the analysis results as they apply to the active project.  
To select a GIS report from your saved My GIS Reports list, click the My GIS Reports arrow and then 
select the report you want to use. 

 
After selecting a report, the Edit and Run Report buttons appear, allowing you to do either of the 
following: 

• Click Edit to display the report’s analysis selections. You can do any of the following: 

ο Leave the previously saved analysis selections in place for viewing in the report. 

ο Modify the selections, and then view the report without saving the modified version (i.e., Do 
not click the Save button at the bottom of the GIS Analysis Reports screen if you do not 
wish to save the report with the revised analysis selections). 

ο Modify the selections, and then save the selected report with the updated selections by 
clicking the Save button at the bottom of the GIS Analysis Reports screen (as noted in 
Steps 9 and 10 of these instructions).   

• Click Run Report to view the previously saved report’s analysis selections or to view the 
previously saved report with any revised analysis selections.  

5. Under Show Results for Entire Alternative, the EST displays the check boxes beside the list of 
Alternatives and Alternative ACE Study Areas, if applicable, with the Select All Alternatives check box 
shown as automatically selected.   

 

Note:  You must select at least one of the options in the Entire Alternative or Individual 
Features sections to run the GIS Analysis Report. 
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To specify the Alternatives you want included in the report, do one of the following: 

• Leave the default Select All Alternatives check box selected if you want to include all of the 
Alternatives shown on the list. 

• Click the Select All Alternatives check box to deselect all of the Alternatives. 

 

• Click a check box beside one or more Alternatives. 

• Leave the Show Results for Entire Alternative check boxes blank if you want to limit the 
analysis results to specific Alternative features.  

6. Under Show Results for Individual Features, click the check box(es) beside the appropriate selections.  
You have the option to: 

• Click Select All Features to select all of the features for all Alternatives shown on the list. 

• Click Select All Features for Alternative Name to select all of the features shown for a specific 
Alternative. 

• Click the check box beside specific Alternative features to only include results in the report for the 
selected features. 

• Leave the Show Results for Individual Features check boxes blank if you do not want to 
include analysis information on specific features in the report. 

Note: If an Alternative has only one feature, the selection for a feature will be unavailable. Click 

the question mark icon, , to view the screen tip for details. 
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7. Under Show Analysis Types for Resource Issues, click the check box beside one or more Resource 
Issues. 

 
8. Depending on your selection(s) in the Show Results for Entire Alternative section, the EST displays 

one of the following screens: 

• If you selected an Alternative that is not an ACE Study Area, the GIS Analysis Report screen 
automatically expands and displays the Select Analysis Types and Buffer Distances section, 
as shown in the next illustration. 

  

Tip!  Authorized users can create or change the name of an Alternative or a feature (such as a 
road segment, facility, or other property location associated with an Alternative) in the EST by 
using one of the forms in the Tools menu or the Update ETDM Project wizard. 

♦ To update or add an Alternative description, go to Tools, point to Project Diary, and 
then click Alternative Description. Use the Alternative Name field to enter a name 
for the Alternative.  

♦ To update or add a feature description, go to Tools, point to Project Diary, and then 
click Segment Description. Use the Segment ID field to enter a name for the 
Segment. 

♦ To make updates to an Alternative or Segment using the EST wizard, go to the 
Wizards menu, and then click Update ETDM Project. 

See the Roles and Privileges section of the Overview chapter of the EST user handbook for the 
list of EST functions and authorized user roles. 
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Note: The Select Analysis Types and Buffer Distances section displays the buffer distances 
for the features of an entire project Alternative. An intersection analysis is run for all features and 
includes features that intersect the boundary of a polygon or are contained within a polygon.   

 

 

• If you selected an Alternative that is an ACE Study Area, the GIS Analysis Report screen 
displays the Select Analysis Types and Buffer Distances section, but only displays the 
analysis type.  

Note: Analyses are only run on features that intersect the study area polygon. 

 

3.2.3.3  GIS Analysis Summary  
The navigation steps for this feature are the same as the steps for the GIS Analysis Report. Please see the 
GIS Analysis Report section (Section 3.2.3.2) for details. 
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3.2.3.4  Agency Comments - Project Effects 
To view the Agency Comments – Project Effects report for a project, select a project from the Project 
Navigation Bar, go to the Reports menu, point to Project Effects, and then click Agency Comments – 
Project Effects. 

 
 

The Agency Comments – Project Effects page opens and displays an ETAT Review Overview table that 
provides a broad view of a project's effects on a resource and includes links for viewing agency comments and 
the Degree of Effect for each resource issue. Click a link to view comments by Resource, Issue, or by 
Organization. The Agency Comments – Project Effects page automatically scrolls to the ETAT Review 
section for the selected target. 

Tip!  After viewing an ETAT Review section, click the Home key to return to the ETAT Review 
Overview table. 

 

3.2.3.5  Agency Comments - Purpose & Need 
The ETAT comments on the Purpose and Need Statement for a selected project are viewed using this report. 
The reviews are not required to contain comments, although these are stored and displayed if submitted. All 
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reviews must indicate whether the agency has accepted or not accepted (or understood or not understood) the 
Purpose and Need Statement. 

To view the Agency Comments – Purpose & Need report, first select a project from the Project Navigation 
Bar, go to the Reports menu, point to Project Effects, and then click Agency Comments – Purpose & Need. 

 
 

The Agency Comments – Purpose & Need report page opens, displaying a search filter and a read-only 
Purpose and Need Statement that is followed by agency reviews.   

 
 

The search feature allows users to find ETAT review comments based on agency and date range for reviews.  
The following illustration shows an example of agency comments found on the Agency Comments – Purpose 
& Need page.   

 

 
 

3.2.3.6  Screening Summary Chart (Draft 04/16/2007) 
The Screening Summary Chart report displays an overview chart of the summary degree of effect assigned for 
specific issues for each project Alternative for a selected project or projects.  To view a Screening Summary 
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Chart for a project, select a project (or projects) using the Project Navigation Bar, go to the Reports menu, 
point to Project Effects, and then click Screening Summary Chart.   

 
 

The Screening Summary Chart page opens displaying the ETAT reviews for each project Alternative. 
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3.2.3.7  Summary Report (Updated 04/16/2007) 
Summary Reports are read-only versions of the reports generated by the ETDM Coordinator using the 
Summarize ETAT Review Screen function described in the Tools chapter of the EST User Handbook.  To 
view a Summary Report for a project, select a project using the Project Navigation Bar, go to the Reports 
menu, point to Project Effects, and then click Summary Report.   

 
 

The Summary Report page opens, displaying options for selecting a Publication or Draft version of the 
Summary Report.   

 
This information is based on the latest milestone data for the project and includes a notation about that 
milestone.  In the example shown, the notation is “Snapshot Data From: Project Re-Published 12/18/2006.” 

If no Screening Summary Report has ever been published for a project (for example, the initial screening event 
is in progress but not completed), the following message will be displayed: 
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Projects in Draft Status 
If a project is in “Draft” status (for example, Editing, Ready for GIS Analysis, GIS Analysis Complete, QA/QC, or 
FIHS Consistency, which are all statuses that apply to projects before an ETAT review begins), and the role of 
the user is one that is authorized to view data for projects that are in “Draft” status, the project header will 
include the notation “Current Project Data” as shown below.  User roles that are authorized to view “Current 
Project Data” are ETDM Coordinator, ETDM Coordinator Management Team, Community Liaison Coordinator, 
Project Manager, FIHS Central Office, and ETDM Data Entry. 

Summary Report Data Options 
The project header is followed by “Summary Report Data Options” for generating a customized Summary 
Report.  The options include a list of available Summary Reports, by publication date.  To select a publication 
date, click the radio button next to that date. 

 

 

Clicking the  next to a publication date 
displays a brief description and ETDM 
Coordinator comments about that Summary 
Report.   

Click a radio 
button to select 

Click the plus sign 
to see a description 
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Next is a list of items that are included in the Summary Report.  All the items have green checkmarks.  The 
Summary Report to be generated can be customized by deselecting items. Click the green checkmark next to 
an item to deselect it.  The checkmark will be removed.  (Note that the “Required Permits and Technical 
Studies” and “Class of Action” options under Project Scope are only available for Programming Phase 
Summary Reports.)  When finished, click the “Generate Report” button at the bottom of the page. 

 

 

 

 

 

 

 

 

 

 

Selecting a Different Publication Date 
In the example shown below, the “Project Re-Published 12/18/2006” publication date was used to generate the 

Summary Report.  At this point, a different publication date can be specified by clicking . 

(Clicking “Make Changes” returns you to the Summary Report Data Options page, where a different publication 
date and/or different items can be selected to generate a different Summary Report.) 

 

Click a green 
checkmark to 
deselect an item  
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Summary Report Contents 
A complete Summary Report is described below.  However, any Summary Report can be customized to display 
only the sections you want to include.  The top portion of the Summary Report displays the project name and 
ETDM number, followed by a notation about the publication date (in the example shown above, the notation is 
“Snapshot Data From: Project Re-Published 12/18/2006”). 

 

The Summary Report header is followed by an overview chart that displays the summary degree of effect 
assigned for specific issues for each project alternative.  Each row of the chart represents a project alternative, 
and each column to the right represents an environmental resource issue organized in "Natural," “Cultural," and 
"Community," groups, followed by a column for Secondary and Cumulative” Effects. The intersection of a 
project row and issue column is a cell that represents the summary degree of effect for a particular project 
Alternative and issue.  The summary degrees of effect are color-coded, and the chart includes a legend that 
explains the color coding, as shown in the image below.  Clicking the number in a color-coded cell will take you 
to the ETAT Review Overview page for that issue and Alternative, as described below. 
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The next section of the Summary Report, under the heading Project Details, includes a summary of the Project 
Description, Summary of Public Comments, and Community Desired Features, followed by project Purpose and 
Need information. 

 
The Purpose & Need portion of the Project Details section includes the Purpose and Need Statement, followed 
by comments from agencies on the Purpose and Need and an indication of whether the agency understood (or 
accepted, if applicable) the Purpose and Need Statement (Acknowledgement). 
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The next section of the Summary Report displays the Alternative-specific data for each project Alternative, 
beginning with Alternative #1 (if this was selected as a data option when generating the Summary Report).  
Alternative-specific data includes a description of the Alternative (from/to locations, type, ETDM status, total 
length, estimated cost, and modes), followed by Segment details.  

 
Segment information includes details about location and length, jurisdiction and class, and statistics for Base 
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Conditions, Interim Plan, Needs Plan, and Cost Feasible Plan traffic conditions.   

This is followed by information about funding sources for the project segment.  In the example shown, no 
funding sources were specified. 

 

The next section of the Summary Report provides an overview of ETAT reviews for the Alternative.   

The overview chart lists each issue commented on by an ETAT agency, the degree of effect indicated by that 
agency, the agency name, and the date the agency submitted their review.  The issues are grouped under 
"Natural," Cultural," "Community," and “Secondary and Cumulative” (indicated by blue heading bars).  Clicking 
the issue category name in the blue bar (for example “Natural”) takes you to the ETAT reviews for that category.  
Clicking an issue name (for example “Air Quality”) takes you to the ETAT reviews for that issue; and clicking the 
organization name (for example “US Environmental Protection Agency”) takes you to that organization’s review 
for that issue.  
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The ETAT Review Overview chart is followed by details concerning agency reviews of the Alternative for 
potential effects to resources.  Again, the information is organized by issue, with the issues grouped under 
"Natural," Cultural," "Community," and “Secondary and Cumulative” (indicated by the dusty rose heading bars). 
This section begins with the Coordinator Summary, indicating the assigned Summary Degree of Effect, and 
including the ETDM Coordinator’s comments.  The Coordinator Summary is followed by a list of the agencies 
that submitted reviews on the issue, including the degree of effect indicated by the agency, and notations about 
reviews that were not submitted. 

 
 

To view the complete text of an agency’s comments, click the  to the left of the agency name.   
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The review information displayed will include the name of the agency representative who submitted the review, 
the date the review was submitted, and the identified resource and level of importance, followed by the 
complete text of the agency’s comments and the FDOT District’s feedback regarding the comments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Alternative-specific information, including Segment details and ETAT reviews, is provided for each project 
Alternative. 

Following the Alternative-specific information is the Project Scope section of the Summary Report, which 
includes information about general project commitments (offered by FDOT in response to agency comments) 
and the Dispute Resolution Log (if applicable).   
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Permits identified as being required for the project; technical studies assigned to the project; and the NEPA 
Class of Action information for the project will also be included if the Summary Report is for a Programming 
Phase ETAT review and those data options were selected when generating the Summary Report. 

 
The Class of Action portion of the Project Scope section displays (if the Summary Report is for a Programming 
Phase ETAT review and the Class of Action data option was selected) the Class of Action Determination for the 
project, lists other actions required, identifies the lead and cooperating agencies, and includes an indication of 
FDOT’s acceptance of the Class of Action, along with their comments, if applicable. 
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Hardcopy Maps 
If “Hardcopy Maps” was selected when generating the Summary 
Report, this information is displayed next.  The Hardcopy Maps 
information is a list of hardcopy maps for each project Alternative 
associated with the selected Summary Report publication date.  To 
view one of the hardcopy maps, use the Print Hardcopy Maps 
function under the Maps pull-down menu on the main menu. 

 

 

 

 

 

 

 

 

Attachments 
If “Attachments” was selected when generating the Summary Report, this information is displayed after the list 
of hardcopy maps (if applicable).  The Attachments section consists of a chart that provides a description, type, 
and date for each document designated as a project attachment.  The chart also includes a link to each 
document.  To view a document, click on the document link (in blue). 
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Summary Report Header Tools 

The generated Summary Report can be emailed or printed using the or  buttons at the top of the 

project header, as shown below. Clicking the button will open a PDF viewer, which can then be used to 

review, save, or print the generated Summary Report. Use the  to bookmark the generated Summary 

Report, or click  to add it to your “My ETDM” pages.  Click  to access the On-line Help information 
for the Summary Report page.  

 
 
 

3.2.3.8  Sociocultural Effects Evaluation Summary Report (New 07/18/2007) 
The Sociocultural Effects Evaluation (SCE) Summary Report provides an overview and detailed ETAT 
comments for a selected project (or projects) for which a Screening Summary Report has been published.  The 
report can also be generated using the most current data available.  The SCE Summary Report is a subset of 
the Screening Summary Report and includes ETAT comments associated with the Community category of 
resource issues (sociocultural issues) only.  The sociocultural issues are:   

• Aesthetics 

• Economic 

• Land Use 

• Mobility 

• Relocation 

• Social 

To view an SCE Summary Report for a project 
(or group of projects), select a project from the 
Project Navigation Bar, go to the Reports 
menu, point to Project Effects, and then click 
Sociocultural Effects Evaluation Summary 
Report.   

The first page of the Sociocultural Effects 
Evaluations Summary Report includes a 
project header with information that identifies 
the selected project (or the first project in the 
selected group of projects).  If more than one 
project is selected, the information will be 
presented for each project (in numerical order 
according to the project ETDM number).  Use 
the scroll bar on the right side of the screen to 
view the information.  (See the SCE Summary 
Report outline below for a list of items included 
for each project.)  . 
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The project header information includes the project name and ETDM number, project location, and a notation 
about the milestone data used to generate the report.  In the example shown, the milestone data notation is 
“Snapshot Data From: Project Published 09/25/2006.”     

 

Data Options 

To view the SCE data from a previous Screening Summary Report, click .  
When the next page opens, select a 
publication date by clicking the radio 
button next to that date.  Clicking the  
next to a publication date displays a brief 
description, ETDM Coordinator 
comments, and the project phase for that 
Summary Report. 

To view the most current data for the selected project or group of projects, click the checkbox next to “Current 

Draft.”  A green checkmark will appear in the box ( ).  (Note that this will disable the option to 
select other publication dates, and you must uncheck “Current Draft” in order to select any of the other 
publication dates.)  When finished selecting published/re-published dates or checking “Current Draft,” click 

.   
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SCE Summary Report Outline 
You can review the generated SCE Summary Report using the scroll bar on the right side of the page to scroll 
through the sections of the report, or view a PDF version of the report (as described in the section below titled 
PDF Version of SCE Summary Report.  An outline of the SCE Summary Report is provided below: 

Each Project 
• Project Header for selected project (or first project in selected group of projects) 

• Overview Chart of Summary Degrees of Effect for SCE issues (for each project Alternative) 

• Project Details 

ο Project Description Summary 

ο Summary of Public Comments 

ο Community Desired Features 

ο Purpose and Need Statement 

ο Agency Comments on Purpose and Need 

• Alternative-specific Information for each Alternative 

ο Alternative Description 

ο Segment Details 

ο ETAT Review Overview Chart 

ο ETAT Reviews: Community 

ο Aesthetics 

ο Economic 

ο Land Use 

ο Mobility 

ο Relocation 

ο Social 

• Project Scope 

ο General Project Commitments 

ο Permits 

ο Technical Studies 

ο Class of Action 

ο Dispute Resolution Log 
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Navigating through SCE Summary Report Using Links 
The SCE Summary Report includes links that take you directly to specific sections of the report.  These links 
and how to use them are described below. 

Summary Degree of Effect Overview Chart 
The Overview Chart shows the Summary Degree of Effect assigned to each of the six SCE issues by the 
ETDM Coordinator for the specified ETAT screening event, as shown in the example below.  Each row of the 
Overview chart represents a project alternative, and the columns to the right represent the six environmental 
resource issues associated with the Community group of issues.  The intersection of a project row and issue 
column is a cell that represents the summary degree of effect for a particular project Alternative and issue.   

The summary degrees of effect are color-coded, and the chart includes a legend that explains the color coding.  
Clicking the number in a color-coded cell takes you to the Coordinator Summary for that issue and Alternative, 
as described below. 

Coordinator Summary 
The Coordinator Summary indicates the assigned Summary Degree of Effect for the selected SCE issue, and 
includes the ETDM Coordinator’s comments for that issue.  The Coordinator Summary also includes a link to 
the list of agencies who submitted review comments for the SCE issue and a link that takes you to the 
beginning of the Alternative-specific information for the selected Alternative. 
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ETAT Reviews for SCE Issues 

Clicking the  to the left of the ETAT Reviews link displays the list of agencies that submitted reviews on the 
issue, including the degree of effect indicated by the agency, and notations about reviews that were not 
submitted.  In the example shown below, FDOT District 1 is listed as submitting a review for the Aesthetics 
issue. 

 

To view the complete text of an agency’s comments, click the  to the left of the agency name.  The review 
information displayed includes the name of the agency representative who submitted the review, the date the 
review was submitted, and the identified resource and level of importance, followed by the complete text of the 
agency’s comments and the FDOT District’s feedback regarding the comments, as shown in the example 
below. 
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Click the   link to go to the beginning of the Alternative-specific information for that 
Alternative, which includes: 

• Alternative Description 

• Segment Details  

• ETAT Review Overview Chart 

• ETAT Reviews: Community 

ο Aesthetics 

ο Economic 

ο Land Use 

ο Mobility 

ο Relocation 

ο Social 

Alternative-specific ETAT Review Overview Chart 
The Alternative-specific overview chart lists each of the six SCE issues commented on by the ETAT agencies, 
the degree of effect indicated by that agency, the agency name, and the date the agency submitted their review.  
Clicking the issue category name (Community) in the blue bar takes you to the Coordinator Summary for the 
first issue in the Community category (Aesthetics).  Clicking an issue name (for example “Economic”) or an 
organization name (for example “Federal Highway Administration”) takes you to the list of ETAT reviews for that 
issue.  You can then use the links described above under “ETAT Reviews for SCE Issues” to view the complete 
text of an agency’s comments. 
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PDF Version of SCE Summary Report 

A PDF version of the selected SCE Summary Report can be viewed by clicking the button at the top of the 
page.  This opens a PDF viewer, which can then be used to review, save, or print the SCE Summary Report.  

To close the PDF viewer, click  in the upper right-hand corner of the screen.  An example from the 
PDF version of the SCE Summary Report for the example projects is shown below. 

 

SCE Summary Report Header Tools 

The generated SCE Summary Report can be printed or emailed using the or  buttons at the top of 

the project header, as shown below.  Clicking the button will open a PDF viewer, which can then be used 

to review, save, or print the generated SCE Summary Report.  Use the  to bookmark the generated SCE 

Summary Report, or click  to add it to your “My ETDM” pages.  Click  to access the On-line Help 
information for the SCE Summary Report page.  
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The findings details include the name of the agency, the Federal Consistency Review finding, and the review 
date. Note: to expand the view to include details, click the  icon. To collapse the view to display only the 
header, click .)   
 

 

3.2.3.10  Track State Clearinghouse Projects Report (Updated 06/30/2009) 
This report displays the State Clearinghouse project record. Until the Federal Consistency determination has 
been made, only the State Clearinghouse can view this report.  Once the determination has been made, the 
report is available for reading by all parties involved and by the public (via the ETDM Public Access Site). 

To generate the report, first select a project using the Project Navigation Bar, go to the Reports menu, point to 
Project Effects, and then click Track State Clearinghouse Projects Report. 

 
The first section of the Track Clearinghouse Projects Report form is a header with information that identifies 
the selected project.  This information includes the ETDM number and project name, the FDOT District(s) and 
county (or counties) where the project is located, the ETDM phase, from and to locations, the associated 
Planning Organization and Plan ID number, the Financial Management number, Federal Involvement level, and 
contact information. 
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Below the header information is the Select a Screening Event to Track dropdown list; by default, the most 
recent screening event is displayed. Click the down arrow to display the list of all screening events available for 
selection.   

 

 

The next section displays the project’s Alternative Details, if any. 

 
As shown in the following image, the Program Information section displays details regarding the project, 
including the Category (Federal Funding, Federal Action, or Federal Permit), the CFDA (Catalog of Federal 
Domestic Assistance) Number, a summary Project Description, Review Type, Routing/Consistency 
information for the project, Applicant Information, Type, and Funding details.   
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Also listed are the Federal Consistency Definitions used by the Federal Consistency Reviewer; there are three 
possible findings: 

• Consistent 

• Consistent, With Comments 

• Inconsistent 

The definition for each finding appears next to the option, as shown below. 

 
Following that is the ICAR Determination. This section displays the Intergovernmental Coordination and Review 
determination from the State Clearinghouse, including any comments.    

 
The Federal Consistency Review findings are displayed on the form, as shown in the example below.  (The 
findings are also available in the Federal Consistency Findings report, accessed via the Reports menu under 
Project Effects.)  The ETAT review comments and other comments are available for viewing on the Agency 
Comments – Project Effects report and the Agency Comments – Purpose & Need report (found in the Reports 
menu, under Project Effects).  The findings submitted are followed by a list of agencies that are required to 
review federal consistency, but from whom no comment has been received for the selected screening event. 
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The Date Closed section shows the date that the State Clearinghouse Coordinator issued the consistency 
determination.  

3.2.3.11  Class of Action Determination Report (New 06/30/2010) 
The Class of Action Determination Report function in the Environmental Screening Tool (EST) Reports 
menu displays the agreed upon environmental Class of Action (COA) Determination between the FDOT and 
the Lead Agency for a project. 

The process for obtaining the environmental COA Determination requires that the District ETDM Coordinator 
recommend a COA Determination following a project's Programming Screen. The District ETDM Coordinator 
enters the recommended COA Determination via the EST Add/Modify Class of Action tool and signs it using 
the Review Class of Action tool.  

Once the COA is signed by the ETDM Coordinator, an email requesting review and approval of the 
recommended COA Determination is automatically generated and sent to the Lead Agency’s primary ETAT 
member for the project. The Lead Agency representative then uses the EST Review Class of Action tool to 
review and sign the COA Determination.  

After the COA Determination process is complete, the determination is part of the project record in the EST and 
is published in the Final Programming Summary Report.  

Viewing the COA Determination Report: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Reports menu, point to Project Effects, and then click Class of Action Determination. 
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The Class of Action Determination Report window opens as a tabbed page, displaying a page 
toolbar and the COA Determination Report for the selected project. 

   
 

Tip!  Click the toolbar icon in the Class of Action Determination Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

 Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

The Class of Action Determination Report is divided into the following sections: 

• Class of Action Determination 

• Class of Action Signatures 
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The Class of Action Determination section displays the Class of Action that has been 
established for the project, Other Actions, the Lead Agency for the project, and Cooperating 
Agency(ies), if any. 

 
 

The Class of Action Signatures section displays signature details for the FDOT District and the 
Lead Agency.  Each section shows: 

• Name (District ETDM Coordinator and Lead Agency Representative) 

• Review Status (Accepted or Not Accepted) 

• Date ( the date the COA Determination was signed) 

• ETDM Role (identifies the EST access role of those who signed the COA Determination) 

• Comments 

 
 

3.2.3.12  GIS Analysis Results (All) (In Development) 
 

3.2.3.13  Agency Comments- Ad Hoc Query (In Development) 
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3.2.4  Reminders (Updated 04/30/2008) 
Reports listed under Reminders provide a quick view of projects related to Dispute Resolution, ETDM QA/QC, 
Summary Reports, Report Republication, and Milestone Needs.  Users may use these reports to monitor or 
follow-up on tasks that still remain pending or identify tasks that have been completed. 

 
 

3.2.4.1  Projects Flagged for Dispute 
To view the Projects Flagged for Dispute report, go to the Reports menu, point to Reminders, and then click 
Projects Flagged for Dispute.   

 
 

This report displays a list of projects with status "ETAT Review Complete,"  and with at least one review 
organization that has indicated a "Potential Dispute" or "Dispute Resolution Required" for the agency 
involvement option.   
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3.2.4.2  Projects in Dispute Resolution 
To open the Projects in Dispute Resolution report, go to the Reports menu, point to Reminders, and then click 
Projects in Dispute Resolution.   

  
 

The Projects in Dispute Resolution report displays a list of projects that have a status of "Dispute Resolution 
in Progress."  An ETDM Coordinator sets the status by using the Update Project Status tool (See Section 3.1 
– Tools in the EST User Handbook).   

 

3.2.4.3  Projects Awaiting ETDM QA/QC 
To view the Projects Awaiting ETDM QA/QC report, 
go to the Reports menu, point to Reminders, and 
then click Projects Awaiting ETDM QA/QC.   
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This report shows all of the projects that have a status of "ETDM QA/QC." The status of “ETDM QA/QC” 
indicates that a project needs to be verified for completeness of information required for the next ETAT review.   

3.2.4.4  Un-published Summary Reports 

 

To view the Un-published Summary Reports list, go to the Reports menu, point to Reminders, and then click 
Un-published Summary Reports.   
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This report lists projects with the status "ETAT Review Complete," along with the time remaining to complete the 
summary report (60 calendar days from the end of the review period).   

 

3.2.4.5  Projects Needing Republication (New 03/21/2008) 
To access the Projects Needing Republication report, click on the Reports button on the main menu.  Go to 
Reminders and then select Projects Needing Republication  

 
This report lists projects that have been edited since the most recent Summary Report was published.  It is 
required that Summary Reports for these projects be republished before the project phase can be updated or 
before the project can undergo a screening event. 
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An example Projects Needing Republication report is shown below.  The list is organized in numerical order by 
ETDM project number.  To sort the list by another column heading, click the column name (in blue). 

 

As you move your cursor through the list, the project row will be highlighted in orange.  To view details for the 
project concerning Summary Reports that may need to be republished, click the  link to the far right of 
the row for that project.   

 

Clicking the  link opens the Project Milestone Needs report for the project, which provides additional 
information about the reports that have been published and whether any need to be republished.  This report 
also includes links for initiating republication.  
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3.2.4.6  Project Milestone Needs (New 04/16/2008) 
To access the Project Milestone Needs Report, select a project using the Project Navigation Bar, go to the 
Reports menu, point to Reminders, and then click Project Milestone Needs. 

 
This report lists the actions that need to be taken to publish outstanding milestone event reports.  An 
unpublished Summary Report or Eliminated Alternatives Report may block the project phase from being 
updated or block the project from undergoing a new screening event. 

The first section of the Project Milestone Needs Report is a project header with information that identifies the 
selected project.  This information includes the ETDM number and project name, the FDOT District(s) and each 
county where the project is located, the ETDM phase, from and to locations, the associated Planning 
Organization and Plan ID number, the Financial Management number, and contact information. 
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The next section of the Project Milestone Needs Report provides details about project data that have been 
updated since the most recent Summary Report was published.  It also includes information indicating whether 
the Eliminated Alternatives Report for the project is up to date or needs to be published.  A key to the symbols 
used in the section is also provided. 

 

Links are provided in this section for republishing a Summary Report and publishing an Eliminated Alternatives 
Report.  Clicking the  link opens the Summarize Results of ETAT Review Screen 
tool, as shown below. 

 

Clicking the  link opens the Summarize and Publish Eliminated 
Alternatives Report, as shown below. 
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3.2.5  Agency Participation (Updated 07/22/2008) 
Reports listed under Agency Participation enable users to view agency and associated resource information 
and to track projects needing required reviews. 

 

3.2.5.1  Agencies and Associated Resource Issues 
To view the Agencies and Associated Resource Issues report, go to the Reports menu, point to Agency 
Participation, and then click Agencies and Associated Resource Issues.   

 
 

The Agencies and Associated Resource Issues report provides a list of review agencies and the resource 
issues they are responsible for reviewing.  The report includes a query function to select either an agency or an 
issue.  To view the resource issues associated with a particular agency, select the agency name from the 
Review Agency pull-down menu at the top of the Agencies and Associated Resource Issues page.  To view 
agencies associated with a particular resource issue, select the issue name from the Issue pull-down menu at 
the top of the Agencies and Associated Resource Issues page.   
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3.2.5.2  Agency Review Overview (In Development) 
 

3.2.5.3  Agency Websites 
To view the Agency Web Sites report, go to the Reports menu, point to Agency Participation, and then click 
Agency Websites.   
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This report provides a list of participating agencies and links to each agency’s website.    To access an individual 
agency’s website, click on the hyperlink to the right of the agency’s name.   

 

3.2.5.4  ETAT Contact List (Updated 11/15/2006) 
This report lists the names, telephone numbers and email addresses for ETDM Coordinators, Community 
Liaison Coordinators (CLCs), and ETAT representatives.  The report includes a query function to search for 
contact information based on District, user’s role, and/or agency name.  To view the ETAT Contact List report, 
go to the Reports menu, point to Agency Participation, and then click ETAT Contact List.   

 
When the form opens, complete the appropriate fields, and then click Search.   
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Portions of an ETAT Contact List report are shown below.  The search criteria selected for this example are 
FDOT District 1 (District), ETAT Member (User’s Role) and -All- (Agency).  To send an email to an individual 
listed on an ETAT Contact List report, click on the email address for that individual. 

 

The ETAT Contact List report can be printed by clicking the printer icon  in the upper right-hand corner of 

the report.  To view a PDF of the ETAT Contact List report, click the  button at the top of the screen.  You 
can then review, save, or print the ETAT Contact List report. 

The ETAT contact information can also be exported as an Excel file.  Click the  button at the top right-
hand side of the ETAT Contact List report, as shown below. 
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3.2.5.5  Projects Needing Class of Action Review (In Development) 
 

3.2.5.6  Projects Needing Federal Consistency Review (New 03/24/2008) 
The Projects Needing Federal Consistency Review report displays projects that need a consistency finding by 
Federal Consistency Reviewers.  

To access the Projects Needing Federal Consistency Review report, go to the Reports menu, point to 
Agency Participation, and then click Projects Needing Federal Consistency Review.    
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Creating the Report 
When the Projects Needing Federal Consistency Review page is generated, by default, the report contains a 
list of all projects in the user’s jurisdiction that require review.  To generate a report for other projects needing 
Federal Consistency review, use the Search Criteria section at the top of the screen to define search 
parameters for your report. Make selections in the County and/or Organization drop-down boxes.  

The page will update and display summary information for all projects which meet your criteria. The results are 
color-coded, as detailed in the Key section, to provide a visual indicator of whether or not the Federal 
Consistency review for a project has been carried out by the selected agency.  

You may sort the results by clicking on the column header. 

 

The Search Criteria section of the Projects Needing Federal Consistency Review screen contains a 
link for Agencies and Associated Resource Issues, which opens a separate tabbed window which 
displays the issues for each review agency. (The Review Agency field defaults to the entry in the 
Organization field on the main Projects Needing Federal Consistency Review page.) 
By using the Detailed Report link at the top right of the Agency and Associated Resource Issues page, you 
can generate a PDF report in a new browser window which defines the review role of all ETAT agencies. For 
each agency, the report lists the relevant citation(s), ETAT review responsibility, pertinent permits and/or 
actions, and EST review issues.  

From the main Projects Needing Federal Consistency Review screen, you can view the details of a project 
by clicking its ETDM number. The reports associated with the project needing Federal Consistency Review 
appear in separate tabbed windows, as described below. Note: all reports are project-specific; by default, the 
information displayed in each window pertains to the project number selected from the Projects Needing 
Federal Consistency Review report by default. 
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• Project Description - gives a detailed overview of a project, from the summary description and Purpose and 
Need Statement to the segment level details.  

• Federal Consistency Finding Report – displays the findings for a project (searchable by agency, project(s), 
and date range). 

• GIS Analysis Results - displays the most recent results of the GIS Analysis routines for a project. 

• Map Viewer – zooms to the project location and provides access to various resource maps 

Click on the Tab title to navigate to a report.  

 
 

On the right side of the screen, there is a Show/Hide Map bar.  This bar toggles the display of the Interactive 
Map Viewer.  To view the interactive Map Viewer over the tools and reports, click the Show/Hide Map bar; to 
hide the map and return to the forms and reports view, click the bar again.  (Note that tips for using the 
Interactive Map Viewer are available by clicking Help on the upper left side of the map, and a detailed 
description of the Interactive Map Viewer is available in the EST Handbook in the ETDM Library.) 

To close the tools and reports, click on the blue “X”  at the top right-hand side of each page (above the 
Page Tool Bar).  This takes you back to the Projects Needing Federal Consistency Review Report. 

3.2.5.7  Projects Needing Advance Notification Review (In Development) 

3.2.5.8  Projects Needing Review (Updated 11/30/2011) 
The Projects Needing Review function in the EST Reports menu enables Environmental Technical Advisory 
Team (ETAT) members to review project details and resource information for projects within their agency’s 
jurisdiction that are currently in an ETAT review period.   

Viewing the Projects Needing Review Report: 
1. On the Reports menu, point to Agency Participation, and then click Projects Needing Review. 
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The Projects Needing Review window opens, displaying a search filter, and a list of the projects 
that are ready to be reviewed by your agency. 

 
Tip!   Click the toolbar icon on the window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

 View the training video about the current page. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the current page. 

 Add the current page to your My ETDM preferences. 
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2. Under Search Criteria, you can view the status of projects being reviewed by other ETAT members 
within your agency or in other agencies. Enter your search criteria by doing the following: 

• In the County list, do one of the following: 

ο Accept the default –All-. 

ο Click the County name. 

• Do one of the following: 

ο If you want to view projects only for your agency (i.e., the assigned organization), click the 
option button beside Assigned Organization(s). 

 

 To view all the projects needing review by the assigned organization, click the option 
button beside Show results for all members of selected organization. 

 To view all the projects available for your review, click Show results for Your Name only. 

ο If you want to view projects needing review by other organizations, click the option button 
beside Other Organizations, and then click the organization name. 

Tip!  Click the Agencies and Associated Resource Issues link to view the report listing the 
resource issues your agency is responsible for reviewing. 

3. Under Projects Needing Review by Name of Organization, the EST displays a table showing the 
projects currently in ETAT review for the organization you selected in Search Criteria section. The 
table displays the following project information: 

• FDOT District – the FDOT District(s) in which the project is located 

• County – the county(ies) in which the project is located 

• ETDM#  – the project number 

• ALT# – project alternative number 

• Project Name – name of the project 

• ETDM Phase – phase project is currently in 

• Days Left – number of days remaining in the review period 

• Last Day –  date the review period ends 

• Start Day – date the review period began 

• Review Authority – indicates whether or not you have authority to enter comments on behalf of 
the selected agency—Yes or No 

Note: If No appears in the Review Authority column when your agency is selected, you must 
email your comments to your agency representative who has authority to enter comments into the 
system. 
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• P&N Review – indicates whether your agency has submitted comments about the Purpose and 
Need Statement 

• Issue Reviews – indicates the percentage of required issues with submitted comments 

Tip!   To sort the project information by column, click the column-heading links (e.g., click the 
Days Left heading to sort the table by deadline priority). 

4. Click the links in the P&N Review and Issue Reviews columns to view comments submitted by your 
agency, if any. 

5. To review a project alternative, click the project ETDM number link in the ETDM# column for the 
corresponding alternative. 

Note: A project may have multiple alternatives, with each alternative listed separately. You will 
need to conduct an independent review for each alternative associated with the project. 

 
 

The EST opens the Interactive Map showing the project’s 
location and the appropriate forms and reports. 

6. To view the forms and reports, click the Click to Close Map bar to 
close the interactive map viewer.  

The EST displays the following tabbed pages, enabling you to 
easily access the necessary tools and reports to conduct your 
review: 

• Projects Needing Review 

• Project Description  

• Review Purpose and Need Statement 

• Describe Direct Effects 

• GIS Analysis Results 

Note: To view the navigation details for the pages associated 
with the Project review, see the EST Handbook. 
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7. Click the tab title to open the page for the selected form or report. 

Tip!  The EST displays a white tab when pages are in active view. (See the Navigation chapter 
of the EST Handbook for navigation details on page tabs.) 

8. When you have finished reviewing the reports for a selected Alternative, close the tabbed pages 
associated with the current review —except for the Projects Needing Review page-- before selecting 
another Alternative. 

Tip!  If you mistakenly close a page before completing your review, close all the tabs for the 
current review, and then click the Project Number on the Projects Needing Review page to re-
open the tools and reports associated with the project. 

3.2.5.9  Track ETAT Notifications (New 11/30/2011) 
The Track ETAT Notifications function in the Environmental Screening Tool (EST) Reports menu enables the 
Environmental Management Office manager, District ETDM Coordinators, and the State Clearinghouse to view 
notifications that were sent to Environmental Technical Advisory Team (ETAT) members, along with the list of 
individuals who were sent the notifications.  The Track ETAT Notification function also enables users to 
forward a notification to additional people.  

Using the Track ETAT Notifications Report: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Reports menu, point to Agency Participation, and then click Track ETAT Notifications. 
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The Track ETAT Notifications window opens as a tabbed page, displaying the notifications sent 
to ETAT recipients for the selected project.  There can be multiple notifications, with each 
notification containing a list of recipients and a Forward button. 

Tip!  Click the minus sign, , to collapse a notification section.  Click the plus sign, , to 
expand a section.  

 
Tip!   Click the toolbar icon on the window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

  Add the page to your My ETDM preferences. 

Below each Notice section, is a Recipients section. This section displays the number of 
recipients who were sent the ETAT review notification for the project, along with the recipients' 
Name, Organization name and E-mail address link. 

 

3. To forward the list of recipients, click the  button located beneath the selected list. 
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3.2.6  Community Coordination (Updated 9/3/2008) 
Reports listed under Community Coordination 
enable users to view read-only screens that display 
community characteristics information and public 
comments regarding one or more projects. The 
Mailing Labels function allows users to print mailing 
labels for public involvement activities. 

3.2.6.1  Community Characteristics 
Inventory (Updated 9/3/2008) 

The Community Characteristics Inventory report 
enables users to view Community Characteristics 
Inventory information that has been added to a 
project database.  To view this report, first select a 
project from the Project Navigation Bar, go to the 
Reports menu, point to Community Coordination, 
and then click Community Characteristics Inventory.  

  
 

On the first screen, the user has options to change the buffer distance and to select an alternate community, if 
available, from the pull-down menu.   

 

If you do not have a project selected, you can search for a Community Characteristics Report by the Region. 
Click the  button to switch to Community Characteristics Inventory by Region view. 
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Clicking the Make Report button loads the report in the same window.  

 

Once the report has loaded, you can click the PDF button to view a PDF version of the report.  This opens the 
PDF Viewer with the specified Community Characteristics Inventory Report displayed.  You can then use the 
PDF Viewer tools to review, save or print the report.  An example Community Characteristics Inventory Report 
by Project is shown in the next illustration. 

 

3.2.6.2  Mailing Labels (In Development) 
 

3.2.6.3  Public Comments Summary (In Development) 
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3.2.7  Performance Management (Updated 
06/30/2010) 

Reports listed under Performance Management enable 
authorized users to access blank survey forms or view 
survey results and reports documenting the performance of 
the ETDM Process and its participants. 

3.2.7.1  Annual Surveys (Updated 06/30/2010) 
The Surveys menu displays options for viewing individual 
surveys completed by ETAT members and District ETDM 
Coordinators or a summary of survey results. 

3.2.7.1.1 View Blank Survey (In Development) 

 

3.2.7.1.2 ETAT Survey (Updated 06/30/2010) 

Biennially, ETAT members complete a survey to provide 
feedback on how the participating agencies view the management and administration of the ETDM Process, the 
quality of the working relationship between the agencies and FDOT, and recommended improvements or 
changes. 

The ETAT Survey function in the Environmental Screening Tool (EST) Reports menu enables ETAT 
Members-Primary to view draft and final surveys for their agency. 

Viewing an ETAT Survey: 
1. On the Reports menu, point to Performance Management, select Surveys, and then click ETAT 

Survey. 
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The ETAT Survey window opens as a tabbed page, displaying a drop-down list box containing a 
list of draft and final surveys, with a page toolbar located in the upper right corner of the window.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the current page. 

 Add the page to your My ETDM preferences. 

 

2. In the Load a Survey field, click the drop-down arrow . 

 
The Load a Survey field expands, displaying the final and draft surveys submitted for your 
agency. 

 
 
3. Click the Survey name you want to view.  

 
 

The survey name appears in the Load a Survey field. 
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4. Click Load Survey. 

 
 

The ETAT Survey window opens as a tabbed page, displaying the completed survey and page 
toolbar. 

 
 

Tip!   Click the toolbar icon on the ETAT Survey window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3.2.7.1.3 ETAT Survey Results (Updated 06/30/2010) 

Biennially, ETAT members complete a survey to provide feedback on how the participating agencies view the 
management and administration of the ETDM Process, the quality of the working relationship between the 
agencies and FDOT, and recommended improvements or changes. 

The ETAT Survey Results function in the Environmental Screening Tool (EST) Reports menu enables Central 
Environmental Management Office (CEMO) Managers to view a summary of the Annual Survey results 
submitted by participating agencies.  
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Viewing ETAT Survey Results: 
1. On the Reports menu, point to Performance Management, select Surveys, and then click ETAT 

Survey Results. 

 
 

The ETAT Survey Results window opens as a tabbed page, displaying the survey results 
summary, with a page toolbar located in the upper right corner of the window.  

 

Tip!   Click the toolbar icon on the ETAT Survey Results window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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The survey results summary organizes agency responses in the following categories:  

• Method of Compensation 

• Types of Funded Positions 

• Methods of Project Notification 

• Methods ETDM Funds are being used  

• Quality of Information 

• ETDM Training 

• Recommendations for Improvements 

• ETDM Performance Measures 

3.2.7.1.4 District ETDM Coordinator Survey (Updated 06/30/2010) 

Biennially, District ETDM Coordinators complete a survey assessing the performance of participating agencies 
and the ETDM Process. District ETDM Coordinators provide a qualitative assessment of ETDM benefits; 
customer service; and the quality of information, coordination and communication. 

The District ETDM Coordinator Survey function in the Environmental Screening Tool (EST) Reports menu 
enables Central Environmental Management Office (CEMO) Managers and Florida Department of 
Transportation (FDOT) ETDM Coordinators Primary to view surveys completed by District ETDM Coordinators.  

CEMO Managers can view completed draft and final surveys from any District.  FDOT District ETDM 
Coordinators can view only completed draft and final surveys for their own districts. 

Viewing District ETDM Coordinator Surveys 
1. On the Reports menu, point to Performance Management, select Surveys, and then click District 

ETDM Coordinator Survey. 
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The District ETDM Coordinator Survey window opens as a tabbed page, displaying a drop-
down list box containing a list of draft and final surveys, with a page toolbar located in the upper 
right corner of the window.  

 
 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. In the Load a Survey field, click the drop-down arrow . 

 
 

The Load a Survey field expands, displaying the draft and final survey names, dates, names of 
the people who completed the surveys, and the agency name. 
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3. Click the survey name you want to view.  

 
 

The survey name appears in the Load a Survey field. 

 
 

4. Click Load Survey. 
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The District ETDM Coordinator Survey window opens as a tabbed page, displaying the 
completed survey and page toolbar. 

 
 

Tip!   Click the toolbar icon on the District ETDM Coordinator Survey window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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3.2.7.1.5 District ETDM Coordinator Survey Results (Updated 06/30/2010) 

Biennially, District ETDM Coordinators complete a survey to provide feedback on how the Florida Department of 
Transportation (FDOT) Districts view the management and administration of the ETDM Process, the quality of 
the working relationship between the agencies and FDOT, and recommended improvements or changes. 

The District ETDM Coordinator Survey Results function in the Environmental Screening Tool (EST) Reports 
menu enables Central Environmental Management Office (CEMO) Managers to view a summary of the Annual 
Survey results submitted by District ETDM Coordinators.  

Viewing District ETDM Coordinator Survey Results: 
1. On the Reports menu, point to Performance Management, select Surveys, and then click District 

ETDM Coordinator Survey Results. 

 
 

The District ETDM Coordinator Survey Results window opens as a tabbed page, displaying 
the survey results summary, with a page toolbar located in the upper right corner of the window.  
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Tip!   Click the toolbar icon on the District ETDM Coordinator Survey Results window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

The survey results summary organizes District ETDM Coordinator responses in the following 
categories:   

• Methods of Project Notification 

• Benefits of ETDM 

• Customer Service 

• Quality of Information 

• Communication and Coordination 

• Performance Measures 

3.2.7.2  Ad Hoc Survey Report 1 (In Development) 
 

3.2.7.3  Ad Hoc Survey Report 2 (In Development) 
 

3.2.7.4  Issue Tracking (New 7/31/2009) 
Reports listed in the Issue Tracking menu enable Central Environmental Management Office (CEMO) 
managers and staff to view issues and concerns reported by agencies to the FDOT. 

3.2.7.4.1 Issue Tracking Details Report (New 7/31/2009) 

The Issue Tracking Details Report enables the Central Environmental Management Office managers and 
staff to view ETDM issue details reported by the agencies to FDOT.  
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Viewing Issue Tracking Details Reports: 
1. On the Reports menu, point to Performance Management, select Issue Tracking, and then click 

Details Report. 

 
 

The Issues Tracking: Details Report window opens as a tabbed page, displaying search filters 
and a page toolbar.  

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The Issues Tracking: Details Report window is divided into two sections—Issues Tracking 
Query and Select an Issue—that enable you to search and view the details of existing issues. 
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2. To search for a report, complete one or more fields under Issues Tracking Query.   

Note:  The fields are not required fields, so you have the option to enter as much information as 
you want into the search filter or you can leave all of the fields blank. However, leaving all of the 
fields blank when you submit your query will result in the EST displaying all issues listed in the 
system. 

 
3. To narrow your search results, complete one or more of the following fields in the Issues Tracking 

Query search filter:  EST then displays the issues matching your search criteria. 

• In the Issue ID field, type the identification number assigned to an issue. 

• In the Assignment ID field, type the assignment ID.  

• In the Reporter field, click the drop-down arrow . The field expands, displaying a pre-populated 
list of people who have reported issues. Do one of the following: 

ο Select your name from the list if you want to view or edit issues you have previously reported.  

ο Select another name to view the issues reported by the selected person. 

• In the Assignee field, click the drop-down arrow , and then select the person assigned to take 
action on specific issues. 

Tip!  You can also select a name in the Reporter and Assignee fields by typing the first letter of 
the person's first name. Keep pressing the letter until the name you are seeking appears.  

• In the Category field, click the drop-down arrow , and then select a category.  
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• In the Type field, click the drop-down arrow  and select the type of issue. The Type field 
populates with options related to the category you selected in the Category field.  

• In the Status field, click the drop-down arrow , and then select a status.  

 

• In the Priority field, click the drop-down arrow , and then select a priority. 

 

• In the Resolution field, click the drop-down arrow , and then select a resolution type.  

 

• In the Submission Date Range fields, type the date range when an issue was originally 
submitted.  

• In the Due Date Range fields, type the date range for action item due dates associated with an 
issue. 

Tip!  When typing in dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 

• In the Keywords field, type any words related to your search query. 
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4. Click Submit Query. 

 
In the Select an Issue section, the Select an Issue field populates with the results based on your 
search criteria, as shown in the next illustration. 

 

5. To view details for an issue, click the drop-down arrow  in the Select an Issue field.  

 
The field expands and displays a list of issues matching the search query you entered in the 
Issues Tracking Query section. 

6. Select the issue you want to view. 
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7. Click Load Report. 

 
 

The Issues Tracking: Details Report window refreshes, displaying the details of the selected 
issue and an expanded page toolbar. 

 

Tip!   Click the toolbar icon on the Issues Tracking: Details Report window to: 

 Print a copy of the report. 

  Export the report to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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3.2.7.4.2 Issue Tracking: To Do List (New 7/31/2009) 

The Issue Tracking: To Do List function in the Environmental Screening Tool (EST) Reports menu enables 
Central Environmental Management Office (CEMO) managers and staff to view open issues assigned to them.  
Issues appearing in the Issue Tracking: To Do List window are recorded and assigned by CEMO managers 
and staff using the Issue Tracking function in the EST Tools menu. 

Opening the Issue Tracking Inbox: 
1. On the Reports menu, point to Performance Management, select Issue Tracking, and then click 

Inbox. 

 
 

The Issues Tracking: To Do List window opens as a tabbed page, displaying a page toolbar 
along with the list of issues and action items assigned to you.   

 

Tip!   Click the toolbar icon on the Issues Tracking: To Do List window to: 

 Print a copy of the report. 

  Export the report to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 
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 Add the page to your My ETDM preferences. 

2. To view the details of an issue, point to the row containing the issue or action item information, and then 
click anywhere on the row. 

 
A message appears asking if you want to view the details of the selected issue. 

 
3. Click OK. 

The Issues Tracking: Details Report window tab opens, displaying the details of the selected 
issue that is assigned to you.    

 
 

Note:  After you have completed the Action Item, the issue and action item will be removed from 
the Issues Tracking: To Do List window.  However, you can view the issue and action item 
details in the Issue Tracking Details Report. 
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3.2.7.4.3 Issues Tracking: Summary Report (New 7/31/2009) 

The Issues Tracking: Summary Report function in the Environmental Screening Tool (EST) Reports menu 
enables Central Environmental Management Office managers and staff to view a read-only report summarizing 
issues being tracked. Details of the report include the issue title, date, participant who reported the issue, person 
to whom the issue is assigned, priority, and status. 

Viewing an Issues Tracking Summary Report: 
1. On the Reports menu, point to Performance Management, select Issue Tracking, and then click 

Summary Report. 

 
 

The Issues Tracking: Summary Report window opens as a tabbed page, displaying a search 
filter and a page toolbar.  

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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The Issues Tracking: Summary Report window is divided into two sections—Issues Tracking 
Query and Select an Issue—that enable you to search and view the status details of existing 
issues. 

 

 
2. To search for an issue, complete one or more of the following fields under Issues Tracking Query:   

Note:  The fields are not required fields, so you have the option to enter as much information as 
you want into the search filter or you can leave all the fields blank. However, leaving all of the 
fields blank when you submit your query will result in the EST displaying all of the issues listed in 
the system. 

• In the Issue ID field, type the identification number assigned to an issue. 

• In the Assignment ID field, type the assignment ID.  

• In the Reporter field, click the drop-down arrow . The field expands, displaying a pre-populated 
list of people who have reported issues. Do one of the following: 

ο Select your name from the list if you want to view or edit issues you have previously reported.  

ο Select another name to view the issues reported by the selected person. 

• In the Assignee field, click the drop-down arrow , and then select the person assigned to take 
action on specific issues. 

Tip!  You can also select a name in the Reporter and Assignee fields by typing the first letter of 
the person's first name. Keep pressing the letter until the name appears.  
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• In the Category field, click the drop-down arrow , and then select a category.  

 

• In the Type field, click the drop-down arrow  and select the type of issue. The Type field 
populates with options related to the category you selected in the Category field.  

• In the Status field, click the drop-down arrow , and then select a status.  

 

• In the Priority field, click the drop-down arrow , and then select a priority. 

 

• In the Resolution field, click the drop-down arrow , and then select a resolution type.  

 

• In the Submission Date Range fields, type the date range when an issue was originally 
submitted.  

• In the Due Date Range fields, type the date range for action item due dates associated with an 
issue. 

Tip!  When typing in dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 
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• If you want to view issues pertaining to a specific organization, click the drop-down arrow  in 
the Organization field, and then select the organization. 

• In the Keywords field, type any words related to your search query. 

3. Click Submit Query. 

 
 

In the Select an Issue section, the Query Results field populates with the results based on your 
search criteria, as shown in the next illustration. 

 

 

4. In the Query Results field, click an issue you want to view. 
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5. Click Selected=>. 

 
6. Repeat Steps 4 and 5 for each issue you want to view. 

Tip! To move all of the issues listed in the Query Results field to the Selected Items field, click 
All Shown=>.  To remove one or more items, select the issue you want removed and click 
Remove.  

7. Click Get Report. 

 
 

The Issues Tracking Summary Report tabbed window opens and displays an expanded page 
toolbar and a Report section listing the selected issues. 
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Tip!   Click the toolbar icon on the Issues Tracking: Summary Report window to: 

 Print a copy of the report. 

  Export the report to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 
8. To view a brief summary of an issue, left-click anywhere on the row.  

 
 

The row expands and displays the issue: 

 
 

Tip!  You can expand and collapse all of the issues listed in the window by clicking the expand 

all    or collapse all   icons. 
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9. To view a detailed summary of an issue, right-click anywhere on the row. 

 
 

A message appears asking if you want to open the issue details in a tabbed window. 

10. Click OK. 

The Issues Tracking: Details Report window opens as a tabbed page, displaying the Issue 
information and Action Items. 

 
 

 

 

3.2.7.5  Performance Monitoring (New 7/31/2009) 
Reports listed under Performance Monitoring enable users to view feedback and annual reports. Monitoring 
reports show agency feedback and performance results, which are displayed as summaries and as details. 
Annual reports document the accomplishments and performance of the ETDM Process and its participants. 
Access to the type of performance monitoring report depends on EST role (e.g., Central Environmental 
Management Office, District ETDM Coordinator etc.). 
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3.2.7.5.1 Agency Annual Reports (New 7/31/2009) 

The Agency Annual Reports function in the Environmental Screening Tool (EST) Reports menu enables 
ETDM participants to view annual reports and annual program review notes for agencies participating in the 
ETDM Process. 

For more details on user roles and privileges, please refer to Chapter 1.5 Roles and Privileges in the EST 
Handbook.  

Viewing Agency Annual Reports: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 

then click Agency Annual Reports. 

 
 

The Agency Annual Reports window opens as a tabbed page, displaying a page toolbar and 
the Agency Annual Reports that are listed in the ETDM Library. 
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Tip!  Click the toolbar icon on the Agency Annual Reports window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. In the Name column, click the Agency Annual Report name. The Library Attachment window opens 
a tabbed window, displaying the report in PDF format.  

 
 

Tip!  Click a column heading to sort the Agency Annual Reports by Name, Category, 
Publication Date, File Extension, and File Size. 

Note: For more information on navigating the ETDM Library, see Chapter 3.6.7 of the EST 
Handbook. 

3. In the Library Attachment window that displays the report PDF, click the navigation icons in left 
column to view the contents of the Agency Annual Report. 

 

Tip!  You can switch between the Library Attachment window displaying the Agency Annual 
Report PDF and the Agency Annual Report window by clicking the tabs.  Click the dark-colored 
tab to display a window, as demonstrated below. 
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Once the window opens, the tab turns white. 

 

4. To print the Agency Annual Report, click the Print icon  located on the top left corner of the 
Library Attachment window. 

5. To save the Agency Annual Report to your desktop or to another location, click the Save icon . 

3.2.7.5.2 Agency Feedback Report (New 7/31/2009) 

The Performance Monitoring function in the Environmental Screening Tool (EST) Reports menu enables 
Central Environmental Management Office managers and support staff to view agency performance reviews, 
feedback reports, and program review notes.  

Agency Feedback Reports are used in the ETDM Performance Management Program to provide a bi-annual 
progress report on agency performance and document actions taken by the Central Environmental 
Management Office managers and support staff to resolve issues presented by the agencies. 

Viewing Agency Feedback Reports: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 

then click Agency Feedback Report. 
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The Agency Feedback Report window opens as a tabbed page, displaying a page toolbar and a 
search filter. 

 

Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Select a Feedback Report, do the following: 

• Click the drop-down arrow  in the Agency field, and then select an agency from the list. 

In the Date Range field, type the date range for the report. 

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 

3. Click Create Report. 

 
 

The Agency Feedback Report window refreshes and displays the Agency Feedback Report for 
the selected agency and date range along with an expanded page toolbar. 

Tip!  Click the toolbar icon on the Agency Feedback Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 
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  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The Agency Feedback Report comprises the following sections: 

• Purpose 

• Project Reviews 

• Off-line Activities 

• Performance Tracking 

• Environmental Technical Advisory (ETAT) Participation 

• Identified Opportunities and Challenges 

4. Click the Agency Review Report link located at the bottom of the Agency Feedback Report window 
for detailed results of the Agency Project Reviews. 

 
 

3.2.7.5.3 Agency Review Matrix (New 7/31/2009) 

The Agency Review Matrix provides Central Environmental Management Office managers and support staff a 
comprehensive view of agency responses to projects submitted for review. 

Viewing the Agency Review Matrix: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and then 

click Agency Review Matrix. 
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The Agency Review Matrix window opens as a tabbed page, displaying a page toolbar and a 
search filter. 

 
 

Tip!  Click the toolbar icon on the Agency Review Matrix window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Select a Reporting Period, do the following: 

• In the Start Date field, type the date the reporting period began. 

• In the End Date field, type the date the reporting period ended. 

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 

3. Click Search. 

 
 

EST generates and displays the Agency Review Matrix. 

Note: The Agency Review Matrix window will remain idle while the report generates. This 
process can take up to a minute.  
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4. Select an agency from the Expected Review for Resource Issues column. 

5. Use the horizontal scroll bar located at the bottom of the window to view the data in the resource issues 
and Total columns.   

Tip!  Pressing and holding the RIGHT ARROW or LEFT ARROW key enables you to scroll 
horizontally across the columns while remaining on your selected row.   
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3.2.7.5.4 Agency Review Report (New 7/31/2009) 

The Agency Review Report enables authorized users to view comprehensive performance measures 
information concerning agency responses to projects submitted for review. 

Viewing the Agency Review Report: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 

then click Agency Review Report. 

 
 

The Agency Review Report window opens as a tabbed page, displaying a page toolbar and a 
search filter. 
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Tip!  Click the toolbar icon on the Agency Review Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Please Specify the Search Criteria Below, do the following: 

• In the Review Agency field, do one of the following: 

ο Accept the default –All- . 

ο Click the drop-down arrow  ,  and then select an agency from the list. 

Note:  For the following illustrations, the Florida Department of Environmental Protection 
(FDEP) has been selected as the Review Agency.  And the value –All- has been selected for 
the remaining fields.   

• In the Counties field, do one of the following: 

ο Accept the default –All- . 

ο Click the drop-down arrow   and select one or multiple counties from the list. 

Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

• In the Issue field, do one of the following: 

ο Accept the default –All- . 

ο Click the drop-down arrow    and select a resource issue from the list. 

• In the Degree of Effect field, do one of the following: 

ο Accept the default –All- . 

ο Click the drop-down arrow    and select a degree of effect from the list. 

• In the Date Review Submitted field, type the From date and the To date. The Date Review 
Submitted field is a required field. 

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 
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3. Click Search Projects. 

 
 

The Agency Review Report window refreshes and expands, displaying the results matching 
your search criteria in the following sections: 

• Review Search Summary 

• ETAT Reviews 

Tip!  Click  to expand the section.  Click  to collapse the section. 

 
 

4. To view the agency review data, expand the Review Search Summary section. This section is 
composed of the following subsections: 

• Selected Search Criteria 

The section displays your selected search criteria. 
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• Review Summary for Selected Agency 

This section displays a table showing the number of screened events along with the number of 
reviews the agency submitted for the screened events within the selected date range and agency 
jurisdiction. 

 
 

Tip!  Rest the mouse pointer on the underscored headings and data to view a brief reference 
description, as shown in the next illustration. 

 
 

• Completed Screening Events by Alternative 

This section displays a table showing the screening events by alternative for the selected date 
range and agency jurisdiction. 

 
 

• Participation for Selected Agency 

This section displays the issues and notifications received by the selected agency under the 
following subsections: 
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ο Selected Agency Resource Issues 

This subsection displays two lists: (1) the Resource Issues for which the selected agency 
is expected to provide reviews and assign Degrees of Effect and  (2) the Resource 
Issues the selected agency may choose to review. 

 

ο Notifications for Assessed Alternatives 

This subsection displays a list of the dates on which the selected agency received 
notification of Environmental Technical Advisory Team (ETAT) Review for each project 
alternative reviewed by the selected agency. In addition, listed notifications may have 
been sent before the reporting period if an associated alternative's review period ended 
within the specified date range. 

 

ο Other Notifications NOT Included in "Notification for Assessed Alternatives" 

The subsection lists the notifications the selected agency may have received but are not 
in the agency's jurisdiction or not associated with a completed screening event within the 
selected date range. 
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ο Assessed Alternatives 

This subsection lists the assessed alternatives. 

 
 

ο Extensions Requested 

This subsection provides a listing of all ETAT Review period extensions requested by the 
selected agency. 

 
 

ο Reviews by Issue 

This subsection lists the expected and submitted reviews by the selected agency for the 
corresponding Resource Issues. 
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Tip!  Rest your mouse pointer on the underscored totals for a brief description of the data, as 
shown in the next illustration. 

 
 

5. To view the details of the ETAT Reviews for the selected agency and time period, expand the ETAT 
Reviews section.  This section displays the reviews based on the completed screening events listed in 
the previous sections of the Agency Review Report window.   

 
 

Review details are listed under Review Detail. 

6. Expand the Review Detail subsection and do the following: 
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• To scroll down the Review Detail section, use the vertical scroll bar.  Alternately, you can use the 
DOWN ARROW and UP ARROW keys. 

• To scroll across the Review Detail section, use the horizontal scroll bar.  Alternately, you can use 
the LEFT ARROW and RIGHT ARROW keys. 

Tip!  You can sort the columns in ascending and descending order by clicking the column 
heading. 

• In the ETDM# column, click the link to view the Project Description Report for the selected Project. 

 
 

The Project Description window opens as a tabbed page, displaying project details. See the 
EST Handbook for information on navigating the Project Description window. 

• In the Degree of Effect column, click the link to view the review details. 
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The ETAT Review Detail window opens as a tabbed page, displaying details for the selected 
Degree of Effect.   

• To send the data in the Review Detail section to an Excel spreadsheet, click export. 

 
 

Note: The columns in the Excel spreadsheet appear in ascending order. Therefore, if you 
change a column to descending order in the ETAT Reviews/Review Detail section of the 
Agency Review Report window, it will not appear the same way in the Excel spreadsheet. 

7. To perform another search, return to the Please Specify the Search Criteria Below section. 

8. Enter your new search criteria by repeating Steps 2 and 3 of these instructions. 

Tip!  Click the Clear Date link to clear the Date Review Submitted fields. 

 
 

3.2.7.5.5 Data Quality Assessment (New 7/31/2009) 

The Data Quality Assessment Report function in the Environmental Screening Tool (EST) Reports menu 
enables Central Environmental Management Office (CEMO) managers and support staff to view performance 
measure information based on ETDM participants' survey rankings. The report delineates data quality 
categories, displaying the project IDs, the number of people responding, and the average ranking of the 
responses regarding a project's data quality and project effects commentary. 
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1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 
then click Data Quality Assessment. 

 
 

The Data Quality Assessment window opens as a tabbed page, displaying a page toolbar and 
the Data Quality Assessment report. 
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Tip!  Click the toolbar icon on the Data Quality Assessment window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

  Add the page to your My ETDM preferences. 

2. Scroll down the Data Quality Assessment window to view the report details. The Data Quality 
Assessment report consists of the following sections: 

• Data Quality Entry Results 

The ETDM Project Data subsection presents a summary of ETAT agency responses to the 
Assess quality of ETDM Project Data field in the Review Purpose & Need Statement 
window.  

The ETAT Comments subsection is detail supporting the ETDM Project Data subsection. 

Tip!  To access the Review Purpose & Need Statement window, go to the EST Tools 
menu, point to Record Results of Project Review, and then click Review Purpose & Need 
Statement. 
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• Individual Data Quality Responses 

This section displays the ratings given by individual ETAT agencies in response to Assess 
quality of ETDM Project Data in the Review Purpose & Need Statement window.  

The ETAT Comments subsection contains supporting detail for the ETDM Project Data 
subsection. 

 
 

• Survey Results 

This section displays selected results from ETAT and District Annual Surveys. 

Tip!  To access the ETAT and ETDM District Coordinator Surveys and Survey Results 
windows, go to the EST Reports menu, point to Performance Management, and then click 
Annual Surveys. 
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• Individual Survey Responses 

This section provides detailed listings of responses from ETAT and District Annual Surveys 
summarized in the previous section. 
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3.2.7.5.6 Environmental/Permitting Documents (New 7/31/2009) 

The Environmental/Permitting Documents function in the Environmental Screening Tool (EST) Reports 
menu enables Central Environmental Management Office Managers to view the environmental documents for a 
selected project. 

Viewing the Environmental/Permitting Documents Report for a Selected Project: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Reports menu, point to Performance Management, select Performance Monitoring, and 
then click Environmental Documents Report. 
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The Environmental/Permitting Documents window opens as a tabbed page, displaying a page 
toolbar and a list of projects with check boxes. 

 
 

Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. To view the environmental and permitting documents for one or multiple projects, click the check box 
beside the project. 
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4. Click the Submit Query button, located at the bottom of the Environmental/Permitting Documents 
window. 

 
 

3.2.7.5.7 ETAT Participation Report (In Development) 

 

3.2.7.5.8 ETAT Review Status (New 7/31/2009) 

The ETAT Review Status function in the Environmental Screening Tool (EST) Reports menu enables 
authorized EST users to view the number of review days left for projects undergoing ETAT review, and agency 
review progress. 

To view the list of user roles and privileges for the ETAT Review Status Report function, see the EST Roles 
and Privileges Matrix in the Overview chapter of the EST Handbook. 
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Viewing the ETAT Review Status Report: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 

then click ETAT Review Status Report. 

 
 

The ETAT Review Status window opens as a tabbed page, displaying a page toolbar and a table 
displaying a list of projects undergoing ETAT review. 
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Tip!  Click the toolbar icon on the ETAT Review Status window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Use the horizontal scroll bar located at the bottom of the window to view the agency review status for a 
project.  

Tip!  Pressing and holding the RIGHT ARROW or LEFT ARROW key enables you to scroll    
horizontally across the columns while remaining on your selected row.   

3.2.7.5.9 ETDM Scorecard (New 7/31/2009) 

The ETDM Scorecard is a performance report that enables Central Environmental Management Office 
Managers and staff to view grades for ETDM agencies, Florida Department of Transportation (FDOT) Districts, 
and the general ETDM Process.   

The scorecard uses a grade to indicate the level of performance.  The color-coded grade, or performance 
indicator, is based upon the particular performance measure, the associated evaluation criteria, and the 
specified period of performance. 

The ETDM Scorecard only includes performance measures for which evaluation criteria have been established.  
The evaluation criteria serve as a benchmark for evaluating the performance and vary by performance 
measure. The performance indicators are represented by three colors: 

• Green = consistently meets expectations 

• Yellow = needs improvement 

• Red = below expectations 

For performance measure details, see Table 7-2, Performance Measures Evaluation Metrics, in the 
Performance Management Handbook. 
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Viewing the ETDM Scorecard: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 

then click ETDM Scorecard. 

 

The ETDM Scorecard window opens as a tabbed page, displaying a page toolbar and a Date 
search filter. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. In the Start Date field, type the start date of the reporting period. 

3. In the End Date field, type the end date of the reporting period. 
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Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 

4. Click Generate Report. 

 
The ETDM Scorecard window refreshes, displaying the ETDM performance measures scorecard 
for the specified time period you entered, along with an expanded page toolbar. 

 

Tip!  Click the toolbar icon on the ETDM Scorecard window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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The ETDM Scorecard window is divided into the following sections: 

• Participation Summary for Agencies with Agreements 

• Participation Summary for FDOT Districts 

• Participation Summary for General ETDM Results 

Each section contains: 

• Performance Measure Descriptions  

This section lists and details the applicable performance measures. 

 
 

• Participation Summary Results  

This section shows the overall Performance Measure grade for each participant: agency, district, 
or general ETDM Process.  Performance Measure grades are based on the responses provided 
in the annual surveys. 
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5. To view the summary details for each performance measure grade, click a cell in a Performance 
Measure column, as shown in the next illustration. 

 
 

A message appears asking if you want to open the selected Performance Measure for a 
participant in a new tab. 

6. Click OK. 

The Performance Measure window opens as a tabbed page, displaying the details of the 
selected participant's Performance Measure grade compared to other participants' performance 
measure grades for the selected reporting period.  

 
 

Note: While each Performance Measure result you select opens a different detail report, the one 
report shown above for Performance Measure 1.1 indicates the percentage of comments 
provided within 60 days by the agencies listed in the far-left column, broken down by district. 
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The overall Performance Measure grade for the selected participant is displayed at the bottom of 
the Performance Measure window. 

 
 

7. To generate another ETDM scorecard for a different date range, click Clear Fields in the ETDM 
Scorecard window, and then type in the date range using the Start Date and End Date fields. 

 

3.2.7.5.10 Performance Measure Results (New 7/31/2009) 

The Performance Measure Results function in the Environmental Screening Tool (EST) Reports menu 
enables Central Environmental Management Office (CEMO) managers and support staff to view summary 
results for specific performance measures.   

1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 
then click Performance Measure Results. 
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The Performance Measure Results window opens as a tabbed page, displaying a page toolbar 
and a search filter with the following fields: 

• Agency 

• District 

• Start Date 

• End Date 

 
 

Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. You can view a Performance Measure Results report for specific agencies, districts, or date ranges by 
completing one or more of the fields in the search filter. 

Note:  The fields are not required fields, so you have the option to enter as much information as 
you want into the search filter or you can leave all the fields blank. However, leaving all of the 
fields blank when you submit your query will result in the EST displaying all agencies and districts 
listed in the system. 

Tip!  When typing in dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 
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3. Click Generate Report. 

The Performance Measure Results window refreshes and expands, displaying the results of 
your search criteria along with an expanded page toolbar. 

 
 

Tip!  Click the toolbar icon in the Performance Measure Summary Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

  Add the page to your My ETDM preferences. 

 

The Performance Measure Summary Report window displays performance measure 
summaries for: 

• Goal 1:  Improve interagency coordination and dispute resolution 

• Goal 2:  Integrate ETDM into project delivery 

• Goal 3:  Develop environmental stewardship through protection of environmental 
resources 

Each Goal section contains the associated performance measures (e.g., Goal 1 contains 
Performance Measures 1.1, 1.2, 1.3 etc…and Goal 2 contains Performance Measures 2.1, 
2.2, 2.3 etc…). 

 

  



 

 Environmental Screening Tool Handbook  3-410 

4. Scroll down the Performance Measure Summary Report window to view the Performance Results 
for each performance measure associated with each goal.   

 
 

Below is a brief desciption of how some of the Performance Measures are presented. 

• Performance Measure description 

Each Performance Measure subsection begins with the Performance Measure number and 
description. Some Performance Measure subsections display a view details button that links to 
other reports. 

 

Tip!  To view the details for a Performance Measure, click the view details button.   

 

• Performance Indicators/Evaluation Criteria  

This area of a subsection describes the performance indicator that is displayed at the bottom of 
Performance Results. 
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• Performance Results 

This area of each Performance Measure subsection displays either a data table, data field, or 
comment field.  

 
 

• Planning Summary Reports published within 60 days 

This area of each Performance Measure subsection displays the number of reports that were 
published within 60 days and the total number of screens along with a Performance Indicator that 
shows if the overall performance meets or is below Expectations. 
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3.2.7.5.11 SCE Evaluation Participation Report (In Development) 

 

3.2.7.5.12 Summary Report Status Report (New 7/31/2009) 

The Summary Report Status Report function in the Environmental Screening Tool (EST) Reports menu 
enables Central Environmental Management Office Managers and support staff to view performance measure 
information regarding published Planning and Programming Summary Reports. 

Viewing the Summary Report Status Report: 
1. On the Reports menu, point to Performance Management, select Performance Monitoring, and 

then click Summary Report Status Report. 

 
 

The Summary Report Status Report window opens as a tabbed page, displaying a page toolbar 
and a search filter. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

Note:  For additional information about using the EST page toolbar buttons, refer to Chapter 
2.8 of the EST Handbook. 

2. Click the drop-down arrow   in the Phase field, and select the project phase. 

 
 

3. In the Counties field, select one, multiple, or All counties. 

Tip! You can select multiple entries by pressing SHIFT+click for adjacent entries or CTRL+click 
for non-adjacent entries. 

 
 

4. In the Date Summary Report Was Published field, enter the date range. 

Tip!  When typing dates, use the mm/dd/yyyy format.  Alternately, you can click the calendar 

icon  and select the dates. 
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5. Click Search. 

 
The Summary Report Status Report window refreshes and expands, displaying the summary 
report details for your selected criteria along with an expanded page toolbar. 

 

Tip!  Click the toolbar icon on the Summary Report Status Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 
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  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The Summary Report Status Report window is divided into the following sections: 

• Selected Criteria Summary 

This section displays your selected criteria. 

 

• Combined Planning/Programming Summary Reports Generated During Selected Time 
Period 

This section displays the total published and republished reports for the selected time period.  

 

• Summary Report Matrix 

This section displays the total number of reports published and republished by district, state, and 
Turnpike. 

 

• Selected Project Phase Summary Report Details 

This section displays the details of the summary reports for the selected project phase. 
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• Unpublished Summary Reports 

This section displays a list of unpublished summary reports. 

 

Note:  Double asterisks (**) indicate that the Summary Report due date was extended because 
the ETDM Coordinator granted a reviewer an extension. 

6. To send the Summary Report Status Report to another person, click Save PDF and Display Email 
Form. 

 
The Summary Report Status Report window refreshes, displaying an email form. 

Note:  EST automatically displays your email address along with the PDF file's name and 
location. 
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7. Complete the following fields, as needed: 

• To 

• Subject 

• Comments 

Tip! You can switch between the current and immediately preceding EST windows by pressing 
ALT + LEFT ARROW keys or ALT+ RIGHT ARROW keys. 

8. Click Send Report. 

The Summary Report Status Report window refreshes, displaying a confirmation.      

 
 

9. To view another Summary Report Status Report, click Show Search Selection Box. 

 
 

EST returns you to the Summary Report Status Report window and blank search filter. 
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3.2.7.6  Quality Assurance Review (New 7/31/2009) 
Reports listed under Quality Assurance Review enable Central Central Environmental Management Office 
managers and staff to monitor the overall performance of the ETDM Process. Information from these reports is 
used for ETDM progress reports. 

3.2.7.6.1 Class of Action Quality Assurance Report (New 7/31/2009) 

The Class of Action Quality Assurance Report function in the Environmental Screening Tool (EST) Reports 
menu enables Environmental Management Office (CEMO) staff and Florida Department of Transportation 
(FDOT) ETDM Coordinators and ETDM Coordinators Primary to view Class of Action (COA) summaries for 
FDOT Districts and Florida's Turnpike Enterprise. 

Viewing a COA Quality Assurance Report: 
1. On the Reports menu, point to Performance Management, select Quality Assurance Review, and 

then click Class of Action Quality Assurance Report. 

 
 

The Class of Action Quality Assurance Report window opens as a tabbed page, displaying a 
page toolbar and a search filter. 
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Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Please Specify the Search Criteria Below, do the following: 

• In the Districts field, select one of the following: 

ο —All— 

ο FDOT District Number 

ο Florida's Turnpike Enterprise  

Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

• In the Final Programming Screen Summary Report Publication Date field, type the date range 
for the report.  

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can also click the 

calendar icon  and select the dates. 

3. Click Search. 

 
 

The Class of Action Quality Assurance Report window refreshes and displays the report 
matching your search criteria along with an expanded toolbar. 

Tip!  You can expand and collapse all of the window sections by clicking the expand all    or 
collapse all   icons. 
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Tip!  Click the toolbar icon on the Class of Action Quality Assurance Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

4. Scroll down the Class of Action Quality Assurance Report window to view the report, which is divided 
into the following sections: 

• Selected Criteria Summary 

This section of the report displays your selected criteria. 
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• Programming Phase Summary 

This section displays the Programming Phase summary of the total number of projects with COA 
Determinations, the total number of projects for which the COA has been accepted by the Lead 
Agency, and the percentage of projects for which the COA has been accepted for the selected 
time period within the state and for the selected Planning Organization.  

 
 

ο To view the report details for the selected Planning Organization, click the link on the selected 
row in the Percentage of Project(s) w/COA Consistently Accepted column.  See Step 5 for 
further instructions on viewing the report details. 

ο To view the report details for all Planning Organizations within the state, click the link on the 
Statewide Totals row in the Percentage of Project(s) w/COA Consistently Accepted 
column.  See Step 6 for further instruction on viewing the report details. 

• COAs Determined that have not been accepted yet by the Lead Agency 

This section displays the the COAs that are still waiting for acceptance by the Lead Agency. 

 
 

Tip!  Click the column headings to sort the columns in ascending or descending order.  

5. To view the report details for the selected Planning Organization, click the link on the selected row in 
the Percentage of Project(s) w/COA Consistently Accepted column.   

 
 

The Class of Action Quality Assurance Report window refreshes and expands, displaying the 
COA summary details for the selected Planning Organization in a table, which breaks down the 
data by: 

• ETDM Project 

• Times COA was Recommended 
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• Times COA was not Accepted 

• Day(s) to accept the COA from Initial Recommendation 

• Lead Agency 

• Initial COA Recommendation 

• Final COA Accepted 

• COA Consistently Determined (Yes or No) 

 
 

Tip!  Click the Go Back to Summary Table link at the bottom of the Programming Detail for 
Planning Organization table to return to the Programming Phase Summary section. 

6. To view the report details for all Planning Organizations within the state, click in the Percentage of 
Project(s) w/COA Consistently Accepted column on the Statewide Totals row.   

 
 

The Class of Action Quality Assurance Report window refreshes and expands, displaying the 
COA summary details for each Planning Organization. (The next illustration shows a segment of 
the COA summary details that are displayed for each Planning Organization.) 

 

Note:  Clicking Send Report to EDMS enables CEMO Managers, FDOT ETDM Coordinators-            
Primary, and FDOT Coordinators to send reports to the Electronic Document Management 
System (EDMS). 
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7. Under EDMS Integration, click Send Report to EDMS to send the list of reports matching the 
selected criteria to the EDMS.  

 

3.2.7.6.2 Integrated Performance Management QA Report (New 7/31/2009) 

The Integrated Performance Management QA Report function in the Environmental Screening Tool (EST) 
Reports menu enables Central Environmental Management Office (CEMO) Managers and Florida Department 
of Transportation (FDOT) ETDM Coordinators and ETDM Coordinators Primary to view summaries of QA 
Reports related to the performance of FDOT Districts and Florida’s Turnpike Enterprise. The report indicates 
percentages for a selected District (or Districts), compared to statewide and target percentages, for seven 
performance measure criteria (designated Report Q1 through Report Q7).  

Viewing an Integrated Performance Management QA Report: 
1. On the Reports menu, point to Performance Management, select Quality Assurance Review, and 

then click Integrated Performance Management QA Report. 
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The Integrated Performance Management QA Report window opens as a tabbed page, 
displaying a page toolbar and a search filter. 

 

Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Please Specify the Search Criteria Below, do the following: 

• In the Districts field, select one of the following from the list: 

ο –All– 

ο FDOT District  

ο Florida's Turnpike Enterprise 

Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

• In the Date Range fields, type the date range of the report.  

 

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can click the calendar 

icon  and select the dates. 

• In the For Q4 Reports - Length of Public Comments field, click the drop-down arrow , and 
then select a variable from the list.   
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3. Click Search. 

 
 

The Integrated Performance Management QA Report window refreshes and displays the 
report matching your search criteria, along with an expanded toolbar. 

Tip!  You can expand and collapse all of the window sections by clicking the expand all    or 
collapse all   icons. 

 
 

Tip!  Click the toolbar icon on the Integrated Performance Management QA Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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4. Scroll down the window to view the report, which is divided into the following sections: 

• Selected Criteria Summary 

This section of the report displays your selected criteria. 

 

• Summary 

This section displays a table showing percentages for the selected Organization's (or 
Organizations') performance related to the seven Performance Measure criteria, along with the 
Statewide Totals and Target percentages for each criterion.  

Note: Cells with a green background, , indicate the Planning Organization exceeded the 

target percentage. Cells with a yellow background, , indicate the Planning Organization 
did not exceed the target percentage. 

 

5. Under Summary, click the link in the FDOT Selected District column to view the report details for each 
performance criterion (i.e., Q1 through Q7).   

(For the next illustration, the report for performance criterion Q1 – Percent of Planning Screen 
Summary reports published within 60 days of comment deadline was selected.) 
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The Name of Report window opens as a tabbed page, displaying the report for the selected 
district along with links for accessing additional details.   

(The next illustration displays the Summary Report Status by Planning Org window that shows 
the report  for Performance Criterion Q1, which was selected in the Summary section of the 
Integrated Performance Management window.) 

 
 

Tip!  Click the links in the Selected Phase Summary section of the Name of Report window for 
additional report details. 

 
 

6. Click the Integrated Performance Management tab to select another report from the Summary 
section of the Integrated Performance Management window. 
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7. Repeat Step 5 to select another Report for the selected Planning Organization. 

8. To view a detailed statewide comparison for a selected Report, click the corresponding link in the 
Statewide Totals column. (For the next illustration, the Statewide Total—82.61%—for Report – Q1 
was selected.) 

 
 

The Name of Report window opens as a tabbed page and displays a table showing the data for 
each Planning Organization along with links for accessing additional report details.  

(In the next illustration, the Summary Report Status by Planning Organization window is 
shown, displaying the statewide totals for Report-Q1, which was selected in the Summary 
section of the Integrated Performance Management window.) 
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Tip!  Click the links in the Selected Phase Summary section of the the Name of Report window 
for additional report details. 

9. To select and open another report from the Statewide Totals column in the Integrated Performance 
Management window, click the Integrated Performance Management tab. 

 

10. Repeat Step 8 to select the Statewide Totals for another Report. 

Note:  Clicking Send Report to EDMS enables CEMO Managers, FDOT ETDM Coordinators-            
Primary, and FDOT Coordinators to send reports to the Electronic Document Management 
System (EDMS). 

11. Under EDMS Integration, click Send Report to EDMS to send the list of reports matching the 
selected criteria to the EDMS.  

 

3.2.7.6.3 Summary of Public Comments Status Report (New 7/31/2009) 

The Summary of Public Comments Status Report function in the Environmental Screening Tool (EST) 
Reports menu enables Central Environmental Management Office (CEMO) staff and Florida Department of 
Transportation (FDOT) ETDM Coordinators to view the percentage of public comment summaries produced by 
selected planning organizations. 

Viewing a Summary of Public Comments Status Report 
1. On the Reports menu, point to Performance Management, select Quality Assurance Review, and 

then click Summary of Public Comments Status Report. 

 



 

 Environmental Screening Tool Handbook  3-430 

The Summary of Public Comments Status Report window opens as a tabbed page, displaying 
a page toolbar and a search filter. 

 

Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Please Specify the Search Criteria Below, do the following: 

• Click the drop-down arrow  in the Phase field, and then select one of the following: 

ο Planning and Programming 

ο Planning 

ο Programming 

• Do one of the following: 

ο To select an FDOT Planning Organization, click the option button next to the Districts field, 
and then select one of the following: 

 —All— 

 FDOT District Number 

 Florida's Turnpike Enterprise  

ο To select a Metropolitan Planning Organization (MPO) or Transportation Planning 
Organization (TPO), click the option button next to the MPO field, and then select one of the 
following: 

 —All— 

 Name of MPO or TPO  
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Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

• In the Summary Report Publication Date fields, type the date range for the report. 

 

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can click the calendar 

icon  and select the dates. 

• In the Length of Public Comments field, click the drop-down arrow , and then select a 
variable from the list.   

 
3. Click Search. 

 
The Summary of Public Comments Status Report window refreshes and displays the report 
matching your search criteria, along with an expanded toolbar. 

Tip!  You can expand and collapse the window sections by clicking the expand all    or 
collapse all   icons. 
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Tip!  Click the toolbar icon on the Summary of Public Comments Status Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The report is divided into the following sections: 

• Selected Criteria Summary 

This section of the report displays your selected criteria. 

 

• Selected Phase Summary 

The EST displays a table showing the total number of Summary Reports completed by the 
selected Planning Organization(s), and also shows statewide comparisons, total number of public 
comment summaries, and the percentage of completed summaries of public comments.  

4. To view public comments for a selected Planning Organization (FDOT or MPO/TPO) or for 
Statewide Totals, click the link on the selected row in the Percentage of Summary of Public 
Comments Completed column.   

 
The Summary of Public Comments Status Report window refreshes and expands, displaying 
a Phase Detail for Planning Organization table that breaks down information by: 

• ETDM Project 

• Review Cycle 

• Publication Type 

• Date Summary Report(s) Published 
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• Review Start Date 

• Review End Date 

• Public Comments (Yes or No) 

For Statewide Totals, the Summary of Public Comments Status Report window refreshes 
and expands, displaying all of the Phase Detail for Planning Organization tables: 

• If you selected Districts in the search criteria, the EST displays all FDOT Districts and Florida's 
Turnpike Enterprise. (The next illustration shows a segment of the Planning Detail section.) 

 
 

• If you selected MPO in the search criteria, the EST display all MPOs and TPOs. (The next 
illustration shows a segment of the Planning Detail section.) 

 

Tip!  Click the Go Back to Phase Detail link at the bottom of the Phase Detail for Planning 
Organization table to return to the Phase Summary section. 
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5. Click the Yes link in the Public Comments column to view the public comments for an ETDM project. 

 
 

The Summary of Public Comments window opens as a tabbed page, displaying the comments 
for the selected ETDM project. The length of the comments is based on the Length of Public 
Comments selection in the search criteria (See Step 2).  

 
 

6. To view comments for other ETDM projects, click the Summary of Public Comments Status Report 
tab to return to the Summary of Public Comments Status Report window.  
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7. Repeat Steps 4 and 5 to view the public comments for a selected ETDM project. 

Note:  Clicking Send Report to EDMS enables CEMO Managers, FDOT ETDM Coordinators-            
Primary, and FDOT Coordinators to send reports to the Electronic Document Management 
System (EDMS). 

8. Under EDMS Integration, click Send Report to EDMS to send the list of reports matching the 
selected criteria to the EDMS.  

 
 

3.2.7.6.4 Summary Report Status by Planning Org Report (New 7/31/2009) 

The Summary Report Status by Planning Org Report function in the Environmental Screening Tool (EST) 
Reports menu enables Central Environmental Management Office (CEMO) Managers and Florida Department 
of Transportation (FDOT) ETDM Coordinators to view Performance Measure results related to the first 
publication of Summary Reports produced by FDOT Districts and Florida’s Turnpike Enterprise for individual 
ETDM projects. 

Viewing a Summary Report Status by Planning Org Report 
1. On the Reports menu, point to Performance Management, select Quality Assurance Review, and 

then click Summary Report Status by Planning Org Report. 
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The Summary Report Status by Planning Org Report window opens as a tabbed page, 
displaying a page toolbar and a search filter. 

 
 

Tip!  Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. Under Please Specify the Search Criteria Below, do the following: 

• Click the drop-down arrow  in the Phase field, and then select one of the following: 

ο Planning and Programming 

ο Planning 

ο Programming 

• In the Districts field, click the drop-down arrow , and then select one of the following: 

ο —All— 

ο FDOT District Number 

ο Florida's Turnpike Enterprise  

Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

• In the Summary Report First Publication Date fields, type the date range for the report. 
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Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can click the calendar 

icon  and select the dates. 

3. Click Search. 

 
 

The Summary Report Status by Planning Org Report window refreshes and displays the 
report matching your search criteria, along with an expanded toolbar. 

Tip!  You can expand and collapse all the window sections by clicking the expand all    or 
collapse all   icons. 

 
 

Tip!  Click the toolbar icon on the Summary Report Status by Planning Org Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 
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  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

The report is divided into the following sections: 

• Selected Criteria Summary 

This section of the report displays your selected criteria. 

 

• Selected Phase Summary 

The EST displays a table showing the total number of Summary Reports published for the first 
time by the selected Planning Organizations, total number of Summary Reports published for the 
first time within 60 days, and the percentage of Summary Reports published on time.  

Note:  If you selected the Planning and Programming option as your search criteria, the EST 
displays a separate table for each phase, as shown in the next illustration. 

 
 

ο To view the report details for the selected Planning Organization, click the link on the selected 
row in the Percentage of Summary Reports Published on time column.  See Step 4 for 
further instructions on viewing the report details. 

ο To view the report details for all Planning Organizations within the state, click the link on the 
Statewide Totals row in the Percentage of Summary Reports Published on time column.  
See Step 5 for further instruction on viewing the report details. 
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4. To view the report details for the selected Planning Organization, click the link on the selected row in 
the Percentage of Summary Reports Published on time column.   

 
 

The Summary Report Status by Planning Org Report window refreshes and expands, 
displaying a Phase Detail for Planning Organization table that breaks down information by: 

• ETDM Project 

• Review Cycle 

• Review Start  

• Review End 

• Summary Report Due 

• Date Published 

• Days to Publish 

• Published On-Time (Yes or No) 

 

 
 

Tip!  Click the Go Back to Phase Detail link at the bottom of the Phase Detail for Planning 
Organization table to return to the Phase Summary section. 

5. To view the report details for all Planning Organizations within the state, click in the Percentage of 
Summary Reports Published on time column on the Statewide Totals row.   
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The Summary Report Status by Planning Org Report window refreshes and expands, 
displaying the summary report details for all Planning Organizations related to the selected 
phase. (The next illustration shows a segment of the Programming Detail section.) 

 

 
Tip!  Click the Go Back to Phase Detail link at the bottom of the Phase Detail for Planning 
Organization section to return to the Phase Summary section. 

 
 

Note:  Clicking Send Report to EDMS enables CEMO Managers, FDOT ETDM Coordinators-            
Primary, and FDOT Coordinators to send reports to the Electronic Document Management 
System (EDMS). 

6. Under EDMS Integration, click Send Report to EDMS to send the list of reports matching the 
selected criteria to the EDMS.  

3.2.7.7  State Clearinghouse Federal Audit Report (New 7/31/2009) 
The State Clearinghouse Federal Audit Report function in the Environmental Screening Tool (EST) Reports 
menu provides the Central Environmental Management Office a breakdown of the Federal Consistency 
Determination totals for closed ETDM projects.  
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Viewing the State Clearinghouse Federal Audit Report: 
1. On the Reports menu, point to Performance Management, and then click State Clearinghouse 

Federal Audit Report. 

 
The State Clearinghouse Audit Report window opens, displaying a search filter, along with a 
page toolbar. 

 
 

Tip!  Click the toolbar icon on the State Clearinghouse Federal Audit Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 



 

 Environmental Screening Tool Handbook  3-442 

2. In the Project Close Date fields, type the date range to view projects closed within a specific time 
period.  

 

Tip!  When typing dates, use the mm/dd/yyyy format. Alternately, you can click the calendar 

icon  and select the dates. 

3. Click Search. 

 
The State Clearinghouse Federal Audit Report window refreshes and expands, displaying the 
selected search criteria and the Number of Projects: 

• Receiving Federal Consistency 

• Affected by the Process 

• with Consistent Determination 

• with Consistent w/Comments Determination 

• with Inconsistent Determination 
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3.2.8  Invoicing Reports (Updated 7/22/2008) 
Reports listed under Invoicing Reports enable Primary Agency Invoice Submitters, Invoice Reviewers, and 
Invoice Administrators to monitor agency activities, invoices, payments, and contracts. 

Although all the participating agency users of the electronic invoicing process can access the reports, they will 
only be able to view data associated with their agency.  The Invoice Administrator and the Invoice Reviewers 
are the only individuals that can view the invoicing data for all agencies.   

 
 

3.2.8.1  Advance Pay Request Log (Updated 07/22/2008) 
The Advance Pay Request Log displays a list of 
Advance Pay Requests by Agency and/or Master 
Agreement (MA)/Contract Number.  The report 
includes the following information: Organization, 
MA/Contract Number, Advance Payment Number, 
Request Date, Payment Cost, Payment Count, and 
Balance.  The list of Advance Pay Requests will 
initially appear in chronological order, but may be 
sorted by any column. 

In the Reports menu, point to Invoicing Reports, 
and then click Advance Pay Request Log.  
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The Advance Pay Request Log window opens, displaying an Add Agreements section containing a form. 

 
When the form opens, begin by selecting an organization.   

Type in all or part of an organization’s name.  A list of organizations will be displayed in a drop-down menu.  
Select an organization.  Note that Agency users are able to view information only for their agency.  Invoice 
Administrators and Invoice Reviewers are able to view information for all agencies. 

 

The agreements for the selected organization will be listed under “Agreements for this organization.”  The 
organization selected to generate this example is Northwest Florida Water Management District.  The 
information that is shown is for example purposes only and does not reflect actual Northwest Florida Water 
Management District agreements or invoices.   

Select agreements by clicking on the agreement number (which will then be highlighted in blue), then click the 
“Selected=>” button.  To select all the agreements listed, click the “All Shown=>” button.  To remove an 
agreement from the list of Selected Agreements, click on the agreement number, then click the “Remove” 
button.   
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Invoice Administrators and Invoice Reviewers can add agreements for another organization by typing in all or 
part of the organization’s name in the “Organization” field, and following the same process as for the first 
organization.   

When finished, click the “Create Report” button at the bottom of the form. 

The report that opens will display information about the selected agreements, as shown below.  The information 
can be sorted by clicking a column header.  For the example shown, only one agreement was selected.  The 
information that is shown is for example purposes only and does not reflect actual Northwest Florida Water 
Management District agreements or invoices. 

 

 

 

 

 

 

The 

Advance Pay Request Log can be printed by clicking the printer icon  in the upper right-hand corner of 

the report.  To view a PDF of the Advance Pay Request Log, click the  button at the top of the screen.  
You can then review, save, or print the Advance Pay Request Log. 

3.2.8.2  Advance Pay Request Report (Updated 07/22/2008) 
The Advance Pay Request Report displays a specific Advance Pay Request that has been saved in the 
database.  The Advance Pay Request is selected by Agency Name, MA/Contract Number, Advance Pay/ 
Invoice Number, or Payment Date.   

In the Reports menu, point to Invoicing Reports, and then click Advance Pay Request Report. 
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When the form opens, begin by selecting an agency.   

Type in all or part of an agency’s name.  A list of organizations will be displayed in a drop-down menu.  Select 
an agency.  Note that Agency users are able to view information only for their agency.  Invoice Administrators 
and Invoice Reviewers are able to view information for all agencies. 

 
The form will be automatically populated with a list of Advance Pay Requests for the selected agency.  The 
organization selected to generate this example is Northwest Florida Water Management District.  The 
information that is shown is for example purposes only and does not reflect actual Northwest Florida Water 
Management District agreements or invoices.   

Select an Advance Pay Request from the “Advance Pay Requests” pull-down menu.  Then click the “Create 
Report” button. 

 
Advance Pay Requests for a specific Master Agreement/Contract or a specific Advance Pay Request may also 
be accessed by typing in an MA/Contract Number, Advance Pay/Invoice Number, or Agency Name and 
Payment Date, then pressing the Tab key.  After the form is populated based on the information you entered, 
select the Advance Pay Request from the “Advance Pay Requests” pull-down menu.  Then click the “Create 
Report” button. 
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An example Advance Pay Request Report is shown below.  Again, the information shown is for example 
purposes only and does not reflect actual Northwest Florida Water Management District agreements or 
invoices.   

 

The Advance Pay Request Report can be printed by clicking the printer icon  in the upper right-hand 

corner of the report.  To view a PDF of the Advance Pay Request Report, click the  button at the top of 
the screen.  You can then review, save, or print the Advance Pay Request Log. 
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3.2.8.3  Agency Activity Report (Updated 07/22/2008) 
The Agency Activity Report displays the agency activities for a specified invoicing period.  Each report includes 
the following sections: Accomplishments Made during Last Period, Summary of ETDM Screening Activities, 
Anticipated Accomplishments for Next Period, Off-line Agency Activity Log (if applicable), and Planning Screen 
and/or Programming Screen Comments (by project). 

In the Reports menu, point to Invoicing Reports, and then click Agency Activity Report. 

 
 

When the form opens, use the pull-down menus to select search criteria.  Note that Agency users are able to 
view information only for their agency.  Invoice Administrators and Invoice Reviewers are able to view 
information for all agencies, and would begin by selecting an agency from the Agency pull-down menu. 

 

The form will be populated with a list of available invoices.  Select an item from the list, and then click the 
“Create Report” button. 
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The report that opens will display information about agency activities entered in the database for the selected 
agency and invoicing period.  The top portion of the report provides the form for selecting a different agency 
(only available to the Invoice Administrator and Invoice Reviewers) or invoicing period.  Follow the same steps 
used for selecting the agency name or invoicing period, as described above. 

The next portion of the Agency Activity Report displays information about agency activities entered in the 
database for the selected agency and invoicing period, as shown in the example below.  The information shown 
is for example purposes only and does not reflect actual agency activities. 

 

 

 

 

 



 

 Environmental Screening Tool Handbook  3-450 

The Accomplishments Made During Period and Summary of ETDM Screening Activities sections are followed 
by Anticipated Accomplishments for Next Period, Off-line Agency Activity Log (if applicable), and Planning 
Screen and/or Programming Screen Comments (by project).  Use the cursor on the right side of the screen to 
scroll to these sections. 

 

The Agency Activity Report can be printed by clicking the printer icon  in the upper right-hand corner of 

the report.  To view a PDF of the Agency Activity Report, click the  button at the top of the screen.  You 
can then review, save, or print the Agency Activity Report. 
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3.2.8.4  District Invoice Reviewer Report (New 07/22/2008) 
The District Invoice Reviewer Report displays lists of FDOT District Invoice Reviewers and Agencies Selected 
by Districts for Invoice Review, followed by a District and Agency Invoice Review Matrix.  This report is available 
to the Invoice Administrator. 

In the Reports menu, point to Invoicing Reports, and then click District Invoice Reviewer Report. 

 
An example District Invoice Reviewer Report is shown in the next illustration. 
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The lists of FDOT District Invoice Reviewers and Agencies Selected by Districts for Invoice Review are followed 
by the District and Agency Invoice Review Matrix, a portion of which is shown below. 

 

3.2.8.5  Invoice Comment Log (Updated 07/22/2008) 
The Invoice Comment Log report displays reviewer comments for a selected invoice.  This report is available to 
CEMO Invoice Reviewers and the Invoice Administrator.   

In the Reports menu, point to Invoicing Reports, and then click Invoice Comment Log. 
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When the form opens, use the pull-down menus to select search criteria.  Begin by selecting an agency from 
the Agency pull-down menu.  The form will be automatically populated with a list of invoicing periods for the 
selected agency.  Select an invoicing period from the “Invoicing Period” pull-down menu.  Then click the “Create 
Report” button.   

 
The report that opens will display reviewer comments entered in the database for the selected agency and 
invoicing period.  The agency selected to generate this example is Northwest Florida Water Management 
District.  The information shown is for example purposes only and does not reflect actual Northwest Florida 
Water Management District agreements or invoices.  The top portion of the report provides the form for 
selecting a different agency or invoicing period.  Follow the same steps used for selecting the agency name or 
invoicing period as described above.   

 

The Invoice Comment Log can be printed by clicking the printer icon  in the upper right-hand corner of 

the report.  To view a PDF of the Invoice Comment Log, click the  button at the top of the screen.  You 
can then review, save, or print the Invoice Comment Log. 
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3.2.8.6  Invoice Tracking Report (Updated 06/30/2008) 
The Invoice Tracking Report lists invoices and their status.  The invoices to be displayed in an Invoice Tracking 
Report are selected by agency, agreement number, invoice number, or submittal date range.   

In the Reports menu, point to Invoicing Reports, and then click Invoice Tracking Report.     

 
 
When the form opens, use the input fields to specify search criteria.  Begin by selecting an organization name. 
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Type in all or part of an organization’s name.  A list of organizations will be displayed in a drop-down menu.  
Select an organization.  Note that Agency users are able to view information only for their agency.  Invoice 
Administrators and Invoice Reviewers are able to view information for all agencies. 

 
 
 
 

 
A list of invoices for the selected organization will be displayed under “Invoices for available criteria.”  The 
organization selected to generate the example shown below is Northwest Florida Water Management District.  
The information shown is for example purposes only and does not reflect actual Northwest Florida Water 
Management District agreements or invoices.   

Invoice Tracking Reports can also be accessed for a specific Agreement/Contract, a specific invoice, or  
submission dates by typing in a Master Agreement/Contract Number, Invoice Number, or  Earliest Submission 
Date and Latest Submission Date.  The Earliest Submission Date and Latest Submission Date fields are used 
to specify a date range.  Select the dates by either entering the dates in dd/mm/yyyy format or clicking the  
icon to select the date from a calendar.  A list of invoices matching the search criteria will be displayed under 
“Invoices for available criteria.” 

 

 

 

 

 

 

 

 

 

Select invoices by clicking on the invoice number (which will then be highlighted in blue), then click the 
“Selected=>” button.  To select all the invoices listed, click the “All Shown=>” button.  To remove an invoice from 
the list of Selected Invoices, click on the invoice number, then click the “Remove” button.  To obtain information 
on all invoices for the selected agency, click the check box above “Ignore the selected list and report on all 
invoices.” 

To add invoices for another organization, type in all or part of the organization’s name in the “Organization” field, 
and follow the same process as for the first organization.  When finished, click the “Create Report” button at the 
bottom of the form. 

The report that opens will display information about the selected invoices, as shown below.  The information can 
be sorted by clicking a column title (for example, Agency, MA/Contract Number, Invoice Number, or Invoice 
Status).  The information shown is for example purposes only and does not reflect actual Northwest Florida 
Water Management District agreements or invoices.   
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The Invoice Tracking Report can be printed by clicking the printer icon  in the upper right-hand corner of 

the report.  To view a PDF of the Invoice Tracking Report, click the  button at the top of the screen.  You 
can then review, save, or print the Invoice Tracking Report. 

3.2.8.7  MA/Contract History Report (Updated 07/22/2008) 
The MA/Contract History Report lists the Organization, MA/Contract Number, Notice to Proceed Date, End of 
Service Date, contract limits (Salary, Training, Travel, and Other), and Change Notes for Master 
Agreements/Contracts in the database.  The user may search for one or multiple agencies to be included in the 
report.  

In the Reports menu, point to Invoicing Reports, and then click MA/Contract History Reports. 
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When the form opens, begin by selecting an organization.   

 

Type in all or part of your organization’s name.  Your organization’s name will be displayed in a drop-down 
menu.  Select your organization.   

 

The agreements for your organization will be listed under “Agreements for this organization.”  The organization 
selected to generate this example is Northwest Florida Water Management District.  The information that is 
shown is for example purposes only and does not reflect actual Northwest Florida Water Management District 
agreements or invoices.  Select agreements by clicking on the agreement number (which will then be 
highlighted in blue), then click the “Selected=>” button.  To select all the agreements listed, click the “All 
Shown=>” button.  To remove an agreement from the list of Selected Agreements, click on the agreement 
number, then click the “Remove” button.  The Invoice Administrator and Invoice Reviewers can add agreements 
for another organization by typing in all or part of the organization’s name in the “Organization” field, and 
following the same process as for the first organization.   

When finished, click the “Create Report” button at the bottom of the form. 
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The report that is generated will display information about the selected agreements, as shown below.  The 
information can be sorted by clicking a column title (for example, Organization, MA/Contract Number, Salary 
Limits, etc.).  For the example shown, only one agreement was selected. 

 

A PDF version of the report can be printed by clicking the printer icon  in the upper right-hand corner of 
the report. 

3.2.8.8  MA/Contract Summary Report (Updated 07/22/2008) 
The MA/Contract Summary Report displays information about agency agreements that are in the ETDM 
database.   

In the Reports menu, point to Invoicing Reports, and then click MA/Contract Summary Report. 

 
 

 

  



 

 Environmental Screening Tool Handbook  3-459 

The MA/Contract Summary Report window opens, displaying a Select/Load an Agreement section. In the 
Organization field, type the name of the organization. Type in all or part of an organization’s name.   

 
 

A list of organizations will be displayed in a drop-down menu.  Select an organization.  Note that Agency users 
are able to view information only for their agency.  Invoice Administrators and Invoice Reviewers are able to 
view information for all agencies.   

 

Select an agreement from the “Existing Agreements” pull-down menu, then click the “Create Report” button. 

 

The screen that opens displays information about the selected agreement.   

 

 



 

 Environmental Screening Tool Handbook  3-460 

The MA/Contract Summary Report can be printed by clicking the printer icon  in the upper right-hand 

corner of the report.  To view a PDF of the MA/Contract Summary Report, click the  button at the top of 
the screen.  You can then review, save, or print the MA/Contract Summary Report. 

3.2.8.9  Payment Tracking/Invoice Report (Updated 07/22/2008) 
The Payment Tracking/Invoice Report includes a summary of the agreement information pertaining to an 
invoice, followed by completed Schedule A-1 (Salary Costs), Schedule A-2 (Hours Assignments), Schedule E-1 
(Reimbursable Direct Expense – Travel), Schedule  E-2 (Reimbursable Direct Expense – Training), and 
Schedule  E-3 (Reimbursable Direct Expense – Other) forms.  The report also includes information about 
Agency Activities associated with an invoice. 

In the Reports menu, point to Invoicing Reports, and then click Payment Tracking/Invoice Report. 

 
 

When the form opens, begin by selecting an organization. 
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Type in all or part of an organization’s name.  A list of organizations will be displayed in a drop-down menu.   

 

Select an organization.  Note that Agency users are able to view information only for their agency.  Invoice 
Administrators and Invoice Reviewers are able to view information for all agencies. 

The form will be automatically populated with a list of invoices for the selected agency.   

The organization selected to generate this example is Northwest Florida Water Management District.  The 
information that is shown is for example purposes only and does not reflect actual Northwest Florida Water 
Management District agreements or invoices.   

 

Select an invoice from the “Invoice List” pull-down menu.  Then click the “Create Report” button. 
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Payment Tracking/Invoice records for invoices can also be accessed for a specific Master Agreement/Contract, 
a specific invoice, or submission dates by typing in a Master Agreement/Contract Number, Invoice Number, or  
Earliest Submission Date and Latest Submission Date.  The Earliest Submission Date and Latest Submission 
Date fields are used to specify a date range.  Select the dates by either entering the dates in dd/mm/yyyy format 
or clicking the  icon to select the date from a calendar.  Select the invoice from the “Invoice List” pull-down 
menu.  Then click the “Create Report” button. 

 

The report that is generated will display the information for the selected invoice, as an “Invoice Summary Sheet.”  
The top portion of the Invoice Summary Sheet provides the form for selecting a different invoice.  Follow the 
same steps used for selecting the first invoice, as described above. 

The next portion of the report displays information about the Agreement/Contract associated with the selected 
invoice, as shown below.  Again, the information shown is for example purposes only and does not reflect actual 
Northwest Florida Water Management District agreements or invoices. 
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The Agreement/Contract information for the selected invoice is followed by the Schedule A-1, Schedule A-2, 
Schedule E-1, Schedule E-2, and Schedule E-3 information for the selected invoice.  The Schedule A-1 and 
portions of the Schedule E-1 information for the example invoice are shown below. 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

The Invoice Summary Sheet can be printed by clicking the  icon at the top of the screen. 

To view a PDF of the invoice, click the  button at the top of the screen.  The PDF viewer will open, 
displaying the selected invoice, as shown in the example below.  You can then review, save, or print the invoice.  

Click the  button to return to the Invoice Summary Sheet screen. 

 

3.2.8.10  Invoice (Updated 07/22/2008) 
The Invoice report displays a Payment Tracking Report and Agency Activity Report for a selected invoice.  The 
Payment Tracking Report includes a summary of the agreement information pertaining to the selected invoice, 
followed by completed Schedule A-1 (Salary Costs), Schedule A-2 (Hours Assignments), Schedule E-1 
(Reimbursable Direct Expense – Travel), Schedule  E-2 (Reimbursable Direct Expense – Training), and 
Schedule  E-3 (Reimbursable Direct Expense – Other) forms.  The Agency Activity Report includes 
Accomplishments Made during Last Period, Summary of ETDM Screening Activities, Anticipated 
Accomplishments for Next Period, and Off-line Agency Activity Log (if applicable). 
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In the Reports menu, point to Invoicing Reports, and then click Invoice. 

 
 

When the form opens, use the blank fields to specify search criteria.   

 

Begin by selecting an organization.  Type in all or part of an organization’s name.  A list of organizations will be 
displayed in a drop-down menu.  Select an organization.  Note that Agency users are able to view information 
only for their agency.  Invoice Administrators and Invoice Reviewers are able to view information for all 
agencies. 
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The form will be automatically populated with a list of invoices for the selected agency.  The organization 
selected to generate this example is Northwest Florida Water Management District.  The information that is 
shown is for example purposes only and does not reflect actual Northwest Florida Water Management District 
agreements or invoices.   

An invoice can also be accessed by specifying a Master Agreement/Contract, an invoice number, or  
submission dates by typing in a Master Agreement/Contract Number, Invoice Number, or Earliest Submission 
Date and Latest Submission Date.  The Earliest Submission Date and Latest Submission Date fields are used 
to specify a date range.  Select the dates by either entering the dates in dd/mm/yyyy format or clicking the  
icon to select the date from a calendar.   

When finished, select an invoice from the “Final Invoices” pull-down menu (which will then be highlighted in 
blue), then click the “Load Report” button. 

 

The report that is generated will display the information for the selected invoice.  The top portion of the report 
provides the form for selecting a different invoice.  Follow the same steps used for selecting the first invoice, as 
described above. 

The next portion of the Invoice report displays the Payment Tracking Report associated with the selected 
invoice, followed by the Agency Activity Report for that invoice.  Portions of the Invoice Package report are 
shown below.  Again, the information shown is for example purposes only and does not reflect actual Northwest 
Florida Water Management District agreements or invoices. 
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The Invoice Package report can be printed by clicking the  icon at the top of the screen.  

To view a PDF of the invoice, click the  button at the top of the screen.  The PDF viewer will open, 
displaying the selected invoice, as shown in the example below.  You can then review, save, or print the invoice.  
Click the “Close PDF” button to return to the Invoice Package screen. 
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3.2.8.11  Agency Activity Log Report (Updated 06/30/2008) 
The Agency Activity Log Report displays details about agency activities that are not recorded in the EST.  
These may include activities such as meetings, technical support of non-ETDM projects, and permit 
coordination.   

In the Reports menu, point to Invoicing Reports, and then click Agency Activity Log Report. 

 
 

When the form opens, use the pull-down menus to select search criteria.  Begin by selecting an agency name. 

 
 

Type in all or part of an agency’s name.  A list of agencies will be displayed in a drop-down menu.  Select the 
agency for which you want to view agency activities.  Note that Agency users are able to view information only 
for their agency.  Invoice Administrators and Invoice Reviewers are able to view information for all agencies.  
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Select the time period for which you want view agency activities by entering a “Start Date” and “End Date.”  The 
dates can be typed in (using mm/dd/yyyy format), or you can select the dates by clicking the  icon, which 
opens a calendar.  Click on the desired date, and it will appear in the date field on the form.  When finished, click 
the “Create Report” button. 

 
The report that opens will display information about agency activities entered in the database for the selected 
agency and date range. For this illustration, the FL Department of Environmental Protection is shown as an 
example. 

 

Note: The illustration(s) does not display an actual agency report.  

Use the search filter in the Search for activity section to select a different Agency Name or Date range.  
Follow the same steps used for selecting the agency name or start and end dates, as described above. 

The Agency Activities Report can be printed by clicking the printer icon  in the upper right-hand corner of 

the report.  To view a PDF of the Agency Activities Report, click the  button at the top of the screen.  You 
can then review, save, or print the Agency Activities Report. 
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3.2.8.12  Schedule A-2 (New 05/01/2008) 
The Schedule A-2 report displays the hours assigned to projects and activities for a designated invoicing period.  
The Schedule A-2 is part of the Invoice Package generated using the Prepare Invoice wizard, but can also be 
viewed independently.   

In the Reports menu, point to Invoicing Reports, and then click Schedule A-2. 

 
 

The Schedule A-2 report (also referred to as “Hours Assignments”) displays your agency name, followed by a 
list of agreements and invoices.  By default, it displays the activities and hours assigned for the first agreement 
and invoice listed in the pull-down menus.  To view a different Schedule A-2, select an agreement from the 
Agreement pull-down menu, then click “Select.”  The Invoices pull-down menu will be populated with invoices 
associated with that agreement.  Select an invoice, and then click “Load.” 
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3.2.8.13  Invoice Payment Overrides (In Development) 
 

3.2.9  Project Tracker (New 7/31/2009) 
Reports listed under Project Tracker enable users to retrieve selected information from the project 
record(s) and ancillary data, including tasks assigned to a project and project costs and times for PD and 
E Studies. 

3.2.9.1  Average District Project Costs and Times (New 7/31/2009) 
The Average District Project Costs and Times function in the Environmental Screening Tool (EST) Reports 
menu enables ETDM Coordinators Primary, ETDM Coordinators, Florida Department of Transportation (FDOT) 
Managers, and Central Environmental Management Office (CEMO) Managers to view FDOT Average Project 
Costs for PD&E Studies for a selected District.   

Users can export the report as a spreadsheet, generate a PDF version of the report, or send a PDF version of 
the report to the Electronic Document Management System (EDMS). 

Viewing the Average District Project Costs and Times Report: 
1. On the Reports menu, point to Project Tracker, and then click Average District Project Costs and 

Times. 

 
 

The Average District Project Costs and Times window opens as a tabbed page, displaying a 
search filter and a page toolbar. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. In the Districts field, click the drop-down arrow , and then select a District from the list. 

 
3. Click Search. 

The Average District Project Costs and Times window refreshes and expands, displaying the 
report for your selected District and an expanded page toolbar.   
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Tip!  Click the toolbar icon in the Average District Project Costs and Times window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Export the current page to Excel. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

4. Click Send Report to EDMS to send a PDF version of the report to EDMS. 

3.2.9.2  Project Tasks Status Report (New 7/31/2009) 
The Project Tasks Status Report function in the Environmental Screening Tool (EST) Reports menu enables 
authorized users to view the tasks assigned to a selected project and the status of each task. Users can view 
the report in HTML, Excel, and PDF formats. 

Users with the following assigned privileges can send the report to the Electronic Data Management System 
(EDMS): 

• Central Environmental Management Office (CEMO) Managers  

• Florida Department of Transportation (FDOT) Coordinators Primary 

• FDOT Coordinators  

For a list of roles authorized for viewing the Project Tasks Status Report, see Table 1-1 in Chapter 1.5 of the 
EST Handbook. 

Using the Project Tasks Status Report: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 
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2. On the Reports menu, point to Project Tracker, and then click Project Tasks Status. 

 
 

The Project Tasks Status Report  window opens as a tabbed page, displaying the project 
header, assigned groups and task details for the selected project, and a page toolbar. 

 
 

Tip!  Click the toolbar icon in the Project Tasks Status Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Export the current page to Excel. 
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  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. Under EDMS Integration, click Send Report to EDMS.  (For this illustration, the EST displays a 
message that no reports in EDMS match the selected criteria.) 

 
 

The EST displays a message stating the report has been successfully integrated into EDMS. 
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3.2.9.3  Task Groups Report (New 7/31/2009) 
The Task Groups Report function in the Environmental Screening Tool (EST) Reports menu enables Central 
Environmental Management Office (CEMO) Managers, Florida Department of Transportation (FDOT) ETDM 
Coordinators Primary, and FDOT ETDM Coordinators to view a read-only format of groups, tasks, and tasks 
assigned by group. 

Viewing the Task Groups Report: 
1. On the Reports menu, point to Project Tracker, and then click Task Groups. 

 
The Task Groups Report window opens as a tabbed page, displaying a search filter and a page 
toolbar. 

 
 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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2. To view the list of groups, click the Groups option button, and then click Search. 

 
 

The Task Groups Report window refreshes and expands, displaying the list of groups and an 
expanded page toolbar. 

Tip!  Click the toolbar icon in the Task Groups Report window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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3. To view the list of tasks, click the Tasks option button, and then click Search. 

 
The Task Groups Report window refreshes and expands, displaying the list of tasks and an 
expanded page toolbar. 

4. To view the list of tasks assigned by group, click the Tasks assigned by group option button, and then 
click Search. 

 
The Task Groups Report window refreshes and expands, displaying the list of tasks assigned by 
group and an expanded page toolbar. 
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3.2.10  Document Review (New 11/30/2011) 
The Document Reviews function in the Environmental Screening Tool (EST) Reports menu enables 
authorized users to view comments and responses for documents that were reviewed during a document 
review event. 

The report can be output in HTML, PDF, or Excel format.  

Note: Document review event Administrators will see a Send to EDMS button at the bottom of 
the Document Reviews screen. At the Administrator's discretion, the Document Reviews and 
Responses report may be sent to the Electronic Data Management System (EDMS). Other data, 
such as staff comments and the reviewed document PDF file, represent interim products not sent 
to EDMS.  

Viewing the Document Reviews Report: 
1. On the Tools menu, point to Document Review, and then click Document Reviews and 

Responses. 

 
 

The Document Reviews window opens as a tabbed page, displaying a page toolbar, and search 
filter.   
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Tip!   Click the toolbar icon on the window to: 

 Print a copy of the report. 

  Export the report to a PDF file. 

 Export the report to Excel. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 
2. To search for a document review event, complete any of the following fields in the Search for a 

Document Review Event section: 

Note: The Search for a Document Review Event fields are not required fields, so you have the 
option to enter as much information as you want into the search filter or you can leave all of the 
fields blank.  However, leaving all of the fields blank when you submit your query will result in the 
EST displaying all documents listed in the database. 

• Event Start Date Range – Type the date range or use the calendar icon, , to select the date 
range of the review event. 

• Organization – Click the Select Managing Organization arrow, and then select the organization. 

• Keyword(s) – Type words associated with the document. 

3. Click Search. 
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The Respond to Document Reviews window displays a Search Results section that lists the 
document review events matching your search criteria. 

 
 

4. Click the document review event link to open it.  

 
 

The Document Reviews window refreshes, displaying a read-only report of the selected 
Document Review Event in the following sections: 

• Event – displays the name and description of the selected event along with the event’s Start Date 
and End Date 

• Document (PDF) – shows the list of documents to be reviewed for the selected event along with 
the size of each document (in megabytes [MB]) and a description of the document 

• Official Reviews – displays the review comments for each document associated with the 
document review event 

• Responses – displays the responses to review comments 
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Chapter 3 Functions 

3.3 Wizards (Updated 10/31/2011) 

The EST wizards make it easy for you to perform tasks related to a specific project and to set up personal 
preferences for managing EST information. The functions listed in the Wizards menu walk you through a 
process, asking you to complete an action one step at a time.  

 

3.3.1 Perform ETAT Review (Updated 01/23/2006) 
The Perform ETAT Review wizard allows the user to view the Project Description and Public Comments for a 
specific project, review the Purpose and Need Statement for that project, indicate their agency’s response to the 
Purpose and Need Statement (Understood or Not Understood), and record the agency’s comments regarding 
the potential effects of the project.  To use the Perform ETAT Review wizard, go to the Wizards menu and 
then click Perform ETAT Review. 

 
 

The Perform ETAT Review wizard includes sequential screens for the following steps in conducting a review: 

• Selecting a project from a list of projects with the status “ETAT Review.” 

• Reviewing summaries of the Project Description and Public Comments for a project, and any documents 
that have been attached to the project record. 

• Reviewing the Purpose and Need Statement for the project. 
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• Indicating whether the Purpose and Need Statement is understood or not understood and recording 
comments concerning the Purpose and Need Statement. 

• Identifying resources for which the user’s agency has jurisdiction and recording agency comments 
regarding potential effects of the project on those resources. 

The first screen lists all the projects that are available for review.  A red asterisk (*) after the project name 
indicates that no reviews have been completed for the project.  A blue checkmark ( ) indicates that at least one 

review has been completed for the project.  Click the option button next to the project name that you want to 
review. 

 

The next screen provides summaries of the project description and public comments for the project, and lists 
any attachments (e.g., a scope of work, map, Systemwide Secondary and Cumulative Analysis Report, or 
technical studies).  After reviewing this information, click “Next.” 
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The next screen displays the Purpose and Need Statement for the project.  After reviewing the Purpose and 
Need Statement, click “Next.” 

 

On the next screen, the user documents whether the Purpose and Need Statement is “Understood” or “Not 
Understood” by clicking the respective option button, and enters agency comments, if any, concerning the 
Purpose and Need Statement for the project.  Enter the agency comments by typing directly in the text box 
under “Comments” or copy and paste text from another document.  When finished, enter your password, and 
click “Next” at the bottom of the screen.  By entering your password, you are certifying that the Purpose and 
Need acknowledgement and comments entered represent the official review for your agency.  To exit this 
screen without saving the entered information, click “Back” to go to the previous screen or “Cancel” to return to 
the list of projects available for review.  
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The next screen displays a confirmation of the agency acknowledgement concerning the Purpose and Need 
Statement for the project.  Click “Next” to continue with the review of the project. 

 

The next screen is used to select an issue to review, assign a degree of effect for that issue, identify resources 
and their level of importance, and enter agency comments concerning potential direct effects to those 
resources, as well as any additional comments.  First, select an issue from the pull-down menu. 

 

After an issue has been selected, you can view data concerning that issue on a map.  Click the “View on Map” 
link to open the Map Viewer, which will display data pertaining to the selected issue in the project area.  You can 
then zoom in or out to display different extents for the selected issue.  (See Section 3.4.1 View Interactive Maps 
for additional information on how to use the Map Viewer.)  To view details about the GIS analysis for an issue 
(including the name of the analysis and the time it was run for the project), click the “View GIS Analysis” link.  
(For additional information concerning the GIS analyses, see Section 3.3.2.4 GIS Analysis Results.) 
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Use the remaining sections of this screen to identify resources for which your agency has jurisdiction and 
describe their level of importance, enter comments concerning the potential effects of the project on these 
resources, and enter any additional comments concerning the agency’s review of the project.  Use the text 
boxes under “Identify resources and level of importance,” Comment on effects to resources” and “Additional 
comments (optional),” respectively, to enter this information.  Information can be typed directly into the form, or 
copied and pasted from another document.  Submit the review information to the database by entering your 
password and clicking “Next.”  By entering your password, you are certifying that the comments entered 
represent the official review for your agency.  To exit this screen without saving the entered information, click 
“Back” to go to the previous screen or “Cancel” to return to the list of projects available for review.  
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The final screen displays the review information that has been submitted to the database, and provides options 
for reviewing another issue, updating the review just completed, reviewing another project, or indicating that 
your agency’s review of the project is complete.  The bottom part of the screen contains the “Review 
Confirmation” information. 

 

The top of the screen displays the options for continuing or finalizing the review.  Click the option button next to 
“Review Another Issue,” “Update This Review” or “Review Another Project” to activate that function.  Click 
“Finish” if all pertinent issues have been reviewed and you wish to indicate that your agency’s review of the 
project is complete. 

3.3.2 Create ETDM Project (Updated 04/30/2012) 
The Create ETDM Project function in the Wizards menu enables authorized users to do the following: 

• Add a new project to the Environmental Screening Tool (EST) database. 

• Designate a project as a Local Agency Program (LAP) project, assign a new or existing LAP agency, 
and enter the assigned LAP agency's PD&E LAP certification status. 

Using the Create ETDM Project Wizard: 
1. On the Wizards menu, click Create ETDM Project. 

 
The Create New Project page opens, displaying a form for entering general project information.  
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2. Under Enter Information For New Project,  do the following: 

• In the Project Name** and Planning ID fields, enter the Project Name and the assigned 
Planning ID for the project.   

Note: Double asterisks (**) indicate a required field.  If the field is blank, the information 
must be added before the form can be processed. 

• In the Local Agency Program (LAP)** field, click the drop-down arrow, , and then do one of 
the following: 

ο Leave Unknown as the default selection if the project's LAP status has not yet been 
determined. Move on to the Financial Management No. field. 

ο Click the drop-down arrow, , and then do one of the following: 

 Click Yes if the project is a LAP project.  

 Click No if the project is not a LAP project.  Move on to the Financial Management No. 
field. 

 Click Anticipated (Planning Phase only) if LAP designation is anticipated.  

 

• If you selected Yes or Anticipated (Planning Phase only), the Enter Information For New 
Project form displays fields for adding LAP information.  Do the following: 

ο For LAP Agency**, select the LAP agency responsible for the project by doing one of the 
following: 
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 Click the LAP Agency arrow, , to expand the list, and then select an agency by 
clicking on the agency name. 

 If the LAP Agency is not listed, click the Add another agency to this list link, and then 
type the name of the agency in the text box. 

 
 

Tip!  You need to type only the first three letters of the name. The EST automatically 
displays a list of names that match your text. Click the appropriate selection from the list. 

If the agency is being added for the first time, type the agency's entire name. The agency 
will be added to the database. 

 

ο In the Agency Completing NEPA Document field, do one of the following: 

 Click the FDOT option button if FDOT will be completing the NEPA document, and 
then go to Financial Management No. field. 

 
 

 Click the Local Agency (with FDOT oversight) option button if the local agency will 
be completing the NEPA document. The LAP Agency Certification field appears, 
displaying options for the agency’s PD&E LAP Certification status.  

Note:  Local agencies must be PD&E LAP Certified if completing the NEPA 
document with FDOT oversight.  

 

ο In the LAP Agency Certification field, click the appropriate option button beside one of the 
following LAP Certification statements: 

 is already PD&E LAP Certified  (The agency selected in the LAP Agency field has 
completed the Local Agency Certification Qualification Agreement and has been 
approved by the District LAP Coordinator.) 

 will need to be PD&E LAP Certified via LAP Coordinator  (The agency selected in 
the LAP Agency field is pending approval by the District LAP Coordinator.) 
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Note:   The agency must be certified by the  District LAP Administrator for the type of 
work it will be performing. Once the project is created, the District LAP Administrator will 
receive an email notification about the project’s LAP designation and whether the need 
for agency certification has been indicated. 

• Complete the remaining fields: 

ο Financial Management No. -– Enter the Financial Management Number, if available. 

ο Alternative Corridor Evaluation (ACE) – Indicate whether or not this project is 
participating in the ACE process by either accepting the default No or by clicking the 
drop-down arrow, , and then selecting Yes. 

ο ETDM Phase – Click the ETDM Phase arrow, and then select one of the project phases. 

ο Project Web Site – Type one or multiple URLs to websites related to the project, if 
available. 

3. Click Next. 

The Create ETDM Project wizard displays the Enter Locational Information screen. 

 

4. Under Enter Locational Information, complete the following fields:  

• In the County** field, use the County scroll bar to move down the list. Select one or multiple 
options by clicking the County name(s). 

Tip!  Use SHIFT+click to select adjacent options. Use CTRL+click to select non-adjacent 
options. 

• In the Beginning Location field – Make edits, if any, to the project’s beginning location by typing 
your changes in the text box. 

• In the Ending Location field – Make edits, if any, to the project’s ending location by typing your 
changes in the text box. 

5. Click Next. 

The Create ETDM Project wizard displays the Enter Consistency and Involvement 
Information screen. 
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• Federal Involvement** – Click the appropriate check box(es) to indicate the level of Federal 
Involvement (or No Federal Involvement) for the project. Descriptions for the various levels are 
provided beside each option listed on the screen. 

• Planning Consistency Status – This section provides an efficient means to enter and track 
project consistency information that is required for NEPA approval. 

Note:  Project consistency information is mandatory for NEPA approval. However, providing the 
information via the EST is optional.  

 

ο Click the Expand this section link to display the form. 

ο Enter the information in the fields and select the appropriate values from the options that 
are presented.  Only fields that have been completed and fields where either a Yes or No 
option has been selected will appear in the summary report.  

 

Tip!  Click the URL link http://www.dot.state.fl.us/planning/policy/metrosupport shown 
on the screen to get the latest Planning Consistency guidance or download the spreadsheet 
from FDOT’s Metropolitan and Regional Support website. 



 

 
Environmental Screening Tool Handbook  3-492 

  

Note: Selecting No requires a written explanation. Type or copy and paste the explanation into 
the appropriate Comments text box. Instructions for what needs to be included in your 
explanation are displayed in light font within the Comments text boxes.  

6. Click Next. 

7. Complete the fields in the following screens: 

• Enter Purpose and Need Statement – Type or copy and paste the Purpose and Need 
Statement in the text box, and then click Next. 

Tip!  To copy and paste text from another document, highlight the selected text and then 
click Ctrl + C on your keyboard to copy the information. Click Ctrl + V keys to paste the 
information in the text box. 

• Enter Project Summary Description – Type or copy and paste a description of the project in 
the text box, and then click Next. 

• Summary of Public Comments – Click the Summarize/Modify Public Comments link to 
open the Summarize/Modify Public Comments page, and then enter the appropriate 
information in the fields provided. Click Next on the wizard screen when done. 

• Add Exemptions – Select or add an agency to the exemption list and type the justification for the 
exemption in the Justification text box beside each selected agency. 

Note: The Federal Transit Administration (FTA) is exempted by default on all Planning 
Phase projects that do not contain a transit mode. However, if the project will contain a transit 
mode or if there is a reason the FTA needs to review the project, you can remove the FTA 
exemption by clicking the remove link.  

 

8. Click Next. 
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The EST displays a confirmation message, giving you the option to review the information before 
submitting it or to proceed with saving your changes.  

 

9. Click OK to save the information or click Cancel to review the previous screens. 

After clicking OK, the wizard displays the What would you like to do now? screen showing 
options for your preferred action regarding the project, along with a message that the project has 
been successfully updated with your changes up to this point.  

 
10. Click the option button beside one of the following preferred actions, and then click Next: 

• Make additional changes to project description – Returns you to the first screen of the  
Create/Update Project Wizard 

• Open map to enter linework – Opens the Project Input Map viewer 

• Add/update alternatives – Opens the Select an Alternative and Add/Update Alternative 
screens in the wizard 

• Enter segment attribute information – Opens the Select an Alternative, Update Segment, 
and Update Segment Information screens in the wizard 

• Submit project for GIS Analysis or update project status – Opens the Update Project 
Status tool 

• Finish – Completes the process. 

 

3.3.2.1 GIS Data Quality Review Checklist  
A clear representation of a project’s extent and location is essential for accurate reviews and commentary by the 
Environmental Technical Advisory Team (ETAT) and the public. After digitizing features in the Environmental 
Screening Tool (EST), or submitting them to be loaded into the geographic information system (GIS) database, 
use the following list to help identify and correct errors: 
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• Verify that the number of mapped Alternatives is equal to the number of Alternatives described in the 
Project Description Report.  

• If the GIS features were loaded into the EST from another source, compare the version in the EST with the 
source to verify that all features loaded correctly. 

• Confirm that mapped Alternative endpoints are consistent with the From and To locations described in the 
Project Description Report. 

• Check the relationships among the map features representing your project (also known as “topology”): 

ο Lines – Alternative segments are adjoined at their respective endpoints unless otherwise intended, and 
there are no duplicate lines representing the same feature 

ο Polygons – coincident borders of areas should not overlap, nor should there be gaps between the 
areas unless otherwise intended 

ο Points – only one point represents the feature unless otherwise intended 

• Compare the location of project features to other features represented on the map:  

ο Zoom to a scale of 1:5000 or less at the endpoint of an Alternative. This scale allows you to use the 
most detailed aerials available in the EST – 1-foot Resolution Digital Orthophoto Imagery (DOI). 

ο Turn on map layers that will help confirm locational accuracy, such as the following: 

 DOI Aerials  

 Navteq Roads, railroads or other layers containing useful information for confirming feature 
locations 

 Layers showing resources you plan to avoid (schools, hospitals, parks, etc.) 

ο Using the Pan tool, move along each project feature, looking to see if it is in the right place relative to 
other features on the map and consistent with the project description you provided. If the project is 
intended to avoid a sensitive resource in the area, confirm that the project does not intersect the 
resource. For example: 

 If an Alternative is intended to be within an existing road right-of-way, confirm that it is in fact within 
a few feet of a road. 

 If an Alternative is intended to avoid a particular park, turn on a layer like Florida Natural Areas 
Inventory’s (FNAI’s) Florida Managed Areas to confirm that the Alternative does not intersect the 
park boundary. 

• Compare the value of the length field for a project Alternative against the total length value entered in the 
Add/Update Alternative Description form. 

3.3.3 Generate Summary Report (New 12/12/2005) 
The Generate Summary Report wizard includes the steps needed to generate a Planning Summary Report or 
Programming Summary Report.  To use the Generate Summary Report wizard, first select a project (or 
projects) using the Project Navigation Bar, then click on Wizards on the main menu, and select Generate 
Summary Report.  



 

 
Environmental Screening Tool Handbook  3-495 

 
 

The Generate Summary Report wizard includes sequential screens for completing tasks associated with a 
Planning Summary Report or Programming Summary Report, depending on the project selected.  The first 
screen lists the tasks.   

First, select a task by clicking the option button next to a task name (for example, “Summarize and Respond to 
Agency Reviews”), then click Next.  Follow the instructions on each screen to complete the task.   

Use the   button to save actions completed on each screen and continue to the next step for the task.  

Use the  button to return to the previous step.  When finished with a task, use the  button to 
return to the task list.  Use the  button to stop the task without saving the work completed in the current 
form and return to the task list.   
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3.3.3.1 Planning Summary Report (New 01/03/2006) 
If the project selected is in the Planning Screen phase, the form that opens will list tasks associated with 
generating a Planning Summary Report.   Tasks associated with generating a Planning Summary Report are 
described below. 

Review Another Project 
To select a different project to review, click on the option button next to “Review Another Project.”  Then click 
“Next.”  The form that opens lists all projects that have the status “ETAT Review Complete.”  Select a project by 
clicking the option button next to the project name.  Then click “Next.”  The information for this project will then 
appear on the “What Would You Like To Do?” page of the wizard.  Proceed with the review of this project by 
selecting a task on the “What Would You Like To Do?” page (shown above). 
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Summarize and Respond to Agency Reviews 
The form shown below appears when you select “Summarize and Respond to Agency Reviews.”  Select an 
issue by clicking on the option button next to the issue name, then click “Next.” 

 

In the example shown below, Aesthetics was selected.  To summarize or respond to another issue, click the 
“change” link beside “Issue Selected.”  To summarize or respond to issues for a different project alternative, 
click the “change” link beside “Current Alternative.”  To summarize the degree of effect for an issue, click the 
“Next” button at the bottom of the screen.   
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Select a degree of effect from the “Summary Effect” pull-down menu, then enter your agency password and 
click “Add/Update.”   

 

A message will appear indicating that comments for the issue have been summarized; and when you return to 
the “Select Issue to Review” screen, a blue check mark ( ) beside the issue name will indicate that the degree 
of effect has been summarized, as shown below.  Select another issue, and follow the same procedure to 
summarize the degree of effect for that issue. 

 

To view details of an agency’s response, including comments, click + next to the agency’s name.  Use the 
"respond" link to reply to specific agency comments.   
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Enter the response to in the text box, then select your organization identification from the pull-down menu and 
click “Add.”  The response can be typed directly in the text box, or text can be copied and pasted from another 
document.  

 

Update Project Commitments 
The “Update Project Commitments” form is shown below.  Click + next to “Current Project Commitments” to 
view the commitments, or use the text box to add a new project commitment.  To add a new project 
commitment, type directly in the text box under “Add New Project Commitment” or cut and paste text from 
another document.  Then select your agency identification from the pull-down menu and click “Add.”   
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To update a current project commitment, click the “edit” link on the right-hand side of the screen, next to the 
description of the commitment.  (The “more” link can be used to view the complete text of a comment.) 

 

The form that opens when you click the “edit” link contains a text box with the full text of the project commitment.  
Make changes to the text by typing directly in the text box.  Text can also be deleted.  When finished, select 
your agency identification from the pull-down menu, then click “Update.”  The commitment can be removed from 
the project record by clicking “Delete.”  To cancel any changes made within the text box, click the “Cancel” 
button to the right of the “Delete” button.  

Summarize Public Comments 
The form that opens when you select “Summarize Public Comments” is shown below.  To add the public 
comment, as it appears on the screen, to the Planning Summary Report, click “Save.”  Make changes to the 
comment by typing directly in the text box under “Summarize Public Comments.”  Text can also be deleted.  
When finished, click “Save.” 



 

 
Environmental Screening Tool Handbook  3-501 

The screen that appears next indicates that the comments have been summarized.  Click the “Next” button at 
the bottom of the screen to begin a new task.  

 

Attach Secondary & Cumulative Report 
A Secondary and Cumulative Effects Report can be added to the project record by clicking the option button 
next to “Attach Secondary & Cumulative Report.”  The form that opens is shown below.   Use the “Browse” 
button to select the document to be added.   

 

The document to be added should be in Adobe Acrobat™ PDF format.  This is an ETDM standard.  The tool can 
support other file formats, but please consider that “what you see is not what you get without the proper 
software.”  A document that is in Word Perfect™ may not be useful to MS Word™ users.  If it is necessary to 
attach a non-PDF file, state the file format in the File Description so that other users are aware of it. 

The file name, including the location path, will appear in the form, as shown below.  Next, enter a description of 
the document in the text box under “File Description.”  Include the document’s title, author, agency, date, status 
(preliminary, draft, final, etc.), purpose and applicable remarks.  When finished, click “Submit.” 



 

 
Environmental Screening Tool Handbook  3-502 

The next screen confirms that the document has been added to the project record.  It includes a file name 
assigned by the EST and the File Description.  To view details about the document, including the date it was 
added to the project record, click + next to “View Recently Uploaded Files.” 

 

Summarize System-wide Plan  
Select the “Summarize System-wide Plan” task to add or modify a Transportation Plan associated with a 
project.  On the form that opens, first select a planning organization from the pull-down menu. 

Next, select a County from the pull-down menu, then select the Cost Feasible horizon year for the 
Transportation Plan from the pull-down menu.  (For example, if a project is proposed for the 2025 Long Range 
Transportation Plan (LRTP), the plan year is 2025.) 
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On the form that opens, enter a descriptive title of the Transportation Plan in the “Short Description” text box.  
Then enter the system needs summary and summary of system-wide public comments in the text boxes 
provided.  Use executive summary style with content no more than one page in length.  An alternative to 
manually entering the summaries is to copy and paste from an existing document.  To copy from a separate 
document, select the text, right-click on the highlighted text and choose "Copy" from the pop-up menu. To paste 
the text into the form, right-click in the appropriate text box on the form and choose "Paste" from the pop-up 
menu.  (The keyboard shortcuts CTRL-C to copy and CTRL-V to paste also work.)  When finished, enter your 
EST password and click “Save.” 

 

Use the “change” links at any time to enter a different Transportation Plan summary.  Use the “Back” or “Cancel” 
buttons to exit the form without saving the information entered. 
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Publish 
The last step involved in generating a summary report using the “Generate Summary Report” wizard is to make 
the report available to the ETAT and public.  This is accomplished by first clicking the option button next to 
“Publish” on the “What Would You Like To Do?” page, then clicking “Next.”  The form that opens includes 
information concerning the summary report that will be generated.  Click the check box next to “Continue?”  

 

The next screen lists the project alternatives for which a Planning Summary Report can be published.  To 
continue, click “Publish.”  The Planning Summary Report will then be added to the list of summary reports 
available in the EST, and can be accessed by the ETAT and the public. 
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3.3.3.2 Programming Summary Report (New 01/03/2006) 
If the project selected is in the Programming Screen phase, the form that opens will list tasks associated with 
generating a Programming Summary Report.  Each task for generating a Programming Summary Report is 
described below. 

 

Review Another Project 
To select a different project to review, click on the option button next to “Review Another Project.”  Then click 
“Next.”   The form that opens lists all projects that have the status “ETAT Review Complete.”  Select a project by 
clicking the option button next to the project name.  Then click “Next.”  The information for this project will then 
appear on the “What Would You Like To Do?” page of the wizard.  Proceed with the review of this project by 
selecting a task on the “What Would You Like To Do?” page (shown above). 
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Summarize and Respond to Agency Reviews 
The form shown below appears when you select “Summarize and Respond to Agency Reviews.”   Select an 
issue by clicking on the option button next to the issue name, then click “Next.” 

 

In the example shown below, Aesthetics was selected.  To summarize or respond to another issue, click the 
“change” link beside “Issue Selected.”  To summarize or respond to issues for a different project alternative, 
click the “change” link beside “Current Alternative.”  To summarize the degree of effect for an issue, click the 
“Next” button at the bottom of the screen.   
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Select a degree of effect from the “Summary Effect” pull-down menu, then enter your agency password and 
click “Add/Update.”   

 

A message will appear indicating that comments for the issue have been summarized; and when you return to 
the “Select Issue to Review” screen, a blue check mark ( ) beside the issue name will indicate that the degree 
of effect has been summarized, as shown below.  Select another issue, and follow the same procedure to 
summarize the degree of effect for that issue. 

 

To view details of an agency’s response, including comments, click + next to the agency’s name.  Use the 
"respond" link to reply to specific agency comments.   
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Enter the response to in the text box, then select your organization identification from the pull-down menu and 
click “Add.”  The response can be typed directly in the text box, or text can be copied and pasted from another 
document.  

 

Update Project Commitments 
The “Update Project Commitments” form is shown below.  Click + next to “Current Project Commitments” to 
view the commitments, or use the text box to add a new project commitment.  To add a new project 
commitment, type directly in the text box under “Add New Project Commitment” or cut and paste text from 
another document.  Then select your agency identification from the pull-down menu and click “Add.”   
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To update a current project commitment, click the “edit” link on the right-hand side of the screen, next to the 
description of the commitment.  (The “more” link can be used to view the complete text of a comment.) 

 

The form that opens when you click the “edit” link contains a text box with the full text of the project commitment.  
Make changes to the text by typing directly in the text box.  Text can also be deleted.  When finished, select 
your agency identification from the pull-down menu, then click “Update.”  The commitment can be removed from 
the project record by clicking “Delete.”  To cancel any changes made within the text box, click the “Cancel” 
button to the right of the “Delete” button.  

 

Summarize Public Comments 
The form that opens when you select “Summarize Public Comments” is shown below.  To add the public 
comment, as it appears on the screen, to the Programming Summary Report, click “Save.”  Make changes to 
the comment by typing directly in the text box under “Summarize Public Comments.”  Text can also be deleted.  
When finished, click “Save.” 
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The screen that appears next indicates that the comments have been summarized.  Click the “Next” button at 
the bottom of the screen to begin a new task.  

 

Assign a Technical Study 
The form used to assign a technical study to a project is shown below.  First, select a category from the pull-
down menu. 

 

In the example shown below, the “Environmental” category was selected.  Next, select a study from the “Select 
a Study” pull-down menu. 
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In the example shown below, “Air Quality Report” was selected.  Enter the requirements for the study in the text 
box under “Conditions.”  Then select your organization identification from the pull-down menu and click “Add 
Study.” 

 

The next screen confirms that the technical study has been added to the project, and includes a function to 
assign additional technical studies to the project.  To assign additional technical studies, click “More Technical 
Studies” and repeat the process described above.  Click + next to “Assigned Technical Studies” at any time to 
see a list of all technical studies assigned to the project.  When finished, click the “Next” button at the bottom of 
the screen to return to the “What Would You Like To Do?” page and select another task. 

Assign a Permit 
To assign a permit to a project, first click the option button next to “Assign a Permit” on the “What Would You 
Like To Do?” page, then select a permit from the “Select a Category” pull-down menu. 
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In the example shown below, the category “Stormwater” was selected.  The next step is to select a permit from 
the “Select a Permit” pull-down menu. 

 

In the example shown below, “Individual Stormwater Permit” was selected.  Enter the requirements for the 
permit in the text box under “Conditions.”  Then select your organization identification from the pull-down menu 
and click “Add Permit.”  

 

The next screen confirms that the permit has been added to the project, and includes a function to assign 
additional permits to the project.  To assign additional permits, click “More Permits” and repeat the process 
described above.  Click + next to “Assigned Permits” at any time to see a list of all permits assigned to the 
project.  When finished, click the “Next” button at the bottom of the screen to return to the “What Would You Like 
To Do?” page and select another task. 
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Prepare Class of Action Determination 
A Class of Action Determination can be prepared for a project by first selecting “Prepare Class of Action 
Determination” on the “What Would You Like To Do?” page.  On the form that opens, select a Class of Action, 
other actions (if pertinent), the lead federal agency, and cooperating agencies (if pertinent).  Then enter your 
EST password and click “Save.” 

 

A message will appear, confirming that the Class of Action Determination has been saved.  When finished, click 
the “Next” button at the bottom of the screen to return to the “What Would You Like To Do?” page.  
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Publish 
The last step involved in generating a summary report using the “Generate Summary Report” wizard is to make 
the report available to the ETAT and public.  This is accomplished by first clicking the option button next to 
“Publish” on the “What Would You Like To Do?” page, then clicking “Next.”  The form that opens includes 
information concerning the summary report that will be generated.  Click the check box next to “Continue?”  

 

The next screen lists the project alternatives for which a Programming Summary Report can be published.  To 
continue, click “Publish.”  The Programming Summary Report will then be added to the list of summary reports 
available in the EST, and can be accessed by the ETAT and the public. 
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3.3.4 Update ETDM Project (Updated 11/30/2011) 
The Update ETDM Project function in the Wizards menu enables you to add or change project information.  

Using the Update ETDM Project Wizard: 
1.      Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Wizards menu, click Update ETDM Project. 

 
The Create/Update Project Wizard displays the Enter Information For Existing Project 
screen.  
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3. Under Enter Information For Existing Projects,  do the following: 

• In the Project Name** and Planning ID fields, make edits or add information, if needed.   

Note: Double asterisks (**) indicate a required field.  If the field is blank, the information 
must be added before the form can be processed. 

• In the Local Agency Program (LAP)** field, click the drop-down arrow, , and then do one of 
the following: 

ο Leave Unknown as the default selection if the project's LAP status has not yet been 
determined. Move on to the Financial Management No. field. 

ο Click the drop-down arrow, , and then do one of the following: 

 Click Yes if the project is an authorized LAP project.  

 Click No if the project is not a LAP project.  Move on to the Financial Management No. 
field. 

 Click Anticipated (Planning Phase only) if LAP designation is anticipated.  

 
 

• If you selected Yes or Anticipated (Planning Phase only), the Update Project Description form 
displays fields for adding LAP information.  Do the following: 

ο For LAP Agency**, select the LAP agency responsible for the project by doing one of the 
following: 

 If the LAP Agency is already listed, click the LAP Agency arrow, , to expand the list, 
and then select an agency by clicking on the agency name. 

 If the LAP Agency is not listed, click the Add another agency to this list link, and then 
type the name of the agency in the text box. 

 
 

Tip!  You need to only type the first three letters of the name. The EST automatically 
displays a list of names that match your text. Click the appropriate selection from the list. 
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ο In the LAP Agency Certification** field, click the appropriate option button beside one of the 
following LAP Certification statements: 

 is already PD&E LAP Certified 

 will need to be PD&E LAP Certified via LAP Coordinator 

 
Note:   The agency must be certified by the Enviromental Management Office for the 
type of work it will be performing. 

ο For Agency Completing NEPA Document, indicate which agency will be completing the 
NEPA document by selecting one of the following options: 

 FDOT 

 Local Agency (with FDOT oversight) 

 

• Add or edit information for the remaining fields: 

ο Financial Management No. -– Enter the Financial Management Number, if available. 

ο ETDM Phase – Click the Project Phase link to open the Update Project Phase page.  

Note:  See the Update Project Phase section of the EST User Handbook for 
information on navigating the Update Project Phase page. 

ο Project Web Site – Type the URL to the project's website, if available. 

ο County** – Use the County scroll bar to move down the list. Select one or multiple options by 
clicking the County name(s). 

Tip!  Use SHIFT+ click to select adjacent options. Use CTRL+click to select non-
adjacent options. 

4. Click Next. 

 
The Update ETDM Project wizard displays the Enter Locational Information screen. 
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5. Under Enter Locational Information, make your changes to the following fields:  

• In the County** field, use the County scroll bar to move down the list. Select one or multiple 
options by clicking the County name(s). 

Tip!  Use SHIFT+ click to select adjacent options. Use CTRL+click to select non-adjacent 
options. 

• In the Beginning Location field – Make edits, if any, to the project’s beginning location by typing 
your changes in the text box. 

• In the Ending Location field – Make edits, if any, to the project’s ending location by typing your 
changes in the text box. 

6. Click Next. 

 
The Update ETDM Project wizard displays the Enter Consistency and Involvement 
Information screen. 

 

7. Under Enter Consistency and Involvement Information, do the following: 

• Federal Involvement** -– Indicate the level of Federal Involvement for the project. 

Note:  LAP projects require Federal Involvement. The option buttons for No Federal 
Involvement and Federal Permit Required without Federal Consistency Review are 
shown as inactive when the project has been identified as a LAP project. 

ο No Federal Involvement♦  (No federal funds will be used and no Federal Consistency Review 
is required) 

ο Federal Funding (Federal funds or assistance is used at some phase of project development) 

ο Federal Action (Federal approval of an action is required; e.g., change in Interstate access 
control) 

ο Federal Permit (Federal permit is required; e.g., U.S. Coast Guard Bridge permit) 
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ο Potential Future Federal Funding (Federal funds or assistance may be used for a project's 
future development) 

ο Federal Permit Required without Federal Consistency Review♦  (Federal permit is 
required, but no federal funds will be used and no Federal Consistency Review is required) 

Tip!  A diamond symbol, , indicates the Project does not require a Federal 
Consistency Review process with the State Clearinghouse in the Programming phase.  

• Consistency -  Click the option buttons in the Y (Yes), N (No), or U (Unknown) columns beside 
each Consistency area: 

Note: The Consistency section enables you to indicate a project’s consistency status for 
the listed areas as the project moves through each phase, and it can be updated at any time. 
However, by the end of the PD&E (Project Development and Environment) phase, the project must 
be consistent in all of the areas listed in the Consistency section ( Y option should be selected) in 
order to receive Location Design Concept Acceptance from the Federal Highway Administration 
(FHWA).  

ο Air Quality Conformity 

ο Local Government Comp Plan 

ο MPO Goals and Objectives 

8. Click Next. 

 

9. Add information or make changes to information shown in the following screens: 

• Enter Purpose and Need Statement – Type your changes in the text box, and then click Next. 

• Enter Project Summary Description – Type your changes in the text box, and then click Next. 

• Summary of Public Comment – Click the Summarize/Modify Public Comment link to open the 
Summarize/Modify Public Comment page, and then enter the appropriate information in the 
fields provided. Click Next on the wizard screen when done. 

• Add Exemptions – Select or add an agency to the exemption list and type the justification for the 
exemption in the Justification text box beside each selected agency. 

Note: The Federal Transit Administration (FTA) is automatically exempted from reviewing 
non-transit projects. You must obtain approval from the FTA to add it as a reviewing agency 
(i.e., non-exempt). The EST displays the Federal Transit Administration and a justification 
statement in the Provide Justification For Exemption box. Contact the ETDM Help Desk 
at help@fla-etat.org (or call 850/414-5334) if you wish to remove the FTA from the exempted 
agencies list. 
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10. Click Next. 

 
The EST displays a confirmation message, giving you the option to review the information before 
submitting it or to proceed with saving your changes. 

 
11. Do one of the following: 

• Click Cancel to review the information. Use the wizard Back buttons to navigate through the 
screens. 

• Click OK to save the information. 

After clicking OK, the wizard displays the What would you like to do now? screen showing 
options for your preferred action regarding the project along with a message that the project has 
been successfully updated with your changes up to this point.  

 
12. Click the option button beside one of the following preferred actions, and then click Next: 

• Make additional changes to project description – Returns you to the first screen of the  
Create/Update Project Wizard 

• Open map to enter linework – Opens the Interactive Map viewer 

• Add/update alternatives – Opens the Select an Alternative and Add/Update Alternative 
screens in the wizard 

• Enter segment attribute information – Opens the Select an Alternative, Update Segment, and 
Update Segment Information screens in the wizard 

• Submit project for GIS Analysis or update project status – Opens the Update Project Status 
tool 
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• Finish – Completes the update process and submits the information to the database. 

After selecting the Finish option button and clicking Next, the wizard displays the Project 
Successfully Added/Updated screen for the selected project along with a link to the Project 
Description Report, which displays your changes. 

 

3.3.5 Set Up User Preferences (Updated 01/06/2006) 
The Set Up User Preferences wizard allows users to set up their My ETDM preferences.  To use the Set Up 
User Preferences wizard, go to the Wizards menu and select Set Up User Preferences.  

 
 

The Set Up User Preferences wizard includes sequential screens for setting up the following preferences: 

• Select a start-up option 

• Add mini-reports to My ETDM 

• Choose My ETDM pages 

• Configure EST maps 

• Change notification settings 

• Update contact information 

The preferences set up using the Set Up User Preferences wizard can be changed at any time by using the 
functions available under Account Settings on the main menu. 

The first screen in the Set Up User Preferences wizard allows the user to select what will be displayed when 
they first log on to the EST.  The two options are: 

• Restore history (select this option if you want to return to the last page or pages that were open when you 
logged off the EST) 

• Load “MyETDM” pages (select this option if you want the EST to load the pages designated as your “My 
ETDM” pages) 
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Click the option button next to the option you prefer.  (The default option is “Restore history.”)  Then click Next. 

 
The second screen can be used to select mini-reports to be added to the user’s My ETDM.  Mini-reports are 
abbreviated versions of standard reports, and the mini-reports selected will be displayed on a single page when 
you log on to the EST.  Select up to five mini-reports by clicking the check box next to the name of the mini-
report.  When finished, click the “Next” button at the bottom of the page. 
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The next screen is used to select My ETDM pages.  Click on the check box next to the name of the page to 
select that page.  There is no limit to the number of pages that can be selected.  The pages selected will 
automatically open each time you log on to the EST.  Each page will be represented by a tab at the top of the 
page (similar to a file folder in a filing cabinet).  You can switch from page to page by clicking on the tabs.  When 
finished, click the “Next” button at the bottom of the page. 

 
The next screen is used to select preferences for how maps are displayed.  Use the drop-down menu to select 
the map to be displayed when you first start the Interactive Map Viewer.  (“Basemap” is the default map.)  Then 
click “set as default issue.” 
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In the example shown below, Land Use was selected as the default map. 

Preferences can also be set for data layers to be displayed on each issue map.  First, click on the file folder icon 
for an issue.   

 
 

The selection will expand to display all the data layers associated with that issue.  Next, click on the check box 
next to the data layer name.  Repeat this process for as many issues as desired, and then click Save Visibility.   

The “Change Notification Settings” screen is used to change the email notifications a user receives.  By default, 
all users receive notices when the “What’s New” page is updated, when the system is experiencing difficulties or 
there will be planned outages, and when ETDM events are announced.  If you do not want to receive these 
notifications, un-check the box next to “Check to receive all EST email notifications.”   

ETAT members can also specify whether they want to receive notices about projects by district or by county.  
Use the pull-down menu next to “ETAT notifications” to select either “District-level Notification” or “County-level 
Notification.” 

Click “Finish” 
to save 
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Clicking “Finish” saves the user preferences and automatically opens the “Update Contact Information” form 
(shown below).  Required fields are highlighted in yellow.  Use the fields to update or add information to your 
contact profile.  When finished, click “Submit Form.” 

 
The next screen is a confirmation of the contact information provided.  Click the blue “X” in the upper right-hand 
corner of the screen to close this screen and return to the Welcome page. 
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3.3.6 Draft ETAT Notification (New 06/30/2010) 
The Draft ETAT Notification Wizard function in the Environmental Screening Tool (EST) Wizards menu 
enables authorized users to configure email notifications to inform Environmental Technical Advisory Team 
(ETAT) members and other relevant users of a screening event. The Draft ETAT Notification Wizard opens a 
sequence of screens that guide you through the ETAT Notification setup.   

The following EST user roles may access the Draft ETAT Notification Wizard: 

• Environmental Management Office (EMO) Managers 

• EMO Liaisons 

• District ETDM Coordinators 

• Metropolitan Planning Organization ETDM Coordinators 

After the Draft ETAT Notification email has been configured and saved, the EST automatically distributes the 
email when you update the project status to ETAT Review.   

Using the Draft ETAT Notification Wizard: 
1.      Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

2. On the Wizards menu, point to and click Draft ETAT Notification. 

 
3. The window that opens next depends upon the selected project’s phase (Planning or Programming). 

The sections that follow describe the process for drafting ETAT notifications for a Planning Screen 
(Section 3.3.6.1) and a Programming Screen (Section 3.3.6.2).  
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3.3.6.1 Draft ETAT Notification for Planning Screen 
After clicking the Draft ETAT Notification link in the EST Wizards menu, the first Notify ETAT Wizard screen 
opens and displays the Project and an Instructions section. 

 
 

1.      Click Next. 

The Select Identity and Recipients screen opens.  
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2. Under Select Identity and Recipients, do the following: 

• In the From field, click the drop-down arrow, , and then select the identity that corresponds to 
the agency you are currently representing. 

Note:  If you are associated with multiple agencies, the field will expand and display a list of 
your agency identities. If you are associated with only one agency, the Draft ETAT 
Notification Wizard will automatically display your identity in the From field. 

 

• Under To, select the Recipients for the Planning Screen ETAT Notification. 

ο Click the plus sign icon, , to expand and view the Mandatory Recipients for Planning 
Screen ETAT Notification section. 

 

ο Click the plus sign icon, , to expand the Select Additional Recipients That Should be 
Included section, and then select the Recipients from the list by clicking the check box beside 
the recipient's Organization and Name. 

 

Tip! To add recipients from your contact list, click the My Contact List link. 
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3. Click Next. 

 

The Edit Subject and Comments screen opens and displays the email, which is divided into the 
following sections: 

• Subject 

• Top Body 

• Middle Body (This section cannot be edited) 

• Bottom Body 
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4. Add any additional information or edits to the Subject and Top Body sections. 

5. In the Bottom Body section of the email, click the section's scroll bar and scroll to the Contact options, 
and insert the following additional Contact information beside option number 2: 

• Name  

• Phone 

• E-mail Address 

 
 

6. Click Next. 

The Preview Draft ETAT Notification Email screen opens, displaying the completed email 
sections. 
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7. Click Finish. 

 
 

The Draft Notification screen displays, with a message stating your Draft Email to users with 
EST Access has been successfully saved.  A selected option button is also shown next to Edit 
Notification to users with EST Access. 

Tip!   Click the delete link to cancel the notification. Click the Next button to make any changes 
to the notification. 

8. To update the project status, go to Tools>Maintain Project Diary>Update Project Status.  For 
navigation details, see the Update Project Status section (located under Tools) of the EST Handbook. 
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3.3.6.2  Draft ETAT Notification for Programming Screen 
After clicking the Draft ETAT Notification link in the EST Wizards menu, the first Notify ETAT Wizard screen 
opens and displays the Project and Instructions section. 

 
 

1.      Click Next. 

The Notify ETAT Wizard displays options for two groups of users requiring notification: Edit 
Draft Notification to users with EST Access and Draft Notification to users with Public 
Access Only. 
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2. Click the option button beside Edit Draft Notification to users with EST Access. 

 
 

3. Click Next. 
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The Notify ETAT Wizard displays the Select Identity and Recipients section. This section 
enables you to select your user identity for the organization you are currently representing, view 
the Recipients selected for the Transmittal List, and select additional Recipients.    

 

4. In the From field, click the drop-down arrow, , and then select the identity that corresponds to the 
agency you are currently representing. 

Note:  If you are associated with multiple agencies, the field will expand and display a list of your 
agency identities. If you are associated with only one agency, the Draft ETAT Notification 
Wizard will automatically display your identity in the From field. 

 
 

5. Under To, view the Recipient lists by doing the following: 

• To view the list of Mandatory Recipients (i.e., those who are conducting an ETAT review and 
consistency review), click the plus sign  beside 1) Mandatory Recipients for Programming 
Screen ETAT Notification. 
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The EST displays a pre-populated list of names for the Mandatory Recipients list. 

 

Tip! Click the column headings to sort the information in ascending or descending order. 

• To view the list of non-mandatory Recipients, click the plus sign  beside 2) Other Recipient(s) 
for Programming Screen ETAT Notification. 

 
 

The EST displays a pre-populated list of Other Recipients (non-Mandatory). 
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• To add additional Recipients, click the plus sign  beside 3) Select Additional Recipients That 
Should Be Included. 

 
 

The EST displays your personal contact list(s).  Click the check box beside the name(s) you 
want to add to the Draft ETAT Notification. 

Tip!  To add names to your personal contact list(s), click the My Contact Lists link. 

 

6. Click Next. 
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The Edit Subject and Comments screen opens. 

 
 

7. Make any necessary edits to the following sections: 

• Subject 

• Top Body 

8. In the Bottom Body section of the email, click the section's scroll bar and scroll to the Contact options, 
and insert the following additional Contact information: 

• Name 

• Phone 

• E-mail Address 
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9. Click Next. 

 
The Notify ETAT Wizard displays a preview of the Draft ETAT Notification Email that will be 
sent to Recipients who have EST accounts, providing you a final review of the text before 
saving the Draft Notification. 
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10. Click Finish to save the draft email. 

 
The EST displays a message that the Draft Email to users with EST Access has been saved 
successfully. 

 
 

Tip!  After you have created the Draft Notification email for Recipients with EST access, a 
delete link appears under Edit Draft Notification to users with EST Access.  Click the link to 
delete the Draft Notification email. Click the Next button to make any changes to the email. 
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11. Click the option button beside Draft Notification to users with Public Access Only. 

 
 

12. Click Next. 

 
 

The Notify ETAT Wizard displays the Select Identity and Recipients section.  
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13. Repeat the process for Edit Draft Notification to users with EST Access.  

Note: The process for creating draft notifications for Public Access users is the same as for 
EST users except the options are limited to selecting Mandatory Recipients and Additional 
Recipients. 

14. To update the project status, go to Tools>Maintain Project Diary>Update Project Status.  For 
navigation details, see the Update Project Status section (located under Tools) of the EST Handbook. 

3.3.7 Prepare Invoice (Updated 07/15/2008) 
The Prepare Invoice wizard can be used by an agency’s Invoice Submitter to prepare an invoice package or 
Advance Payment Request and submit it to FDOT.  To use the Prepare Invoice wizard, log in to the EST using 
your agency-specific username and password for the Invoice Submitter role.  After logging on to the EST, go to 
the Wizards menu and then click Prepare Invoice.  

 
The Prepare Invoice wizard includes sequential screens for entering invoice information, as follows: 

• Enter invoicing period end date 

• Upload receipts for the invoicing period 

• Confirm uploaded receipts 

• Edit Expenses for the invoicing period 

ο Personnel  

ο Travel 

ο Training 

ο Other Expenses 

• Summarize Agency Activities 

• Log Agency Activity 

• Assign Hours 

When these steps are completed, the Prepare Invoice wizard provides two additional steps for submitting and 
viewing, saving a PDF version and/or printing the invoice, as follows: 

• View/Submit Invoice 

• View Invoice Package 
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If an Advance Payment Request is being prepared using the Prepare Invoice wizard, the steps include: 

• Enter invoicing period end date 

• Enter anticipated compensation elements (labor and expenses) 

• Print, view or save PDF version of submitted Advance Pay Request 

The first screen of the Prepare Invoice wizard displays the agency associated with the Invoice Submitter 
username and password used to log in to the EST.  In the example shown below, the username and password 
for the U.S. Environmental Protection Agency (USEPA) Invoice Submitter was used.  The first screen is also 
populated with information about the agreements associated with your agency and the Invoicing Period Start 
date (which is based on the end date of the previous invoice for the selected agreement).  If there is more than 
one agreement for the agency, select the agreement for which you are preparing an invoice from the 
Agreement pull-down menu.  Then enter the Invoicing Period End date for the invoice you are preparing.  You 
can enter the date using the mm/dd/yyyy format, or select the date from a calendar using the Calendar feature. 

 

If using the Calendar feature, click on the calendar icon  to the right of the 
Invoicing Period End field, then select the Invoicing Period End date from the 
calendar, as shown here. 

After entering or selecting the Invoicing Period End date, click the  
button at the bottom of the screen. 
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Upload Receipts 
The next screen is used to upload images of receipts associated with the invoice being prepared.  Scanned 
images of expense receipts are required as part of the invoice package.  Images of receipts may be in BMP, 
GIF, JPG, PNG or PDF format, but must be scanned with a scanning density of 300 dots per inch (DPI).  Note 
that receipt pages must be uploaded one 8-1/2 x 11-inch page at a time if they are not in PDF format.  To 
upload images of receipts, use the Browse button to locate and select the file containing the image.  Add a brief 
description of the receipt in the Description textbox.  Then click the “Upload and View Confirmation Page” 
button. 

 

The next screen is used to view the PDF version of the receipt and either keep the receipt as part of the invoice 
package or delete it.  After reviewing the PDF version of the receipt displayed in the lower portion of the screen, 
click either “Yes – keep receipt” or “No – delete receipt.”  When finished, click the “Next” button at the bottom of 
the screen. 
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Edit Expenses 
The next screen is used to enter invoice amounts for personnel charges, travel expenses, training expenses 
and other expenses.  The top portion of the screen is populated with information about the invoice being 
prepared (i.e. agency name, agreement number, number assigned to the unsubmitted invoice, and the invoicing 
period start and end dates).  The Invoicing Period End date can be changed by typing in the new date or using 
the Calendar feature to select a date. 

 

The next portion of the Edit Expenses screen is used to enter personnel changes for the invoicing period.  Click 
“Add Personnel” to begin. 

 

When “Add Personnel” is clicked, a line is added to the form where the person’s name and job classification, 
number of hours worked during the invoicing period, average hourly rate, additional overhead amount, and 
overhead percentage are entered.  As each number is typed in, the “Cost this Period” amounts are 
automatically calculated.  If personnel charges for more than one person are being invoiced, click “Add 
Personnel” to enter the charges for each additional person.  Note that all fields must contain data, so if you add 
a line that is not going to be used, you must delete that line by clicking the “Remove” button next to the line.  The 
“Remove” button is also used to delete personnel charges that were previously entered (prior to finalizing and 
submitting the invoice). 
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The next portion of the Edit Expenses screen is used to enter travel expenses for the invoicing period.  Begin by 
clicking the “Add Expense” button.  A line will be added to the form, as shown here, where a description of the 
travel expense and the amount are entered.  Note that an image of the receipt for each travel expense amount 
must be included before an invoice can be finalized and submitted.  To include additional travel expenses, click 
the “Add Expense” button again.  If a line is added that is not subsequently used, click the “Remove” button to 
delete the line.  The “Remove” button is also used to delete expenses that were previously entered (prior to 
finalizing and submitting the invoice). 

 
The next portion of the Edit Expenses screen is used to enter training expenses for the invoicing period.  Begin 
by clicking the “Add Expense” button.  A line will be added to the form, as shown here, where a description of 
the training expense and the amount are entered.  Note that an image of the receipt for each training expense 
amount must be included before an invoice can be finalized and submitted.  To include additional training 
expenses, click the “Add Expense” button again.  If a line is added that is not subsequently used, click the 
“Remove” button to delete the line.  The “Remove” button is also used to delete expenses that were previously 
entered (prior to finalizing and submitting the invoice). 

 
The next portion of the Edit Expenses screen is used to enter other expenses for the invoicing period.  Begin by 
clicking the “Add Expense” button.  A line will be added to the form, as shown here, where a description of the 
expense and the amount are entered.  Note that an image of the receipt for each expense amount must be 
included before an invoice can be finalized and submitted.  In the example shown, a previously uploaded receipt 
has been included.  To include additional expenses, click the “Add Expense” button again.  If a line is added that 
is not subsequently used, click the “Remove” button to delete the line.  The “Remove” button is also used to 
delete expenses that were previously entered (prior to finalizing and submitting the invoice).  Note that all fields 
must be completed.  In the example shown, a description of the expense and amount would need to be entered 
before saving the draft invoice. 
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The final portion of the Edit Expenses screen displays the total cost for the invoice being prepared, and provides 
a textbox for entering additional notes, if needed.  The total cost for the invoice is automatically calculated based 
on the amounts entered for personnel, travel, training, and/or other expenses.  To save the entries, click “Save 
Draft.”  To proceed to the next step for preparing the invoice, click the “Next” button at the bottom of the screen.   

 

Summarize Agency Activities 
The next screen is used to enter information about agency activities for the invoicing period.  The top portion of 
the screen is populated with information about the invoice being prepared (i.e. agency name, agreement 
number, number assigned to the unsubmitted invoice, and the invoicing period start and end dates). 

 

The remaining portions of the screen are used to enter narrative about agency activities, with separate sections 
for accomplishments made during the invoicing period, a summary of ETDM screening activities, and 
anticipated accomplishments for the next invoicing period, as shown in the example.  Enter a brief description of 
activities for each category, using the textboxes.   
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The first section is used to enter information about accomplishments made during the invoicing period. 

 

Following are guidelines for the information for each category under Accomplishments Made During Period: 

• Administrative or Supervision Tasks – discuss management and/or supervision tasks performed during the 
period 

• Coordination – discuss non-field interagency and FDOT coordination 

• Performance Measures – discuss how the agency has performed on the Performance Measures outlined in 
the Agreement 

• Problems Encountered/Suggestions for Improvement – provide information on any problems discovered or 
anticipated, and any proposed improvements that would facilitate the streamlining effort of the ETDM 
Process 

Under Summary of ETDM Screening Activities, use the textboxes to describe any problems encountered using 
the EST and any other comments. 
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Under the Anticipated Accomplishments for Next Period, enter a brief description of anticipated activities for the 
next invoicing period, and the number of anticipated hours and number of persons performing the anticipated 
activities.  When finished, click the “Save Draft” button on the left side of the screen, then click “Next.” 

 

Log Agency Activities 
The next screen is used to provide details about agency activities that are not recorded in the EST.  These may 
include activities such as meetings, technical support of non-ETDM projects, and permit coordination.  If there 
are no agency activities to log, click “Finish” to proceed to the View/Submit Invoice screen. 

Each agency activity is logged individually.  This screen can also be used to edit Activity Logs previously 
submitted via the EST. 
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Agency activities are entered during this step using the Prepare Invoice wizard, or may be entered at any time 
by an agency ETAT representative using the Log Agency Activity tool found on the main menu under Invoicing 
Tools in the Tools menu.   

Begin by either selecting an existing Activity Log to be edited from the pull-down menu, or click “Clear/Create 
New” to add an Activity Log.  Use the form that opens to enter or edit the activity information.   

First, enter the date of the activity by either typing in the date (in mm/dd/yyyy format) or select the date from a 
calendar by clicking the  icon.  Then use the pull-down menus to select Activity Type, Work Program Phase, 
FDOT District, County, and ETAT Representative.  If the activity is related to an ETDM project, type in the 
ETDM project number in the Project field, then press the tab key.  Then enter the number of hours for the 
activity.   

 
 

If the activity is not directly related to an ETDM project, click the ETDM button to toggle to Non ETDM.  Select 
and load a project from the pull-down menu or create a new record by clicking “create new.”  Enter the 
information for the project, as shown below, and then click “Save.”  You can then enter the number of hours 
associated with the activity. 
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Use the Activity Description textbox to type in a brief text description of the activity being logged.  Use the 
Results or Anticipated Actions textbox to describe any actions taken by FDOT or the agency as a result of the 
activity or any actions anticipated.  When finished, click “Save.”  Then click “Next” to go to the next step, or click 
“Finish” to proceed to viewing and submitting the invoice,.” 

 

Assign Hours 
The next screen is used to assign hours for each project or activity, or update hours previously assigned using 
the Agency Activity screen.  The top portion of the screen displays the Agency, Agreement, and Invoice number 
for which hours are being assigned. 
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The bottom portion of the Assign Hours screen is used to enter the number of hours for project activities and, if 
needed, to update the number of hours for agency activities.  The form will be populated with the number of 
hours entered into the database via the Activities Log.  To assign hours for a project activity or update hours for 
an agency activity, enter the number of hours in the “Hours” field to the right of the activity, then click “Save.”  If 
you are assigning or updating hours for more than one activity, enter the number of hours for each activity, then 
click the “Save All” button at the top left side of the list.  Note that as you enter hours for an activity, the “Total 
hours accounted for” field at the bottom of the list will automatically change to reflect the total number of hours 
assigned for the listed activities.  When finished, click the “Next” button at the bottom of the screen. 

 

View/Submit Invoice 
The View/Submit Invoice screen includes a Payment Tracking Report and Agency Activity Report for the invoice 
that has been prepared.  The Payment Tracking Record includes a summary of the agreement information 
pertaining to the invoice, followed by completed Schedule A-1 (Salary Costs), Schedule A-2 (Assigned Hours), 
Schedule E-1 (Reimbursable Direct Expense – Travel), Schedule  E-2 (Reimbursable Direct Expense – 
Training), and Schedule  E-3 (Reimbursable Direct Expense – Other) forms.  The Agency Activity Report, which 
includes the information entered on the Summarize Agency Activities screen and the Log Agency Activity 
screen (if applicable), includes Accomplishments Made during Last Period, Summary of ETDM Screening 
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Activities, Anticipated Accomplishments for Next Period, and Agency Activities Log (if applicable).  Examples of 
a Payment Tracking Report and Agency Activity Report are shown below. 

Example Payment Tracking Report 
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The Summary section of the Payment Tracking Report is followed by the Schedule A-1 and Schedule A-2. 
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The Schedule A-1 and Schedule A-2 sections of the Payment Tracking Report are followed by the Schedule E-
1, Schedule E-2, and Schedule E-3, followed by a list of Attachments (if applicable). 
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Example Agency Activity Report 
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If changes need to be made to the invoice before submittal, click the  button on the far right side of the 
screen to close the wizard.  You can then access the unsubmitted invoice selecting Prepare Invoice on the 
Wizards menu, and make any necessary changes. 

Use the icons at the top of the screen to print the invoice or save it on your computer as a PDF file.  To submit 
the invoice, enter the Invoice Submitter password for your agency, and click “Submit Invoice.” 

 

When the invoice is submitted, a PDF file of all of the components is created and stored in the database.  The PDF will 
have the submittal date and “DRAFT” printed on each page.  The Invoice Administrator and Invoice Reviewers receive 
an email informing them that the draft invoice is available on the EST for their review.  The Invoice Submitter receives 
a copy of the email.  The email identifies the invoice by agency, agreement number, invoice number, and submittal 
date. 

Advance Pay Request 
The Prepare Invoice wizard can be used to prepare requests for Advance Payment and to report expenditures 
by agencies that are authorized to receive advance payment.  On the first screen of the Prepare Invoice wizard, 
select the agreement for which advance payments have been authorized.  Enter the Invoicing Period End date 
by either typing in the date (in mm/dd/yyyy format) or selecting the date from a calendar by clicking the  icon.  
The Advance Payment Request form that opens is automatically populated with information about the 
agreement, as shown in the example.  
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Next, enter the amounts for compensation elements (labor and expenses) for the Advance Pay Request.  After 
the amounts for compensation have been entered, the EST calculates the total amount of the advance payment 
requested, the total advance payments to date (including the current request), and the balance remaining in the 
contract.   

 

Notes about the Advance Pay Request can be added, using the “Other notes” textbox.  When finished, click 
“Save.”  The data you entered will be added to the database, and will be displayed on the Payment Tracking 
Report Summary Sheet of your current invoice submittal. 

 

Click “Next” to add documentation for expenditures associated with your previously submitted Advance Pay 
Request (also referred to as Current Reporting Period expenditures).  Clicking “Next” will take you to the Upload 
Receipts screen described above, and the wizard will sequence you through all the subsequent steps for 
documenting expenditures for the Current Reporting Period (i.e., Confirm uploaded receipt, Edit Expenses, 
Summarize Agency Activities, Log Agency Activity, and Assign Hours). 
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When finished, click the “Finish” button at the bottom of the screen to proceed to the “View/Submit Invoice” 
screen.  An Advance Pay Request Report, followed by a Payment Tracking Report for the Current Reporting 
Period expenditures will be displayed, as shown below.   

 

 

 

 

 

 



 

 
Environmental Screening Tool Handbook  3-559 

Check the information for accuracy.  If changes need to be made before submittal, click the  button on the 
far right side of the screen to close the wizard.  You can then access the unsubmitted Advance Pay Request 
and invoice package by selecting Prepare Invoice on the Wizards menu, and make any necessary changes. 

Use the icons at the top of the screen to print, save as a PDF file, or email the Advance Pay Request and 
invoice package.  To submit the Advance Pay Request, enter the Invoice Submitter password for your agency, 
and click “Submit Invoice.” 
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Chapter 3 Functions 

3.4 Maps (Updated 11/30/2011) 

The Maps menu allows you to access various types of maps, both interactive and hard copy.   

 

3.4.1  Interactive Maps 
A key component of the Environmental Screening Tool (EST) is access to Geographic Information Systems 
(GIS) data about ETDM projects and environmental resources.  GIS is a computer technology that brings 
together information about anything with a physical location, such as an address or map coordinates.  The EST 
interactive maps are linked to data files that describe an area’s features.  When you click on a location on the 
map, the EST can access database information describing the features shown for the selected map location. 

3.4.1.1  Map Viewer (Updated 11/30/2011) 
The Map Viewer provides easy access for selecting features, changing the geographic extent, and querying the 
database. 

You can open the Map Viewer by doing any of the following: 

• Click the Maps menu, and then click View Interactive Maps.   

Note: You do not need to select a project before opening the Map Viewer. 

 
 

The Interactive Map Viewer opens and displays either the state of Florida or the project last 
viewed on the map, depending on the preferences you have set.  

Note: Maps retain the most recently used project selection and map extent unless the user clicks 
the Map it button to refresh the map using new project selections.  
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• Click the Click to Open Map bar. 

 
 

The map opens and covers the EST window.  Click the Click to Close Map bar to hide the map.   

• To zoom to a project location on the map, do the following: 

ο Select a project using Advanced Project Search, and then click the Map It button. 

 

ο Double-click on your target area directly on the Map Viewer. 

ο Click the Zoom In icon on the top toolbar, and then highlight the target area on the Map Viewer. 
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The main portion of the Map Viewer screen is the image of the current map.  Use the menus and toolbars to 
select features, change the geographic extent, and query the database from the Map Viewer window.  The next 
illustration displays the components of the Map Viewer. Instructions for using the main components of the Map 
Viewer are described in the following sections: 

 

3.4.1.1.1 Overview Map 
The overview map displays the general vicinity of the current map view compared with the state of Florida.  The 
corner arrow acts as a toggle button.   

• Click the   arrow to open the location map.  

• Click the  arrow to close the location map. 
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3.4.1.2 Map Toolbar: Tools 

The toolbar at the top of the Map Viewer screen contains mapping tools and a map menu.  Instructions for 
using the components of the top toolbar are described in the sections that follow. 

 

The tools in the top toolbar enable you to quickly access commonly used map functions. The toolbar icons are 
described as follows: 

 
Click the Pan icon to move the extent of the map view. Click on the map and drag 
to the desired location.  

 
Click the Zoom In icon to enlarge a specific area of the map for greater detail. 
Click on the map and drag the shaded box to highlight an area you want to zoom 
to. 

 
Click the Zoom Out icon to reduce the magnification level of a specific area. Click 
on the map and drag the shaded box to highlight an area you want to zoom out of. 

 
Click the Identify icon to view information on an area's features.  (See the Identify 
Map Features section for details on using this tool.) 

 
Click the Clear icon to clear selected features in the active data layer. 

3.4.1.2.1 Identify Map Features 
The identify map features component of the EST enables you to view information about an area’s features by 
map layer.   

1. Zoom to an area on the map by doing one of the following: 

• Point to a target area on the map and then use the Zoom In tool on the map toolbar. 

• Select a project using Advanced Project Search and then click Map It. 

2. Select a feature you want highlighted on the map by turning a layer on or off (See the Table of 
Contents section of these instructions for information on using map layers).  

3. Click the Identify icon, , on the top toolbar; the Identify list box appears. 

4. Click on the map to view feature information for a selected location. 
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5. Click the drop-down arrow to expand the list of map layers. 

 
Select the map layer option you want to display on the map.  

• Active Layer (Alternatives (Currently in Review)) – Displays the layer that has been selected as 
active in the Contents panel. 

• Top-most layer – Displays the dominant layer that overlays the lower layers in a geographic map 
data frame (i.e., like layer transparencies stacked on top of each other, the topmost layer is at the 
top of the stack and obscures the layers below it) 

• Visible layers – Displays all the layers that have been turned on in the layers list  

The Identify box expands, showing the results for the selected layer. The Identify box will also 
display No Features Found, which Lists layers in which no features were found for the selected 
location. 

Tip! You can view the results in an outline (tree) format or as a table.  Click the Tree option 
button to view the results in an outline format.  Click the Table option button to view the results in 
a table format. 

 
 

Tip!  The Identify box can be moved or resized to provide a better view of the map. To move the 
Identify box to another part of the map viewer screen, click the title bar at the top of the Identify 
box and drag the box to the desired spot. To reduce the Identify box size, click the bottom right 
corner of the box and drag the corner in the opposite direction. Click and drag the bottom corner 
to the right to expand the Identify box. 
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6. To display details for a particular area, click the feature listing or click the layer detail. A table appears 
and shows the data for the selected option. 

Tip!  Click the Show on Map link to highlight the area on the map. After you click the Show on 
Map link, the map viewer will zoom to and shade the selected area, and the Identify box will 
refresh and display the feature results for the area. 

 

3.4.1.3 Map Toolbar: Map Menu  

The map menu displays options for selecting features, turning layers on and off, querying the database, and 
viewing help for using the map tools. 

• Click a map menu button to display the menu panel. The button becomes highlighted when you point to it, 
as shown in the next illustration. 

 

• The menu panel displays the list of available options for the selected menu item. 

3.4.1.3.1 Table of Contents  
The Contents panel in the map menu contains the table of contents for the Interactive Map Viewer, 
enabling you to apply queries and control the type of layers displayed on the map. 

Note: A layer is a dataset that represents a single feature class (e.g., roads, streams, forest stands).  Each 
layer that is loaded will be listed in the table of contents.  

The Contents panel in the map menu displays the following components: 

• The Active project (if applicable) 

• A list of Maps, enabling you choose the type of resource issue you want to analyze in the Map Viewer 

• A list of layers, displaying options to specify the type of analysis you want to run in the Map Viewer (e.g., 
projects in draft editing, projects currently in review, projects previously reviewed, Alternatives and features, 
demographics, and road information)    
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The Contents panel displays the list of layer options for the current view.  If you selected a project 
and clicked the Map It button, the Active project name and number will be displayed. 

Tip! Click the change link to change the Active project. 

 

3. Click Maps. 

The Maps icon expands, showing a series of thumbnails that represent the issues or categories 
relating to environmental effects.   

The issues displayed in the Maps box are listed below, along with a description of each map. 

• Base Map:  Contains data representing an overview of the project area, for example, major roads, 
water bodies and rivers, county boundaries, and FDOT District boundaries.  These data are not 
considered an issue for analysis, but as a reference for all other issues being reviewed.  Base map 
data are also included in each of the issue maps. 

• Aesthetics: Includes data used to evaluate project effects on community character, including 
resources that may be sensitive to noise, vibration, and visual intrusions. 

• Air Quality: Contains data for the assessment of the air quality surrounding proposed project sites.  
Used to identify if the project is located in a non-attainment or maintenance area for ozone or 
particulate matter. 

• Coastal and Marine:  Pertains to the evaluation of coastal ecosystems, marine life, sensitive 
shorelines, and degradation/preservation concerns. 
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• Contaminated Sites:  Contains data to support the evaluation of the likelihood of contamination 
and its impact on the proposed project. 

• Economics:  Includes information to assist with the evaluation of effects to businesses, 
employment, and changes in the tax base. 

• Farmlands:  Used to determine the potential involvement of any farmlands within the proposed 
project study/construction area. 

• Floodplains:  Contains data to support the evaluation of the 100-year floodplain within the 
proposed project study/construction area.  Considerations include the type of encroachment, 
potential for backwater impacts, and project influence on floodplain development. 

• Historic and Archaeological Sites:  Used for assessing the potential involvement with properties 
eligible for or listed on the National Register of Historic Places. 

• Infrastructure:  Contains data that represent the current infrastructure of the project area in order 
to determine possible impacts. 

• Land Use:  Used to identify existing and future land uses that show growth potential and the 
potential for the proposed project to induce area growth. 

• Mobility:  Contains data used to examine the public transportation facilities of an area. 

• Navigation:  Contains data used to determine if a USCG navigation permit is required. 

• Recreation Areas:  Contains data to be used to identify all recreational areas within the proposed 
project study area. 

• Relocation:  Designed to evaluate the potential displacement of residences, businesses, 
community institutions, etc. 

• Secondary and Cumulative Impacts:  Contains data sets for the determination of possible 
secondary and cumulative effects within the proposed project study area. 

• Section 4(f) Potential:  Contains data to be used to identify all potential Section 4(f) designated 
lands within the project study area. 

• Social:  Concerned with changes in demographics, community cohesion, safety/emergency 
response, and compatibility with community goals and values. 

• Special Designations:  Used for identifying all specially designated lands within the project study 
area. 

• Water Quality and Quantity:  Contains data for surface water and groundwater quality and 
quantity impact assessment. 

• Wetlands:  Used to identify the amount of wetlands affected by the proposed project, the type of 
wetlands involved, and their overall significance to the surrounding area. 

• Wildlife and Habitat:  Used to consider any species or habitat affected by the proposed project. 

Please Note: Data requirements were identified during a series of workshops with 
representatives from ETAT agencies.  Existing data layers were identified to meet those 
requirements, when available.  The best source of available information to meet the requirement 
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has been used in each map; however, not all information was available.  As new data layers are 
made available, they are added to the maps.  A current list of data layers for each issue can be 
obtained on the Frequently Asked Questions (FAQ) link from the Environmental Screening Tool 
home page.  Contact help@fla-etat.org if you have additional data layers to add to these maps. 
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4. To set map preferences, do the following: 

• Select the map you want to use by clicking the appropriate thumbnail for the issue you are 
reviewing. For the next series of illustrations, Wildlife and Habitat is shown as the selected issue 
related to the Active project. 

 
The Contents panel automatically refreshes, displaying the list of data layers available in the 
Map Viewer for the selected resource issue.  
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Tip! Click the change link beside the resource issue header to display the Maps resource issue 
thumbnails. 

• Click the Category label or folder icon to expand the list of data layers. 

• Click a check box to display a layer on the map. To hide a layer, click the checked box to deselect 
the layer. 

• Click an option button to select the layer you will be working in (this is referred to as the active 
layer)  

Note: Only one layer at a time can be active.  

• Click Refresh to apply your changes to the map. You can set your map to automatically refresh 
and set the refresh time by clicking the Auto-refresh check box and then typing a number in the 
seconds text box. 

• Click Save. The following attributes will be saved to the map and will apply to future map viewer 
sessions: 

ο Layer Visibility Settings – The map layers that were turned on for the selected issue. 

ο Load selected issue by default – The current selections automatically load when you open 
the Map Viewer. 

Note: By default, the Basemap opens when the Map Viewer is first used in a session.  You can 
select a different default issue map by clicking the Load selected issue by default check box. 
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The Map Viewer refreshes and displays the SHPO National Register Sites symbol, , on the 
Map Viewer (click the Legend thumbnail to view the map key). 

7. Click the Tools link, and then click the NRS Photos icon. 

  
8. Click the SHPO National Register Sites symbol on the Map Viewer.  For this illustration, the target 

site is shown with a red circle around it.   
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The National Register of Historic Places box appears, showing the Site Name and Site ID.    

 

Tip!  You can change the size of a screen or move it to another spot on the Map Viewer by 
doing the following:  

• To expand or reduce the size of the National Register of Historic Places screen, click and drag 
the bottom-right corner (move the corner to the left to reduce the screen size; move the corner to 
the right to increase it).  

• To move the National Register of Historic Places screen, click and drag the National Register 
of Historic Places bar at the top of the screen to another spot on the Map Viewer. 

• Click the X at the top of the screen to close it. 

9. Click the Site Name link to view the site information.  The site file opens as a PDF in a separate 
window, enabling you to print or save the file. 

 
To view information for other sites shown on the Map Viewer, simply click the NRS symbol on the 
Map Viewer.  The National Register of Historic Places box will remain in place, refreshing to 
display the selected Site Name. 

Tip!  Click the X at the top of the National Register of Historic Places box to close it. 
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2. On the Map Viewer, point to and click the project you want to view attachments for.  

 
 

The Project Attachments box appears, showing the list of documents associated with the 
selected project.  

 
3. In the Document Description column, click the appropriate link to open the document. 

 
 

The document PDF opens in a separate window. 
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The Measure dialog box appears. 

 
4. Select the type of measurement by doing the following: 

• To measure a distance between two points using the Line tool, click the Line icon, and then click 
the Units arrow to select a unit of measurement from the list box. 

 

• To measure an area, click the Area tool, and then click the Units arrow to select a unit of 
measurement from the list box. 

 

• To view the latitude and longitude coordinates, click the Lat/Lon tool, and then select the 
coordinates from the Units list box. 

 
5. Click the point on the Map Viewer to activate the line and begin measuring the distance.  

Tip!  Click the left mouse button once to set your starting point. Drag the line to the point where 
you want to stop measuring. Do one of the following: 

• Single-click the left mouse button to stop the line at a point, and then continue to drag the line in 
another direction to continue measuring the distance. 

• Double-click the mouse button to deactivate the line and end the measurement. 

Tip!  Click the Clear button to erase the drawing. 
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• Double-click on your target area directly on the Map Viewer. 

• Click the Zoom icon on the top toolbar, and then highlight the target area on the Map Viewer. 

• Click the Search link in the map menu to search for the target area or project. Do the following: 

ο Type your search query. 

ο Accept the All Searchable Layers default, or click the drop-down arrow, , and then select 
the appropriate layer.  

ο Click Search. 

ο Click the appropriate link from the Search results to zoom to the selected area on the Map 
Viewer. 

2. In the map menu, click Contents to select a resource map and to turn layers on and off (see the 
Setting Map Layers in the Table of Contents section for details on selecting maps and turning layers on 
and off).  For this illustration, an area around a project is being reviewed:  Land Use is shown as the 
selected Map for a project Currently in Review, with GIS Analysis Buffers set at 5280 ft. (1 mile) and as 
the active layer.   
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The Map Viewer refreshes and displays the selected buffer area, as shown in the next 
illustration. 

 

Tip!  Click the Legend thumbnail in the Contents panel to view the color key for the buffer 
distances. 

3. Click the Tools link. 

 
The Tools panel opens and displays the list of available tools. 

4. Under Query, click Query Database. 
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The Query Builder dialog box opens, displaying a search filter for selecting feature criteria. 

 
5. In the Query Builder dialog box, do the following: 

• Click the scroll bar, and then double-click the appropriate layer.  For the next illustration, 
FK_Project is shown as selected to view an area within 5280 ft. (1 mile) of a project. 

• Click Get Unique Values. A list of values appears in the list box, as shown in the next illustration. 
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• To build the search string expression, click the appropriate symbol from the operator keypad. 

 
 

Tip!  You can also copy and paste or type the expression into the Query criteria text box. 

• Click a value from the Get Unique Values list. 

 
 

• In the Query criteria text box, continue to build the search string by doing any of the following: 

ο Click the appropriate symbol on the operator keypad, and then select an option from the Get 
Unique Values list. 

ο Copy and paste the search string into the text box. 

ο Type the search string into the text box. 

Note: See the Writing Search Strings table for descriptions of commonly used operators and 
examples for building a string expression in the EST Query Builder. 

• After you have completed the search string in the Query criteria text box, do one of the following: 

ο To view all results for the state of Florida, click the Statewide option button. 

ο To view the results for the current map view, click the Visible Map Extent button. 
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• Click Execute. 

 
 

The Query Results screen appears, showing the results of the query search criteria. 

  
 

6. Do any of the following: 

• To view an individual result on the Map View, click the Show on Map link on the row of the 
selected result. 

• To view all the results on the Map View, click the Show Results on Map link at the bottom of the 
Query Results screen. 
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• To buffer the results, click the Buffer these Records link. Go to Step 8 for instructions on selecting 
features within a buffer area. 

Note: Buffering the records listed in the Query Results screen enables you to establish a map 
boundary around the selected area and then search for additional attributes and features within 
the area or within a set distance outside of the area (e.g., performing a query search within a land 
use parcel for rail lines that intersect the parcel area).  

 
 

Note: The Buffer these Records link only buffers the records that are displayed in the box. If 
there are more than 25 records, you will need to click the More Records link to display and buffer 
the additional records. 

7. You can select features within the buffer zone by doing any of the following: 

• Use the Query Results dialog box. See Step 8 for instructions. 

• Use the Maps and map layer options in the Contents panel (See the Setting Map Preferences 
section for instructions on using map layers). 

8. To select additional features within the buffer zone using the Query Results dialog box, do the 
following: 

• Click the Select features from arrow to expand the list box.  The box populates with the features 
available in the database. 

• Select a variable from the list by clicking it.  For this illustration, District 6 Generalized Land Use 
(Parcels Derived) is shown as selected.   
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• In the Within Miles of the selected features of Name of Feature text box, do one of the following: 

ο Accept the default, 0 Miles, if you want to search for features within the established buffer 
zone. 

ο Type the number of miles in the text box if you want to expand the search range beyond the 
established buffer zone (i.e., searching for schools within the established buffer zone plus 
number of miles). 

ο Click Go. The Query Results screen refreshes and displays the results for the specific 
features within the established buffer zone and, if added, the extended distance range. The 
next illustration shows the Query Results screen displaying the results along with the buffered 
area (shaded areas on map) in the background. 

 

ο Click the Show on Map or Show Results on Map links to view the results on the Map 
Viewer.  

Tip!  Clicking the links for Show on Map or Show Results on Map will zoom to the 
specified area on the Map Viewer. Use the Scale box located in the Map Viewer 
toolbar or the zoom slider to zoom out to a distance that allows you to view a feature 
and buffer area in relation to the project location.  

Creating Search Strings in the EST Query Builder 
The Query Builder dialog box in the Environmental Screening Tool’s (EST’s) Interactive Map Viewer 
provides a list box containing the available layers and features, enabling you to select the first part of the 
query string that will appear in the Query Criteria text box.  Once you have selected your layers from the 
list box, you can further filter your search criteria by building an expression using the operator keys and 
then clicking an option from the Get Unique Values list.  Alternatively, you can copy and paste 
expressions or type the full expression into the Query criteria text box. 
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The following table provides a quick reference for creating search strings in the EST Query Builder: 

Table 3-1 Writing Search Strings 
Operator Description Example 

 ‘ ’ Features within a WHERE clause must 
always be enclosed within single quotes. 

STATE_NAME = ‘California’ 

UPPER or 
LOWER  

Use either the UPPER or LOWER function 
for file-based data sources like file 
geodatabases or shapefiles.  

The following expression will select customers 
whose last name is stored as either Jones or 
JONES. 
UPPER LAST_NAME = ‘Jones’ 

= Use the equal sign operator to search the 
database for a specific value. 

FK_Project = ‘7767’ 

LIKE 
Use the LIKE operator (instead of the = 
operator) to search for a particular pattern. 

For example, this expression would select 
Mississippi and Missouri among USA state names: 
STATE_NAME LIKE ‘Miss%’ 

% 
Use with the LIKE operator when anything 
is acceptable in its place. You can use the 
% operator to represent anything from zero 
characters to a hundred characters.  

 
STATE_NAME LIKE ‘Miss%’ 
 

__ 

Use the underline operator with the = 
operator to treat a character as part of a 
string. 
 
or 
 
Use with LIKE to represent only one 
character. 

To search for _atherine Smith: 
 
OWNER_NAME = ‘_atherine smith’ 
 
To search for Catherine Smith or Katherine Smith:  
 
OWNER_NAME LIKE ‘_atherine smith’ 

> Use to select string values for greater than. BUFFER_DISTANCE >  '200' 

< Use to select string values for less than. BUFFER_DISTANCE <  '200' 

>= 
Use to select string values for greater than 
or equal to. 

This expression will select all the cities in coverage 
with names starting with the letters M to Z. 
CITY_NAME >= ‘M’ 

<= 
Use to select string values for less than or 
equal to. 

This expression will select all the cities in coverage 
with names starting with the letters A to M. 
CITY_NAME <= ‘M’ 

< > 
Use the not equal operator to exclude 
values that are equal to a specific value.  

This expression will select water bodies where the 
description is “not.” 
 ‘RESERVOIR’. DESCRIPT <>  'RESERVOIR' 

Is null 

Use the NULL keyword to select features 
and records that have null values for the 
specified field. The NULL keyword is always 
preceded by IS or IS Not. 

To find cities whose 1996 population has not been 
entered: 
 
POPULATION96 IS NULL 
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Operator Description Example 

Is not null 

 To find cities whose 1996 population has been 
entered: 
 
POPULATION96 IS NOT NULL 

AND Use the AND and OR operators to filter 
information based on one or more 
conditions. 
The AND operator displays records based 
on both conditions being true. 
The OR operator displays records based on 
one of the conditions being true. 
You can combine AND and OR to form a 
complex expression. 

The following AND expression would select all the 
houses that have more than 1,500 square feet and 
a garage for three or more cars: 
 
AREA > 1500 AND Garage > 3 
 
The following example demonstrates an OR 
expression: 
 
RAINFALL < 20 or SLOPE > 35 
 
The following example demonstrates a combined 
AND and OR expression: 
 
AREA > 1500 AND (Garage > 3 OR Carport > 3) 

OR 

NOT 

Use the NOT operator to find features or 
records that don’t match the specified 
expression. 
The NOT operator must be placed at the 
beginning of the expression and can be 
used in AND and OR expressions. 

NOT STATE_NAME= ‘Colorado’ 
 
To find all the New England states except Maine: 
 
SUB_REGION = ‘New England’ AND NOT 
STATE_NAME = ‘Maine’ 

+ Use arithmetic operators to include 
calculations in an expression. 

Calculation between field and number: 
 
AREA > = PERIMETER * 100 
 
Calculation between fields: 
 
POP1990/ AREA <= 25 

- 

* 

/ 

( ) 

Use the parentheses to establish the 
precedence in which an expression is 
evaluated. Expressions enclosed in 
parentheses are evaluated before the part 
that isn’t enclosed. 

 
LAST_NAME = ‘Smith’ (FIRST_NAME = ‘John’ 
OR  FIRST_NAME = ‘Jane’) 
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The Map Viewer refreshes and displays the selected buffer area. Click the Legend thumbnail to 
view the color key for the buffer distances. 

 
3. Click the Tools link. 

 
The Tools panel opens and displays the list of available tools. 
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4. Under Query, click Select From Map. 

 
5. Click and drag on the map to draw a rectangular selection area. After you draw the rectangle, the 

Query Results box automatically appears and displays the results for the active layer. 

Note:  The Query Results box only displays 25 records at a time. If there are more than 25 
records, click the More Records link at the bottom of the Query Results box. 

6. Do any of the following: 

• To view an individual result on the Map View, click the Show on Map link on the row of the 
selected result. 

• To buffer the results, click the Buffer these Records link. Go to Step 7 for instructions on selecting 
features within a buffer area. 

Note: Buffering the records listed in the Query Results box enables you to establish a map 
boundary around the current feature and then search for additional attributes and features within 
the boundary area or within a set distance outside of the boundary area (e.g., performing a query 
search within a land use parcel for rail lines that intersect the parcel area).  

 

Note: The Buffer these Records link only buffers the records that are displayed in the Query 
Results screen. If there are more than 25 records, you will need to click the More Records link 
to display and buffer the records that are shown on the screen. You will need to click the Buffer 
these Records link for each group of records displayed on the Query Results screen (i.e., you 
would click the Buffer these Records link to buffer records 1 through 25, and then after you click 
the More Records link, you would click the Buffer these Records link again to buffer records 1 
through 50, etc.). 
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7. You can select features within the buffer zone by using the Query Results box to search for features 
within the current zone. Do the following: 

• Click the Select features from arrow to expand the list box.  The box populates with the features 
available in the database. 

• Select the variable from the list by clicking it.  For this illustration, Generalized Land Use (Parcels 
Derived) is shown as selected.   

 
 

• In the Within Miles of the selected features of Name of Feature text box, do one of the following: 

ο Accept the default, 0 Miles, if you want to search for features within the established buffer 
zone. 

ο Type the number of miles into the text box if you want to expand the search range beyond the 
established buffer zone (e.g., searching for schools within the established buffer zone plus 
number of miles outside the buffer). 

For this illustration, the default, 0 Miles, is accepted because the search range will remain in the 
established buffer zone. 

• Click Go. The Query Results box refreshes and displays the results for the specific area drawn on 
the map (solid polygon) within the established buffer zone and, if added, the extended distance 
range. The next illustration shows the Query Results box displaying the results along with the 
buffered area (shaded area) and drawn area (solid polygon) in the background. 
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2. In the map menu, click Contents, and then click Maps to select a resource map. Under the issue 
heading, click the appropriate check boxes to turn layers on and off (see the Selecting Issue Layers 
and Setting Map Preferences in the Table of Contents section for details on selecting maps and turning 
layers on and off).  For this illustration, the Historic and Archaeological Sites issue is shown as the 
selected resource map, with the Archeological and Historic Sites layer shown as the active layer.   

 
The Map Viewer refreshes and displays the Archaeological and Historic Sites layer, with the sites 
indicated by color (click the Legend thumbnail to view the map feature color coding and 
symbols). 

3. Click the Tools link. 
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4. Under Query, click Buffer. 

 
The Query Results dialog box appears, showing the Select features from list box and text box 
for setting the distance at or beyond the selected area.  

 

5. You can select features within the selected area by using the Query Results dialog box to search for 
features within the current zone. Do the following: 

• Click the Select features from arrow to expand the list box.  The box populates with the features 
available in the database. 

• Select the variable from the list by clicking it.  For this illustration, SHPO National Register Sites is 
shown as selected.   

 
 

 



 

 Environmental Screening Tool Handbook  3-602 

• In the Within Miles of the selected features of Name of Feature text box, do one of the following: 

ο Accept the default, 0 Miles, to search for features within the established buffer zone. 

ο Type the number of Miles in the text box to expand the search range beyond the established 
buffer zone (e.g., searching for schools within the established buffer zone plus number of 
miles). 

Note: You must use numbers greater than zero in the Miles text box. 

• Click Go. The Query Results box refreshes and displays the results for the buffered area. 

 
 

• Click the Show on Map link on the data row you want to view on the Map Viewer.  

Tip!  Clicking the Show on Map link will zoom to the specified area on the Map Viewer. Use the 
Scale box located in the Map Viewer toolbar or the zoom slider to zoom out to a distance that 
allows you to view a feature and buffer area in relation to the project location.  

6. Repeat the steps listed above for buffering additional features within the Map Viewer. 
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3.4.1.3.3 Search 

The Search feature in the maps menu enables you to search selected map layers by project, key words, or by 
latitude and longitude coordinates. 

1. Click the Search button in the map menu to search for the target area or project.  The Search panel 
displays a search filter and a list of layers that are searched. 

 

Tip! Your query can be a partial spelling of a name or keyword. 

2. Accept the Everything default, or click the drop-down arrow, , and then select the appropriate layer.  

3. Click Search. For this illustration, just the partial word for widening (“wide”) is shown as the search 
operator for projects involving road widening.  

 
 

4. Click the appropriate link in the Search results to zoom to the selected area on the Map Viewer. 
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3.4.1.3.4 Help 

The Help feature in the map menu opens a panel that provides quick access to tips for using the Map Viewer 
along with a Getting Started section for quick reference to start using the Interactive Map Viewer.  

Note:  You will find additional Map Tips at the bottom of the Contents and Tools panels. The tips found 
in these panels provide a general overview of the functions shown within the respective panel. 
 

 
 

3.4.1.4  Map Editor (Updated 11/30/2011) 

The Edit Map Features tools provide easy access for editing project features and community boundaries. 

3.4.1.4.1 Drawing and Editing Project Features 

The Editing Project Features tool in the Map Editor enables authorized users to digitize project features 
for projects in Draft, QA/QC, or Editing status within their jurisdiction.  

Note: Check with your organization’s EST administrator or contact the ETDM Help Desk for information 
about EST privileges. 

The Editing Project Features tool allows you to do the following: 

• Create new project features 

• Edit existing projects 

• Use an extraction tool to include segments from the RCI map 
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1. Open the Interactive Map Viewer and then go to the project location by doing any of the following: 

• Zoom to a project location directly in the Map Viewer: 

ο Click the Click to Open Map bar. 

ο In the Map Viewer, zoom to a location by clicking the area directly on the map or by using the 
Zoom In and Zoom Out buttons on the map toolbar. 

Note: See the Map Viewer section at the beginning of this chapter for information on opening 
the viewer and using the Map Viewer Top Toolbar. 

• Select a project using the Project Navigation bar and then click the Map it button to zoom to the 
project location. 

Note: See the Navigation chapter of the EST Handbook for instructions on using Advanced 
Project Search. 

• Change to another project using the Map Viewer’s table of contents: 

 

 

ο Click the Contents button on the map menu bar. The Contents panel expands. 

ο Beside Active Project, click the change link. 

 

ο In the Search panel, type the project number, the full project name or part of the project name 
in the Search field. 

ο Click Search. 

ο Under Projects, click the appropriate project name from the list of search results. The Map 
Viewer refreshes and displays the project location. 
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2. After the project location opens in the Map Viewer, open the Map Editor by clicking the Tools button 
on the map menu.  

3. In the Tools panel, click Transportation Projects.  

 
The Editing Project dialog box appears and displays the Alternative name (or a list box 
containing multiple Alternatives), a Features table of contents, and drawing tools that allow you to 
create or modify a feature’s shape. 

Note: A project must have at least one Alternative before you can create a feature’s shape. To 
add an Alternative to a project in the EST, go to the Tools menu, point to Project Diary, and then 
select Alternative Description (see the Add/Update Alternative Description section of the Tools 
chapter in the EST user handbook for detailed instructions). 
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4. Click the Select Alternative arrow, and select the Alternative name from the list box. The features that 
are drawn on the map will apply to the selected Alternative.  

Tip! An Alternative can have one or more features. 

 

5. Create a new feature by doing one of the following: 

• Click the New button beside the selected feature to create a new shape. Go on to the next step, 
Step 6, of these instructions. 

• Click the Extract button beside Segments to extract an existing roadway from the RCI map. Go to 
the Extracting Segments from Existing RCI Roadways section for details on extracting from the 
RCI map. 

6. After clicking the New button beside the selected feature, a check box appears for the new feature and 
the Editing Project dialog box refreshes, displaying a highlighted Draw button. 

 
7. In the Name field, enter the name of the feature, or you can leave the default name provided by the 

EST (e.g., Segment 1). 
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8. If you are creating multiple features, you can assign a different color to each feature.  To assign a 
different color to a feature, do the following: 

• Click the color pallet icon beside a feature name.   

 
The pallet box will expand, enabling you to select and assign a color for the selected feature.  

• On the color hue bar, move the slider bar to select the color range. 

 

• In the color pallet box, click the color value. A circle appears on the selected value. 

• Click OK.  The color icon shows the assigned color for the feature. 
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3. On the Map Editor, begin making edits to a segment or polygon by doing the following: 

• Move a vertex (bold box) to another location on the map by clicking and dragging it to the desired 
location, as indicated in the next two illustrations.  The Editing Project dialog box displays the 
segment Length or polygon Area. 

 
 

The lines and midpoints adjust to the new coordinates set by the vertex’s change in location. The 
next illustration shows the segment change from its previous location (Vertex1 and midpoint) and 
a change in the segment’s distance (shown in the Length box). 
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• Click a midpoint (transparent box) and drag it to a desired location on the map. 

Note: Dragging a midpoint is an effective way to add points to a segment or polygon. 

 
Dragging a midpoint changes the midpoint to a vertex, adds new segments on either side of the 
midpoint connecting to the adjacent vertices, and inserts new midpoints on the new segments (as 
shown in the next illustration).   

 
 

The next illustration displays a polygon in edit mode. 
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The Editing Project dialog box refreshes and displays a form for entering FDOT roadway ID and 
milepost information. 

 

2. You can either extract RCI roadways by using the form (enter Roadway ID and Milepost locations) or 
by clicking on an RCI roadway on the map.   

• To extract RCI roadways using the form, do the following: 

ο Enter the Roadway ID, Begin Milepost, and End Milepost locations into the appropriate 
fields. 

ο Click the Extract button. 
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The Editing Project dialog box displays the roadway ID (e.g., 10590000) and milepost (MP) 
information under the Segments category and in the Name field.  The length of the segment is 
also displayed in the Length field.  

 
The extracted feature appears on the map, displaying vertices and midpoints. 

 

• To extract RCI roadways using the map, do the following: 

ο In the Map Editor, click once on the location where you want to begin the RCI segment. The 
location is marked by a pushpin.  

 

ο Click the next location point to complete the segment extraction. Another pushpin appears. 
The database automatically extracts the RCI roadway data.  
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The extracted feature then appears on the map, displaying vertices and midpoints. 

Note: Both points must be on the same RCI roadway. Placing points on different roadways or on 
roadways other than RCI will result in an error message. 

 
The Editing Project dialog box displays the FDOT roadway ID (e.g., 10590000) and milepost 
(MP) information in the Name and Length fields of the form. The roadway ID and MP information 
also appears under the Segments category of the Features table of contents. 

Tip! You can rename the Roadway ID in the Name field. The revised name will appear under 
the Segments category after you click Save. 

3. To assign a different color to an extracted segment, click the color icon beside the segment’s name, 
and then follow the steps listed for assigning a different color to a feature found in the Drawing and 
Editing Project Features section of this chapter. 

4. Click the Edit button to alter the shape of the segment.  (See the Editing Features in the Map Editor 
section for details.) 

5. Click Save. 

3.4.1.5  Edit Communities 

The Communities tool in the Map Editor enables authorized users to digitize community boundaries within 
their jurisdiction.  

Note: Check with your organization’s EST administrator for information about EST privileges, or you can 
contact the ETDM Help Desk. 

With the Communities tool, you have the option to do any of the following: 

• Create a new community boundary (See the Creating a Community Boundary section for details.) 

• Edit existing community boundaries (See the Editing a Community Boundary section for details.)  

3.4.1.5.1 Opening the Communities Tool 

1. Open the Map Viewer and zoom to a project location. 

2. In the map menu, click Tools. The Tools panel opens and displays the Map Editor icons. 
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3. Under Edit Map Features, click Communities. 

 
The Edit Community Features dialog box appears, giving you the option to create a new 
community or search for an existing community or ETDM project. 

 

3.4.1.5.2 Creating a Community Boundary 

1. In the Edit Community Features dialog box, click the Create New Community link. 

 
The Edit Community Features dialog box refreshes and displays a form along with drawing tool 
icons. 
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2. In the form, complete the following fields: 

• In the Name field, assign a name for the community. 

Note: The Name field is a required field. The History and Values & Goals fields are optional. 

• Provide a brief history of the community in the History text box. You can copy and paste or type 
the information into the text box. 

• In the Goals & Values text box, type or copy and paste information regarding the community’s 
goals. 

3. Click the Draw button. 

 
4. In the Map Editor, draw the community boundary.  

Tip!  Refer to the Drawing Project Features and Editing Project Features sections for illustrations 
of drawing and editing in the Map Editor. 

5. Click Save. 
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3.4.1.5.3 Editing a Community Boundary 

The Search function of the Edit Community Features tool enables you to select and edit a saved shape. You 
can search by Community Name or by ETDM Project # if you are searching for communities within a specified 
distance of a project. 

 
 
1. In the Search for Existing Communities dialog box, do one of the following: 

• To search for a community by name, select Community Name and then do the following: 

ο Enter the name of the community in the first field on the left side of the dialog box. 

 

ο Go to the next step, Step 2, of these instructions. 

• To search for communities within a specified distance of a project, click the drop-down arrow and 
then click ETDM Project #.  Do the following: 

ο Type the ETDM number in the first field on the left side of the dialog box. 

ο Type the distance in the within field. 

ο For the unit of measure, click the drop-down arrow and then select a unit of measure from the 
list. 

 

ο Go to the next step, Step 2, of these instructions. 

2. Click Search. The Search for Existing Communities dialog box expands, displaying the search 
results along with Edit Boundary links. 
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3. Click the Edit Boundary link to display the boundary shape on the map. 

4. In the Map Editor, click a vertex point (displayed as square boxes) and drag it to the desired location. 
Continue moving the vertex points until the desired boundary shape is completed. 

5. Click Save. 

3.4.2 Print Hard Copy Maps (Updated 11/30/2011) 
The Print Hard Copy Maps option provides access to maps that have been initially created automatically for a 
project when the standard GIS Analysis program was run.  Maps are also automatically generated when the 
status of a project Alternative is set to GIS Analysis Complete, ETDM QA/QC, or ETAT Review; or they can be 
manually generated by the ETDM Coordinator if GIS data updates are available.   

Note: Instructions for setting and updating the status for Alternatives can be found in the Tools section of the 
EST User Handbook. 

Viewing a List of Project Maps: 
1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project 
from your Saved Searches or Project History lists, or you can click the Advanced Project 
Search link to select another project. See the Navigation chapter of the EST Handbook for 
information on using the Project Navigation Bar. 

 
2. On the Maps menu, point to Print Hard Copy Maps. 

 
The Print Hard Copy Maps window opens as a tabbed page.  

Tip!   Click on the toolbar icons to: 

   Send feedback about the current page. 

   Access online Help. 
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Depending on the project’s status, one of the following Print Hard Copy Maps screens will 
appear: 

• If maps have been created for a project, the screen (shown in the next illustration) will display. Go 
to Step 3.  

 
 

• If maps have not been created for a project or if you do not have draft access privileges, the 
following screen appears. Go to Step 6 for information on creating hard copy maps for a project. 

Note:  If a message indicates you do not have draft access, contact the ETDM Help Desk for 
assistance at help@fla-etat.org  or by phone at (850) 414-5334. 
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3. To view maps associated with completed milestones for the project, or current data if the project has 
been released for ETAT review or an ETAT review has been completed but not summarized, click a 
Project Milestone date link or Current Project on the Project Milestone Dates row header. 

Tip!  When you point to a Project Milestone date link, a help tip pops up and provides a brief 
description of the project milestone.  To open the Project Milestone Report, click the Project 
Milestone Dates row header. The report displays a snapshot timeline and details for the selected 
project. 

 
The selected milestone becomes highlighted, indicating that this is the data set currently 
displayed. A description of the milestone appears in the Project Milestone box.   

 
After selecting a Project Milestone date link or Current Project, the Print Hard Copy Maps 
screen refreshes and displays the maps associated with the selected date.  

Note:  The Print Hardcopy Maps page displays a regenerate button if the underlying map data 
has been updated since the map was last generated. Click the button to update the map with the 
latest data.  

If no image of the map is currently available a  missing ** note appears in the Publication Date 
and Format columns.  ETDM Coordinators for the project’s planning organization or district can 
click the regenerate button to update maps, if needed. 

 
4. Select the print format by clicking the JPG or PDF link.   

Tip!  Clicking the PDF link requires Adobe Reader be installed on a browser in order for the 
images to be viewed. Clicking JPG enables an image to display without using special software.  
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5. Print, save, or email the map by doing the following: 

• On the JPEG image, right-click the mouse button to display the browser menu, click Print to print a 
hard copy of the map, or click Save Picture As to save the map to your desktop; click E-mail 
Picture to attach the map to an email. 

 

• On the PDF image, print the map by doing any of the following: 

ο Use the toolbar at the top of the PDF window to print, , or save, , the image to your 
desktop. 

 

ο Right-click on the image and then click Print on the screen menu. 

 
 

Tip!  You can also print a map in either format by pressing Ctrl + P. 
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6. If no hardcopy maps are listed for a selected project, you can create a map in the Interactive Map 
Viewer by doing the following: 

• In the Project Navigation bar, click the  button. The Interactive Map Viewer opens 
and zooms to the project location. 

Note: The project name needs to be displayed in the Active project field beside the Map it 
button before you can zoom to the project location. 

• On the Map Viewer top toolbar, click the Print icon. 

 
 

A Print dialog box opens, displaying fields for providing a Map Title and for selecting page 
Orientation, paper Size, and key map elements to display on the hard copy map. 

• Complete the fields in the Print dialog box. 

• To display key map elements—Legend, North Arrow, and Scale Bar—on the hard copy map, 
click the check box(es) beside the element(s) you want to display. 

• Click Print Map. 
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The EST displays the map in a separate PDF window. 

 

• Follow the standard steps to print the PDF (see Step 5 of this document for instructions) or save it 
to your desktop.  

 

3.4.3 Print Potential Impact Assessment Maps (In Development) 
 

3.4.4 Hard Copy Map Queue (In Development) 
 

3.4.5 Potential Impact Assessment Map Queue (In Development) 
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Chapter 3 Functions 

3.5 Account Settings (Updated 6/30/2010) 

The Account Settings functions in the EST enable users to manage their personal information, EST account, 
and saved reports. This menu includes functions to set user preferences, change password, and other user-
specific option management. 

   
 

3.5.1 Change Password 
The Change Password function enables users to create a new password.  To access the Change Password 
function, go to the Account Settings menu, and then select Change Password.   
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A form will open, with fields for your old password, new password, and confirm your new password.  When 
completed, click Change. 

 
 

Tip!  Click the toolbar icon in the page to: 

  View a training video about this function. 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

 Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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3.5.2 Update Contact Information 
This function allows users to update their own personal account information stored in the ETDM database.   

1. Go to the Account Settings menu, and then select Update Contact Information.   

 

2. Enter the contact information on the Update Contact Information form then click Submit Form. 
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3.5.3 Customize My ETDM 
This function allows the user to set preferences for the My ETDM page.  Selecting this function opens a form 
that allows the user to select one or more pages from a checklist of available pages.  Up to five form(s), report(s) 
or static page(s) may be selected by the user to be displayed on the primary page.  The available selections for 
these pages are listed in Table 2-1. 

To access the Customize My ETDM function, click on the Account Settings button on the main menu, then 
select Customize My ETDM under the Account Settings pull-down menu.  On the form that opens, click on the 
check box next to the desired pages, then click “Add Selection(s).” 
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My ETDM pages may also be selected by navigating to a page, then following the instructions on the Customize 
My ETDM Pages screen (as illustrated below). 
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3.5.4 My GIS Analysis Reports (New 6/22/2007) 
My GIS Analysis Reports allows you to create your own unique GIS Analysis Report by selecting issues of 
interest and specific GIS analyses and buffer distances within those issues and including them in a customized 
report.  After you set up the report, you can use it as a template for all projects or you can apply the report to one 
project only.  Then, when you use the GIS Analysis Results report found under Reports > Project Effects  on the 
main menu, you have the option of using that report to view GIS analysis results for one issue at a time or you 
can use a link to view the GIS analysis results specified in a customized My GIS Analysis Report.   

To set up My GIS Analysis Reports, select this option from the Account Settings heading on the main menu. 

 
 

When accessing My GIS Analysis Reports for the first time, you will see a message indicating there are no GIS 
report preferences currently configured for your user account, as shown below.  Click 

 to set up your first custom GIS Analysis Report. 
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Select Issues 
The first step in setting up a custom GIS Analysis Report is to select the issues to be included.  Click the check 
box next to each issue of interest.  A green checkmark will appear in the check box.  Because this report can 
become quite large if a large number of issues are selected, you may want to limit the number of issues that you 
select for each report.  Instead of setting up one large “My GIS Analysis Report” with many issues, you could set 
up several smaller reports with fewer issues to improve processing speed and performance.  When finished, 

click . 
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In the example shown here, the Air Quality, Economic, and Land Use 
issues have been selected, and are indicated by green checkmarks. 

Configure Custom GIS Analysis Report 
The next step is configuring your custom GIS Analysis Report.  First, 
indicate a name for the report using the text box next to Report Name.  
The default name (GIS Report #1 in the example) can be changed by 
deleting that text and typing in a new name.  Next, indicate if the 
selected GIS analyses will be used for all projects or only for the 
currently selected project.  The default is “Use report for all projects.”  If 
this option is used, the custom GIS Analysis Report will be available for 
any project when you open GIS Analysis Report (under Reports on the 
main menu).  Selecting the other option (Use report for currently selected project only) will limit the availability of 
the custom GIS Analysis Report to that project only.  To select the second option, click the radio button next to 
that option. 

 

 

If you select the second option (Use report for currently selected project only), you must then select one or more 
project Alternatives.  A drop-down list will appear.  Click the check box next to each Alternative for which you 
want to use the custom GIS Analysis Report. 
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Next, select individual GIS analyses and buffer distances for each issue.  (Note that individual analyses and 
buffer distances must be selected before saving your custom GIS Analysis Report.)  There are several ways to 
do this.  One way is to select one or more buffer distances that will apply to all the analyses.  To use this option, 
click the check box next to each buffer distance of interest (in the orange-colored bar), or click “Select All 
Buffers.”  A green checkmark will appear.  In the example shown, the buffer distance of 500 ft was selected.  
Note that selecting a buffer distance also selects all the individual analyses for the issue (indicated by green 
checkmarks).  To deselect an analysis, click the check box in front of the analysis name.  The green checkmark 
will be removed. 

 
Another way to select individual GIS analyses and buffer distances is to first select an individual analysis by 
clicking the check box in front of the analysis name.  A green checkmark will appear.  In the example, Air Quality 
Maintenance Areas and Industrial Areas 2000 were selected.  Note that all the buffer distances for the selected 
analyses will also have green checkmarks.  To deselect a buffer distance, click the check box in front of the 
buffer distance.  The green checkmark will be removed.  The second example illustrates this.  The 100 ft., 200 
ft., and 5280 ft. buffer distances were deselected for Air Quality Maintenance Areas, and the 100 ft., 200 ft., and 
500 ft. buffer distances were deselected for Industrial Areas 2000.  Again, selecting a large number of analysis 
types and buffer distances will affect processing time and performance.  The more analysis types and buffer 

distances that you select, the longer it will take to generate the report.  When finished, click .  
Note that you can clear these selections and reconfigure your custom GIS Analysis Report by clicking 

. 
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Save Custom GIS Analysis Report 

Clicking the  button saves the report that you configured using the steps described above, and 
displays a message indicating that your report was successfully added to your custom GIS Analysis Reports.  
This page displays a list of all your custom GIS Analysis Reports, as shown below.  Click the load report link (

) to view your custom GIS Analysis Report, or click  to create a 
new report. 

 

 

Clicking a buffer 
distance deselects it. 

Click here to view 
custom GIS report 



 

 
Environmental Screening Tool Handbook  3-638 

View Custom GIS Analysis Report 

Clicking   opens the GIS Analysis Results report (also found under Reports > Project Effects > GIS 
Analysis Results).  This report includes a project header for the currently selected project, followed by the GIS 
Analysis Results specified in the custom GIS Analysis Report, as shown below.  To view GIS Analysis Results 
for a different project using the selected custom GIS Analysis Report, select a different project using the Project 
Search tool bar.  You can also view GIS Analysis Results for the currently selected project using a different 

custom GIS Analysis Report.  Click  to return to the list of custom GIS Analysis Reports 
and select a different custom GIS Analysis Report. 
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Note that if the custom GIS Analysis Report was set up for a particular project only, the report that loads will be 
for that project, and will not refresh if a different project is selected.  An error message will be displayed, as 
illustrated in the following example. 

 

Note also that if you select specific alternatives for a particular project, and any of these alternatives is put back 
into a Draft status by the ETDM Coordinator, these alternatives will no longer be available for viewing if you do 
not have Draft access.  Milestone versions of the data will still be available.  

Accessing My GIS Analysis Reports via the Reports Menu 
The GIS Analysis Results report found under Reports > Project Effects >GIS Analysis Results includes a link to 
My GIS Analysis Reports, as shown below.   

 

Clicking  takes you to your list of custom GIS Analysis Reports, as illustrated in the 
example below.  Click the plus sign ( ) to the right of the report name to see the configuration for that 
report.  In the example below, the plus sign ( ) for GIS Report #1 has been clicked, and the list of 
analyses selected for that report are displayed. 
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Editing and Deleting Custom GIS Analysis Reports 
After setting up one or more custom GIS Analysis Reports, you can view, edit, or delete a custom GIS Analysis 
Report by opening My GIS Analysis Reports under Account Settings.  Click the edit tool ( ) (in the orange-
colored bar) to edit a report, or click the blue X ( ) to delete a report.  Click the load report link ( ) to 

view a custom GIS Analysis Report, or click  to create a new report. 

 

Note that these functions are also available when you click  and when you click 

. 
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3.5.5 Manage Saved Searches 
The Manage Saved Searches function allows the user to view and edit the project selection searches that the 
user has saved, which are located under Saved Searches on the Project Navigation Bar (See Section 2.3 for a 
description of the Project Navigation Bar.) 

To access the Manage Saved Searches function, click on the Account Settings button on the main menu, then 
select “Manage Saved Searches” under the Account Settings pull-down menu.  The Saved Searches are 
organized under the headings “Manual Selections” and “Dynamic Selections.”  The user can add or remove 
projects from a Saved Search by first clicking “edit” next to the description of the Saved Search.  The Project 
Selection page will open, where projects may be added or removed. 
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3.5.6 Manage Contact Lists (New 6/30/2010) 
The Manage Contact Lists function in the Environmental Screening Tool's (EST's) Account Settings menu 
enables you to select individual contact records from the database and group them together into personal 
contact lists or add new contacts to existing contact lists.  

The Manage Contact Lists function provides you the tools to: 

• Create a personal contact list (See Step 2 for navigation details) 

• Add Contacts who are existing EST users (See Step 3 for navigation details) 

• Add Contacts who do not have existing EST accounts (See Step 4 for navigation details) 

• Edit an existing contact list (See Step 5 for navigation details) 

• Rename a contact list (See Step 6 for navigation details) 

• Delete a contact list (See Step 7 for navigation details) 

Managing Contact Lists: 

1. On the Account Settings menu, point to and click Manage Contact Lists. 

 

The Manage Contact Lists window opens as a tabbed page, displaying a page toolbar and a 
Contact Lists section. 
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Tip!  Click the toolbar icon in the Manage Contact Lists window to: 

 Print a copy of the current page. 

  Export the current page to a PDF file. 

 Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

2. To create a contact list, do the following: 

• In the Enter a name for the new list field, type the name of the contact list you are creating. For 
this illustration, the new contact list is called "Division Contacts." 

 
 

• Click Create New List. 

 
 

A message appears stating the new contact list has been successfully added. 
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• Under Contact Lists, click the Edit link beside the newly added contact list located in the List 
Name column.  

 
 

Tip!  Click the Delete link beside the corresponding contact list to delete it. 

The Manage Contact Lists window refreshes and displays a What would you like to do? 
section, which provides options for managing the selected list.   

• Do one of the following: 

ο To add Contacts who have existing EST user accounts to the contact list, click the option 
button beside Search for existing users to add to your Name of List contact list.  (Go to 
Step 3 for further navigation details for adding existing users to a contact list.) 

 
 

ο To add Contacts who do not have existing EST user accounts, click the option button beside 
Create a new user to add to your Name of List contact list.  (Go to Step 4 for further 
navigation details on adding contacts who do not have existing user accounts to a contact list.) 

 
 

• Click Go. 
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3. To add contacts with existing user accounts to your contact list, do the following: 

 

Tip!  The Search For Existing Users fields are not required to perform a search. You can click 
Search Contacts without completing any of the fields in the filter. However, the more fields you 
complete, the fewer returned results will be displayed. Clicking Search Contacts without 
completing any of the search fields results in the EST displaying all the names in the database. 

• In the Search For Existing Users search filter, complete one or more of the following fields: 

ο Click the drop-down arrow  in the Organization field. The field expands, displaying a pre-
populated list of organizations. Select an organization by clicking on the organization’s name. 

 
 

ο Click the drop-down arrow  in the District field. The field expands, displaying a pre-
populated list of FDOT districts. Select a district by clicking on the district name. 
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ο Click the drop-down arrow  in the County field. The field expands, displaying a pre-
populated list of counties. Select a county by clicking on the county name. 

 
 

ο Click the drop-down arrow  in the User Role field. The field expands, displaying a pre-
populated list of user roles. Select a user role by clicking on the user role name. 

 
 

ο To search for a specific existing user’s contact information, type the contact's name in the 
Name field. 

 
 

ο To search for contacts by job title, type a job title in the Title field. 
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ο To search for a specific existing user by email address, type the contact's email address In the 
E-mail field. 

 
 

• Click Search Contacts. 

 
 

The Manage Contact Lists window refreshes and displays the results matching your search 
criteria.  The Select recipient(s) from search results to add to your list section displays 
the contact information in the following columns: 

ο Name (Contact's Name) 

ο Email (Contact's E-mail) 

ο Organization (Contact's Organization) 

Tip!  Click the column heading to sort the information in ascending order.  Click the column 
heading again to sort the information in descending order. 

 
 

Tip!  If a name does not appear in the search results shown in the current window, click the 
Search Again button located at the bottom of the Manage Contact Lists window.  The EST 
returns you to the Search For Existing Users filter where you can re-enter your information. 
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• Under Select recipient(s) from search results to add to your list, select the name(s) you want 
to add to your contact list by doing one of the following: 

ο To select one or multiple names, click the check box  beside the name(s). 

 
 

ο To select all the names listed on the screen, click Select All. 

 
 

The EST displays all the check boxes as checked. 

Tip!  Click the Select All check box again to deselect the checked boxes. 

 
• Click Add Selected Contacts. 

 
 

The Manage Contact Lists window refreshes, displaying a green checkmark and a 
statement that the contacts have been added to the selected contact list.  The User 
Accounts Associated With Your "Name of List" List section shows the contact user 
accounts in a table that is divided into the following columns: 

ο Name (Contact's name) 

ο Email (Contact's email) 

ο Organization (Contact's organization) 

ο Created By (Organization of user setting up contact list) 
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Tip!  To remove a contact, click the check box(es)  beside the contact name(s), and then click 
Remove Selected Contacts.  To remove all the names listed in your contact list, click the 
Remove All check box , and then click Remove Selected Contacts. 

 
4. To create a new Contact who has not been assigned an EST user account, do the following: 

• Under Create a New Contact for the "Name of List" List, complete the appropriate fields under 
Contact Information: 

Note: Fields that are highlighted or containing an asterisk (*) are required fields.  The EST 
will not process your information if these fields are left blank. 

ο In the First Name field, type the contact's first name (Required). 

ο In the Last Name field, type the contact's last name (Required). 

ο In the E-mail Address field, type the contact's work email address (Required). 

The remaining Contact Information fields are not required. You may complete these fields 
or leave them blank: 

ο Middle Name 

ο Title 

ο Position Description 

ο Address Line 1 

ο Address Line 2 

ο City 

ο State 

ο Zip Code 
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ο Alternate E-mail 

ο 10-Digit Direct Phone   

ο 10-Digit Office Phone 

ο 10-Digit Fax 

ο 10-Digit Cell Phone 

 
 

• The Account Information section of the Manage Contact Lists window enables you to assign a 
user account role to a contact.  Under Account Information, complete the following fields to 
create the Contact's user account. 
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ο In the Organization field, click the drop-down arrow , and then select the Contact's 
Organization name from the pre-populated list. 

 
 

ο In the Regions field, use the scroll bar to select the jurisdiction associated with the Contact 
(i.e., District and County). 

 
 

ο Make your selection by clicking directly on the District Number- Name of County. 

Tip!  You can select multiple entries by using the SHIFT+click for adjacent entries or 
CTRL+click for non-adjacent entries. 

 
 

ο In the Role field, assign the Contact a user role by clicking the option button beside one of the 
following role types: 

 Advance Notification – Commenting Interested Party 

 Advance Notification – Other Interested Party 

 Federal Consistency – Commenting Interested Party 

 Federal Consistency – Other Interested Party 
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Tip!  Information detailing a Contact's user role appears in the Role Described Here 
box. (See next illustration for an example.) 

 

ο In the Notification Type section, do the following: 

 Click the option button beside Electronic if the Contact is to receive electronic notifications 
and information, and has authority to submit comments via the EST. 

 Click the option button beside AN Hard Copy if the Contact is to receive hard copy 
versions of the AN Package and does not have authority to submit comments via the EST. 

 

Tip!  If the Electronic option has been selected as the Notification Type, the Notification Type 
field and check boxes in the Electronic Notification Preferences section become active. You 
can indicate whether the contact receives notifications of ETDM project updates occurring in the 
contact’s District or County, or for projects that affect the contact’s Agency’s specific Resources 
(e.g., projects impacting National Parks for a contact at the National Parks Service).  

ο Click the drop-down arrow  in the Notification Type field and select one of the following 
options: 

 None – The contact will not receive notifications of ETDM project updates. 

 District-level Notification –The contact will receive notifications of ETDM project updates 
in the Contact’s District. 

 County-level Notification – The contact will receive notifications for only ETDM project 
updates in the contact’s County. 

 Resource-level Notification – The contact will receive notifications for ETDM project 
updates affecting agency-specific resources. 
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ο Under Electronic Notification Preferences, add or change the following preferences by 
clicking the check box beside one or more of the following options: 

 EST Notifications :  Notifies the Recipient of EST updates  

 Quarterly Feedback Reports: Sends quarterly ETAT performance reports for the 
Recipient's organization 

 Invoice Reminders:  Sends the Recipient email reminders when invoices are due for the 
Recipient's organization 

Tip!  Click a checked box to deselect an option. 

• Click Save Information to save your information. 

Note:  If you need to exit the system before completing the Create a New Contact form, be 
sure to click Save Information before closing the window.  Otherwise, your information will 
be deleted.   
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5. To edit a contact list, do the following: 

• Under Contact Lists, select the list from the List Name column and click the Edit link beside the 
selected list. 

 
 

The Manage Contact Lists window refreshes, displaying the following sections: 

ο What would you like to do? 

ο User Accounts Associated With Your “Name of List” List 
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• Under User Accounts Associated With Your “Name of List” List, click the Edit link beside the 
user account you want to edit. 

 
 

The Manage Contact Lists window refreshes and displays the selected contact's information 
(Contact and Account). 
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• Under Update a Contact in the "Name of List" List, make the appropriate edits. 

• After making your changes, click the Save Information button located at the bottom of the 
Manage Contact Lists window. 

 
 

Tip!  Click Cancel Add/Update to cancel the operation. 

6. To rename a contact list, do the following: 

• Under Contact Lists, select the list to be renamed in the List Name column, and then click the 
corresponding Edit link. For the following illustrations, "Diane's List" will be renamed "Office List." 

 
 

The Manage Contact Lists window refreshes, displaying the user accounts for the selected 
contact list. 
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• Under What would you like to do?, click the option button beside Rename your contact list. 

 
 

• In the Rename your contact list field, type the new name for the contact list. For this illustration, 
the new name "Office List" is shown. 

 
 

• Click Go. 

 
 

The Manage Contact Lists window refreshes and displays a green checkmark along with a 
message that notes your contact list has been successfully renamed. 
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7. To delete a contact list, do the following: 

• Under Contact Lists, select the list you want to delete from the List Name column, and then click 
the corresponding Delete link.  For the following illustrations, "Bob's List" will be deleted. 

 
 

A message appears asking you to confirm the deletion. 

• Click OK. 

 
 

Tip!  Click Cancel to terminate the deletion process. 

The Manage Contact Lists window refreshes and displays a green checkmark along with a 
message noting the deletion was successful. 
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3.5.7 Manage Bookmarks 
This function allows users to select/deselect one or more pages from a checklist of available pages that are 
referenced on any of the navigation bars (top, left or bottom).  The total number of pages added to Bookmarks is 
not limited in number.  To access the Manage Bookmarks function, click on the Account Settings button on the 
main menu, then select “Manage Bookmarks” under the Account Settings pull-down menu.  On the form that 
opens, click on the check box next to the desired pages, then click “Add Selection(s).”  Bookmarks can then be 
accessed by clicking “navigate to bookmarks” on the form or via the Top toolbar. 
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Bookmarks may also be selected by navigating to a page, then following the instructions on the “Manage 
Bookmarks” screen (as illustrated below). 
 

3.5.8 Manage My ETDM Dashboard 
This function allows the user to make changes to the “My ETDM Dashboard” page. The “My ETDM Dashboard” 
page shows short summaries of standard reports on a single page to give quick access to critical information. 
Up to five items may be selected by the user to be displayed on the “My ETDM Dashboard” page. To access 
the “Manage My ETDM Dashboard” function, click on the Account Settings button on the main menu, then 
select “Manage My ETDM Dashboard.”  Click on the check box next to a desired item (up to five items), then 
click “Save.”  To remove an item from the “My ETDM Dashboard” page, un-check the box next to the name, 
then click “Save” to save the changes. 
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The “My ETDM Dashboard” is viewed by selecting it as a default page in the “Customize My ETDM” option 
under Account Settings.  After selecting “My ETDM Dashboard” as a default page, click the My ETDM button in 

the Top toolbar to view the Dashboard.  In the example shown below, New FAQs, ETDM 
Meetings and Conferences, and Agency Comments - Project Effects have been selected.  By 
selecting the “My ETDM Dashboard” page as a default page, it will also open each time you log 

on to the EST. 

 
The layout of the “My ETDM Dashboard” page can be changed by clicking “Change Layout.”  The form that 
opens lists the reports selected for the Dashboard, and shows their relative location on the page.  The top box 
contains larger reports that require the entire width of the window to view.  The two boxes at the bottom list 
smaller reports that can be viewed in either the left or right column on the window.  To move a report, click on 
the report title (as shown below) and then click on an arrow to change its position. 
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3.5.9 Set Default Layers on Maps 
This function allows the user to select an issue and layers that will initially appear on maps.  To access the Set 
Default Layers on Maps function, click on the Account Settings button on the main menu, then select “Set 
Default Layers on Maps.”  To change the default issue, select an issue from the pull-down menu, then click the 
“set as default issue” button.  A message will appear under the default issue field, confirming your selection.  
The issue name will also appear in the issue header.  

 
To change the default layers to be initially displayed on maps, click the folder icon next to “expand all,” then 
check or uncheck the boxes next to the data layer names.  When finished, click the “Save Visibility” button. 

 

To restore the default data layers, click the “Restore Default Visibility” button. 
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3.5.10 Change Notification Settings 
The Change Notification Settings function is used to specify which email notifications the user receives.  To 
access the Change Notification Settings function, click on the Account Settings button on the main menu, then 
select “Change Notification Settings” under the Account Settings pull-down menu.  By default, all users receive 
notices when the “What’s New” page is updated, when the system is experiencing difficulties or there will be 
planned outages, and when ETDM events are announced.  If you do not want to receive these notifications, un-
check the box next to “Check to receive all EST email notifications.  Click “Submit Form” when finished. 

ETAT members also use this tool to specify if they want to receive notices by district or by county.  Use the pull-
down menu next to “ETAT notifications” to select either “District-level Notification” or “County-level Notification. 
Click “Submit Form” when finished. 
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Chapter 3 Functions 

3.6 Help Links (Updated 11/30/2011) 

The Environmental Screening Tool’s (EST’s) Help links located at the bottom of the EST Main Menu includes 
the system help and other help-related topics.  

 
 

3.6.1  Frequently Asked Questions (FAQs) 
The Frequently Asked Questions function enables you to troubleshoot or find answers to commonly asked 
questions about the ETDM Process and the Environmental Screening Tool (EST).  To access the Frequently 
Asked Questions function, click the FAQ link.   
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The Frequently Asked Questions window opens, displaying questions that are organized by the following 
categories: Computer Questions, Data Questions, and Documentation Questions.   

 

 
 
The Questions are active links (blue underline). To view the answer to a question, click the Question 
Number link.  The Frequently Asked Questions window refreshes, displaying the answer to the selected 
question. 
 

 
 

Tip!  If the answer includes a table, click the column headings to sort the column in ascending or 
descending order. 
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3.6.2  Tip Sheets (New 11/30/2011) 
In addition to the EST User Handbook, users can get a quick overview for navigating a particular function. A list 
of available tip sheets is available in the ETDM Library.  

1. To access the list of tip sheets, click the Tip Sheets link in the Help section at the bottom of the EST 
Main Menu. 

 
 

The ETDM Library window opens, displaying the list of tip sheets. 

Note: The EST displays a tip sheet icon on the page toolbar if a tip sheet is available for the 
page in active view. 
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2. Select a tip sheet by doing one of the following: 

• Under Search the ETDM Library, type part of or the entire function name in the Keywords field, 
click Search, and then select the tip sheet by clicking the link in the Name column. 

• Scroll down the ETDM Library table, and then select the tip sheet by clicking the link in the Name 
column. 

Note: See the ETDM Library (Section 3.6.6.) section of this handbook for additional information 
on using the ETDM Library function. 

3.6.3  User Handbook 
The User Handbook function provides access to the Internet version of the Environmental Screening Tool 
(EST) Handbook.  Search and print capabilities are included.  Click the User Handbook link located in the list of 
Help links at the bottom of the EST Main Menu.   

 
The EST Help window opens, displaying the index for the EST User Handbook. 
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View a list of contents by clicking the Contents button .  An alphabetical list of topics can be 

accessed by clicking the Index button .  Search for information by clicking the search button  

  or using the search bar .  Use the Print button  to 
open a printer dialogue. 

3.6.4  ETDM Glossary 
This function opens a glossary of ETDM terms.  Users with the appropriate roles (e.g., EST administrators for 
an organization) can add, edit, or delete glossary entries from the list. 

1.      To access the Glossary, click the ETDM Glossary link located in the list of Help links at the bottom of 
     the EST Main Menu.   

 
The ETDM Glossary page opens, displaying a Search Glossary function that can be used to 
quickly find the definition of a term.   

2. In the Keywords field, type part of or the entire word, or you can type a phrase. 

3. Click Search. 
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Note: Depending on the user’s role, a term can be added to or deleted from the Glossary, or the 
definition of an existing term can be edited.   

4. To add a new term, click the Add button.  A dialog box will open, where the term and its definition can 
be typed in.   

 
 

• Do the following: 

ο Type the Term (this is a required field). 

ο Type the Definition. 

ο Click Add. 

5. To edit a definition, do the following: 

• Click the pencil icon beside the glossary Term. 

 
The ETDM Glossary page refreshes and displays the Edit Glossary Item fields. 

 

• Make the appropriate changes. 

• Click Update. 

Tip!  Click the Cancel button to cancel the changes. 
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6. To delete an item from the Glossary, click the X icon beside the Term. 

 
 

3.6.5  ETDM Acronyms 
This function opens a list of acronyms used in the ETDM Process.  Users with the appropriate roles (e.g., EST 
administrators for an organization) can add, edit, or delete acronym entries from the list. 

1. To access the list of acronyms, click the ETDM Acronyms link located in the list of Help links at the bottom 
of the EST Main Menu.   

 
The ETDM Acronyms page opens, displaying a Search Acronyms function that can be used to 
quickly find an acronym and its definition.   

2. In the Keywords field, type part of or the entire word or acronym. 

3. Click the Category arrow to narrow your search results, and then click the appropriate variable from the 
list. 
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4. Click Search. 

 
 

Note: Depending on the user’s role, a definition can be added to or deleted from the Acronyms 
list, or an existing definition can be edited.   

5. To add a new acronym, click the Add button.  A dialog box will open, where the acronym, its term, and 
its definition can be typed in.   

 
 

• Do the following: 

ο Type the Acronym (This is a required field). 

ο Type the Term (this is a required field). 

ο Type the Definition. 

ο Click the Category arrow to do one of the following: 

 Assign the acronym to a particular category by clicking the name on the list. 

 Create a new category by clicking enter category name. 

ο Click Add. 
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6. To edit an acronym, term, or definition, do the following: 

• Click the pencil icon beside the Acronym. 

 
 

The ETDM Acronyms page refreshes and displays the Edit Acronym fields, enabling you to 
correct or revise an acronym and its related information. 

 

• Make the appropriate changes. 

• Click Update. 

Tip!  Click the Cancel button to cancel the changes. 

 
7. To delete an item from the Acronyms list, click the X icon beside the Acronym. 
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3.6.6  ETDM Library 
This function provides links to documents stored in the ETDM database. Depending on the user’s role, a 
definition can be added to or deleted from the Acronyms list, or an existing definition can be edited. 

1. To access the ETDM Library, click the ETDM Library link located in the list of Help links at the bottom 
of the EST Main Menu. 

 
2. The ETDM Library window opens, displaying a search filter and a table listing the document Name, 

Category, Publication Date, File Extension, and File Size. 

Tip!  Click the column heading to sort the column in ascending or descending order. 
 

 
 

3. Under Search the ETDM Library, search for a document by doing the following: 

• In the Keywords field, type part of or the entire title, or you can type related words. 

• Click the Category arrow to narrow your search results, and then click the appropriate variable 
from the list. 

 

• Click Search. 
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4. Click the document name in the Name column to open it. The document PDF will open as a separate 
tabbed page. 

 
 

Note: Depending on the user’s role, a definition can be added to or deleted from the Acronyms 
list, or an existing definition can be edited.   

5. To add a new document to the ETDM Library, click the Add button.  The Add Document to the ETDM 
Library dialog box will open, where the document description and related information can be typed in 
or selected from a prepopulated list.   

  
 

• Complete the fields shown on the screen, with attention to entering information in required fields 
showing double asterisks (**). 

Note: Click the Exempt from Public Access Site check box if the document is not to be 
displayed on the ETDM Public Access Site. 

• In the New Attachment field, click the Browse button to locate and upload the target document to 
the ETDM Library. 



 

 
Environmental Screening Tool Handbook  3-675 

Note: The document must be in PDF or JPG file format before it can be uploaded.  Contact 
the ETDM Help Desk at help@fla-etat.org or call 850-414-5334 for assistance in uploading 
documents created in other formats. 

 

• Click Add. 

6. To edit a document in the ETDM Library, do the following: 

• Click the pencil icon beside the document name. 

 
 

The ETDM Acronyms page refreshes and displays the Edit ETDM Document fields, 
enabling you to correct or revise information related to the document or to upload the revised 
document from a desktop file. 

• Make the appropriate changes. 

• Click Update. 

Tip!  Click the Cancel button to cancel the changes. 

7. To delete an item from the ETDM Library, click the X icon beside the document name. 

3.6.7  Calendar (Updated 11/30/2011) 
The ETDM Calendar function in the Environmental Screening Tool (EST) is an interactive calendar that 
enables users to view upcoming training sessions and events.  With the ETDM Calendar, users will also have 
the ability to: 

• View ETDM-related events, including ETDM Milestones showing: 

ο ETAT Review Begin 

ο ETAT Review Complete 

ο ETAT Summary Report Published or Republished 

• Register for hands-on training sessions 

• Set up meetings and events for their organization (only applicable to users with the appropriate EST user 
roles) 

• Manage event types, enabling users to set preferences for events to be displayed in their ETDM Calendars 
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Using the ETDM Calendar Function in the EST: 

1.      Go to the list of links located at the bottom of the EST Main Menu, and then click ETDM Calendar. 

 
The Calendar page opens, displaying an electronic calendar showing icons that represent event 
types and a tabbed section showing an Event List and Display. 

Tip!   Click on the toolbar icons to: 

  Open the tip sheet for a quick guide on navigating the current page. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

  

The next two illustrations provide a brief overview of the Calendar screen. Go to Step 2 of these 
instructions for an index listing the Calendar functions. 
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Tip!  To provide more screen space for the Calendar, click the hide menu link at the top of the 
EST Main Menu. 

  
 

2. Click on the links or go to the steps listed below for instructions on using the ETDM Event Calendar. 

• Viewing calendar events and selecting events to display (Step 3) 

• Adding New Events (Step 4) 

• Attaching Documents to an Event (Step 5) 

3. To view event details for the selected month do any of the following: 

• The Event List provides a quick view of all scheduled events for the month along with their 
corresponding event icons. Move your mouse over an event to view the event details. 

Note: Click the Display tab to view the icon legend. 

 

 
 

• Event icons appearing on scheduled dates provide a quick view of the type of event(s) that are 
scheduled for that date.  Move your mouse over the icon to display the event details. 

Tip!  Click the left mouse button to keep the event details box open. Click the close link to 
close the event details box. 
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• The Display section shows each of the available event icons along with the corresponding label. 
Check boxes enable you to select events to be shown on the calendar. 

Note: Click Show only Events in my regions if you want the calendar to only display 
events within your jurisdiction. 
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Note: By default, the EST automatically shows all check boxes as selected. Click a checked 
box to deselect an event. 

4. Add a new event or meeting to the Calendar by doing the following: 

Note: You must have authorization to perform this function for your organization(s). 

• Access the Add New ETDM Event form by doing one of the following:  

ο Click the date link or double-click the date cell. The ETDM Events screen opens, displaying 
the ETDM Event form that shows the selected calendar date. 

 

ο On the Event List tabbed section, click the Add New Event link. The ETDM Events screen 
opens, displaying the ETDM Event form. 

 
 

• After the ETDM Events screen opens, do the following. 

Note: Fields showing double asterisks (**) are required fields.  You must enter information in 
these fields in order for the EST to process the information. 

ο Type the Name of the event (e.g., Summary Report Due, Introduction to the EST). 

ο Select your Organization name from the list. 

ο Type a Description of the event (e.g., Meeting to Discuss Regional Planning) 

ο Type the event’s Start date and End date using the mm/dd/yyyy format, or click the calendar 

icon, , and select a date .  

Tip!  If the event starts and ends on the same day, you can leave the end date blank. If 
the event does not have a specific time on that date, leave the time as the default 12:00 
AM. 

ο Type the name of the event Location, which can be a physical location or a web address 
(e.g., Main Conference Room, webinar URL address). 

ο Type the Contact Information for the event. 

ο Add any website URL links for the event (e.g., links to webinars, Go to Meeting, Google maps, 
organization’s website). 
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ο Click the Event Type arrow, and then select the appropriate option from the list (e.g., ETAT 
Review Start, Meeting, Training). 

Note:  To add documents related to the event, click the Attach a Document link, and 
go to the next step of these instructions (Step 5). 

ο Click Add. 

5. To attach a document to a new event, do the following: 

• Open and enter your information in the Add ETDM Event form using the steps shown in Step 4 of 
this document. 

• At the bottom of the Add ETDM Event form, click the Attach a Document link. 

 
The Add ETDM Event form expands and displays an option for selecting an existing 
document from the ETDM Library or for adding a new document.   

 

• Do one of the following: 

ο Accept the default option Select Existing Document to attach a document from the ETDM 
Library. Do the following: 

 Type part of or the full name of the document in the Search for Documents field or click 
Search for Documents to view the complete list of documents.  A list of documents will 
appear in the left list box. 

 Click the document name. 

 Click  to move the document to the right list box (documents being attached to the 
event notice). 
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Tip! Click  to return the document to the document list in the left list box. This will 
remove the document from the list of attachments. 

 Click Add.  The EST displays the ETDM Events list, showing the added event(s) for your 
organization along with the links to documents that were attached. 

Tip!  Click the document link to open it. 

 
 

Tip! To edit an event, click the pencil icon, .  Click the X to delete the event. 

ο Click Add New Document to add a document that is not in your list. Do the following: 

 Click the Display in ETDM Library check box if you want to add the document to the 
ETDM Library. 

 Type the Name of the event. 

 Type a Description of the document. 

 In the Category field, do one of the following: 

 Click the Category arrow, and then select a category from the list. 

 Click Add if a category is not listed. The Category field displays the category 
type form. Click the appropriate option button in the Type Id column. 

 

 Type the Publication Date using the mm/dd/yyyy format 

 Click the Browse button beside New Attachment to locate and upload the target 
document. 

 Click Update. The EST displays the ETDM Events list, showing the added event(s) along 
with a link to the document attachment(s). 

Note:  Document attachment links appear in the Calendar event boxes. Click on a 
Calendar icon to view the event details along with any attached document links.   
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3.6.8  EST Training Videos (New 6/30/2010) 
The EST Training Videos function enables you to access a collection of videos that demonstrate the general 
functions of the EST website. 

You can also access a training video for a particular function when you see the EST Training Video button,
on a page toolbar.  Clicking the button automatically opens the training video page, which displays links to 
videos associated with the selected function (e.g., Describe Direct Effects). 

Accessing the EST Training Videos: 

1.      To open an EST Training Video, do one of the following: 

• Click EST Training Videos link in the list of Help links located at the bottom of the EST Main 
Menu. 

 

• On the page toolbar, click the EST Training Video button , . 

 
 

Note:  A training video may not be available for your selected function. If this is the case, the 
EST Training Video button will not appear on the page toolbar. 
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2. Depending on your access selection, one of the following windows opens as a tabbed page: 

• If you clicked EST Training Videos in the Help menu, the EST Training Videos page opens, 
displaying a page toolbar and links to all available training videos that demonstrate the navigation 
steps for various tasks.  

 
 

• If you clicked the training video icon, , in the page toolbar, only the links to videos associated 
with the selected function are shown.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

  Add the page to your My ETDM preferences. 
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3. Under a How to section, click the link to the video you want to view. 

 
 

The video opens in a separate window. After the video loads, it will automatically begin playing. 

 

Tip!  If you want to pause the video, click the pause button, , located at the bottom left of 
the video player.   

 

4. After the video ends, close the window by clicking either the red  button at the top right of the window 

or the  button located at the bottom right of the video player. 
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3.6.9  What’s New (Updated 11/30/2011) 
This function provides an overview showing the latest and past information about enhancements made to the 
Environmental Screening Tool.   

Tip! You can find the latest changes made to the EST in the What’s New section on the EST 
home page. Click the more… button to open the What’s New page, enabling you to view the 
history of EST enhancements. 

 
 

Click the What’s New link located in the list of Help links at the bottom of the EST Main Menu to 
view a complete list (recent and past) of EST Enhancements.  

 
 

The What’s New page opens, displaying the list of enhancements along with the dates they were 
implemented. 

Tip!   Click on the toolbar icons to: 

 Print the current page. 

  Create a PDF of the current page. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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3.6.10  EST Site Map 
The EST Site Map provides an outline of the functions that make up the EST.  To access the Site Map, click 
the EST Site Map link located in the list of Help links below the EST Main Menu. 

 
The EST Site Map window opens, displaying an outline of the EST menus and function categories.  Each 
function is an active link, enabling you to go directly to a tool or report.  Only those functions that the user has 
access to will be listed in the Site Map. 
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3.6.11  About EST 
About EST provides an overview of the Environmental Screening Tool 
(EST) as found in Section 1 of the EST Handbook.  Click the About 
EST link located in the list of Help links at the bottom of the EST Main 
Menu.   

 

 

 

 

 

 

 

3.6.12  Contact Us 
This function provides phone numbers and email addresses for 
technical support in using the EST.  It also provides contact 
information for the ETDM Coordinators, Community Liaison 
Coordinators, and Environmental Technical Advisory Team 
representatives for each District.  To access the Contact Us 
function, click the Contacts link located in the list of Help links at 
the bottom of the EST Main Menu. 

The Contact Us page opens, displaying the contact information 
and navigation links. 

 

 

 

Tip!   Click on the toolbar icons to: 

 Print the current page. 

  Create a PDF of the current page. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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Tip!  Use the links at the top of the Contact Us window to navigate directly to: Technical 
Support, District, Turnpike, SIS, or Map of Contacts. 

3.6.13  ETDM Public Access Site (New 11/30/2011) 
Click the Public Site link located in the list of Help links at the bottom of the EST Main Menu to open the 
ETDM Public Access Site. 

 

3.6.14  Get Adobe Acrobat Reader (New 11/30/2011) 
Adobe Reader is freeware that enables users to view and print PDF files. The EST provides easy access 
to the Adobe Reader site for downloading the necessary reader, enabling you to view PDF documents. 
Click the Get Adobe Acrobat Reader link located in the list of Help links at the bottom of the EST Main 
Menu to access the Adobe Reader site. 

 
 
After you have accessed the Adobe Reader site, follow the sequence of instructions for downloading the 
appropriate Reader. 



Public Information Site 
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Chapter 4 ETDM Public Access Site (Updated 04/16/2007) 

The Efficient Transportation Decision Making (ETDM) Public Access Site provides public access to information 
about proposed transportation projects as they progress through the ETDM Process. Project information is 
loaded to the Web site when the Environmental Technical Advisory Team (ETAT) representatives begin 
reviewing the projects for environmental effects. During the review period, the public and the ETAT 
representatives review the projects for potential effects to the surrounding resources.  The ETAT 
representatives enter their agency position and provide the official “electronic signature” for the agency. The 
public is able to view planning/project information and maps at this time.  Although the public is not able to 
directly input comments into the tool, they are able to provide input using district and MPO traditional public 
involvement activities. Attendance at MPO and FDOT meetings and workshops and written comments during 
workshops and hearings will continue to be recorded by MPOs or by the FDOT.  After the 45-day review period, 
the public input and ETAT comments are loaded to the Web site. Summary reports are copied to the site as 
they are published.  Project updates are released after the draft material has been reviewed by the ETDM 
Coordinator, and re-released for the next review cycle.  When the project moves beyond the Programming 
Screen, the project information is updated at the end of subsequent phases 

4.1 Web Site Access 

The public accesses the Web site directly at http://etdmpub.fla-etat.org/ or through the FDOT Environmental 
Management Office home page at: www.dot.state.fl.us/emo/. 
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A link to the site is also available on the Sign In page of the secure Environmental Screening Tool site.  Before 
logging into the secure site, click on the link at the bottom of the page for the "Public Site." 

 

Access public, read-only 
version of the 
Environmental 
Screening Tool 



Public Information Site 
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4.2 Welcome Page 

The ETDM Public Access Site Welcome page includes information about the ETDM Process and instructions 
for finding a project, getting started in using the Site, and how to sign up to receive emails concerning projects of 
interest.  The Welcome Page also includes a Project Search tool for identifying an ETDM project, pull-down 
menus for accessing Site tools and reports, a Help feature that provides a description of each Site page, and 
links to the Florida Department of Transportation and MyFlorida.com Web sites. 
 

4.3 Pull-down Menus 

The pull-down menus at the top of the page are used to access the features available on the Web site.  Click on 
one of the tabs to see the list of features available for that category. 

4.3.1 Welcome Menu 
Information for First Time Users is available under the Welcome menu.  Additional 
features available under Welcome are Contact Us, FAQs, First Time Users, Get Involved, 
On-line Help, Site Map, Watch Project, Welcome Page, and What’s New.  Click on 
feature name to open that page.  Hover your mouse over the feature name to see a 
description of that page in the Help box at the bottom left of the page. 

Contact Us 
This page provides phone numbers and email addresses for technical support in using 
the ETDM Public Access Site.  It also provides contact information for the ETDM 
Coordinators, CLCs, and ETAT representatives for each FDOT District. 
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Use the scroll bar on the right side of the page to scroll through the contact information, or click one of the links 
at the top of the page (for example, District 1, District 5) to go to the contact information for that group.  Click the 

button to view a PDF version of a Contact List or click the button to print the information displayed on 
the screen. 

FAQs 
The Frequently Asked Questions (FAQ) page lists answers to common questions about the ETDM Process and 
the Environmental Screening Tool. The questions are organized under subheadings of: 

• Computer Questions  

• Data Questions  

• Documentation Questions  
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Click on the question text (for example, "What are the minimum system requirements for the ETDM Mapper to 

run on my computer?”) to see the answer.  Click the button to view a PDF version of the information 

displayed on the screen or click the button to print the information. 

First Time Users 
The First Time Users page provides information about the features of the ETDM Public Access Site, how to find 
a proposed transportation project, and how to access information about that project.  Use the scroll bar to scroll 

through all of the information.  Click the button to print the information. 

 

Get Involved 
This page is used to sign up to receive email notices when projects of interest are updated. You may select 
specific projects or receive notices about all projects in an FDOT District or county.  You may also sign up to 
receive information about general ETDM activities such as publication updates and public notices.  (A link for 
unsubscribing is also provided.)  The Get Involved page also includes links to the FDOT Public Involvement 
Web site, and Web sites for local Metropolitan Planning Organizations and FDOT District offices.  Click on one 
of the links (in blue) to go to that Web site. 
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Use the sign-up form to enter your contact information.  Then select the types of notices you want to receive by 
clicking the checkbox next to your preference.   

 

You are also requested to review FDOT’s Privacy Statement, and indicate your agreement by clicking the 
checkbox next to “I agree.”  When finished, click “Save Preferences.” 
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Online Help 
Online Help provides a description of each page of the ETDM Public Access Site.  Selecting “Online Help” 
under Welcome takes you to a complete list of the page descriptions, organized by category, beginning with the 
Welcome menu.  Use the scroll bar on the right side of the screen to scroll through the page descriptions.  Click 

the button to print the descriptions. 

 

Site Map 
This page lists and provides a link to every page that is available in the ETDM 
Public Access site.  Use the scroll bar on the right side of the page to scroll 
through the list.  Click on a page name to go to that page.  Click on the “?” in 
front of the page name to view a description of that page.  Click the 

button to print the information. 
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Watch Project 
The Watch Project page is used to sign up to receive email notifications when updated information is available 
for a selected project.  Enter your email address, click the check box next to “I agree to the FDOT Privacy 

Statement,” and click the Save Preferences button.  Click the button to print the Watch This Project page. 

 
The Watch Project feature is also available on the project-specific pages under Project Diary, Project Effects, 
and ETDM Maps.  Click the "watch project" link in the upper right corner of the page.  You can also sign up to 
watch the current selected project by going to the Get Involved page. 

Welcome Page 
Clicking on the Welcome Page feature takes you to the ETDM Public Access Site Welcome Page described in 
Section 4.2. 

What’s New 
The What’s New? Page displays the latest notices about updates and changes to the ETDM Public Access site.  

Click the button to view a PDF version of the information displayed on the screen or click the button 
to print the information. 
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4.3.2 General Information 
The General Information menu includes links to information and documents 
associated with the ETDM Process. 

Agency Agreements 
The Agency Agreements page displays a list of Master Agreements and Funding 
Agreements, if applicable, which have been executed by the Florida Department 
of Transportation and state and federal agencies participating in the ETDM 
Process.  Use the scroll bar on the right side of the page to scroll through the list 

of agreements.  Click  to sort the list of agreements.  Click on the 
agreement name to view a PDF of the agreement. 

 
To find agreements for a specific agency, type the agency name (or a 
portion of the name) in the "Keywords" field, then click "Search."  Use 
the Category pull-down menu to find other documents that are 
included in the ETDM Library.  Select a category, then click “Search.” 
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Agency Jurisdiction Matrix 
This page provides a link to the matrix of review agencies and the resource issues they are responsible for 
reviewing.  The page includes a query function to select either an agency or an issue. 

 
To view the list of resources for which an agency provides reviews, select the agency name from the pull-down 
menu, then click “Submit.”  In the example shown below, the agency selected is FL Department of Agriculture 
and Consumer Services. 

 
To view the list of agencies responsible for providing reviews for a resource issue, select an issue from the pull-
down menu.  In the example shown below, the issue selected is Wildlife and Habitat. 
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Annual Reports 
The Agency Annual Reports page displays a list of annual reports and annual program review notes for 
agencies participating in the ETDM Process. Use the scroll bar on the right side of the page to scroll through the 

list of annual reports.  Click  to sort the list of annual reports.  To find an Agency Annual Report for a 
specific agency, type in the agency name (or a portion of the name) in the Keywords field, then click "Search." 

Click on the name of a document to display that document.  After reviewing the selected document, click the 
"Back" button to return to the list of Agency Annual Reports. 

Use the Category pull-down menu to find other documents that are included in the ETDM Library.  Select a 
category, then click “Search.” 

 

ETDM Acronyms 
This option opens a list of acronyms used in the ETDM Process.  The Acronyms page includes a Search option 
that can be used to quickly find the definition of an acronym.  Type in the acronym, or a word or phrase, then 
click “Search.” 
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To see a list of acronyms associated with a category, select the category from the Category pull-down menu, 
then click “Search.” 

 

 

 

 

 

ETDM Glossary 
This function opens a glossary of ETDM terms. The Glossary page includes a Search option that can be used 

to quickly find the definition of a term. Type in a word or phrase, then click “Search.”  Click  to sort the 

list of terms.  Click the button to view a PDF version of the Glossary, or click the button to print the 
Glossary. 
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ETDM Guidance 
The ETDM Guidance page displays a list of documents that have served as guidance in the development of the 
ETDM Process and associated procedures.  To find a specific document, type the document title or a portion of 
the title in the "Keywords" field, then click "Search."  Click on the document name to view a PDF version of the 
document.  Use the Category pull-down menu to find other documents that are included in the ETDM Library.  
Select a category, then click “Search.” 

 

ETDM Library 
This page provides links to documents stored in the ETDM database (for example, the ETDM Manual and 
ETDM Process Flow Diagram).  Click on the name of a document to display a PDF version of that document.  
To find specific documents or documents related to a specific topic, type in the document or topic name (or a 
portion of the name) in the Keywords field, then click "Search."  A list of all documents for a specific category is 
displayed by selecting the category from the Category pull-down menu, then clicking "Search." 

Click  to sort the list of documents.  Click the button to view a PDF version of the list of ETDM 

Library documents, or click the button to print the list. 

 
After reviewing the selected document, click the "Back" button to return to the list of documents. 



Public Information Site 

 
Environmental Screening Tool Handbook  4-14 

ETDM Manuals 
This page provides links to the ETDM Policies and Procedures Manual and other manuals associated with the 

ETDM Process.  Click on the name of a document to display that document.  Click  to sort the list of 
documents.  To find a specific document, type in the document name (or a portion of the name) in the Keywords 

field, then click "Search."  Click the button to view a PDF version of the list of ETDM Manuals, or click the 

button to print the list.  

 

After reviewing the selected document, click the "Back" button to return to the list of manuals.  Use the Category 
pull-down menu to find other documents that are included in the ETDM Library.  Select a category, then click 
“Search.” 
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ETDM Overview 
This page displays a document that provides an overview of the ETDM Process.  The document is displayed in 
a PDF viewer, which can be used to review, save, or print the document. 

 

LRTP Adoption Schedule 
This page provides the anticipated dates when Long Range Transportation Plans (LRTPs) for individual 
Metropolitan Planning Organizations (MPOs) are scheduled for adoption.  The LRTP Adoption Schedule is 
displayed in a PDF viewer, which can be used to review, save, or print the document.  Use the PDF zoom 
feature to view the schedule.  Click the plus button to zoom in, and the minus button to 
zoom out, or select a size percentage from the pull-down menu.   
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Links to the individual LRTPs are also provided.  To view a specific LRTP, click on the link (in blue) to the right of 
the MPO name. 

Project Release Schedule 
This page lists dates when the FDOT Districts anticipate notifying the ETAT and public that ETDM projects are 
ready to be reviewed.  The Project Release Schedule is displayed in a PDF viewer, which can be used to 
review, save, or print the document.  Use the PDF zoom feature to view the schedule.  
Click the plus button to zoom in, and the minus button to zoom out, or select a size 
percentage from the pull-down menu.   

 

4.3.3 Project Diary 
The Project Diary menu provides links to project-specific information for the 
selected project or projects.  Each page included in the Project Diary menu 

includes a   option.  Clicking this button will allow you to sign up 
to receive email notifications concerning updates to the selected project. 
 

Class of Action 
The Class of Action page displays information about the status of a project's 
NEPA Class of Action Determination.  The page also includes links to Class of 
Action information for various milestones pertaining to the project.  Click on a milestone date to view the Class of 
Action information pertaining to that milestone date. 
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In the example shown below, the Class of Action Determination for the milestone date of 8/31/2005 is 
“Categorical Exclusion.” 

 

Click the button at the top right side of the page to view a PDF version of the Class of Action information, or 

click the button to print the Class of Action page. 

Community Desired Features 
The Community Desired Features report lists features (such as sidewalks or bicycle facilities) that are desired 
by the affected community and have been identified through MPO and FDOT public involvement activities.  The 
page also includes links to Community Desired Features information for various milestones pertaining to the 
project.  Click on a milestone date to view the Community Desired Features information pertaining to that 

milestone date.  Click the button at the top right side of the page to view a PDF version of the Community 

Desired Features information, or click the button to print the Community Desired Features page. 
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Dispute Resolution Activity Log 
When a project enters into formal dispute resolution, the ETDM Coordinator keeps a record of meetings, 
communication, and actions that occur throughout the process to resolve the dispute.  The Dispute Resolution 

Activity Log lists these records in descending chronological order.  Click the button at the top right side of 

the page to view a PDF version of the Dispute Resolution Activity Report, or click the button to print the 
report. 

 

Permits 
This page lists required permits for a project that have been identified by the ETDM Coordinator or Project 
Manager.  The top of the page identifies the project and lists available Project Milestone Dates.  Click on a 
milestone date to view the information pertaining to that milestone date. 
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The bottom portion of the Permits page lists the permits assigned to the project for the selected project 
milestone and indicates the type of permit. 

 

Project Alternatives 
This page provides a summary description for each project alternative and details about the segments 
associated with the alternative, including location and length, jurisdiction and class, current and future 
conditions, and funding sources.  The top portion of the screen identifies the project and lists available Project 
Milestone Dates.  Click on a milestone date to view the information pertaining to that milestone date.   
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The bottom portion of the Project Alternatives page displays the summary description for each alternative, 
followed by the segment details associated with that alternative.  Use the scroll bar on the right side of the 

screen to scroll through the information.  Click the button at the top right side of the page to view a PDF 

version of the information, or click the button to print the Project Alternatives page. 

 

Project Commitments/Responses (to be updated) 
The Project Commitments/Responses page provides FDOT responses to ETAT review comments for a project, 
and any FDOT commitments for the project in response to the ETAT review comments.  The top of the page 
identifies the project and lists available Project Milestone Dates.  Click on a milestone date to view the 
information pertaining to that milestone date. 
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The next portion of the form displays general project commitments by FDOT regarding the project, followed by 
FDOT’s responses to specific comments received during the ETAT review of the project. 

 

Project Description 
The Project Description page gives a detailed overview of a project, including the summary description, Purpose 
and Need Statement, Summary of Public Comments, Consistency information, and links to supporting 
documents.  It also includes a description for each project Alternative and associated segment level details.  
Use the scroll bar on the right side of the page to review the Project Description information.   

The top portion of the page identifies the project and lists available Project Milestone Dates.  Click on a 
milestone date to view the information pertaining to that milestone date. 
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The next portion of the page includes a summary of the Project Description, the Purpose and Need Statement, 
a summary of Public Comments, and a list of Supporting Documents.  Click on the name of a supporting 
document to view a PDF version of that document. 

 

The Project Description information is followed by detailed information for each project Alternative, including 
segment details, beginning with the Alternative Description.   
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The Segment Details include location and length, jurisdiction and class, current and future conditions (including 
base conditions, interim plan, needs plan, and Cost Feasible plan), and funding sources.  A  button 
is provided at the end of the Segment Details section.  Clicking this button returns you to the Project Description 
summary. 

 

Project Managers 
This page provides a list of Project Managers for the selected project, with contact information for each Project 
Manager.  Select a milestone date to view Project Manager information for that date. 
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Technical Studies 
This page lists the technical studies assigned to a project after the Programming Screen.  Use the scroll bar on 

the right side of the screen to scroll through the list.  Click the button at the top right side of the page to view 

a PDF version of the information, or click the button to print Technical Studies page. 

 

Transportation Plan Summary 
The Transportation Plan Summary page displays the system plan summary information for the county 
where the selected project is located. Click "Submit" to view the information.  This page can also be used to find 
transportation plan summary information for specific plan years, planning organizations, or other counties.  Use 
the County pull-down menu to select a county or select “-All-“ to view information for all Florida counties.  Select 
a plan year from the Plan Year pull-down menu, and/or select a planning organization from the Planning 
Organization pull-down menu.  When finished, click “Submit.” 
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The Transportation Plan Summary includes the name of the applicable Transportation Plan, the Plan Year, and 
Planning Organization, as well as the System Needs Statement, if available, and a Summary of System-wide 
Public Comments.  

 

4.3.4 Project Effects 
The Project Effects menu provides links to information related to ETAT 
reviews of projects for potential effects to resources.   

Agency Comments – Project Effects 
The Agency Comments - Project Effects page includes a link to an 
overview of ETAT reviews of project effects and links to the reviews 
associated with specific issues.  Click on "Overview" to see a summary of the reviews.  Issues are grouped 
under Natural, Cultural, Community, and Secondary and Cumulative Effects.  Click on the issue name (for 
example, Floodplains) to see the text of ETAT reviews for that issue. 
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The issues included in the Natural category are: 

• Air Quality: Contains data for the assessment of the air quality surrounding proposed project sites.  
Used to identify if the project is located in a non-attainment or maintenance area for ozone or 
particulate matter. 

• Coastal and Marine:  Pertains to the evaluation of coastal ecosystems, marine life, sensitive shorelines, 
and degradation/preservation concerns. 

• Contaminated Sites:  Contains data to support the evaluation of the likelihood of contamination and its 
impact on the proposed project. 

• Farmlands:  Used to determine the potential involvement of any farmlands within the proposed project 
study/construction area. 

• Floodplains:  Contains data to support the evaluation of the 100-year floodplain within the proposed 
project study/construction area.  Considerations include the type of encroachment, potential for 
backwater impacts, and project influence on floodplain development. 

• Infrastructure:  Contains data that represent the current infrastructure of the project area in order to 
determine possible impacts. 

• Navigation:  Contains data used to determine if a USCG navigation permit is required. 

• Special Designations:  Used for identifying all specially designated lands within the project study area. 

• Water Quality and Quantity:  Contains data for surface water and groundwater quality and quantity 
impact assessment. 

• Wetlands:  Used to identify the amount of wetlands affected by the proposed project, the type of 
wetlands involved, and their overall significance to the surrounding area. 

• Wildlife and Habitat:  Used to consider any species or habitat affected by the proposed project. 

The issues included in the Cultural category are: 

• Historic and Archaeological Sites:  Used for assessing the potential involvement with properties eligible 
for or listed on the National Register of Historic Places. 

• Recreation Areas:  Contains data to be used to identify all recreational areas within the proposed 
project study area. 

• Section 4(f) Potential:  Contains data to be used to identify all potential Section 4(f) designated lands 
within the project study area. 

The issues includes in the Community category are: 

• Aesthetics: Includes data used to evaluate project effects on community character, including resources 
that may be sensitive to noise, vibration, and visual intrusions. 

• Economic:  Includes information to assist with the evaluation of effects to businesses, employment, and 
changes in the tax base. 

• Land Use:  Used to identify existing and future land uses that show growth potential and the potential 
for the proposed project to induce area growth. 

• Mobility:  Contains data used to examine the public transportation facilities of an area. 

• Relocation:  Designed to evaluate the potential displacement of residences, businesses, community 
institutions, etc. 



Public Information Site 

 
Environmental Screening Tool Handbook  4-27 

• Social:  Concerned with changes in demographics, community cohesion, safety/emergency response, 
and compatibility with community goals and values. 

The Secondary and Cumulative Effects issue contains data sets for the determination of possible secondary 
and cumulative effects within the proposed project study area. 

When “Overview” is clicked, a chart is displayed.  Each row of the chart under the Issue heading corresponds to 
an ETAT agency’s review of the project alternative and includes the degree of effect assigned by the ETAT 
agency.  The degree of effect is displayed on the screen as color-coded text.  To view the full text of an 
agency’s review for an issue, click on the agency name in the Organization column. 
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The table below provides definitions of the color codes used in the Overview of ETAT Reviews. 

Color 
Code 

Degree of 
Effect 

Definition in Regulatory Context Definition in Community Context 

1  Enhanced 

Project has positive effect on the ETAT 
resource or can reverse a previous 
adverse effect leading to environmental 
improvement.  

Affected community supports the 
proposed project. Project has positive 
effect.  

2  
Minimal to 
None 

Project has little adverse effect on 
ETAT resources. Permit issuance or 
consultation involves routine interaction 
with the agency. Low-cost options are 
available to address concerns.  

Minimum community opposition to the 
planned project. Minimum adverse 
effect on the community.  

3  Moderate 

Agency resources are affected by the 
proposed project, but avoidance and 
minimization options are available and 
can be addressed during project 
development with a moderated amount 
of agency involvement and moderate 
cost impact.  

Project has adverse effect on elements 
of the affected community. Public 
Involvement is needed to seek 
alternatives more acceptable to the 
community. Moderate community 
interaction will be required during 
project development.  

4  Substantial 

The project has substantial adverse 
effects but ETAT understands the 
project need and will be able to seek 
avoidance and minimization or 
mitigation options during project 
development. Substantial interaction will 
be required during project development 
and permitting.  

Project has substantial adverse effects 
on the community and faces substantial 
community opposition. Intensive 
community interaction with focused 
Public Involvement will be required 
during project development to address 
community concerns.  

5  
Potential 
Dispute 

Project may not conform to agency 
statutory requirements and may not be 
permitted. Project modification or 
evaluation of alternatives is required 
before advancing to the LRTP 
Programming Screen.  

Community strongly opposes the 
project. Project is not in conformity with 
local comprehensive plan and has 
severe negative impact on the affected 
community.  

 

5  
 

No ETAT 
Reviews 

  

 

 

 



Public Information Site 

 
Environmental Screening Tool Handbook  4-29 

When an issue is clicked, the page that opens will include a Coordinator Summary of the reviews for the 
selected issue, followed by the complete text of each ETAT agency’s review.  In the example shown below, the 
issue selected is Farmlands.  A  button is provided at the end of each issue section.  Clicking this 
button returns you to the list of issues. 

 

The right-hand scroll bar can also be used to scroll through the Agency Comments – Project Effects information.  

Click the button at the top right side of the page to view a PDF version of the information, or click the 

button to print the Agency Comments – Project Effects page. 
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Agency Comments – Purpose and Need 
This page displays the Purpose and Need Statement for the selected project, followed by agency comments on 
the Purpose and Need Statement.  Use the right-hand scroll bar to view the agency comments. 

 
The example shown below displays one agency’s comments on the Purpose and Need Statement for the 
selected project. 
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Community Inventory 
The Community Characteristics Inventory page provides access to information about communities for which 
Community Characteristics Inventories have been completed.  This information includes statistics such as 
population, housing, and income; narratives about community goals, values, and history; and lists of community 
facilities such as schools, health facilities and parks. 

Begin by selecting a District from the pull-down menu. 

 
 

Then select a county from the County pull-down menu.  Communities in that county for which there are 
Community Characteristics Inventories will be listed in the Community pull-down menu.  Select a community, 
then click "Make Report.” 
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The Community Characteristics Inventory report will open in a PDF viewer, which can be used to review, save, 
or print the report. 

 

GIS Analysis Results 
The GIS Analysis Results page is used to identify features that are in proximity to the project corridor centerline 
(for example, the number of Historic structures within 500 feet).  These features are from various GIS datasets 
made available through the Florida Geographic Data Library.  

The page opens with a project header displaying the project name, the County and FDOT District where the 
project is located, the ETDM phase, from and to locations, contact information, and project milestone dates. 
Below the project information is a pull-down menu for selecting an issue (for example, Historic and 
Archaeological Sites).  Click on the issue name, then click “View GIS Analyses.”   
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The next screen displays a list of specific GIS datasets associated with the selected issue.  Click the checkbox 
next to “Analysis Name” to select all the datasets, or click the checkbox next to an individual dataset.  Buffer 
distances can be deselected by clicking the checkmark next to a buffer distance.  The checkmark will be 
removed.  When finished, click the “Generate Report” button on the right side of the screen, or click “Select 
Different Issue” to return to the Issues pull-down menu.  In the example, “Land Use” is the selected issue. 

 

If “Generate Report” is clicked, the next screen will display a list of GIS Analysis Results.  Click on the analysis 
name to go to the results for that analysis.  Detailed results of selected dataset features detected within the 
selected set of buffers around the project line will be displayed.  Analyses are run periodically on the database, 
and the date of analysis is listed with each result set.  Click “back to top” to return to the list of analyses.  Click 
the “Start Over” button to return to the Issues pull-down menu. 

 

In the example shown below, “2000 Census Designated Places” was selected.  Click the  button to 
see metadata describing each data set and the values it contains.  The metadata are in standard Florida 
Geographic Data Library format. 
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GIS Analysis Summary 
The GIS Analysis Summary page is used to view a summary of features that are in proximity to the project 
corridor centerline associated with an issue (for example, the number of Historic structures within 500 feet). 
These features are from various GIS datasets made available through the Florida Geographic Data Library.  

The page opens with a project header displaying the project name, the County and FDOT District where the 
project is located, the ETDM phase, from and to locations, contact information, and project milestone dates. 
Below the project information is a pull-down menu for selecting an issue (for example, Historic and 
Archaeological Sites).  Click on the issue name, then click “View Summary.”   

 

A summary of the GIS Analysis Results associated with the selected issue will be displayed.  The first column 
lists the features, and the other columns display the number of those features located with the various buffer 
distances around the project centerline.   

 

To view the GIS Analysis Summary for a different issue, select the issue from the pull-down menu, then click 

“View Summary.”  Click the button to print the GIS Analysis Summary page. 
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Screening Summaries 
The Screening Summaries page displays a summary of the results of ETAT reviews for screening events.  The 
Screening Summaries page opens with a project header displaying the project name, the review start date, the 
ETDM phase, from and to locations, the County and FDOT District where the project is located, contact 
information, and the project milestone date for the most recent screening event.  To see screening summary 
information for other project milestone dates, select one of the dates. 

 
The project header is followed by a chart that displays the summary degree of effect assigned for specific issues 
for each project alternative.  The issues are grouped into Natural, Cultural, and Community categories.  The 
summary degrees of effect are color-coded, and the chart includes a legend that explains the color coding. 

 

Click the button at the top right side of the page to view a PDF version of the information, or click the 

button to print the Agency Comments – Project Effects page. 
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Summary Report 
If the selected project has been reviewed during ETAT screening events, the completed Summary Reports 
showing the results of the screening events can be generated using the Summary Report page.  The ETDM 
Coordinators create the Planning Screen and Programming Screen Summary Reports following the ETAT 
review cycles.  The Screening Summary report is available 60 days after the review period ends.  These reports 
include a summary of the agency comments, and responses made to those comments. 

The Summary Report page opens with a project header displaying the project name, the review start date, the 
ETDM phase, from and to locations, the County and FDOT District where the project is located, contact 
information, and the project milestone date for the published Summary Report. 

 
The project header is followed by a list of items that are included in the Summary Report.  All the items have 
green checkmarks.  Items can be deselected by clicking the checkmark next to the item.  The checkmark will be 
removed.  When finished, click the “Generate Report” button at the bottom of the page. 
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The next page will display an outline of the items selected for the Summary Report.  Use the scroll bar on the 
right side of the page to scroll through the Summary Report, or click on any item in the outline to take you to the 
text for that item.  You can make changes to your selections for the Summary Report by clicking the 

 button, which will take you back 
to the Summary Report Options screen.  Click 
the  button to return to the Summary 

Report outline.  Click the button at the top 
right side of the page to open the Summary 
Report in the PDF viewer, which can then be 
used to review, save, or print the Summary 

Report.  Click the button to print the 
Summary Report page. 

 

 

 

 

 

 

 

4.3.5 ETDM Maps 
The ETDM Maps menu includes two options: Hardcopy Maps and a link to the 
Interactive Mapper. 

Hardcopy Maps 
The Hardcopy Maps page provides links to maps for specific issues pertaining to the selected project (for 
example, Coastal and Marine Map, Historic Resource Map, and Land Use Map).  The Hardcopy Maps page 
opens with a project header displaying the project name, the review start date, the ETDM phase, from and to 
locations, the County and FDOT District where the project is located, and contact information, followed by 
project milestone dates. 
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Below the project header is a list of maps available for the most current project milestone date.  To see lists of 
maps for other project milestone dates, click on one of the milestone dates.  Use the scroll bar on the right side 
of the page to scroll through the list of maps for each project alternative.  To view the map in PDF format, click 
the “PDF” link to the right of the map name.   

 
The map will be displayed in a PDF viewer; and you can then review, save, or print the map.  Use the scroll bar 
on the right side of the screen to scroll through the map.  Note that the top of the map is labeled with the project 
name. 
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The bottom portion of the map includes the map name (in the example shown, it is Population Density).  A 
legend for the map is also provided, as well as a list of the sources of the data used to generate the map.  Click 
the “Back” button at the top left side of the map page to return to the list of maps. 

 

Click the “JPG” link next to the map name to view the map in JPG format.  The image can then be saved to your 
computer.  Click the “Back” button at the top left side of the map page to return to the list of maps.   
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Interactive Mapper 
The Interactive Mapper page provides visual access to data about ETDM projects and environmental 
resources.  This tool lets you display information over a geographic location through a custom map.  The map 
displayed in the window is linked to data files that describe the features.  You can easily change the location on 
the map, or learn more about the data by using the available map tools. 

Navigating Around the Map 
If you have a project selected in the Project Search window, the map will automatically focus on that location.  
Use the slide bar to zoom in or out.  Click, hold and drag the map to move to a new location.  Quickly find a new 
location using the Map Search options.  

Exploring the Map 
Use the Map Tool Bar located above the map to search for new locations, customize the map, and learn more 
about the data used on the map. 

• Map Search - find a location on the map by address, zip code, FDOT district, county, city, or water 
management district  

• Map Info - pick which data to show on the map, view the legend, identify map features, and learn more 
about the data  

• Print - create a printable version of the map with various size and orientation options  

• Help - learn more about using the mapper functions  

Please note: creating an interactive map viewer that is compatible with Web Content Accessibility Guidelines 
(WCAG) is technically not feasible at this time.  Use the Hardcopy Maps and GIS Analysis Results report for 
alternative sources of the mapped information. 

4.4 Project Search 

Click on the Project Detail option on the left side of the page to select a 
project.  Once a project is selected, you will be able to view project 
details, maps, results of spatial analyses, comments received from 
agencies and the public regarding potential impacts to surrounding 
resources, and summary reports.   

 
 
 
 
 
 

4.5 Finding Projects 

The ETDM Public Access Site provides two methods to search for projects loaded into the database.  The 
primary method is to search for projects visually by clicking on location maps and then selecting the project 
name.  The advanced search provides a form to search the database by using pull-down menus to select 
projects based on several criteria such as the street name or degree of effect to surrounding resources. Both of 
these methods are described below. 
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4.5.1 Basic Search 
 

 

The simplest method of finding a project in the ETDM database is by navigating to it on a map.  The site home 
page opens with a map of the state of Florida showing the FDOT districts.  To see which counties are within a 
district, move your cursor over the map.  As the cursor moves over a district, a small map will appear showing 
the counties within the district. Begin the search by zooming 
into a FDOT district.  Click within a district to zoom to the 
district extent, or click on the district name at the bottom of 
the screen.  The window will update with a new map showing 
the extent of the district.   

Zoom to the county where the project is located by clicking 
on the map within the county boundaries.  The window will 
update with a map of the county.  The ETDM projects will 
show up on the map as a red line and will be listed at the 
bottom of the page.  Click on the name of the project to view 
project specific information (see Section 4.4). 

 

 

 

 

 

 

Click on map 
or District list 

to open 
District map. Hover mouse 

over Florida 
map to view 

counties within 
a District. 

Click project 
name for 

more 
information 

Project 
location(s) 

shown in red 
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4.5.2 Advanced Search 
Click the "Advanced Search" option in the menu at the top of the ETDM Public Access Site home page. This 
takes you to a page to query the database for projects.  You can specify projects by name, FDOT district, 
county, ETDM phase, street name, degree of effect to surrounding resources, and/or issue.  Use one or more of 
these options to narrow down the list of projects. If you want the entire list, click the "Submit" button without 
entering any selection criteria.   

 

After entering the selection criteria, click the "Submit" 
button to start the search for projects meeting the criteria.  
A new window appears listing the projects found in the 
database that meet the criteria specified in the search 
criteria.  Click on the project name for more information 
about that project. 

 

Click project 
name for 

more 
information 

Search by project name. Enter 
as much of the project name as 

you know. Click on the radio 
buttons to search any of the 

words in the phrase, all of the 
words, or exactly as entered 

Click on the 
district 

name(s) to 
search by 

FDOT district. 
 

Click on the 
name(s) to 
search by 

ETDM phase. 

Click on the name(s) 
to search by county. 

Search by street name. Enter as much of the 
name as you know. Click on the radio buttons 
to search any of the words in the phrase, all of 

the words, or exactly as entered. 

Use the pull-down 
menu to find 

projects by degree 
of effect 

Click on issue 
name(s) to 

search by ETAT 
comments on 
environmental 

topics of interest. 

Click "Submit" to retrieve projects 
from the database matching the 

specified criteria, or click "Reset" to 
clear the form. 
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4.6 View Project Information 
The project description page provides the details about the project.  In addition, the pull-down menu at the top 
provides access to project maps and additional reports.  

 

The View menu includes a number of reports, as well as a link to the ETDM Mapper.  Select the option from the 
pull-down menu. When viewing agency comments on project effects or the GIS analysis results, select an 
environmental issue to focus on specific issues (select "All Issues" if not interested in a specific issue).  The 
issues include: 

After selecting a View and an Issue (or "All Issues"), click "Go" 
to open the report or map. It will open in a new window.  The 
following options are available in the View menu: 

• Agency Comments: Project Effects - This report gives 
an overview to the ETAT reviews of project effects 
with links to individual comments.  Each row 
corresponds to an ETAT representative’s review of a 
particular project alternative and related issue.  The 
degree of effect is displayed on the screen as color-
coded text.  Click on the color-coded degree of effect 
text to view the detailed agency comments. 

Scroll down 
for more 

project details 

1. Select 
report or map 

from View 
menu 

2. Select 
environmental 

issue, if desired 
3. Click "Go" 
to open new 

page. 

Project 
details 
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• Agency Comments: Purpose and Need - View the comments on the Purpose and Need Statement for 
a selected project with this report.  The report header displays the project name, from and to locations, 
and the agency name. Below the header information, a read-only Purpose and Need Statement 
appears above a table of the agency reviews.  The reviews are not required to contain comments, 
although these are stored and displayed if submitted.  All reviews must indicate whether the agency 
has accepted or not accepted the Purpose and Need Statement. 

• Environmental Review Summary Report - If the selected project has been reviewed during ETAT 
screening events, the completed summary reports are displayed showing the results of the screening 
events.  The ETDM Coordinators create the Planning Screen and Programming Screen Summary 
Reports following the ETAT review cycles.  These reports provide a summary of the agency comments, 
and response made to those comments.  Each row of the table represents a project alternative corridor, 
and each column on the right-hand side represents an environmental resource issue organized in 
"Natural," Physical" and "Social" groups, as shown below.  The intersection of a project row and issue 
column is a cell that represents the summary degree of effect for a particular project and issue.  As 
shown in the legend, a number and color code are used to designate the summary degree of effect (for 
example, 1  signifies "Enhanced").  For each project, the ETDM Coordinator assigns a summary 
degree of effect for the resource issue in collaboration with the ETAT reviewers who submitted 
comments.  To view the specific agency comments, click on the color-coded cell (for example, 2  ) 
below the environmental resource issue and sharing the same row as the project name. The pull-down 
menus on the upper left of the window are used for filtering the list of projects by county, plan year, 
ETDM phase, and/or planning organization.  The table is automatically updated when changes are 
made to these selection menus.  A second set of menus provides some project-level reports. Under the 
"System-wide Evaluation" menu, there are utilities for viewing a county map, a Summary of Public 
Comments, and the Secondary and Cumulative Effects report, which provide information about 
transportation plans for a county.  The "Project Details" menu provides access to a suite of reports 
including project description report, GIS analysis results, agency reviews, commitments and responses 
to the ETAT reviews, and a dispute resolution history.  For the Programming Screen Summary Report, 
the "Project Details" menu also includes the list of technical studies and required permits needed for the 
project.  Some reports will not open unless a project and issue is selected first.  To select a project, click 
on the circular radio button beside the column named "ETDM #."  To select an environmental resource 

Click to view 
agency comments 
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issue, click on the circular radio button below the issue.  The "Project Selection" menu creates a subset 
of the projects listed in the summary table to include only those that involve potential disputes, or 
substantial effects.  It is a useful filter when there are many projects listed in the summary table.  To 
close the summary report form, click "X" on the upper-right-hand corner of the window. 

 

Legend: 

Color 
Code 

Degree of 
Effect 

Definition in Regulatory Context Definition in Community Context 

1  Enhanced 

Project has positive effect on the ETAT 
resource or can reverse a previous 
adverse effect leading to environmental 
improvement.  

Affected community supports the 
proposed project. Project has positive 
effect.  

2  Minimal to 
None 

Project has little adverse effect on ETAT 
resources. Permit issuance or 
consultation involves routine interaction 
with the agency. Low-cost options are 
available to address concerns.  

Minimum community opposition to the 
planned project. Minimum adverse effect 
on the community.  

3  Moderate 

Agency resources are affected by the 
proposed project, but avoidance and 
minimization options are available and 
can be addressed during project 
development with a moderated amount of 
agency involvement and moderate cost 
impact.  

Project has adverse effect on elements of 
the affected community. Public 
Involvement is needed to seek 
alternatives more acceptable to the 
community. Moderate community 
interaction will be required during project 
development.  

Click number 
for detailed 
comments 

Click number 
for detailed 
comments 
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Legend (continued): 

4  Substantial 

The project has substantial adverse 
effects but ETAT understands the project 
need and will be able to seek avoidance 
and minimization or mitigation options 
during project development. Substantial 
interaction will be required during project 
development and permitting.  

Project has substantial adverse effects on 
the community and faces substantial 
community opposition. Intensive 
community interaction with focused Public 
Involvement will be required during 
project development to address 
community concerns.  

5  Potential 
Dispute 

Project may not conform to agency 
statutory requirements and may not be 
permitted. Project modification or 
evaluation of alternatives is required 
before advancing to the LRTP 
Programming Screen.  

Community strongly opposes the project. 
Project is not in conformity with local 
comprehensive plan and has severe 
negative impact on the affected 
community.  

 

5  
 

No ETAT 
Reviews 

  

 

• GIS Analysis Results - This report identifies features that are in proximity to the project corridor 
centerline (for example, the number of Historic structures within 500 feet).  These features are from 
various GIS data sets made available through the Florida Geographic Data Library.  The report opens 
with a Table of Contents link for each data set belonging to the selected issue. The links can be 
followed to the various sections of the report, and each section is followed by a "Back To Top" link to 
navigate easily between sections and the Table of Contents. A section of the report contains detailed 
results of data set features detected within a set of buffers around the project line.  Analyses are run 
periodically on the database, and the date of analysis is listed with each result set.  If an analysis has 
not yet been run, a message indicates the missing results.  There are also links to metadata describing 
each data set and the values it contains.  The metadata are in standard Florida Geographic Data 
Library format. 

• Transportation Plan Overview - Use this option to view the summary information about the 
transportation plans for which the project is proposed.  

• ETDM Mapper - Use this option to view the project map in the ETDM Mapper interface (see Section 
4.5). 

4.7 View Maps using ETDM Mapper 

When the "ETDM Mapper" option is selected, a new window will open with the ETDM Mapper.  This is an 
interactive map application made available through the FGDL that lets you view and query the data on maps 
that have been custom-made for the ETDM process.  For each project, a base map is available, as well as 
maps for various environmental issues.  After selecting "Maps" from the pull-down menu, a new window will 
open with the ETDM Mapper.  
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Figure 4-1 ETDM Mapper Window 

 

ETDM Mapper tools and functions help users to view and query information about the projects and resources in 
the project area.  The screen capture above identifies specific components of the application, which are 
discussed in the following sections. 

4.7.1 Map View (to be updated) 
The main portion of the ETDM Mapper window is the Map View, which contains the image of the current map.  
The Map View is an interactive window.  By using tools in the tool bar, you are able to select features, change 
the geographic extent, and query the database from the Map View window.  Use the Table of Contents to 
change the data layers that are visible. The Table of Contents and the Map View tool bar are discussed below. 

4.7.2 Table of Contents 
The Table of Contents (TOC) is 
located on the right side of the Map 
View (see Figure 4-1).  The TOC 
displays the list of data layers 
available in the Map View, allows the 
user to choose the layers to view and 
query on the map, and provides 
access to the map legend. The data 
layers are organized in categories 
that are symbolized with a folder 
icon. The default TOC lists data 
categories (groups of data sets). To 
see a list of the individual data layers 
within a category, click on the folder 
icon next to the category name. 

Tool bar 

Menus 

Table of 
Contents 

Map 
View 

Scale Bar

North Arrow 
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(Click on the category folder again to close it and hide the list of data layers.) In an opened category, notice the 
circular radio button and square check boxes next to the name of each data layer.  These are used to toggle 
data layer options on and off.  The check box is used to indicate whether or not the data layer is visible on the 
map.  Click on an empty check box next to the data layer to display it in the Map View.  To turn off a data layer, 
click and uncheck the check box.  Turn on and off as many layers as desired and then click the "Refresh Map" 
button to accept changes and redraw the map.  The circular radio button indicates whether a data layer is 
"Active."  An "Active" data layer is used to perform operations such as database queries and feature 
identification.  Only one layer on the list can be "Active."  To make a data layer active, click once on the circle 
beside the data layer and then use the tools in the tool bar to perform the desired action. The various icons used 
in the TOC are described below: 

TOC Icon Descriptions 

 A closed group, click to open  A visible group/layer, click to hide 

 An open group, click to close  A visible layer, but not at this scale 

 A layer contained within a group  
A partially visible group, click to make 
visible 

 A layer not contained within a group  An inactive layer, click to make active 

 A hidden group/layer, click to make visible  The active layer 

 

The TOC also allows you to view the map legend by 
clicking on the "View Legend" button at the bottom of 
the TOC.  To return to the Layers view, click on the 

"View Layer List" button at the bottom of the Legend.  In order for a layer to be 
active, the TOC must be in the Layer List view, not the Legend view. 

The available data layers that can be viewed on the map change as you zoom 
in and out of the map, because more detailed data become available as you 
zoom in.  Some layers are scale dependent. Detailed and dense data do not 
become available until the map is zoomed in to a scale of 1:70,000. 
Generalized data that have a corresponding detailed layer are turned off when 
the more detailed layer is made available. For example, rivers and streams that 
were digitized from 1:100,000-scale maps are available when the map is 
zoomed to 1:800,000-scale.  When the map is zoomed to 1:70,000, these are 
turned off and the 1:24,000-scale rivers and streams are turned on.  Data 
layers that are made visible (checked check box), but not shown at the current 
scale, are indicated by a magnifying glass icon.   Zoom in or out to view 
these layers.  The data sets are grouped into four scale-dependent categories: 

Zoomed Out More Than 1:800,000  
Only general map reference information appears, such as FDOT district and county boundaries, urban areas, 
and a few large water features on the map. 

1:250,000 - 1:800,000 
More detailed map reference information, such as major highways and city limits, are added to the map.  More 
distinct hydrographic features are added, with a general indication of large wetlands areas.  At this scale, the 
ETDM project centerlines can be viewed on the map. 
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1:70,000 - 1:250,000 
At this scale, the resource data begin to appear on the TOC.  Resources represented by points, generalized 
lines, and large polygon areas are visible, such as the FDOT Roadways, US Census data, Level 1 of the Florida 
Land Use Land Cover Classification System (FLUCCS), and Public Lands boundaries. 

Zoomed In More Than 1:70,000 
All of the issue data are visible at this scale, as are the most detailed base map layers.  Please be aware that 
most of the GIS data were developed for planning purposes rather than design and engineering.  The most 
precise data were usually mapped from 1:24,000-scale map sources such as the USGS 7.5-Minute 
Topographic Map Series.  Please read the metadata for information about the accuracy and intended use of 
each data set before making project-specific decisions and recommendations. 

4.7.3 Map View Tool Bar  
The Map View tool bar contains tools to help view and query the map image.   
 

Details about each tool’s operation are discussed below. 

Print Map 
Print the current Map View.  The application will open a printer dialog box and let you choose a 
printer from those already set up on your computer. 

Refresh 
Re-load the Internet browser. 

 

Map Navigation Tools 
Pan, or move the current extent of the Map View. Click on the map, hold down the mouse key, and drag 
the Map View in the desired direction. 

Zoom into a specified extent of the Map View.  Click on the map, hold down the mouse key, and draw a 
box around the area you would like the Map View to zoom into. 

Zoom out from the current extent.  Click once on the Map View to change the Map View extent.  (This 
tool generally works best if you click on the area that you would like to have in the center of your Map 
View once the extent is zoomed out.) 

Print 

Refresh 

Pan 

Zoom In 

Zoom Out 

Back 

Zoom to Full Extent 

Zoom to Selected Feature

Metadata 
Identify Active Layer 

Identify All

Select

Clear

Measure 

Set Units 

Set Scale 
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Return the Map View to the previous extent.  Similar to the "Back" function of an Internet browser, this 
button allows you to go back to previous views. 

Zoom the extent of the Map View to the largest extent of all data layers listed in the Table of Contents.  
For example, if there are two data layers in the Table of Contents (one that only has features in one 
county, and the other with features throughout the state), the extent of the Map View will zoom to the 
extent of the larger, statewide data layer. 

Zoom the extent of the Map View to the selected features of the currently active data layer in the Table of 
Contents. 

Metadata  
Open a Web page providing detailed information about the source, accuracy, and content of the active 
data layer.  This is especially useful when trying to understand codes and classification systems used in 
a data set. 

Identify Feature of Active Layer 
Click on a map feature of the active data 
layer and view information describing that 
feature. 

To identify a feature in a data layer:  

1. Make the data layer active by clicking 
on the radio button beside the name of 
the data layer. 

2. Click on the "Identify Feature" tool.  

3. Click on the feature in the Map View.  

4. View results in the pop-up dialog 
window, which opens, reporting all of 
the attribute information associated 
with that feature.  

 

 

 

For example, if interested in finding the name of an FDOT district, make the FDOT Districts layer active.  Next, 
click on the "Identify Feature" tool. Then, click the mouse cursor on a road.  The resulting dialog box displays the 
information stored in the database.  Information about the database table items and any codes used in the data 
are explained in the metadata file, which can be accessed by clicking the "Metadata" button described above. 

Identify Features of All Visible Layers 
Click on the map and view attribute information for all visible layers.  Database information associated 
with the features for all visible layers that are found under the click point is displayed in a new window. 
Unlike the previous tool, a layer does not need to be active, but it will take longer for results to return 
when many layers are visible. 

11  MMaakkee llaayyeerr aaccttiivvee

22 CClliicckk  IIddeennttiiffyy  TTooooll

33 CClliicckk oonn  mmaapp  
44 VViieeww rreessuullttss
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Selection Tool  
Select multiple features of the active data set by drawing a box on the Map View.  Any features of the 
active data set that intersect the rectangle will be selected.  Once the features are selected, any action 

performed on that data set will only use those selected records.  

1. Make a data set active in the Table of Contents by 
clicking on the radio button next to its name. 

 
2. Click on the "Selection" tool.  

3. Draw a box on the Map View.  Click and hold the 
mouse button at a point on the map to start one 
corner of the rectangle, drag the mouse corner to the 
opposing corner. 

4. After the shape is drawn, the map redraws, with the 
selected features highlighted.  A window pops up 
listing the selected records from the database. 

5. To select a record from the list, click on the link in the 
"Rec" field.  To remove the selected set and clear the highlighting off selected features, use the 
"Clear Selected Features" tool.  

Clear Selected Features  
Use this tool in conjunction with any of the "Select Features" tools to unselect features of the active data 
layer.  After clearing the selected set of features, any action performed on the data set will be performed 

an all features. 

Measuring Distances 
Distances in the Map View are measured between two points of a line.  Two types of distances are 
displayed at the top left corner of the Map View.  The "Total" distance is a cumulative measure of one 
or more segments.  The "Segment" distance is the linear measurement between a beginning point of a 

segment and the cursor position on the map. 

 

Click on the tool to activate it.  Click on the map to begin the segment.  The Map View redraws showing the 
beginning point of the segment.  Move the cursor on the Map View, and the distance between the location of the 
previous mouse click and the 
cursor's present location is 
updated in the Segment field.  

Click on the map again to 
complete the segment.  The total 
distance is updated to show the 
distance between the two points.  
Continue adding points to extend 
the line.  The total distance is 
updated after each segment is 
completed to show the 
cumulative length of the line.   

Cursor position 

Beginning point
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In order to measure any other shape such as the perimeter of a rectangle, delineate the shape segment-by-
segment, and then consult the dialog box for the total distance that approximates the perimeter.  To change the 
measurement units, use the "Set Units" tool discussed below.  To start a new line, click on the "Clear Selection" 
tool, and add a new beginning point. 

Set Units  
The "Set Units" tool is used in the scale bar and with the "Buffer" tool and "Measure" tool.  Click on the 
"Set Units" tool.  The Set Units tool bar appears at the bottom of the screen with new menus and 
buttons.  Choose a new unit from the pull-down menu.  Click on the "Set Units" button to accept the 

changes and close the 
Set Units tool bar. Click 
"Cancel" to disregard any 
changes that may have 
been selected in the pull-
down menu and close 
the Set Units tool bar. If 
you are using the 
"Measure" tool, the 
distance will automatically be updated when you set new units. 

Set Scale 
The scale indicates the ratio between the distance on the map and the corresponding 
distance in the real world.  The map scale is set automatically when the map extent 

changes.  To set the scale manually, click inside the box and type a whole number for the desired scale.  For 
example, to set the relative map scale to 1:24,000, type "24000" in the box.  Do not add commas or quotation 
marks in the scale, just the numeric value.  The map will redraw, zoomed to the new scale. It will remain 
centered on the same location. 

4.7.4 ETDM Mapper Menu Options 
The ETDM Mapper includes customized tools that provide access to the project database, the results of GIS 
analysis, and comments about potential project effects.  These tools are selected from pull-down menus located 
on the right side of the Map View, above the TOC.  View selections on any of the pull-down menus by clicking 
on the inverted triangle to the right of the menu box. Scroll through selections and click on the option to select it. 

County 
The "County" pull-down menu lists the Florida counties.  When a county 
is selected, click "Go" to zoom the Map View to the extent of that 
county.  The "Project" pull-down menu will update to contain only the 
projects in that county. The county is also selected for use with reports. 

Project 
The "Project" pull-down menu lists the projects currently in the ETDM 
database for the county selected.  When a project is selected, click "Go" 
to zoom the Map View to the geographic extent of the project. The 
project is also selected for use with reports.  
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Issue 
The "Issue" pull-down menu contains the list of issues or categories 
relating to environmental effects that the ETAT representatives are 
responsible for reviewing.  Select an issue from the list, then click "Go" 
to display a customized issue map.  The issue is also selected for use 
with review forms and reports.  The issues include: 

• Aesthetics: Includes data used to evaluate project effects on 
community character, including resources that may be 
sensitive to noise, vibration, and visual intrusions. 

• Air Quality: Contains data for the assessment of the air quality surrounding proposed project sites.  
Used to identify if the project is located in a non-attainment or maintenance area for ozone, CO or 
particulate matter. 

• Base Map:  Contains data representing an overview of the project area, for example, major roads, 
water bodies and rivers, county boundaries, and FDOT District boundaries.  These data are not 
considered an issue for analysis, but as a reference for all other issues being reviewed.  Base map 
data are also included in each of the issue maps. 

• Coastal and Marine:  Pertains to the evaluation of coastal ecosystems, marine life, sensitive shorelines, 
and degradation/preservation concerns. 

• Contaminated Sites:  Contains data to support the evaluation of the likelihood of contamination and its 
impact on the proposed project. 

• Economic:  Includes information to assist with the evaluation of effects to businesses, employment, and 
changes in the tax base. 

• Farmlands:  Used to determine the potential involvement of any farmlands within the proposed project 
study/construction area. 

• Floodplains:  Contains data to support the evaluation of the 100-year floodplain within the proposed 
project study/construction area.  Considerations include the type of encroachment, potential for 
backwater impacts, and project influence on floodplain development. 

• Historical and Archaeological Sites:  Used for assessing the potential involvement with properties 
eligible for or listed on the National Register of Historic Places. 

• Infrastructure:  Contains data that represent the current infrastructure of the project area in order to 
determine possible impacts. 

• Land Use:  Used to identify existing and future land uses that show growth potential and the potential 
for the proposed project to induce area growth. 

• Mobility:  Contains data used to examine the public transportation facilities of an area. 

• Navigation:  Contains data used to determine if a USCG navigation permit is required. 

• Recreation Areas:  Contains data to be used to identify all recreational areas within the proposed 
project study area. 

• Relocation:  Designed to evaluate the potential displacement of residences, businesses, community 
institutions, etc. 

• Secondary and Cumulative Impacts:  Contains data sets for the determination of possible secondary 
and cumulative effects within the proposed project study area. 
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• Section 4(f) Potential:  Contains data to be used to identify all potential Section 4(f) designated lands 
within the project study area. 

• Social:  Concerned with changes in demographics, community cohesion, safety/emergency response, 
and compatibility with community goals and values. 

• Special Designations:  Used for identifying all specially designated lands within the project study area. 

• Water Quality and Quantity:  Contains data for surface water and groundwater quality and quantity 
impact assessment. 

• Wetlands:  Used to identify the amount of wetlands affected by the proposed project, the type of 
wetlands involved, and their overall significance to the surrounding area. 

• Wildlife and Habitat:  Used to consider any species or habitat affected by the proposed project. 

After selecting an issue, click on "Go" to redraw the map, displaying a new set of data layers pertinent to the 
selected issue. 
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Reports 
Various reports are available to view project information, the results of 
the standard GIS analyses, and the recommendations of the ETAT. 
These are the same reports available on the project detail page 
(Section 4.4). 

• Agency Comments: Project Effects - This report gives an 
overview to the ETAT reviews of project effects with links to 
individual comments. Each row corresponds to an ETAT 
representative’s review of a particular project alternative and 
related issue. The degree of effect is displayed on the screen 
as color-coded text. Click on the color-coded degree of effect text to view the detailed agency 
comments (see image below). 

 

• Agency Comments: Purpose and Need - View the comments on the Purpose and Need Statement for 
a selected project with this report.  The report header displays the project name, from and to locations, 
and the agency name.  Below the header information, a read-only Purpose and Need Statement 
appears above a table of the agency reviews.  The reviews are not required to contain comments, 
although these are stored and displayed if submitted.  All reviews must indicate whether the agency 
has accepted or not accepted the Purpose and Need Statement. 

• Environmental Review Summary Report - If the selected project has been reviewed during ETAT 
screening events, the completed summary reports are displayed showing the results of the screening 
events. 

Click to view 
agency comments 
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The ETDM Coordinators create the Planning Screen and Programming Screen Summary Reports following the 
ETAT review cycles.  These reports provide a summary of the agency comments, and response made to those 
comments.  Each row of the table represents a project alternative corridor, and each column on the right-hand 
side represents an environmental resource issue organized in "Natural", Physical" and "Social" groups, as 
shown below.  The intersection of a project row and issue column is a cell that represents the summary degree 
of effect for a particular project and issue.  As shown in the legend, a number and color code are used to 
designate the summary degree of effect (for example, 1  signifies "Enhanced").  For each project, the ETDM 
Coordinator assigns a summary degree of effect for the resource issue in collaboration with the ETAT reviewers 
who submitted comments.  To view the specific agency comments, click on the color-coded cell (for example, 
2  ) below the environmental resource issue and sharing the same row as the project name. 

 

The pull-down menus on the upper left-hand side of the window are used for filtering the list of projects by 
county, plan year, ETDM phase, and/or planning organization.  The table is automatically updated when 
changes are made to these selection menus.  A second set of menus provides some project-level reports. 
Under the "System-wide Evaluation" menu, there are utilities for viewing a county map, a Summary of Public 
Comments, and the Secondary and Cumulative Effects report, which provide information about transportation 
plans for a county.  The "Project Details" menu provides access to a suite of reports including project description 
report, GIS analysis results, agency reviews, commitments and responses to the ETAT reviews, and a dispute 
resolution history.  For the Programming Screen Summary Report, the "Project Details" menu also includes the 
list of technical studies and required permits needed for the project.  Some reports will not open unless a project 
and issue is selected first.  To select a project, click on the circular radio button beside the column named 
"ETDM #."  To select an environmental resource issue, click on the circular radio button below the issue.   

The "Project Selection" menu creates a subset of the projects listed in the summary table to include only those 
that involve potential disputes, or substantial effects.  It is a useful filter when there are many projects listed in 
the summary table. 

To close the summary report form, click "X" on the upper-right-hand corner of the window. 

 

Click number 
for detailed 
comments 
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Legend: 

Color 
Code 

Degree of 
Effect Definition in Regulatory Context Definition in Community Context 

1  Enhanced 

Project has positive effect on the ETAT 
resource or can reverse a previous 
adverse effect leading to environmental 
improvement.  

Affected community supports the 
proposed project. Project has positive 
effect.  

2  Minimal to 
None 

Project has little adverse effect on ETAT 
resources. Permit issuance or 
consultation involves routine interaction 
with the agency. Low cost options are 
available to address concerns.  

Minimum community opposition to the 
planned project. Minimum adverse effect 
on the community.  

3  Moderate 

Agency resources are affected by the 
proposed project, but avoidance and 
minimization options are available and 
can be addressed during project 
development with a moderated amount of 
agency involvement and moderate cost 
impact.  

Project has adverse effect on elements of 
the affected community. Public 
Involvement is needed to seek 
alternatives more acceptable to the 
community. Moderate community 
interaction will be required during project 
development.  

4  Substantial 

The project has substantial adverse 
effects but ETAT understands the project 
need and will be able to seek avoidance 
and minimization or mitigation options 
during project development. Substantial 
interaction will be required during project 
development and permitting.  

Project has substantial adverse effects on 
the community and faces substantial 
community opposition. Intensive 
community interaction with focused Public 
Involvement will be required during 
project development to address 
community concerns.  

5  Potential 
Dispute 

Project may not conform to agency 
statutory requirements and may not be 
permitted. Project modification or 
evaluation of alternatives is required 
before advancing to the LRTP 
Programming Screen.  

Community strongly opposes the project. 
Project is not in conformity with local 
comprehensive plan and has severe 
negative impact on the affected 
community.  

 

5  
 

No ETAT 
Reviews 

  

 

• GIS Analysis Results - This report identifies features that are in proximity to the project corridor 
centerline, for example, the number of Historic structures within 500 feet.  These features are from 
various GIS data sets made available through the Florida Geographic Data Library.  The report opens 
with a Table of Contents link for each dataset belonging to the selected issue. The links can be followed 
to the various sections of the report, and each section is followed by a "Back To Top" link to navigate 
easily between sections and the Table of Contents.  A section of the report contains detailed results of 
dataset features detected within a set of buffers around the project line.  Analyses are run periodically 
on the database, and the date of analysis is listed with each result set. If an analysis has not yet been 
run, a message indicates the missing results.  There are also links to metadata describing each dataset 
and the values it contains.  The metadata are in standard Florida Geographic Data Library format. 

• Transportation Plan Overview - Use this option to view the summary information about the 
transportation plans for which the project is proposed. 

• Project Description - This report displays the details about the project. It includes the Purpose and 
Need Statement and links to any document attachments. 

To close the ETDM Mapper, click the "X" button at the upper right-hand corner of the window. 




